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Welcome to Winter ’14
Sell, service, market, and innovate like never before with Winter ’14. Be productive on the go with new mobile features that
let you connect with your customers in a whole new way. 

We have all the resources you need to get up to speed quickly. 

• Release Notes – Let this document be your comprehensive guide to the release.

• Success–Release Readiness community – Join now to be in-the-know on Winter ’14.

• Release demos – Get quick video overviews of what’s coming this release.

Welcome to Winter ’14!

About the Release Notes
HTML Release Notes—Beta
Your Feedback Matters
You Asked for It!
Change Log

About the Release Notes
For every new major enhancement, the release notes provide:

• A brief, high-level description of the functionality

• Implementation tips to help you get started with setup and administration

• Best practices to help you maximize the benefit

• Complete end-to-end instructions

Smaller changes to existing features are also described, so that you can plan for the new release. Unlike a traditional release
notes document that includes only a simple list of enhancements, these release notes give you everything you need to get up
and running with the new features and enhancements in the latest release.

Let the release notes be your guide to success with the latest release from salesforce.com!

HTML Release Notes—Beta
The Salesforce.com Release Notes are now available in HTML format. The new format and user interface make it easier to:

• Quickly access information about the latest release, without having to download a big Adobe® PDF file

• Read the release notes from any mobile device as the result of responsive design

• Find the sections that you care about, and avoid those you don’t, with better navigation and search

• Bookmark and share specific topics using the unique URLs

• Get better results in search engines due to better search indexing

The HTML release notes is currently available as a beta feature. How can we make it better? What improvements would you
like to see? We really want your feedback! Please post your thoughts and suggestions to this idea on IdeaExchange.

Note:  The content of the HTML release notes matches what’s in the PDF. “Beta” applies to the HTML delivery
format only, and not the content.
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https://success.salesforce.com/_ui/core/chatter/groups/GroupProfilePage?g=0F9300000001oku
http://bit.ly/175Sd5J
http://docs.releasenotes.salesforce.com
https://success.salesforce.com/ideaView?id=08730000000ktqZAAQ


Your Feedback Matters
We know how important the Release Notes, online help, and documentation are to your company’s success with Salesforce.
To continually improve the content we deliver to you, we want to know what works and what doesn’t. Let us know!

• Feedback forms—Every HTML documentation page, both in the online help and in our developer guides at Developer
Force, includes a feedback form for you to submit your suggestions, corrections, and feedback about the documentation.
Let us know what you think!

• IdeaExchange—We’re listening to your ideas too. Winter ’14 includes some of your top ideas. Visit IdeaExchange for a
complete list of ideas coming in Winter ’14.

Want to be notified whenever we publish new documentation or make significant updates to existing documentation? Follow
us on Twitter: @salesforcedocs.

You Asked for It!
We delivered the features you asked for on the IdeaExchange.

Here’s what we delivered!Here’s what you asked for

General Enhancements

More Search Options in Enhanced LookupsSearch More Fields in Enhanced Lookups

Chatter

Archived Groups in ChatterMake Chatter Groups Inactive/Archive

@mention Chatter GroupsChatter Mention Utilization for Chatter Groups

Topics with the Same Name MergedMerge and/or Rename Chatter Topics

Increased Post and Comment SizeModify the 1000 Character limit for a Chatter Comment

New Preview LinksAdd Thumbnail Preview of Link Post

Mobile

SalesforceAAdministration for Mobile Devices

Salesforce1 Features“Mark Complete” Button on Tasks

Quick Close of Tasks

Show Task Status

Salesforce1 FeaturesDelegated Tasks Visibility

Salesforce1 FeaturesShow Company Name on Task List

Salesforce1 FeaturesTask Sorting on Mobile Devices

Sales

Introducing the Salesforce Console for SalesService Cloud Console available in the Sales Cloud

See Opportunity Splits in Sales ForecastsOpportunity Splitting and Forecasting

Creating Lookup RelationshipsLink Price Book to Account or Customer
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http://wiki.developerforce.com/index.php/Documentation
http://wiki.developerforce.com/index.php/Documentation
http://ideas.salesforce.com/
http://twitter.com/salesforcedocs
https://success.salesforce.com/ideaSearch
https://success.salesforce.com/ideaView?id=08730000000BrFaAAK
https://success.salesforce.com/ideaView?id=08730000000XoxuAAC
https://success.salesforce.com/ideaView?id=08730000000Ku1gAAC
https://success.salesforce.com/ideaView?id=08730000000krRkAAI
https://success.salesforce.com/ideaView?id=08730000000K92qAAC
https://success.salesforce.com/ideaView?id=08730000000gRphAAE
https://success.salesforce.com/ideaview?id=08730000000BrjbAAC
https://success.salesforce.com/ideaView?id=08730000000Bq47AAC
https://success.salesforce.com/ideaView?id=08730000000iOu3AAE
https://success.salesforce.com/ideaView?id=08730000000BrgwAAC
https://success.salesforce.com/ideaView?id=08730000000BqZqAAK
https://success.salesforce.com/ideaView?id=08730000000GymgAAC
https://success.salesforce.com/ideaView?id=08730000000YvJ2AAK
https://success.salesforce.com/ideaView?id=08730000000awCUAAY
https://success.salesforce.com/ideaView?id=08730000000Brg4AAC
https://success.salesforce.com/ideaView?id=08730000000JA6UAAW


Here’s what we delivered!Here’s what you asked for

Support for Microsoft® Exchange OnlineSupport for Microsoft Exchange Online with
Salesforce for Outlook

Send and Add EmailsInclude send and add option for new emails

Add Events to Salesforce Records with Event AssociationAdd events to Salesforce records

Hiding the Account Hierarchy LinkAbility to Hide ‘View Account Hierarchy’ link

Service

Salesforce Knowledge Access for Internal UsersCustomers have read-only access to Salesforce Knowledge
regardless of license

More Custom Fields for Article TypesMake Salesforce Knowledge article types more like other
objects (partially)

Improve Salesforce Knowledge page layout editor

Add lookup relationships to Salesforce Knowledge

Customize Supervisor SettingsLive Agent Supervisor Column Filtering

Merge Fields Available for Custom Agent Name and Auto
Greetings

Allow Dynamic Variables in Chat Greetings

Lookup Components for the Salesforce ConsoleCTI Integration Lookup

Analytics

Historical Trend ReportingOpportunity Field History report

Opportunity History with Products Report

Analytics APIExecute Report via API

Show or Hide Role Hierarchy in ReportsAbility to Hide the Role Hierarchy in Reports

Resize the Reports and Dashboards Folder ListMake Folders pane expandable on Reports tab

Force.com

Search in Setup—BetaSearch for Users in the User/Setup Screen

Workflow for the User Object—BetaWorkflow Rules for the User object

Approval Comment Merge Fields are Available in All
Approvals-Related Email Alerts

Allow Approval Comment merge fields to be used in all
approval related emails

User Sharing—Generally AvailableSharing Model for User Object

Triggers for Topic and TopicAssignmentTriggers on Chatter Topic Assignments

Statement Limit EliminationIncrease script statement limit per record in triggers

Scheduled Job Name and Type Available in QueriesCronTrigger Name field needs to be exposed

Additional Components with Support for Pass-Through HTML
Attributes

Support HTML5 Custom Data Attributes in Visualforce
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Change Log
This log summarizes changes to the release notes, with the most recent changes first.

Description of ChangeSalesforce FeatureDate

We’re pleased to announce the general availability of the Salesforce1
app, the new and improved Salesforce mobile experience.

Salesforce1November 17,
2013

Added topics about the new SalesforceA app.SalesforceANovember 17,
2013

Added information about the upgrade of Salesforce Touch to the
improved Salesforce1 experience.

Salesforce Touch is Upgrading to
Salesforce1

November 17,
2013

Added information about the upgrade of the Chatter Mobile for
iPhone and iPad and Chatter Mobile for Android apps to the

Chatter MobileNovember 17,
2013

improved Salesforce1 experience. Chatter Mobile for BlackBerry
remains unchanged.

Added the UserPreferencesHideS1BrowserUI field to the
User object.

New and Changed ObjectsNovember 17,
2013

Deleted this section of the release notes, as this feature is not
available in this release.

View Agents’ Chat Capacity in Chat
Transfer Menu

November 6, 2013

In organizations using Salesforce Communities, the list of mention
suggestions now includes all matches for people and groups across
communities.

Mention Suggestions Include
Members and Groups Across
Communities

November 6, 2013

Clarified that existing Unlimited Edition customers can continue
to purchase new licenses.

Introducing Performance EditionNovember 6, 2013

Added that the File Information, Batch resource
(/chatter/files/batch/fileIds) supports the DELETE

Chatter REST API ResourcesNovember 6, 2013

HTTP method. Make a DELETE request to this resource to delete
a list of files. This method was incorrectly omitted from the
documentation.

The Streaming API is now included in Flexible API Limits—Pilot.Flexible API Limits—PilotOctober 30, 2013

Clarified which organizations default actions are available in.Default Publisher Actions Now
Available

October 30, 2013

Clarified which organizations mobile smart actions are available
in.

Mobile Smart Actions Now
Available

October 30, 2013

Added information about a change to the relationship name for
displaying the Notes and Attachments related list.

Changed Relationship Name for
Notes and Attachments Related List

October 30, 2013

Added support for approvals in Salesforce1.Approvals in the Salesforce1 AppsOctober 30, 2013

Added the PreferencesS1BrowserEnabled field to the
Organization object.

New and Changed ObjectsOctober 30, 2013

Added Update to the supported types in the type field for
DescribeAvailableQuickActionResult and
DescribeQuickActionResult.

SOAP APIOctober 30, 2013

Added Update to the valid values for the standardLabel and
type fields in the QuickAction type.

Metadata APIOctober 30, 2013

4

Change LogWelcome to Winter ’14



Description of ChangeSalesforce FeatureDate

Added QuickAction.DescribeQuickActionDefaultValue
Class and instance methods.

Added the getDefaultValues method to the
QuickAction.DescribeQuickActionResult class.

Apex CodeOctober 30, 2013

Added describeAvailableQuickActions and
describeQuickActions methods to the QuickAction class.

Added clarity about the user interface changes in Chatter Answers.Updated User Interface for QuestionsOctober 23, 2013

Removed reference to New Groups action being part of the mobile
smart actions bundle on global layouts. This action is not included
as a mobile smart action in Winter ’14.

Mobile Smart Actions Now
Available

October 23, 2013

Added information about update actions, a new type of publisher
action.

New Publisher Action TypesOctober 23, 2013

Added a note that the change has no impact on the user interface.Contact Visibility under Shared
Accounts

October 23, 2013

Added information about the new outbound single email limit.Outbound Single Email LimitOctober 23, 2013

Clarified that PATCH is newly supported in API version 29.0. To
make a PATCH request to update a group member’s role, pass

Chatter REST API ResourcesOctober 23, 2013

only the new role parameter or the new role property of the
Group Member Input request body. Don’t pass userId as was
previously stated.

Added new renditionUrl240By180 and
renditionUrl720By480 properties to the File Summary response
body and the ConnectApi.File output class.

Chatter REST API Response Bodies

Chatter in Apex Output Classes

October 23, 2013

Added information about Performance Edition Limited for
customers in Japan, Singapore, and South Korea.

Introducing Performance EditionOctober 16, 2013

Removed incorrect information about the save order and concurrent
modification of User records.

User Object Save Behavior and Error
Changes

October 16, 2013

Added link to Analytics API Developer Guide.Analytics APIOctober 9, 2013

Added information about the new Company Community Add-on
permission set license.

New Company Community
Permission Set License

October 9, 2013

Support for predefined field values in publisher actions is now
available for lookup and master-detail fields.

Lookup and Master-Detail Fields
Supported for Predefined Field
Values in Publisher Actions

October 9, 2013

Added support for using Microsoft Exchange Online with
Salesforce for Outlook.

Support for Microsoft® Exchange
Online

October 2, 2013

Removed xStranormal.com from the list of supported preview links.
The web site is no longer in business.

New Preview LinksOctober 2, 2013

Added the Help and Training section, which lists videos and
documents that are new or updated for Winter ’14.

Help and TrainingSeptember 17,
2013

Restructured the section for clarity and added more information
about preparedness for the archived groups feature.

Archived Chatter GroupsSeptember 17,
2013
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Description of ChangeSalesforce FeatureDate

The Motif response body has a new color property which contains
the hex value of the record type’s base color. Use this value behind
the motif icons.

ConnectApi.Motif has a new color property which contains
the hex value of the record type’s base color. Use this value behind
the motif icons.

Chatter REST API

Chatter in Apex

September 17,
2013

The Bulk API is now included in Flexible API Limits—Pilot.Flexible API Limits—PilotSeptember 17,
2013

Added information about the code coverage-related features
removed from Setup.

Code Coverage Information in the
Developer Console Only

September 17,
2013

Added information about the new App Launcher for Identity
license users.

App Launcher for Identity License
Users

September 17,
2013

Added information on colors field for
DescribeQuickActionResult and
DescribeQuickActionListItemResult.

SOAP API Updated CallsSeptember 10,
2013

Corrected the documentation to reflect that filtered subscriptions
are now available for all API versions.

Streaming API Filtered SubscriptionsSeptember 10,
2013

Added information about the new Live Agent Pre-Chat API
methods available for developers.

Live Agent Pre-Chat API: Generally
Available

September 4,
2013

Added information about the new Live Agent REST API resources
available for developers.

Live Agent REST API: Generally
Available

September 4,
2013

Added an announcement about the new option of viewing the
release notes in HTML format. The HTML version of the release

HTML Release Notes—BetaSeptember 4,
2013

notes will be available on September 6 or 7, depending on your
time zone.

Visualforce pages are now supported on case detail pages for Case
Feed users.

Add Visualforce Pages to Case Detail
Pages in Case Feed

September 4,
2013

Removed reference to New Groups default action on global layouts.
This default action is not included in Winter ’14.

Default Publisher Actions Now
Available

September 4,
2013

Added information about new objects supported by Streaming API
PushTopic queries (Pilot).

New Supported Objects for
PushTopic Queries — Pilot

September 4,
2013

Added information about new events that allow custom console
components to interact with Case Feed.

New Publisher JavaScript API Events
Let Custom Salesforce Console
Components Interact with Case Feed

September 4,
2013

The All Company feed in Chatter doesn’t include system-generated
record updates that don’t have likes or comments.

Record Updates in All Company
Feed

September 4,
2013

Removed this section for an announcement at a later date.Retirement of Support for the
Salesforce CTI Toolkit

September 4,
2013

Added information about Compact Layouts in Salesforce1.
Additional compact layout entries in the REST API, SOAP API,
Metadata API, and ISVForce sections.

Compact Layout OverviewSeptember 4,
2013

Corrected the list of available field types for historical trending.Historical Trend ReportingSeptember 4,
2013

6

Change LogWelcome to Winter ’14



Description of ChangeSalesforce FeatureDate

Corrected the list of values for standardLabel as well as type
in QuickAction.

Metadata APIAugust 28, 2013

Corrected the list of supported types for
DescribeAvailableQuickActionResult as well as
DescribeQuickActionResult.

New and Updated CallsAugust 28, 2013

Clarified how Data.com defines inactive account records.Data.com Prospector: Simplified
Definition of “Inactive” for Account
Records

August 28, 2013

The feed search icon moved and is now located on the left side of
the feed, below the publisher.

Relocated Feed SearchAugust 28, 2013

Corrected dates for the start of automatic Salesforce app installation.Automatic Installation of Salesforce
Apps

August 28, 2013

Added content about the new Company Community user license.New Company Community LicenseAugust 28, 2013
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Feature Summary and User Impact
Winter ’14 has features that immediately affect all users after the release. You may want to communicate these changes to
your users beforehand so they are prepared. Other features require direct action by an administrator before users can benefit
from the new functionality.

When will you start seeing Winter ’14 changes on your instance? The best way to find out is to check the Major Release
Schedule section of the Salesforce trust site at trust.salesforce.com/trust/maintenance/.

These release notes describe the new and modified features available in this release. For visibility into known salesforce.com
issues, please refer to the Known Issues Site.

This table summarizes the Winter ’14 features and their impact on users. Review the feature details for the applicable Salesforce
editions.

General Enhancements
Mobile
Chatter
Communities
Sales
Data.com
Service
Analytics
Site.com
Force.com Customization
Force.com Developer

General Enhancements
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Browsers

Introducing Performance Edition

Updates to Translated Terminology

Internationalized Domain Name Support

Search

More Search Options in Enhanced
Lookups
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Mobile
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Salesforce1

Introducing Salesforce1

Salesforce1 Features

Set Up Your Organization to Use
Salesforce1

Salesforce1 Differences from the Full
Salesforce Site

Salesforce1 Platform Overview

SalesforceA

SalesforceA

Salesforce Touch

Salesforce Touch is Upgrading to
Salesforce1

Chatter Mobile for BlackBerry

Chatter Mobile for BlackBerry is Now
a Connected App

Salesforce Classic

Salesforce Mobile Rebranded to
Salesforce Classic

Additional Mobile Support

Mobile Packaging

Chatter
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Groups
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Archived Chatter Groups

Using Publisher Actions in Chatter
Groups

@mention Chatter Groups

Using Email to Post to Chatter Groups
— Pilot

Profiles

New Chatter Profile Page (Profile Tabs)

Enabling Customization of Chatter User
Profile Pages

Introducing Subtab Apps (Apps on
Profile)

Files

Salesforce Files—Pilot

Publisher Actions

Default Publisher Actions Now Available

Mobile Smart Actions Now Available

Publisher Actions Available in Groups
and on Topic Pages

New Publisher Action Types

Lookup and Master-Detail Fields
Supported for Predefined Field Values
in Publisher Actions

Rich Text Area Fields Supported in
Publisher Actions

Topics

Feed Tracking Automatically Enabled
for Topics (available within 24 hours
after the Winter ‘14 release)

Following Topics (available within 24
hours after the Winter ‘14 release)

New Topics User Permissions (available
within 24 hours after the Winter ‘14
release)
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Editing Topic Names

Topics with the Same Name Merged
(available within 24 hours after the
Winter ‘14 release)

Feeds

Chatter Thanks

Increased Post and Comment Size

Combined Filter and Sort Options

New Preview Links

Relocated Feed Search

Record Updates in All Company Feed

Chatter and Email

Redesigned Email Notifications

API Enhancements

Chatter REST API

Chatter in Apex

Communities
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Communities Moderation

Default Profile for Communities
Self-Registration

Sharing Groups for High-Volume
Community Users

Offline Communities No Longer Show
Up in The Community Drop-Down
Menu
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

View Global Header Permission Is No
Longer On By Default

Maximum Number of Communities
Listed in Setup

Case Visibility in Communities

Improved Communities API Support

Use Site.com Pages Instead of Standard
Tabs

Use Salesforce Header and Footer on
Site.com Pages

Adding Site.com Pages as Tabs in Your
Community

New Communities Widgets

Sales
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Salesforce Console

Introducing the Salesforce Console for
Sales

Opportunities and Collaborative Forecasting

See Opportunity Splits in Sales Forecasts

Integrate Product Families in Forecasts

Price Books

Creating Lookup Relationships

Customizing Search Layouts

Salesforce for Outlook

Send and Add Emails
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Add Events to Salesforce Records with
Event Association

View and Work with More Salesforce
Records

Social Accounts and Contacts

Contact, Account, and Lead Profile
Image Visibility

Social Network Fields Available on List
Views

Accounts

Hiding the Account Hierarchy Link

Email Templates

Email Template Access

Partner Portal

Removed Change My Password Button
For Partner Users with Single Sign-On

Change in Behavior For The Username
Field On Partner Users

Salesforce to Salesforce

Improved Security For Salesforce to
Salesforce

Data.com
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Prospector

Get to Salesforce Records Directly from
Data.com Search Results

Expanded Definition of What’s
Considered a Duplicate Record

13

Data.comFeature Summary and User Impact



Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Increased Export Limit

Simplified Definition of “Inactive” for
Account Records

Data.com Licenses & Limits Page
Rebranded with Data.com Prospector
Name

Additional Enhancements

Clean

Clean Info Objects

Clean Info Custom Report Types

Record Cleaning from List Views

Reporting an Account, Contact, or Lead
as Inactive or Active to Data.com

Flagging an Account, Contact, or Lead
Field Value as Wrong or Right to
Data.com

Additional Enhancements

Social Key

Social Key is Now Generally Available

Service
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Case Feed

Case Feed Automatically Enabled in
New Organizations

New Publisher JavaScript API Events
Let Custom Salesforce Console
Components Interact with Case Feed
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Add Visualforce Pages to Case Detail
Pages in Case Feed

Updated Look for Feed Items in Case
Feed

Combined Filter and Sort Options in
Case Feed

New Labels for Portal-Related Buttons
in Case Feed

Chatter Answers

Activity History

Rich Text and Images in Chatter
Answers Replies

Updated User Interface for Questions

Reply to Questions with Email

Update Needed for Notification URLs
When Enabling My Domain

Customize Chatter Answers with
Visualforce Components

Customize the Account Creation
Experience for Chatter Answers Portal
Users

Build the Chatter Answers Search into
Your Applications

Customize Component Events with the
Chatter Answers JavaScript API—Pilot

Entitlement Management

Create More Flexible Entitlement
Processes with Recurring Milestones

Entitlement Versioning—Generally
Available

Monitor Case Activity with Milestone
Feed Items

View Milestones on the Case Feed Page
with the Milestone Tracker
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Show the Time Since a Milestone Target
Was Violated

Change the Account Associated with an
Entitlement

Ideas

Activity History

“Like” Comments

Set a Profile Type for Your Ideas Users

Knowledge

Salesforce Knowledge Access for Internal
Users

Knowledge One with Federated Search

More Custom Fields for Article Types

Search Articles to Create Smart Article
Links

Chatter Feed Available on Article
Toolbar

Topics on Salesforce Knowledge
Articles—Pilot

Metadata API Support for Article
Approval Actions

Play Videos from Any Provider with a
Custom Visualforce Page

Live Agent

Automated Chat Invitations—Generally
Available

Customize Supervisor Settings

Merge Fields Available for Custom
Agent Name and Auto Greetings

Customize Agent Names

Create, Delete, and Edit Live Agent
Session Records
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Critical Wait Alerts for Unanswered
Chats

Filter Agents by Button and Status in
the Supervisor Panel

Enable Live Agent’s Pre-Chat API

Chat Tab Alerts for Waiting and Ended
Chats

Preview Chat Requests and Transfers

Updated Look for the Chat Request List

Updated Look for the Agent Chat
Window

Setup Label Changed from “Agent
Configurations” to “Live Agent
Configurations”

Live Agent API Versions

Access Your Live Agent API Endpoint

Live Agent Deployment API: New
Methods

Live Agent Pre-Chat API: Generally
Available

Live Agent REST API: Generally
Available

Open CTI

Force.com Canvas for Open CTI

New Open CTI Method:
notifyInitializationComplete()

Salesforce Console

Service Cloud Console Name Change

Salesforce Console Supports Microsoft®

Internet Explorer 10®

Lookup Components for the Salesforce
Console

Home Tab for the Salesforce Console
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Most Recent Items

Keyboard Shortcuts Panel

Force.com Canvas for the Salesforce
Console

Salesforce Console Integration Toolkit:
New Methods

Customer Portal

Removed Change My Password Button
For Customer Users with Single
Sign-On

Change in Behavior For The Username
Field On Customer Users

Analytics
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Historical Trend Reporting

Embedded Analytics (available within
24 hours after the Winter ‘14 release)

Analytics API (available within 24 hours
after the Winter ‘14 release)

Show or Hide Role Hierarchy in Reports

Report Types Support for User Sharing

Analytics Folder Sharing is On By
Default

Restrict List View Creation

Resize the Reports and Dashboards
Folder List

Report Charts from Page Layouts in the
Metadata API
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Format of Report Object in the SOAP
API

Site.com
Contact

salesforce.com to
enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Multilingual Site Support—Generally
Available

Custom Properties for Widgets

Sandbox Enabled for Site.com

HTML Import

New Broken Link Finder

New Live Mode for Editing Content

Inline Editor

Default Doctype Changed to HTML5

Approval Processes Enabled in Site.com

External Reference Checking Enabled
in Site.com

Additional Updates to Site.com Studio

Organization ID Required for Domain
Names

New Company Community License

New Company Community Permission
Set License

Force.com Customization
Data
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Business Logic and Process Automation
Security
Sharing
Critical Updates
Additional Customization

General Administration

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

SalesforceA Mobile App for
Administrators

Search in Setup—Beta

Freezing User Accounts

Permission Set Licenses

Geolocation Performance Improvements

Rich Text Area Editor Context Menu
Changes

Data

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Data Import Wizard—Beta

Field History Data Retention
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Business Logic and Process Automation

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Visual Workflow

End of Support for the Legacy Desktop
Flow Designer

Workflow

Workflow for the User Object—Beta

Approvals

Approvals in the Salesforce1 Apps

Approval Comment Merge Fields are
Available in All Approvals-Related
Email Alerts

New Limit of 30 Steps per Approval
Process

Security

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Critical Updates

Clickjack Protection for Non-Setup
Salesforce Pages

Authentication

Creating Service Providers as
SAML-Enabled Connected Apps

RelayState Parameter Default Changed

Entire SAML Assertion Now Signed

Using OpenID Connect Authentication
Providers

Mutual Authentication
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Using Frontdoor.jsp to Log Into
Salesforce

Identity

Identity License

Identity Connect License

Automatic Installation of Salesforce
Apps

Custom Attributes for Connected Apps

Updated Connected Apps OAuth Usage
Page

Add Alternate Identity Providers on
Login Page

Administration

Visibility and Control for Sessions and
Identity Confirmation

Session-Level Security

Restricting User Email Domains

Setting Two-Factor Authentication
Login Requirements

Using Time-Based Tokens to Access the
API

Using Time-Based Tokens for Identity
Confirmation

My Domain

New Location of My Domain in Setup

Identity Provider Auto-Enabled for New
My Domains

Customizable Branding on Login Page
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Sharing

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

User Sharing—Generally Available

New Description Field for Sharing
Rules

Sharing Records with Managers Groups

External Organization-Wide
Defaults—Pilot

Parallel Organization-Wide Default
Updates—Pilot

Asynchronous Recalculation of Sharing
Rules—Pilot

Monitoring Parallel Recalculations

Contact Visibility under Shared
Accounts

Globalization

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Custom State and Country
Picklists—Generally Available

Rename Standard Objects and Fields
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Critical Updates

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Clickjack Protection for Non-Setup
Salesforce Pages

Additional Customization

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

“Chatter Feed” Section of the Page
Layout Editor Now “Publisher Actions”

Email Log Size Limits

Outbound Single Email Limit

App Launcher for Identity License Users

Force.com Developer
Sandboxes
Change Sets and Deployment
Developer Console
Visualforce
Force.com Canvas
Apex Code
API
ISVForce
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Sandboxes

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

“Configuration Only” Sandboxes
Renamed to “Developer Pro”

Sandbox Sizes Increase

Hyphen Now Required in Sandbox
Subdomain Name

Change Sets and Deployment

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Approval Post Templates Available in
Change Sets

Compact Layouts Available in Change
Sets

Flexible Pages Available in Change Sets

Change Sets Queue and Processing
Improvements

Improvements to Deployment
Monitoring

User Permissions in Profile Settings in
Change Sets
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Developer Console

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Code Search

Save Order Debug View

SOSL Search Support and Query
History

Static Resource Editors

Override Log Levels for a Class or
Trigger

Improved Visualforce Development in
the Developer Console

Visualforce

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

HTML5 Development

New <apex:input> Component

type Attribute for <apex:input> and
<apex:inputField>

HTML5 <datalist> Element for
Input Components

Additional Components with Support
for Pass-Through HTML Attributes

Accessibility Improvements to
Visualforce Components

Deferred Loading of JavaScript
Resources via
<apex:includeScript>

Additional Enhancements
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Changed Relationship Name for Notes
and Attachments Related List

Preview Page Button for Visualforce
Pages

Available for Touch Checkbox
Renamed

Improved Visualforce Development in
the Developer Console

registrationClassName Attribute
Added to the
<chatteranswers:registration>
Component

chatteranswers:allfeeds
forceSecureCustomWebAddress
Attribute Deprecated

Server-Side View State—Pilot

SOQL WHERE Clause No Longer Reset
In a StandardSetController
Initialized with a queryLocator

Force.com Canvas

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Canvas Apps in the Publisher and the
Chatter Feed—Pilot

This feature is visible to all users in new
Development Edition organizations. To
enable this feature in existing
Development Edition organizations or
other organizations, contact
salesforce.com.

Canvas Apps in the Salesforce1
App—Pilot
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Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

This feature is visible to all users in new
Development Edition organizations. To
enable this feature in existing
Development Edition organizations or
other organizations, contact
salesforce.com.

API Enabled User Permission No
Longer Required

SDK Object and Field Changes

Force.com Canvas Support for Streaming
API

Apex Code

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Statement Limit Elimination

Scheduled Job Name and Type Available
in Queries

PreviousFireTime Reset for
Upgraded Scheduled Apex Jobs

Triggers for Topic and
TopicAssignment

New Classes, Methods, and Interfaces

Chatter in Apex

Updated Errors for Email Messaging
Methods

Different Status Codes Returned by
DML Exceptions for the User Object

Code Coverage Information in the
Developer Console Only
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API

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

New and Changed Objects

Flexible API Limits—Pilot

SOQL

OFFSET Use In Sub-queries – Pilot

Increased Number of Relationship Fields

SOSL

WITH NETWORK Supports Multiple
Communities

REST API

AppMenu Resource

FlexiPage Resource

CompactLayouts Resource

Get Deleted Objects Resource

Get Updated Objects Resource

Limits Resource—Pilot

This feature is visible to all users in
Development Edition organizations. To
enable this feature in other organizations,
contact salesforce.com.

Limit Info Header

QueryAll Resource

SObject Describe Resource Support for
If-Modified-Since Header

SObject Quick Actions Resource

Themes Resource

SOAP API

New and Updated Calls

LimitInfoHeader

29

APIFeature Summary and User Impact



Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Streaming API

Increased Limits for Performance,
Unlimited, and Enterprise Edition
Organizations

Filtered Subscriptions

Support for Delete and Undelete Events

Generic Streaming — Pilot

New Supported Objects for PushTopic
Queries — Pilot

Additional APIs

Chatter REST API

Metadata API

Bulk API

Tooling API

Analytics API (available within 24 hours
after the Winter ‘14 release)

ISVForce

Contact
salesforce.com to

enable this feature.

Not automatically
visible. Feature is

available but
requires some

setup.

Automatically
visible to all

administrators. No
setup required.

Automatically
visible to all users.
No setup required.

Feature

Environment Hub

Signup API Enhancements

Deleting Components in a Managed
Package—Pilot

Flexible Pages Available in Packages

Compact Layouts Available in Packages
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General Enhancements
General enhancements affect many users.

Browsers
Introducing Performance Edition

Beginning in November 2013, we’re offering a new edition that combines CRM and the Force.com platform with Data.com,
Work.com, Identity, Live Agent, Salesforce Knowledge, and additional sandbox functionality.

Updates to Translated Terminology
More Search Options in Enhanced Lookups
Internationalized Domain Name Support

You can use email addresses with an Internationalized Domain Name (IDN) in email fields.

Browsers
Review the supported browsers for this release.

Salesforce Console Supports Microsoft® Internet Explorer 10®

The Salesforce console is available for use with Microsoft’s Internet Explorer® 10 browser.

Supported Browsers

Learn about the browsers we support for Salesforce.

Salesforce Console Supports Microsoft® Internet Explorer 10®

The Salesforce console is available for use with Microsoft’s Internet Explorer® 10 browser.

Supported Browsers
Learn about the browsers we support for Salesforce.

Important: Beginning Summer ’15, we’ll discontinue support for Microsoft® Internet Explorer® versions 7 and 8.
For these versions, this means that some functions may no longer work after this date. Salesforce.com Customer
Support will not investigate issues related to Internet Explorer 7 and 8 after this date.

CommentsBrowser

If you use Internet Explorer, we recommend using the latest version. Apply
all Microsoft software updates. Note these restrictions.

Microsoft® Internet Explorer® versions 7, 8,
9, and 10

• The Compatibility View feature in Internet Explorer isn’t supported.

• The Metro version of Internet Explorer 10 isn’t supported.

• Internet Explorer 7 and 8 aren’t supported for the Developer Console.

• Internet Explorer 7 isn’t supported for Open CTI.
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CommentsBrowser

• Internet Explorer 7 isn’t supported for Salesforce CRM Call Center built
with CTI Toolkit version 4.0 or higher.

• Internet Explorer 7 isn’t supported for Force.com Canvas.

For configuration recommendations, see “Configuring Internet Explorer” in
the Salesforce Help.

Salesforce.com makes every effort to test and support the most recent version
of Firefox. For configuration recommendations, see “Configuring Firefox” in
the Salesforce Help.

Mozilla® Firefox®, most recent stable version

Google Chrome applies updates automatically; salesforce.com makes every
effort to test and support the most recent version. There are no configuration

Google Chrome™, most recent stable version

recommendations for Chrome. Chrome isn’t supported for the Console tab
or the Add Google Doc to Salesforce browser button.

Supported plug-in for Internet Explorer 6 and 7 only. Google Chrome Frame
applies updates automatically; Salesforce supports only the most recent version.

Google Chrome Frame™ plug-in for
Microsoft® Internet Explorer® 6 and 7

For configuration recommendations, see “Installing the Google Chrome
Frame™ Plug-In for Microsoft® Internet Explorer®” in the Salesforce Help.
Chrome Frame plug-in isn’t supported for the Salesforce console or Forecasts.

There are no configuration recommendations for Safari. Apple Safari on iOS
isn’t supported.

Apple® Safari® versions 5.x and 6.x on Mac
OS X

• Safari isn’t supported for the Salesforce console.

• Safari isn’t supported for Salesforce CRM Call Center built with CTI
Toolkit versions below 4.0.

Recommendations and Requirements for All Browsers
• For all browsers, you must enable JavaScript, cookies, and SSL 3.0.

• Salesforce.com recommends a minimum screen resolution of 1024 x 768 for the best possible user experience. Screen
resolutions smaller than 1024 x 768 may not display Salesforce features such as Report Builder and Page Layout Editor
properly.

• Some third-party Web browser plug-ins and extensions can interfere with the functionality of Chatter. If you experience
malfunctions or inconsistent behavior with Chatter, disable all of the Web browser's plug-ins and extensions and try again.

Certain features in Salesforce—as well as some desktop clients, toolkits, and adapters—have their own browser requirements.
For example:

• Internet Explorer is the only supported browser for:

◊ Standard mail merge (We don’t support Google Chrome Frame™ plug-in for Internet Explorer because the ActiveX
controls required for mail merge are supported in Internet Explorer only.)

◊ Installing Salesforce Classic on a Windows Mobile device
◊ Connect Offline

• Firefox is recommended for the enhanced page layout editor.
• Browser requirements also apply for uploading multiple files on Chatter.
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Discontinued or Limited Browser Support
As of Summer ’12, salesforce.com discontinued support for Microsoft® Internet Explorer® 6. Existing features that have
previously worked in this browser may continue to work through 2014. Note these support restrictions.

• Internet Explorer 6 isn’t supported for:

◊ Chatter
◊ Global search
◊ Answers
◊ Cloud Scheduler
◊ The new user interface theme
◊ Quote Template Editor
◊ Salesforce console
◊ Salesforce Knowledge
◊ Live Agent
◊ Forecasts
◊ Chatter Answers
◊ Enhanced profile user interface
◊ Site.com
◊ Schema Builder
◊ Joined reports
◊ Enhanced dashboard charting options

Internet Explorer 7 isn’t supported for Site.com and Chatter Messenger. For systems running Microsoft Windows XP, Internet
Explorer versions 7 and 8 with the latest security patches are supported for Chatter Answers.

Introducing Performance Edition
Beginning in November 2013, we’re offering a new edition that combines CRM and the Force.com platform with Data.com,
Work.com, Identity, Live Agent, Salesforce Knowledge, and additional sandbox functionality.

Performance Edition is designed for customers that need to drive amazing growth, achieve new levels of customer satisfaction,
and maximize sales and service success in the social and mobile world. Performance Edition includes all Unlimited functionality
plus clean, targeted lead and customer data from Data.com, coaching and feedback tools from Work.com, trusted identity
services from Identity, and more. For customers in Japan, Singapore, and South Korea, we offer Performance Edition Limited,
which includes all Performance Edition functionality except Data.com.

As of November 2013, Unlimited Edition is no longer available for purchase. Customers using Unlimited Edition can continue
to maintain and renew their edition, purchase additional licenses, or upgrade to Performance Edition.

Updates to Translated Terminology
We updated some terminology, including tab and field names for our Finnish, Russian, Thai, Traditional Chinese, Czech,
Hungarian, Romanian, and Turkish language users.  For each term, we provide the English version and the corresponding
previous and new translations. You can find the complete list of term changes in knowledge article number 000181874 (URL:
https://help.salesforce.com/apex/HTViewSolution?urlname=Winter-14-Updates-to-Translated-Terminology&language=en_US)
on the salesforce.com Customer Support site.

These terminology changes are available to all organizations. To keep your current tab and field labels, system administrators
can change the name back using our rename tabs and labels functionality. For more information, see “Renaming Tab and
Field Labels” and “Considerations for Renaming Tab and Field Labels” in the Salesforce Help or contact Customer Support.
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For more information about supported languages, see “What languages does Salesforce support?” in the Salesforce Help.

More Search Options in Enhanced Lookups
When searching for records using enhanced lookups, you have a new option to search more fields. By default, enhanced lookups
query a limited set of fields, known as Name fields, for each object. If you’re searching for a record that returns a large number
of matching records, such as a contact with a widely used name, you can instead query all searchable fields to narrow your
results. If available in the enhanced lookup search dialog, select All Fields and enter other search terms unique to the record,
such as the contact’s email address. This option is currently available for accounts, contacts, and custom objects. It’s not available
for the user object.

For more information about Name fields and searchable fields, see “Searchable Fields in Lookup Searches” and “Searchable
Fields by Object” in the Salesforce Help.

Internationalized Domain Name Support
You can use email addresses with an Internationalized Domain Name (IDN) in email fields.

Available in: All Editions.

Since a large number of mail transport agents (MTAs) are not Unicode-compliant, Salesforce translates IDNs to an
ASCII-compatible encoding (ACE) version. This gives MTAs a greater chance of processing email addresses containing an
IDN. The email addresses are translated to the ACE version upon sending the email.

Example email address with an IDN and its ACE
• Email with an IDN: example@föö.com
• Translated ACE version: example@xn--f-1gaa.com

Depending on the recipient’s email client, they may see the ACE version of the email address rather than the original email
address with the IDN. Any custom code that handles email addresses may need modification to support IDNs.
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Mobile
Stay productive on the go with Salesforce mobile apps.

Salesforce1

The Salesforce1 apps let you stay up to date on your most-important records, activities, conversations, and dashboards—from
wherever you are.

SalesforceA

Manage users and view information for Salesforce organizations from your mobile device.

Salesforce Touch is Upgrading to Salesforce1

Salesforce Touch is upgrading to the new Salesforce1 experience. The new app gives you the same Salesforce Touch features
you’ve come to expect, in an updated interface that makes it easy for users to find what they need and get their work done
faster. On top of that, Salesforce1 gives you more, with many new enhancements.

Chatter Mobile

The Chatter Mobile for Android and Chatter Mobile for iPhone and iPad apps have upgraded to Salesforce1 v5.0. Chatter
Mobile for BlackBerry isn’t upgrading in the Winter ’14 timeframe.

Salesforce Mobile Rebranded to Salesforce Classic

Salesforce Mobile, the original Salesforce CRM mobile app, is now Salesforce Classic for Android™, BlackBerry®, and
iPhone® devices.

Mobile Packaging

Mobile Packaging lets you seamlessly define, categorize, and deploy mobile apps to your organization through Connected
Apps. Mobile Packaging is currently available through a pilot program.

Salesforce1
The Salesforce1 apps let you stay up to date on your most-important records, activities, conversations, and dashboards—from
wherever you are.

Introducing Salesforce1

The Salesforce1 apps are Salesforce on the go!  These enterprise-class mobile apps give you real-time access to the same
information that you see in the office, but organized for getting work done faster when you’re between customer meetings,
waiting for a flight...even when you’re in line for coffee.

Salesforce1 Features

The new Salesforce1 apps include a broad range of features and functionality designed to help users stay connected and
productive wherever they are. These features are based on the Salesforce experience and are optimized for mobile devices.

Requirements for Using Salesforce1

These are the requirements and supported environments for using the Salesforce1 downloadable and mobile browser apps.

Data That’s Supported in Salesforce1

The Salesforce1 apps use your organization’s Salesforce edition, user license types, and assigned user profiles and permission
sets to determine the data that’s available to each user. In most cases, users see the same objects, record types, fields, and
page layouts that they do when working in the full Salesforce site. Not all Salesforce data is supported in this release, however.
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Access the Salesforce1 Apps

The way users access Salesforce1 depends on how you configure your organization.

Learn about Using Salesforce1

The Salesforce1 app includes a Help link that you can use to learn about using the mobile app.

Set Up Your Organization to Use Salesforce1

There are several ways that you can customize the Salesforce1 apps for your organization, to make it easier for your users to
work effectively on the go.

Salesforce1 Differences from the Full Salesforce Site

The Salesforce1 apps don’t have all of the functionality of the full Salesforce site, and in some cases include features that
aren’t available in the full site.

Salesforce1 Platform Overview

There are several Force.com platform changes and enhancements that support Salesforce1 development.

Introducing Salesforce1
The Salesforce1 apps are Salesforce on the go!  These enterprise-class mobile apps give you real-time access to the same
information that you see in the office, but organized for getting work done faster when you’re between customer meetings,
waiting for a flight...even when you’re in line for coffee.

The intuitive interface is optimized for easy navigation and data interaction on a touchscreen, so you can review details, update
data, and create new records with just a few taps. And Salesforce1 includes many of your organization’s Salesforce customizations,
which means your mobile experience is as tailored to your specific business needs as you need it to be.

You can get Salesforce1 in different ways:

• As a downloadable app from the App Store and Google Play™. Users can install the app directly on Apple® and Android™

mobile devices.
• As a mobile browser app that runs in supported mobile browsers on Apple and Android mobile devices. This option doesn’t

require anything to be installed.

Note:

This release of Salesforce1 doesn’t have all of the functionality of the full Salesforce site. To see data or do actions
that aren’t supported in Salesforce1, use the full site instead.

Salesforce1 Features
The new Salesforce1 apps include a broad range of features and functionality designed to help users stay connected and
productive wherever they are. These features are based on the Salesforce experience and are optimized for mobile devices.

Here’s an overview of what Salesforce1 offers.

Collaborate on the go

Access Chatter feeds, groups, people, and files to stay connected to colleagues and customers on the go, keep tabs on
records you’re following, and share files from anywhere.

Work faster

Log calls, add meeting notes, create and update records, and more...right in the feed.
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Keep up to date with your customers

Reach out to accounts and contacts directly from their Salesforce records, log calls and emails after you make them, and
keep current on news about your customers.

Stay on top of your CRM data

Create and edit sales, service, marketing, and custom object records right from your mobile device—no more scribbling
notes on scrap paper after client meetings so you can update records when you’re back at your desk.

Find what you need

Quickly and easily find the data you need with just a few taps. Use list views, recently accessed records lists, and global
or record search.

Manage your day

Use Today to prepare for meetings, tap your way into conference calls, and get directions to your next appointment.

Track your activities

Manage your time in the field effectively: Use lists to track and manage tasks, close or reopen tasks with one tap, create
tasks and events on the spot, and view existing Salesforce events.

Measure your progress

Monitor dashboards to stay current on whatever you’re measuring, wherever you are.

Keep posted

Receive in-app notifications about approval requests or when someone has mentioned you in Chatter.

Customize the Salesforce1 experience

Create and integrate mobile-optimized Visualforce pages and custom publisher actions to put custom tools, functionality,
and user interfaces at users’ fingertips.

Use custom and third-party apps

Easily tailor Salesforce1 to your company’s specific needs by integrating custom apps built on the Salesforce1 Platform
and third-party apps.

Maintain permissions

Use role and profile-based permissions and sharing to ensure that the right users have access to the right data, no matter
how they access Salesforce.

Feel secure

Salesforce1 uses the same level of identity and security as the full Salesforce site, which means your data is as safe when
you’re working on your mobile device as it is when you’re working on your desktop.

What’s Available in Each App
In most cases, the Salesforce1 downloadable and mobile browser apps include the same features. But there are some differences
between the apps.

Downloadable Apps for iOS and
Android

Mobile Browser AppFeature

Receive push notifications

Receive in-app notifications
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Downloadable Apps for iOS and
Android

Mobile Browser AppFeature

Use the publisher and publisher actions
(Requires Chatter)

Use Chatter feeds, people, and groups

Attach photos or files to posts or
comments, or use publisher actions to
post photos or files

Share Chatter posts

See previews of files posted to a feed

Double-tap to add or remove bookmarks
for Chatter posts

Use the app when Chatter is turned off

Search for Salesforce records

Search for files

Use list views

Use record actions to make phone calls,
log calls, send emails, map locations, and
view news or Websites

(Phone calls supported on Android phone
and iPhone devices only)

Add new records and update existing
records

Use Today

(Available on Android phone and iPhone
devices only)

Track, close, or reopen tasks

Create and view Salesforce events

View dashboards and dashboard
component details

Use Salesforce Files (Requires Chatter)

Launch Salesforce1 from Salesforce email
notifications

View Visualforce pages

Access custom and third-party apps from
the navigation menu or the publisher

Use app settings
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Downloadable Apps for iOS and
Android

Mobile Browser AppFeature

Configure connections to multiple
instances

Control app access with a security PIN

Requirements for Using Salesforce1
These are the requirements and supported environments for using the Salesforce1 downloadable and mobile browser apps.

Supported Devices

You can run the Salesforce1 downloadable and mobile browser apps on these mobile devices.

• Apple mobile devices with iOS 7 or later:

◊ iPhone® 4 and later models

◊ iPad® 2 and later models (including the iPad mini)

• Android phones with Android 4.2 or later

Supported Browsers

You can run the Salesforce1 mobile browser app in one of these mobile browsers.

• For iOS devices:

◊ The default Apple browser, Safari®

• For Android devices:

◊ Chrome™ for Android devices

◊ The stock Android browser supplied by your manufacturer

For best results, Private Browsing in Safari or Incognito Mode in Chrome should be turned off.

Salesforce Editions and Licenses

These Salesforce editions allow the use of Salesforce1.

• Contact Manager Edition

• Developer Edition

• Enterprise Edition

• Group Edition

• Performance Edition

• Personal Edition

• Professional Edition

• Unlimited Edition

Database.com Edition isn’t supported.

These user license types can access Salesforce1.

• Salesforce users
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• Salesforce Platform and Force.com users

• Chatter Plus users, Chatter Free users, and Chatter customers

These user license types aren’t supported:  all communities and portal users, Database.com users, Sites and Site.com users,
Data.com users, and Work.com users.

Note:  You can access the same data and functionality that’s available to you in the full site, as determined by your
organization’s Salesforce edition, you user license type, and your assigned user profile and permission sets.

Wireless Connection

A Wi-Fi® or cellular network connection is required to communicate with Salesforce. For the best performance, we recommend
using Wi-Fi.

If Chatter is enabled, however, the Salesforce1 downloadable app includes support for viewing Files when a mobile device is
offline.

Locales and Languages

Salesforce1 works with almost all Salesforce-supported locales and the fully-supported and end user languages. (The Salesforce
Help includes a complete list of supported locales and languages.)  Languages that are read right to left, including Arabic and
Hebrew, aren’t supported in this release.

Salesforce1 includes multi-currency support, but advanced currency management isn’t available.

Accessibility

Salesforce1 is designed with accessibility in mind and delivers a fully-accessible mobile experience for all individuals, including
users working with screen readers. Unlike the full Salesforce site, Salesforce1 doesn’t require accessibility mode to give users
working with assistive devices a fully accessible experience.

Check your mobile device’s documentation for more information about using a screen reader.

Data That’s Supported in Salesforce1
The Salesforce1 apps use your organization’s Salesforce edition, user license types, and assigned user profiles and permission
sets to determine the data that’s available to each user. In most cases, users see the same objects, record types, fields, and page
layouts that they do when working in the full Salesforce site. Not all Salesforce data is supported in this release, however.

Users can view, edit, or create records for these objects.

• Accounts and Person Accounts

• Campaigns

• Cases

• Contacts

• Contracts

• Dashboards (view only)

• Leads

• Live Chat Transcripts (view only)

• Opportunities

• Tasks

• Users

• Custom objects that are included in a Salesforce app
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Salesforce events are available from Open Activities and Activity History related lists. And with the downloadable apps on
Android phones or iPhone devices, Today helps users prepare for meetings, stay in touch with customers, quickly join conference
calls, and generally manage their day.

With some exceptions, all of the standard and custom fields are available on supported records. As are most of the related lists
for supported objects.

If Chatter is enabled, users can access feeds, people, and groups. And Files is available in the downloadable apps.

For global searches in Salesforce1, results are returned for objects that the user recently accessed in the full Salesforce site, with
the exception of tasks and events. Results for Chatter people and groups are also returned if an administrator added these
items to the Salesforce1 navigation menu. Files are searchable in the downloadable apps.

Access the Salesforce1 Apps
The way users access Salesforce1 depends on how you configure your organization.

Downloadable Apps

The Salesforce1 downloadable apps for Android phones and iPad and iPhone devices are now generally available. Users can
download and install an app from Google Play or the App Store, then launch the app from their device’s home screen and log
in to their Salesforce account.

The Salesforce1 downloadable apps are connected apps. By default, the apps are available to all users in your organization.
But you can configure which users are authorized to log in to the downloadable apps. You can also control other security
policies, such as requiring that users enter a security PIN to use the app. See Configure the Salesforce1 Downloadable Apps
for more details.

Mobile Browser App

The Salesforce1 mobile browser app runs in a supported mobile browser and can be used on Android phones and iPad and
iPhone devices. The mobile browser app is a great option if your organization doesn’t allow downloadable apps to be installed
on company-issued devices.

By default, the mobile browser app is enabled for your organization and all of your users are able to access it. Login sessions
from supported mobile browsers are automatically redirected to the app. If you disable the mobile browser app, it’s turned off
for everyone. See Enable the Salesforce1 Mobile Browser App for more details.

Learn about Using Salesforce1
The Salesforce1 app includes a Help link that you can use to learn about using the mobile app.

The Help link is located in the navigation  menu. You can also view the Salesforce1 help from here. Select the link for the
mobile experience you’re interested in.

• Salesforce1 mobile browser app on a mobile phone

• Salesforce1 mobile browser app on a tablet

• Salesforce1 for iPhone

• Salesforce1 for iPad

• Salesforce1 for Android phones
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Set Up Your Organization to Use Salesforce1
There are several ways that you can customize the Salesforce1 apps for your organization, to make it easier for your users to
work effectively on the go.

Using the Setup menu, which you access from the Setup link on the upper-right corner of any Salesforce page, you can:

• Define the users who can access the Salesforce1 apps.

◊ For the downloadable apps, click Manage Apps > Connected Apps, and select the app you want to configure. (See
Configure the Salesforce1 Downloadable Apps.)

◊ For the mobile browser app, click Mobile Administration > Salesforce1. (See Enable the Salesforce1 Mobile Browser
App.)

• Customize how data shows up in the Salesforce1 apps.

◊ Optimize your page layouts so they’ll display well on mobile devices. You can do this by modifying existing page layouts
or by creating new page layouts that are mobile-friendly from the outset.

For standard objects, click Customize > Object > Page Layouts. For custom objects, click Create > Objects, click
the name of the object, then click New in the Page Layouts related list. (See Customizing Page Layouts in the Salesforce
Help.)

◊ Add expanded lookups or Visualforce pages to the Mobile Cards section of a page layout to have them display as mobile
cards in Salesforce1. (See New Mobile Cards Section in the Enhanced Page Layout Editor.)

◊ Make sure that Visualforce pages are enabled for use in Salesforce1, so they’ll display in the apps. Click Develop >
Pages, click Edit next to the name of a page, and select Available for Salesforce mobile apps. (See Enable
Visualforce Pages for Use in Salesforce1 Apps.)

◊ Define the fields that show up in an object’s record highlight area and in record preview cards, by creating custom
compact layouts.

For standard objects, click Customize > Object > Compact Layouts. For custom objects, click Create > Objects,
click the custom object name, and click New from the Compact Layouts related list. (See Compact Layout Overview.)

◊ Verify that your existing search layouts populate Salesforce1 search results with the desired fields. Click Customize >
Object > Search Layouts. (See Search Layouts in Salesforce1.)

• Make it easy and efficient to work in the field by creating publisher actions tailored to your specific business activities and
use cases. Publisher actions are available if Chatter is enabled. (See Publisher Actions in the Salesforce1 Apps.)

◊ Make sure that publisher actions are enabled for your organization. Click Customize > Chatter > Settings.

Be sure to enable feed tracking on objects for which you want to create publisher actions. Click Customize > Chatter
> Feed Tracking.

◊ Create global actions that allow users to add new object records with no automatic relationship to other records. Click
Create > Global Actions. To customize the fields that are used by publisher actions, click Layout on the Global Actions
page.

Then add the new actions to the global publisher layout so they’ll show up in the Salesforce1 apps. Click Customize
> Chatter > Publisher Layouts.

◊ Create object-specific actions that allow users to add new records or update data in existing records. Click Customize
> Object > Buttons, Links, and Actions. To customize the fields used by a publisher action, click Layout on the
Buttons, Links, and Actions page.

Then add the new actions to the appropriate object page layout so they’ll be available in the Salesforce1 apps. Click
Customize > Object > Page Layouts.
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• Customize the options that are available in the Salesforce1 navigation menu, as well as the order in which items appear.
Click Mobile Administration > Mobile Navigation. (See Customize the Salesforce1 Navigation Menu.)

• Help keep Salesforce1 users aware of important Salesforce activities by enabling in-app and push notifications. Select
Mobile Administration > Notifications > Settings. (See Salesforce1 Notifications.)

• Integrate third-party apps into the Salesforce1 navigation menu by adding Flexible Page tabs for the Flexible Pages deployed
to your organization. Click Create > Tabs, then click New on the Flexible Page Tabs related list. (See Creating Flexible
Page Tabs.)

Configure the Salesforce1 Downloadable Apps
The Salesforce1 downloadable apps are connected apps. As a result, you can control the users who have access to the apps, as
well as other security policies. By default, all users in your organization can log in to the Salesforce1 downloadable apps.

Available in: All editions except Database.com

User Permissions Needed

“Customize Application”To edit your Salesforce1 downloadable app settings:

“View Setup and Configuration”To view your Salesforce1 downloadable app settings:

You can control security and access policies for each of the Salesforce1 downloadable apps using settings components that are
installed from the managed Salesforce1 and Chatter Apps connected apps package. These components need to be installed
in Salesforce:

• Salesforce1 for Android

• Salesforce1 for iOS

These components are automatically installed when one of your users installs a Salesforce1 downloadable app from the App
Store or Google Play on his or her mobile device and authenticates with your organization by logging in to the mobile app.

Alternatively, you can manually install the Salesforce1 and Chatter Apps connected apps package so you can review and modify
the default security and access settings before rolling out the Salesforce1 downloadable apps to your users.

When the Salesforce1 connected apps components are installed, they’re added to the Connected Apps page at Setup > Manage
Apps > Connected Apps. Here, you can view and edit the settings for each of the apps, including controlling user access with
profiles, permissions, and IP range restrictions. An error message is displayed if a restricted user attempts to log in to a
Salesforce1 downloadable app.

Push notifications for the Salesforce1 downloadable apps aren’t managed from the Connected Apps page. To manage these
settings, go to Setup > Mobile Administration > Notifications > Settings.

Enable the Salesforce1 Mobile Browser App
You can control whether or not users can access the Salesforce1 mobile browser app when they log in to Salesforce from a
mobile browser. By default, the mobile browser app is turned on for your organization.

Available in: All editions except Database.com
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User Permissions Needed

“Customize Application”

“Modify All Data”

To view or modify Salesforce1 mobile browser app settings:

1. From Setup, click Mobile Administration > Salesforce1.
2. Select Enable the Salesforce1 mobile browser app to allow all users in your organization to access the app.

 Deselect this option to turn off access to the app.
3. Click Save.

When this option is turned on, users who log in to Salesforce from a supported mobile browser are always automatically
directed to the Salesforce1 interface. If you want your users to access the full Salesforce site from mobile browsers instead,
deselect this option.

Note:

Automatic redirection to the Salesforce1 mobile browser app is available in supported mobile browsers only. Logging
in from an unsupported mobile browser loads the full Salesforce site.

When the mobile browser app is enabled, individual users can turn off the Salesforce1 redirection for themselves in one of
these places:

• From the navigation menu in the mobile browser app, by tapping Full Site.
• In the full site, by deselecting the Salesforce1 User checkbox from either My Settings > Personal > Advanced User

Details or Setup > My Personal Information > Personal Information.

Alternately, you can use SOAP API to quickly turn automatic redirection to the mobile browser app off (or on) for users.
When the mobile browser app is enabled, the UserPreferencesHideS1BrowserUI field is added to the User object. By
default, this field is set to false, which turns on automatic access to the mobile browser app for all user records. Change this
field to true to turn the redirection off for desired users. See the User section in the SOAP API Developer’s Guide for more
information.

New Mobile Cards Section in the Enhanced Page Layout Editor
You can add expanded lookups and mobile-enabled Visualforce pages to the new Mobile Cards section of the Enhanced Page
Layout Editor. The elements you include in this section display as mobile cards in the Salesforce1 apps, on the related
information page in a record view. Elements in the Mobile Card section don’t display on the record detail page in the full
Salesforce site.

The Expanded Lookups category in the enhanced page layout editor contains fields with lookup relationships. These fields,
when added to the Mobile cards section, display as related lookup cards on records. A page layout can include up to 20 expanded
lookups.

In the Mobile Cards section, only Visualforce pages enabled for Salesforce mobile apps will display in Salesforce1.
Mobile-enabled Visualforce pages show up as slightly different-colored elements in the palette than their non-mobile-enabled
counterparts. Also, hovering your mouse over a Visualforce page element in the palette shows whether it’s mobile-enabled or
not.

Some standard objects have mobile cards added for you by default. Customize the page layout to remove them or add additional
cards.
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Enable Visualforce Pages for Use in Salesforce1 Apps
You can use Visualforce to extend the Salesforce1 apps and give your mobile users the functionality they need while on the
go. Before adding a Visualforce page to Salesforce1, make sure the page is enabled for mobile use or it won’t be available in
the mobile apps.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”

“Author Apex”

To enable the display of Visualforce in Salesforce1:

Tip:

Before exposing existing Visualforce pages in the Salesforce1 apps, consider how they’ll look and function on mobile
phones and tablets.  Most likely, you’ll want to create a new page that’s designed specifically for mobile form factors.

Visualforce pages must be enabled for mobile use before they can display in these areas of the Salesforce1 user interface:

• The Navigation menu, via a Visualforce tab
• The publisher, via a custom action
• Mobile cards on a record’s related information page
• Overridden standard buttons, or custom buttons and links
• Embedded in record detail page layouts

To enable a Visualforce page for Salesforce1:

1. From Setup, click Develop > Pages.
2. Click Edit for the desired Visualforce page.
3. Select Available for Salesforce mobile apps then click Save.

Consider these notes about Visualforce support in the Salesforce1 apps.

• Standard tabs, custom object tabs, and list views that are overridden with a Visualforce page aren’t supported in Salesforce1.
The Visualforce page is shown for full site users but Salesforce1 users will see the default Salesforce1 page for the object
instead. This restriction exists to maintain the Salesforce1 experience for objects.

• You can also enable Visualforce pages for Salesforce1 through the metadata API by editing the isAvailableInTouch
field on the ApexPage object.

• The Mobile Ready checkbox on Visualforce Tab setup pages is for Salesforce Classic only and has no effect on Visualforce
pages in the Salesforce1 apps.

Compact Layout Overview
Compact layouts are used in Salesforce1 to display a record's key fields at a glance. Compact layouts are designed for viewing
records on touchscreen mobile devices, where space is limited and quick recognition of records is important.

Available in: All editions except Database.com
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In the full Salesforce site, compact layouts determine which fields appear in the Chatter feed item that appears after a user
creates a record with a publisher action.

In Salesforce1, compact layouts determine the fields that show up in:

• An object’s record highlights area

• An object’s record preview cards (but not those shown in search results)

• Enhanced lookup cards on a record’s related information page

Note:  Compact layouts aren't available for the Salesforce Classic, Chatter Mobile for BlackBerry, Salesforce Touch,
or Dashboards for iPad mobile apps.

If you don’t create custom compact layouts, records display using a read-only, predefined system default compact layout. Once
you create custom compact layouts, you can set one as the primary compact layout for the object. If you have record types
associated with an object, you can override the primary compact layout assignment and assign specific compact layouts to
different record types.

Compact layouts support all field types except:

• text area

• long text area

• rich text area

• multi-select picklist

You can clone a compact layout from its detail page.

Creating Compact Layouts
Create compact layouts to customize the fields that display for object records when viewed in Salesforce1.

Available in: All editions except Database.com

User Permissions Needed

“Customize Application”To customize compact layouts:

“View Setup”To view compact layouts:

The first four fields you assign to your compact layout populate the record highlights section at the top of each record view in
Salesforce1.

1. For standard objects, from Setup, click Customize, select an object, and click Compact Layouts. For custom objects, from
Setup, click Create > Objects, click the name of a custom object, then click New from the Compact Layouts related list.

2. Click New to create a fresh compact layout.
3. Enter a label for your compact layout.
4. Select up to 10 fields to display on the compact layout and click Add.
5. Sort the fields by selecting them and clicking Up or Down.

The order you assign to the fields determines the order in which they display when the record is viewed on a mobile device,
and in a Chatter feed item resulting from a record create action.

6. Click Save.
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Assigning Compact Layouts to Record Types
If you don’t create custom compact layouts, records display using a read-only, predefined system default compact layout. Once
you create custom compact layouts, you can set one as the primary compact layout for the object. If you have record types
associated with an object, you can override the primary compact layout assignment and assign specific compact layouts to
different record types.

Available in: All editions except Database.com

User Permissions Needed

“Customize Application”To customize compact layouts:

“View Setup”To view compact layouts:

1. For standard objects, from Setup, click Customize > Object > Compact Layouts. For custom objects, from Setup, click
Create > Objects, click the name of a custom object, then scroll down to the Compact Layouts related list.

2. Click Compact Layout Assignment.
3. Select a compact layout to use as the primary compact layout for this object.
4. In the Record Type Overrides section, select one or more record types to which you want to assign a compact layout.

If you don’t have record types set for the object, you won’t see this section. If you don’t set any record type overrides, all
record types use the object’s primary compact layout by default. Press SHIFT + click or click and drag to select a range of
adjacent cells. Press CTRL + click to select individual, non-adjacent cells.

Note that some record types in the list might be inactive. You can assign a compact layout to an inactive record type.

5. Select a compact layout from the Compact Layout To Use drop-down list to assign it to the selected cells.
6. Click Save.

Notes on Compact Layouts

Available in: All editions except Database.com

• Each record type can have only one compact layout assigned to it. However, a compact layout can be associated with
multiple record types.

• Users who don’t have access to certain fields in Salesforce won’t see them on the compact layout.
• A compact layout must contain at least one field.
• A compact layout can only contain fields from its object. This can include a formula field that is a cross-object reference

to another object.
• Removing a field from a page layout doesn’t remove it from the object’s compact layout. The two layout types are

independent.
• If you change a field on a compact layout to an unsupported type, the field is removed from the compact layout.
• Before you can delete a compact layout that’s set as the primary compact layout for the object, you must choose another

compact layout to replace it.
• In Salesforce1, tasks automatically show the status and due date. When customizing a task compact layout, you don’t need

to add these fields to the Selected Fields list.
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Search Layouts in Salesforce1
The Salesforce1 app uses your organization’s Search Results search layouts to determine the fields that display in search results.

Search layouts allow up to 10 fields, but Salesforce1 search results show only the first four fields from an object’s Search Results
layout. You may want to re-order the fields in some or all of your organization’s Search Results layouts so that the most
important data is visible for mobile users.

In the Salesforce1 downloadable app for iOS devices, each recent record listed on a record search page shows the record’s
name and the value of the second field in that object’s Search Results layout. As a user types a search term in the record search
box, the recent record list is filtered based on matching in the second field on the layout, as well as the Name field. This allows
users to see records associated with a different object or data value, not just those with simple name matching. For example,
if Account Name is the second field in the search layout for the contact object, typing Acme in the search box on the contact
search page shows recently-accessed contacts that are related to the Acme account. When you execute the search, however,
the search results page shows records that match against any of the searchable fields for the object.

Publisher Actions in the Salesforce1 Apps
The publisher actions feature lets you create actions and add them to the publisher, which displays in Salesforce1 on feeds and
record views. You can customize the order in which standard Chatter actions, including Post, Link, and Poll, appear in the
publisher. You can also use action layouts to specify the fields that are included in each action, and in which order.

Winter ’14 includes mobile smart actions for Salesforce1, which let you make publisher actions available for your mobile users
with very little effort. The mobile smart actions provide a set of actions that are added to the Salesforce1 publisher on account,
case, contact, lead, and opportunity pages, and on the global publisher layout. They’re automatically populated with all of your
organization’s required fields for the relevant object. Winter ’14 also includes several new types of publisher actions that are
advantageous on mobile devices.

• Log a call actions let users record the details of phone calls or other customer interactions.

• Update actions let users make changes to a record from the record’s feed.

• Custom Canvas actions let users access Canvas apps directly in the publisher.

See Publisher Actions and Mobile Smart Actions Now Available for more details.

In addition to the default actions, you can create unique global or object-specific publisher actions that are tailored to your
business needs. See Setting Up Publisher Actions in the Salesforce Help.

Note:  If you want to assign a custom icon to a publisher action, the optimal icon size for display in the Salesforce1
publisher is 120 x 120 pixels. For best results, don’t use an icon larger than this.

Customize the Salesforce1 Navigation Menu
Customize your mobile Salesforce experience by selecting apps, standard menu items, Visualforce pages, or Flexible Pages to
display in the Salesforce1 navigation menu.

Available in: All editions except Database.com

User Permissions Needed

“Customize Application”To customize Salesforce1 navigation:
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Before you can include Visualforce pages or Flexible Pages in Salesforce1, you must create tabs for them in Setup at Create
> Tabs.

Depending on your organization’s settings, the Salesforce1 navigation menu can contain:

• Dashboards—Availability depends on edition and user permissions.
• Feed—Displays for organizations that have Chatter enabled.
• Flexible Pages—Custom Salesforce1 app home pages.
• Groups—Displays for organizations that have Chatter enabled. If it’s not included as a distinct node in the menu, then

it’s automatically included in the set of Smart Search Items.
• People—Displays for organizations that have Chatter enabled. If it’s not included as a distinct node in the menu, then it’s

automatically included in the set of Smart Search Items.
• Smart Search Items—Represents a set of recently searched-for objects. Determines the content in the Recent section of

the menu. Only searches done in the full Salesforce site influence the objects in this element, and only searchable objects
display in the Recent section. If users pin objects on the Search Results screen in the full Salesforce site, those objects will
stick to the top of the Recent section.

• Tasks—Lists of a user’s open and closed tasks, and tasks that have been delegated.
• Today—An app that helps users plan for and manage their day, by integrating calendar events from their mobile device

with their Salesforce tasks, contacts, and person accounts.  Available in the Salesforce1 for iPhone and Salesforce1 for
Android Phones downloadable apps only.

• Visualforce pages

Note:  Only Visualforce pages enabled for Salesforce mobile apps can be added to the Salesforce1 navigation
menu.

1. From Setup, click Mobile Administration > Mobile Navigation.
2. Select items in the Available list and click Add.
3. Sort items by selecting them and clicking Up or Down.

The order you put items in the Selected list is the order that they display in the navigation menu.

Note:  The first item in the Selected list becomes your Salesforce1 landing page.

4. Click Save.

Once saved, the navigation menu items and their order should be reflected in Salesforce1. You may need to refresh to see the
changes.

Tip: When organizing the menu items, put the items that users will want most at the top. The Smart Search Items
element can expand into a set of eight or more menu items in the mobile experience, and it may end up pushing other
elements below the scroll point if you put it near the top of the menu. Anything you put below the Smart Search
Items element will appear in the Apps section of the navigation menu.

Salesforce1 Notifications
Salesforce1 notifications let your users know when certain events occur in Salesforce, such as when they receive approval
requests or are mentioned.

Two types of notifications can appear to Salesforce1 users.

In-app notifications keep users aware of relevant activity while they’re using Salesforce1. Users can access their 20 most recent
notifications by tapping the  icon.
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Push notifications are alerts that appear on your mobile device when you're not using the Salesforce1 downloadable app. Push
notifications aren’t supported in the Salesforce1 mobile browser app. These alerts can consist of text, icons, and sounds,
depending on your device type. You can choose whether to receive push notifications; however, you can't enable push notifications
if they were disabled by your administrator.

Note:  Some notifications include text that your users enter in Salesforce. To ensure that sensitive information isn’t
distributed through a third-party service, push notifications to iOS devices include the user’s name only.

For example, an in-app notification might be “Allison Wheeler mentioned you: @John Smith, can you update the
Acme account with their new shipping address?” The equivalent push notification for iOS devices would be “Allison
Wheeler mentioned you.”

Not all notifications can be received as push notifications.

Push NotificationIn-App NotificationNotification Type

You received an approval request

Someone mentioned you

Someone posted to your profile

Someone commented on your post

Enable Notifications
Enable all users in your organization to receive Salesforce1 notifications about events in Salesforce, such as when they receive
approval requests or are mentioned.

Available in: All editions except Database.com

User Permissions Needed

“View Setup and Configuration”To view notifications settings:

“Customize Application”To modify notifications settings:

1. From Setup, click Mobile Administration > Notifications > Settings.
2. Select the notifications you want your Salesforce1 users to receive.
3. Click Save.

A user can receive approval requests in Salesforce1 notifications only when the user receives approval requests as email
notifications. You or your user can change the Receive Approval Request Emails user field to set this preference.

Creating Flexible Page Tabs
Before you include a Flexible Page in the Salesforce1 navigation menu, you must create a custom tab for it.

Available in: All editions except Database.com
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User Permissions Needed

“Customize Application”To create and edit custom tabs:

Note: Flexible Page tabs don’t work like other custom tabs. Once created, they don’t show up on the All Tabs page
when you click the plus icon ( ) that appears to the right of your current tabs. Flexible Page tabs also don’t show up
in the Available Tabs list when you customize the tabs for your apps.

You must have at least one Flexible Page in your organization for the Flexible Page Tabs section to show up.

1. From Setup, click Create > Tabs.
2. Click New in the Flexible Page Tabs related list.
3. Choose a Flexible Page for the tab.
4. Enter a label.

This text is the display name for the Flexible Page in the Salesforce1 navigation menu.

5. Click the Tab Style lookup icon to display the Tab Style Selector.

If a tab style is already in use, a number enclosed in brackets [] appears next to the tab style name. Hover your mouse over
the style name to view the tabs that use the style. Click Hide styles which are used on other tabs to filter
this list.

6. Click a tab style to select a color scheme and icon for the Flexible Page tab.

The icon you choose here is the icon that displays to the left of the Flexible Page label in the Salesforce1 navigation menu.

Optionally, click Create your own style on the Tab Style Selector dialog if you want to create a custom tab style and your
organization has access to the Documents tab. To create your own tab style:

a. Click the Color lookup icon to display the color selection dialog and click a color to select it.
b. Click Insert an Image, select the document folder, and select the image you want to use.

Alternatively, click Search in Documents, enter a search term, and click Go! to find a document file name that includes
your search term.

Note:  This dialog only lists files in document folders that are under 20 KB and have the Externally Available
checkbox selected in the document property settings. If the document used for the icon is later deleted, Salesforce

replaces it with a default multicolor block icon ( ).

c. Select a file and click OK. The New Custom Tab wizard reappears.

7. Enter a description of the tab, if desired, and click Next.
8. Choose the user profiles for which the new custom tab will be available:

• Select Apply one tab visibility to all profiles and choose Default On, Default Off, or Tab Hidden from the drop-down
list.

• Alternatively, select Apply a different tab visibility for each profile and choose Default On, Default Off, or Tab
Hidden from the drop-down list for each profile.

Note:  The Default On and Default Off options for Flexible Pages don’t work as they would with other custom
tabs. The Flexible Page menu item appears for the selected profiles in Salesforce1 whether you choose Default
On or Default Off. Select the Tab Hidden option to hide the Flexible Page menu item for the selected profiles
in Salesforce1.

9. Click Save.
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Salesforce1 Differences from the Full Salesforce Site
The Salesforce1 apps don’t have all of the functionality of the full Salesforce site, and in some cases include features that aren’t
available in the full site.

There are differences in these areas:

• Supported Salesforce data

• Chatter feeds, groups, and profiles

• Searching for information

• Creating and editing records

• Tasks and events

• Approval requests

• Notifications

• The new Today feature

• Supported Salesforce customizations

Differences in Working with Salesforce Data
Currently, Salesforce1 doesn’t support:

• Objects other than those mentioned in Data That’s Supported in Salesforce1.

• Standard or custom Salesforce apps. (Instead, the navigation menu gives users access to all of the objects that are available
to them in the mobile app, including the Salesforce1-supported standard objects and all custom objects that are included
in one of your organization’s Salesforce apps.)

• List views on objects other than accounts, contacts, campaigns, cases, groups, and custom objects.

• A few record fields, including:

◊ division fields

◊ rich text area fields

◊ territory management fields

• Links on formula fields.

• The default custom links on a record detail page.

• Salesforce Communities.

• Salesforce console, Agent console, or other Service Cloud features besides Cases and Live Chat Transcripts.

• Advanced currency management.

Related Lists

• Related lists in the Salesforce1 app are read-only. Action buttons on related lists, including the ability to create new related
records, aren’t available.

• Some related lists aren’t available in this release, including:

◊ Content Deliveries

◊ External Sharing

◊ Related Content

See the following sections for related lists that aren’t available for specific objects.
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• Files, notes, attachments, and Google docs attached to records display in the related list for that specific record. Files,
notes, attachments, and Google docs on child records don’t display in the parent record’s related list. You can’t add notes
to related lists on records, and you can’t delete files, notes, attachments, and Google docs from related lists.

Accounts and Contacts

• Social accounts aren’t available. However, if an account has been linked to a social network profile, the selected profile
image may display when viewing the account in Salesforce1. Profile images from LinkedIn appear when you’re logged in
to LinkedIn; images from Facebook or Twitter may appear even if you aren’t currently logged in to those networks. You
can’t switch to a different profile image in Salesforce1.

• The Clone, Manage External Account, and Enable As Partner buttons aren’t available.

• You can’t view the account hierarchy.

• You can’t merge contacts, or add new contacts, opportunities, cases, partners, notes and attachments, or account users.

• You can view account teams, partners, and case teams, but you can’t edit them.

• Reports and tools aren’t available.

Campaigns

• The Manage Members and Advanced Setup buttons aren’t available.

• Campaign Hierarchy is available only as a related list. The option to View Hierarchy from a link on the campaign detail
page isn’t available. When viewing a parent campaign, the Campaign Hierarchy related list shows only the child campaigns,
while the full site displays both the parent and child campaigns.

• The Campaign Members related list isn’t available.

Cases

• Case Feed layouts and Case Feed-specific buttons, including Email, Portal, Case Note, Change Case Status, and the
Case Feed version of Log a Call, aren’t supported in the Salesforce1 app. Users assigned to Case Feed layouts in the full
Salesforce site see the standard case layout in the mobile app.

• Some fields on Service Contract and Contact Line Item related lists aren’t available.

• These case related lists aren’t available:

◊ Business Hours on Holiday List

◊ Case Contact Role

◊ Milestone List

◊ Solution List

◊ Team Member List

◊ Team Member on Team List

◊ Team Template Member List

Contacts

• Activity logs aren’t created when you use the  icon to send emails from the Salesforce1 app.
• Social contacts aren’t available. However, if a contact has been linked to a social network profile, the selected profile image

may display when viewing the contact in Salesforce1. Profile images from LinkedIn appear when you’re logged in to
LinkedIn; images from Facebook or Twitter may appear even if you aren’t currently logged in to those networks. You can’t
switch to a different profile image in Salesforce1.

• The Clone, Request Update, Manage External User, and Enable Customer User button aren’t available.

• You can’t add opportunities, cases, notes and attachments, or account users on a contact.

• You can’t add contacts from Data.com or clean contact records with Data.com Clean.

Contracts
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• The Clone, Activate, and Deactivate buttons aren’t available.

• These contracts related lists aren’t available:

◊ Contract History

◊ Items to Approve

Dashboards

• Dashboards are read-only.

• Filters and source reports aren’t available.

• Dynamic dashboards let you see data as yourself only.

• Chatter feeds for dashboards aren’t available, nor can you post dashboards or components to feeds.

Files, Attachments, and Content

• You can’t add files to posts or comments but you can see files that were posted to updates in the full Salesforce site. In
addition, there are no file thumbnails available in the feed in Salesforce1; instead, you see a file type icon when possible
(for example, a PDF attachment will have a special PDF icon).

• Salesforce CRM Content isn’t available.

Leads

• The Convert, Find Duplicates, and Unlock Record buttons aren’t available.

• Social leads aren’t available.

• The Lead History related list isn’t available.

• When adding a new lead, the Campaign field and the Assign using active assignment rule” checkbox
aren’t available. You can add values to these fields in the full Salesforce site.

Live Chat Transcripts

• Live chat transcript records are read-only. Because rich text area fields aren’t supported in Salesforce1, you’re not able to
view the Body field in transcript records.

Opportunities

• The Competitors, Quotes, and Opportunity Team buttons aren’t available.

• These fields aren’t available: Opportunity Splits amount field, Products subtotal field, and Stage History
connection field.

• The Similar Opportunities related list isn’t available.

• These related lists are available but the lists display record preview cards only; you can’t tap to open any of the list records.

◊ Campaign Influence

◊ Competitors

◊ Opportunity Splits

◊ Products

◊ Stage History

• You can’t edit the Probability or Forecast Category fields. However, field values are automatically entered when
you save the record (based on the value of the Stage Opportunities field). You can manually edit the values for these
fields in the full Salesforce site.
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Differences in Using Chatter
When using Chatter in the Salesforce1 app, you can’t:

• Create or update your profile information, or upload profile pictures.

• Use custom profiles.

• View your followers and the people and records you’re following. (This feature is available in the Salesforce1 downloadable
app for iOS devices.)

• Send or view Chatter messages.

• See Chatter activity statistics or Chatter influence status.

• Receive Chatter recommendations.

• See trending topics.

• Invite coworkers to sign up for Chatter.

• View or download files that were uploaded via Files or that were uploaded to a comment. You can, however, view files
that are attached to a post on a Chatter feed. (Salesforce1 can display these file types: .doc, .docx, .pdf, .ppt, .pptx,
.xls, .xlsx, and all image files, including .gif, .jpg, and .png formats.)

• Share public posts.

• Add or view Chatter favorites.

• Filter records.

• Search Chatter feeds in the Salesforce1 mobile browser app or the Salesforce1 downloadable app for Android phones

• Create new groups.

• View lists of group files or post files in a group.

• See group list views until a least one user in your organization visits a group in Salesforce1.

• Invite Chatter customers to join private groups.

• Use group owner and manager functions, including:

◊ Change group settings, information, and access levels

◊ Add or remove members from a group

◊ Archive groups

◊ Activate archived groups

◊ Delete groups

Differences in Finding Information
If you’re new to Salesforce and don’t yet have a history of recent items, you initially see these objects in the Recent section of
the navigation menu:

• Accounts

• Cases

• Contacts

• Files (if you’re using one of the downloadable apps and Chatter is enabled)

• Groups (unless added directly to the navigation menu)

• Leads

• Opportunities

• People (unless added directly to the navigation menu)

55

Salesforce1 Differences from the Full Salesforce SiteMobile



As you spend more time in Salesforce and the Salesforce1 app, the objects that you use the most will display in the Recent
section instead.

To be available in Salesforce1—in the navigation menu, in the list of recently accessed records that appears when you begin
a search, or in search results—an object must be included in a standard or custom Salesforce app. This is true for the supported
standard objects and your organization’s custom objects.

When searching in Salesforce1, you can’t:

• Search by division

• Cancel a search that’s in progress

• Sort or filter search results

• Pin frequently used items

• Search Chatter feeds in the Salesforce1 mobile browser app or the Salesforce1 downloadable app for Android phones

In addition, list views aren't included in the search results from a global search or record searches. To find list views, open the
record search page and type your search terms. As you type, the list of matching items expands to show list views you can
access for the object, not just the ones you accessed recently.

Differences in Creating and Editing Records
There are some differences between the full Salesforce site and the Salesforce1 app when adding new records or updating
existing data.

Editing
Records

Creating
RecordsIssueCategory

Inline editing isn’t available.Any Record

You can’t modify a record’s owner or its record type.

You can’t enter data in geolocation custom fields.

Combo boxes, which combine a picklist with a text field, aren’t available. Typically
the text field is available but the picklist is not.

You can’t enter data in rich text area fields.

If territory management is enabled, you can’t assign or modify a record’s territory
rules.

The Copy Billing Address to Shipping Address and Copy Mailing Address to
Other Address links aren’t available.

Accounts and
Contacts

If territory management is enabled, the Evaluate this account against territory
rules on save option isn’t available when editing account records.

An event owner can't change, add, or remove an event’s invitees or related leads
or contacts.

Events

You can’t accept or decline an event you’ve been invited to.

You can’t use Shared Activities to relate multiple objects to an event.

When you add a new lead, the Campaign field and the Assign using active
assignment rule” checkbox aren’t available. You can add values to these
fields in the full site.

Leads
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Editing
Records

Creating
RecordsIssueCategory

You can’t edit the Probability or Forecast Category fields. However,
values are automatically added to these fields (based on the value of the Stage

Opportunities

field) when you save the record. You can manually edit the values for these fields
in the full site.

The Subject field doesn’t include a picklist of previously defined subjects.Tasks

The Related To field remains editable when the Name field is set to Lead but
you’ll receive an error if the Related To field contains data when you save the
record.

The Email and Phone fields for an associated contact aren’t displayed.

You can’t use Shared Activities to relate multiple objects to a task.

You can’t create recurring tasks or change the details for recurring tasks.

Spell-checking for the Comments fields isn’t available.

You can’t add attachments.

You can’t send notification emails.

You can’t set task reminders.

Enhanced lookups aren't supported, so you can't use wildcards in lookup searches
and you can't sort, filter, and page through search results.

Lookup Fields

Dependent lookups aren't supported.

Lookup filters aren't respected, so lookup search results aren't restricted in any
way. You may wind up selecting an item that isn't valid for your organization,
resulting in an error message when you save your record.

Phone number fields display a keypad, from which you tap out the phone number.
The keypad doesn’t include parentheses, hyphens, or periods, and Salesforce1

Phone Number
Fields

doesn’t apply any phone number formatting when you save the record. To apply
a specific phone number format, edit the record in the full site.

Controlling and dependent picklists are supported, but Salesforce1 doesn’t display
indicators on create and edit pages for these fields. To determine if a picklist field
is dependent, and which picklist field controls it, switch to the full site.

Picklist Fields

Differences in Tracking Your Activities
Events

• Archived events aren’t available, and you can’t use Shared Activities to relate multiple objects to an event.

• You can’t accept or decline an event you’ve been invited to.
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• Invitee related lists display slightly different content from the full Salesforce site. In the full site, the Invitee list includes
the event owner and related contacts and leads who aren’t also invitees. In Salesforce1, the Invitee related list includes
invitees only. To reproduce the full site functionality in Salesforce1, use this query:

select relation_id from CORE.activity_relation where
master_activity_id in (select master_activity_id from
CORE.activity_relation where child_activity_id='[EVENT_ID]')

where EVENT_ID is the child event’s ID. This query gets the main event’s relations and displays them for the given child
event. You can add a WHERE clause to further filter the results.

• Each event in a related list shows:

◊ The  icon, identifying the item as an event
◊ The event title

◊ The start date and time

◊ Up to three more fields, depending on your organization’s settings

Tasks

• Archived tasks aren’t supported, and you can’t use Shared Activities to relate multiple contacts to a task.

• New, edited, and deleted tasks don’t appear in a task list until you refresh the list. When you close a task by tapping the
 icon, the task is shown crossed out until you refresh the list.

• In task lists, the sorting of priority tasks is determined by the order of the fields in the priority picklist.

• The more tasks you view, and the more relationships tasks have to other records, the longer it may take to view tasks or
use other features in the Salesforce1 app.

• Task layouts contain a few unique elements that make tasks easier to work with. These elements don’t appear in a compact
layout because you can’t change them, but users always see them:

◊ The  and  icons represent the status of the IsClosed field to users with the Edit Task permission.
◊ The  icon represents a task marked high priority (including custom high priority).
◊ All tasks show the subject.

◊ All tasks show the due date, if it exists.

◊ Tasks include the primary contact and the account or other record, if they exist.

The fields in each list may vary, depending on your organization’s settings.

You control the layout of task records and tasks in the task list using the new compact layout feature. You control related
lists, as always, using the page layout editor. Adding the subject or due date field to either layout doesn’t change the
appearance of tasks—those fields won’t appear twice.

Below the built-in task elements, Salesforce1 displays up to three additional fields.

◊ The default compact layout for tasks includes two fields: the name of a lead or contact, and an opportunity, account,
or other record the task is related to.

◊ In an Activities related list, a task’s fields depend on what record you’re viewing and how you’ve defined the layout for
that object.

For more information, see Compact Layout Overview.

Differences with Approvals
These approval-related options aren’t available in the Salesforce1 app:
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• Submitting records for approval.

• Recalling approval requests.

• Reassigning approval requests.

• Accessing an approval request from the record view. Instead, approvers need to tap the Salesforce1 notification.

• Manually selecting the next approver. For approval requests that require this manual selection, the approver needs to log
in to the full Salesforce site.

In addition:

• The Approval History related list doesn’t display comments.

• The Items to Approve related list isn’t available.

• Salesforce1 notifications for approval requests aren’t sent to queues. For each approval step involving a queue, we recommend
adding individual users as assigned approvers, so at least those individuals can receive the approval request notifications in
the mobile app. To have both queues and individual users as assigned approvers, select Automatically assign to approver(s)
instead of Automatically assign to queue in the approval step.

• Salesforce1 notifications for approval requests are sent only to users who have access to the record being approved. Assigned
approvers who don’t have record access can still receive email approval notifications, but they won’t be able to complete
the approval request until someone grants record access.

Notifications in the Salesforce1 App
• The notifications list in the app displays your 20 most recent notifications.

• To ensure that sensitive information isn’t distributed through a third-party service, the only customer data included in
push notifications to iOS devices is the user’s name.

• Streaming API limits apply to notifications.

Using Today
Today is a new feature that’s available in the Salesforce1 downloadable apps for Android phones and iPhone devices. It’s not
available in the full Salesforce site.

There are some considerations when using Today.

• You see local events from selected calendars on your mobile device but Salesforce events aren’t available in this release.

• If some or all of your calendar servers don’t automatically push data to your device, you need to update your calendars
before you can see the most current information in Today.

• The 24–hour time format isn’t supported.

• When viewing a multi-day event, only the ending date and time are displayed in the highlights area.

• The wrong date and time may display for recurring multi-day events.

• If your calendar doesn’t display invitee names because the list is too long, Today shows a count of “1 invitee” on the event
card and doesn’t show any invitees when you open the event.

• If an event doesn’t include invitees and there aren’t any notes, only the detail page displays.

• Today supports links in the Notes card on the event home page, provided they use the http://, https://, or www
protocols. But links aren’t active in the Notes field on the event detail page.

• The meeting organizer’s acceptance status isn’t displayed on iPhone devices.

• Today is unable to find a matching Salesforce record for a meeting organizer of an iCloud event because the iCloud API
doesn’t return an email address.

• On Android devices, a meeting organizer’s name may not display correctly if there isn’t a matching Salesforce record for
the person.
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• On Android devices, if a meeting organizer of a Microsoft Exchange® event is also an invitee, the person appears in both
the Invitees and Invitation from cards. The person’s acceptance status may be displayed in multiple locations and may not
be accurate. Also, there’s a matching Salesforce record for the organizer, the event page might not display correctly.

• Chatter Free users and Chatter Customers aren’t able to access Today because these user license types don’t have access
to contacts or person accounts.

Support for Salesforce Customizations
• Custom Home Pages

◊ Salesforce1 doesn’t support login redirection to Salesforce apps or custom home tabs like the full Salesforce site does.
If you prefer to retain this redirection for users who log in to Salesforce from a mobile browser, turn off the Salesforce1
mobile browser app. This can be done on a user-by-user basis or for your entire organization.

• Visualforce Pages

◊ Standard tabs, custom object tabs, and list views that are overridden with a Visualforce page aren’t supported in
Salesforce1. The Visualforce page is shown for full site users but Salesforce1 users will see the default Salesforce1 page
for the object instead. This restriction exists to maintain the Salesforce1 experience for objects.

◊ Embedded Visualforce pages—that is, those added to a page layout—that contain an <apex:enhancedList>
component may cause the Salesforce1 app to crash when used on iOS devices.

◊ When viewing Visualforce pages on an Android device, horizontal scrolling doesn’t work if the page is wider than the
viewport. Redesign the page so that it’s narrower than the viewport.

• Flexible Pages

◊ You can’t add more than 25 components to a Flexible Page.

◊ The recent items component doesn’t support standard objects.

• Programmatic Customizations

◊ These programmatic customizations to the UI aren’t supported: Web tabs and S-controls.

Salesforce1 Platform Overview
There are several Force.com platform changes and enhancements that support Salesforce1 development.

• Visualforce Changes

• Force.com Canvas Changes

• Publisher Actions Changes

• Flexible Pages

• API Changes

Visualforce Changes
You can now use Visualforce to extend the Salesforce1 app, letting users access your Visualforce pages from the navigation
menu, the publisher, or a record's home page.

When developing Visualforce pages for Salesforce1 users, consider how they’ll look and behave on a mobile device. Also note
that you can develop your Visualforce pages to work with both Salesforce1 and standard Salesforce.
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You’ll need to indicate that a Visualforce page is mobile-ready and can be used in the Salesforce1 app by enabling the Available
for Salesforce mobile apps checkbox in your Visualforce page settings under Develop > Pages. For custom Visualforce
tabs, enable the Mobile Ready checkbox to make that tab available in the Salesforce1 app.

For Winter ’14, several updates have been made to make development with Visualforce easier, including improvements for
HTML5 development. You'll want to consider these changes when developing mixed HTML and Visualforce pages for
Salesforce1. You’ll also want to utilize HTML5 pass-through attributes on your Visualforce components to enable HTML5
features, such as client-side validation. See Visualforce.

The sforce.one JavaScript utility object is automatically added to all Visualforce pages when run inside the Salesforce1
container. This object is used to manage programmatic navigation in Salesforce1.

Force.com Canvas Changes
Force.com Canvas lets you easily integrate a third-party Web application in the Salesforce1 app.

In Winter ’14, you can expose Force.com Canvas apps as publisher actions, which lets you expose your Canvas apps in the
Salesforce1 publisher. Canvas apps can also now be exposed as Chatter feed items, which lets you expose your Canvas apps
in Salesforce1 as feed items.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through a
pilot program and is available in all new Development Edition organizations. For information on enabling it for your
organization, contact salesforce.com.

See Canvas Apps in the Salesforce1 App—Pilot for more details.

In Winter ‘14 Force.com Canvas supports Streaming API notifications, which you can use in your Canvas app exposed in
Salesforce1. See Force.com Canvas Support for Streaming API.

Publisher Actions Changes
Actions appear in the publisher in the Salesforce1 app, and are a quick way for mobile users to access commonly used tasks
or functionality. You can create custom actions using Visualforce or Force.com Canvas.

Custom actions aren’t specific to mobile users, and can appear in both the Salesforce1 app and in the full Salesforce site. In
the Salesforce1 app, custom actions appear in the publisher. In the full Salesforce site, custom actions appear in the publisher
menu.

Note:  If you want to assign a custom icon to a publisher action, the optimal icon size for display in the Salesforce1
publisher is 120 x 120 pixels. For best results, don’t use an icon larger than this.

Custom actions automatically get their own REST API endpoints of the form /services/data/API
version/sobjects/Object name/quickActions/Custom action name. For example, a custom Create_Delivery
action created for the Invoice__c object would get an endpoint that looks like:
/services/data/v29.0/sobjects/Invoice__c/quickActions/Create_Delivery.

Flexible Pages
In Winter ‘14, you can use Flexible Pages to create custom app home pages in Salesforce1. A Flexible Page is a new type of
custom layout, designed for mobile apps. See What is a Flexible Page? for more details.

In Winter ‘14, Flexible Pages can be used with change sets and within app packages. See Flexible Pages Available in Change
Sets and Flexible Pages Available in Packages.

API Changes
The following changes have been made to Force.com APIs to support Salesforce1 development.
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New and Changed Objects
The new AppMenuItem object represents an item in the Salesforce1 navigation menu, exposing metadata for tab sets,
service providers, and Connected Apps.

In the Organization object, the PreferencesS1BrowserEnabled field has been added to control access to the
Salesforce1 mobile browser app.

In the User object, the UserPreferencesHideS1BrowserUI field has been added to control user redirection to the
Salesforce1 mobile browser app.

SOAP API
The new describeAppMenu() call retrieves metadata about items in the Salesforce1 navigation menu.

The new describeCompactLayouts() call retrieves metadata details about compact layouts for the specified object
type.

The new describeFlexiPages() call retrieves metadata details about a set of Flexible Pages.

The new describeTheme() and describeGlobalTheme() calls return information about color and icon themes
available to the current logged-in user.

Several changes have been made to the QuickActions calls (describeAvailableQuickActions(),
describeQuickActions(), performQuickActions()) and their return types to provide information about custom
actions, and support additional action types and contexts.

REST API
The new AppMenu Resource retrieves metadata about items in the Salesforce1 navigation menu.

The new FlexiPage Resource returns a list of Flexible Pages and their details. Information returned includes Flexible
Page regions, the components within each region, and each component’s properties, as well as any associated QuickActions
(publisher actions).

The SObject Quick Actions Resource has a new URI to evaluate the default values for an action.

The new Themes Resource returns information on icons and colors used by themes in the Salesforce1 app.

Chatter REST API
Chatter REST API now supports Force.com Canvas app feed attachments. You can now post a feed item with a canvas
app attachment to the News Feed, Record Feed, and User Profile Feed using new POST parameters for the REST
resources for those feeds. New REST request and response body parameters are available to manage canvas app
attachments.

Clients can use the X-Connect-Theme HTTP header to specify a UI theme for any API request. There are two themes,
each with their own set of motif icons: Classic and Salesforce1.

Apex
Chatter in Apex provides an easy, efficient way to work with Chatter data in Apex.

New and updated methods and classes are available for working with publisher actions.

Metadata API
The new FlexiPage type represents the metadata associated with a Flexible Page.

The CustomObject type has new compactLayout and compactLayoutAssignment fields that contain metadata
about the compact layouts associated with the given custom object.

The CustomTab type has a new flexipage field that contains the name of the Flexible Page to display in this tab.

The QuickAction type has a new canvas field that contains the fully-qualified name of the Force.com Canvas app
associated with the quick action (if the quick action is a custom action created using a Canvas app).
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What is a Flexible Page?
A Flexible Page is a type of custom layout.

Flexible Pages occupy a middle ground between page layouts and Visualforce pages. Like a page layout, Flexible Pages allow
you to add custom items to a page. However, they don’t have the same structure as a page layout, and the custom items are
all components.

You can use a Flexible Page to create a home page for a third-party app that you can then add directly into the Salesforce1
mobile navigation. This provides your Salesforce users with a mobile home page that lets them quickly access the objects and
items that are most important in that app.

You can also assign global publisher actions to a Flexible Page by specifying them in the Flexible Page XML. When users tap
 from a Flexible Page, any global actions that you’ve assigned to it will show up in the publisher.

About Flexible Pages
A Flexible Page consists of a list of a single region, named “main”, containing ComponentInstances. A ComponentInstance
contains a set of properties for an instance of a particular component, such as which component the instance points to, and a
set of name/value pairs representing a subset of the component’s attributes.

Available Components

Not every component can be specified in a ComponentInstance. Even among those that are allowed, not all of their attributes
can be specified. Currently, two components are supported for use in Flexible Pages.

flexipage:filterListCard

Points to a list view and displays the first few records from that view.

The flexipage:filterListCard component supports only:
• Custom Objects
• Account
• Campaign
• Case
• CollaborationGroup
• Contact
• Contract
• Lead
• LiveChatTranscript
• Opportunity

flexipage:recentItems

A list of most-recently used items which is limited to specific custom objects, based on the properties specified.

So, what can a Flexible Page contain?

Flexible Pages can include:

• Components that display list views
• Components that display a scoped list of recently used items
• Global Chatter publisher actions
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SalesforceA
Manage users and view information for Salesforce organizations from your mobile device.

Available in: Contact Manager, Group, Professional, Enterprise, Unlimited, Performance, and Developer Editions

User Permissions Needed

“Manage Users”To use SalesforceA:

The SalesforceA mobile app offers greater flexibility for Salesforce administrators. With SalesforceA, you can perform essential
user management tasks—including editing user details, resetting passwords, assigning permission sets, and unlocking, freezing,
and deactivating user accounts—all from your mobile device.

Supported Devices for SalesforceA
SalesforceA is free and available for:

• Android phone or tablet with OS 2.2 or higher

• Apple iPhone and iPod Touch with iOS 5.0 or higher

Download SalesforceA from www.salesforce.com/mobile/, the Apple App Store, or Google Play.

SalesforceA Navigation Basics
The following items and tasks are available on the home screen.
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1. Tap  to search for users in your organization. From the search box, type a few letters of a user’s name, then select it
from the list that appears.

2. Tap Frozen Users or Locked Out Users to open a list of frozen or locked user accounts. From the list, tap a user to view
and edit the user’s details.

3. Tap Recently Viewed Users to open a list of the users you most recently accessed.
4. View the date, time, and type of the next scheduled maintenance.
5. Verify your username, organization name, and the type of organization you’re logged into. Tap Log Out to log out of your

account.
6. Tap Release Notes to view the latest release notes in HTML format. (HTML-format release notes are currently in Beta.)
7. Tap Feedback to take a short survey.

The following items and tasks are available on the user screen.
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1. Tap  to return to the home screen.
2. Tap Edit to update the user details.
3. Tap the down arrow to reset the user’s password, assign permission sets, or unlock (if locked), freeze, or deactivate the user

account.
4. Anywhere below the buttons, swipe left to view assigned permission sets and login history. Swipe right to return to the

user details.

Connect to a Different Instance
By default, SalesforceA is set up to connect to your production environment. You can set up SalesforceA to connect to your
sandbox environment or a custom host.

To connect from an iPhone or iPod touch:

1. From the Home screen, tap Settings.
2. Scroll down and tap SalesforceA.
3. Under Connection, tap Login Host, then select a host.
4. If you selected Custom Host, tap SalesforceA to return to the SalesforceA Settings page, then in the Custom Host field,

enter the host name.
5. Tap Settings to return to the Settings page.
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To connect from an Android phone:

1. Tap to open the SalesforceA app.

2. Tap , then tap Change Server.
3. Select a host.

Optionally, to add a host, tap Add Connection, enter the host name and URL, then tap Apply. The URL must start with
https://.

SalesforceA Limitations
The user screen in SalesforceA has the following differences from the user detail page in the full Salesforce site:

• The user screen doesn’t include these fields, which appear on the user detail page in the full site:

◊ User License

◊ Call Center

◊ Delegated Approver

• For users with the Japan (Japanese) locale, addresses appear in the following format:

Street
City, State/Province Zip/Postal Code Country

• The user screen includes a read-only User Type field, which doesn’t appear on the user detail page in the full site. User
Type is the category of user license.

Salesforce Touch is Upgrading to Salesforce1
Salesforce Touch is upgrading to the new Salesforce1 experience. The new app gives you the same Salesforce Touch features
you’ve come to expect, in an updated interface that makes it easy for users to find what they need and get their work done
faster. On top of that, Salesforce1 gives you more, with many new enhancements.

• Expanded Chatter functionality, including the ability to post links, post and vote on polls, sort your feeds, and bookmark
posts. The Salesforce1 downloadable apps also include access to Salesforce Files.

• The Chatter publisher, with a default set of publisher actions and the option to add custom actions that are suited to your
business needs.

• List views, enhanced global search, and object-specific searches.

• The new Today feature, which helps you prepare for meetings, quickly join conference calls, and get directions to meetings.

• Improved tasks, with different types of task lists and the ability to close and reopen tasks.

• New in-app and push notifications.

• The ability to integrate custom and third-party apps into the navigation menu or the publisher.

• Support for Android phones, as well as iPad and iPhone devices.

Note: Salesforce1 will include Salesforce Communities soon. If your organization uses Salesforce Touch to access
Communities, the Salesforce Touch mobile browser app will remain available until Salesforce1 supports Communities.

See Salesforce1 for details about the new Salesforce mobile experience and how to get started optimizing the Salesforce1 apps
for your users.

The transition to Salesforce1 depends on how your organization uses Salesforce Touch.
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• For mobile browser app users, the transition will be seamless. On November 18, 2013, the Salesforce1 mobile browser app
will be automatically enabled for your organization and users who log in to Salesforce from a supported mobile browser
will automatically redirect to the new Salesforce1 interface.

If you’d like more time to prepare your users for the new mobile experience, you can turn off the Salesforce1 mobile browser
app and return to using Salesforce Touch. See Transition Salesforce Touch Users to the Salesforce1 Mobile Browser App
for more details.

• Downloadable app users will receive in-app notifications encouraging them to download and install the Salesforce1
downloadable app.

The upgrade to Salesforce1 completes with the Spring ’14 release, at which time the Salesforce Touch interface will be turned
off.

Transition Salesforce Touch Users to the Salesforce1 Mobile
Browser App

On November 18, 2013, the Salesforce1 mobile browser app will be automatically enabled for your organization.

Note:  If your organization uses Salesforce Touch to access Salesforce Communities, you will not be upgraded to
Salesforce1 on November 18, 2013. Your Salesforce Touch access will remain unchanged until Communities support
is available in the Salesforce1 mobile browser app.

There’s a new Salesforce1 setting that controls access to the Salesforce1 mobile browser app for your organization. When this
setting is turned on, as it is by default, it:

• Overrides your organization’s Salesforce Touch settings, even if the Salesforce Touch mobile browser is currently enabled.

• Replaces the Touch User checkbox with the Salesforce1 User checkbox on the My Settings > Personal > Advanced
User Details or Setup > My Personal Information > Personal Information page. The Salesforce1 User checkbox
is turned on for all of your users.

When both the Salesforce1 organization and user settings are turned on, users who log in to Salesforce from a supported
mobile browser are automatically redirected to the new Salesforce1 interface—instead of Salesforce Touch.

If you’d prefer more time to transition to the new Salesforce mobile experience, you can turn off the Salesforce1 mobile browser
app to restore your organization’s Salesforce Touch settings. Your users can continue to use Salesforce Touch until the Spring
’14 release.

Here’s a summary of how the Salesforce Touch and Salesforce1 settings interact.

Redirection When
User Logs in to
Salesforce from a
Mobile Browser

Salesforce1 User
Setting

Salesforce1 Mobile
Browser App Access

Touch User SettingSalesforce Touch
Mobile Browser Access

Salesforce1OnEnabledOn or OffEnabled or Disabled

Full Salesforce SiteOffEnabledOn or OffEnabled or Disabled

Salesforce Touchn/aDisabledOnEnabled

Full Salesforce Siten/aDisabledOffEnabled

Full Salesforce Siten/aDisabledn/aDisabled
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Note:  The Salesforce Touch settings let you specify the device types that are allowed to access the mobile browser
app. When the Salesforce1 mobile browser app is enabled, users can access the app from their choice of supported
mobile devices, but they must also use a supported mobile browser. Logging in from an unsupported browser redirects
to the full Salesforce site instead of the mobile experience.

Chatter Mobile
The Chatter Mobile for Android and Chatter Mobile for iPhone and iPad apps have upgraded to Salesforce1 v5.0. Chatter
Mobile for BlackBerry isn’t upgrading in the Winter ’14 timeframe.

For details about the Salesforce1 app, see Salesforce1.

For a refresher on how to set up the Chatter Mobile for BlackBerry connected app for your users, see these topics.

Chatter Mobile for BlackBerry is Now a Connected App

The Chatter Mobile for BlackBerry app is now a connected app. Because of this change, the Chatter Mobile for BlackBerry
settings have moved to the connected apps area in the Setup menu.

Chatter Mobile for BlackBerry is Now a Connected App
The Chatter Mobile for BlackBerry app is now a connected app. Because of this change, the Chatter Mobile for BlackBerry
settings have moved to the connected apps area in the Setup menu.

A connected app is an application that integrates with Salesforce using APIs. Moving the Chatter Mobile for BlackBerry app
to connected apps gives administrators all the benefits of connected apps, such as greater control over who can access the apps,
the IP restrictions they’re subject to, and how long their sessions remain active.

Administrators can view and manage the Chatter Mobile for BlackBerry settings in the same way they view and manage other
connected app settings. In Setup, click Manage Apps > Connected Apps, then click Edit for the Chatter Mobile for BlackBerry
app. To view details about the Chatter Mobile connected app, click the app’s name.

Chatter Mobile for BlackBerry is automatically installed as part of a managed Salesforce connected apps package when one
of these events occurs:

• A user in your organization downloads the Chatter Mobile for BlackBerry mobile app and authenticates with your
organization by logging in to the mobile app.

• An existing Chatter Mobile user’s session refreshes.

Note:  Sessions refresh automatically between every 15 minutes and 12 hours while a user is in the app based upon
the session Timeout value set for your organization; this is often undetected by the user.

Alternatively, an administrator can manually install the Salesforce1 and Chatter Apps connected apps package to view and
manage the settings before the package is automatically installed.

The connected apps package includes a separate connected app for the BlackBerry mobile device type.

Important:  Unless an administrator manually installs the package, you'll only see the Chatter Mobile for BlackBerry
connected app after someone in your organization activates a mobile app or an existing user’s session refreshes.

If your organization was using Chatter Mobile before the switch to connected apps, your original settings were migrated to
the connected apps settings.
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Changes to Chatter Mobile for BlackBerry Settings
Your original Chatter Mobile for BlackBerry settings are labeled differently in the connected apps settings.

Use this table to see how the original Chatter Mobile settings map to the connected apps settings. To see the connected apps
settings, click Setup > Manage Apps > Connected Apps.

Default Settings for New
Organizations

Changes for Existing
Organizations

New Chatter Mobile
Connected App Settings

Original Chatter Mobile
Settings

As a connected app, Chatter
Mobile for BlackBerry is

Once the connected apps
package is installed, Chatter

N/AEnable Chatter Mobile

enabled by default; any user inMobile for BlackBerry is set
your organization can
download the app.

to Admin-approved users
are pre-authorized by
default.

All Users may
self-authorize

If you previously deselected
Chatter Mobile for
BlackBerry, it is set to

Permitted Users under
OAuth policies

Authorized Devices

Admin-approved users
are pre-authorized.

Never ExpireSettings persist.Session Timeout under
Mobile Integration

Session Timeout

4This connected app setting is
new for Chatter Mobile for
BlackBerry.

Pin Length under Mobile
Integration

Enforce IP
Restrictions

Restricted users stay
restricted.

IP Restrictions under OAuth
policies

IP Restricted Users

Users and Devices
To view Chatter Mobile for BlackBerry activity in your organization (including the date each user activated or used the app
since moving to connected apps), to remotely revoke access to the app for a specific device (if the device is lost or stolen, for
example), or to block a user’s access to the app, from Setup, click Manage Apps > Connected Apps OAuth Usage.

Edit Chatter Mobile for BlackBerry Connected App Settings
Administrators can view and manage the Chatter Mobile for BlackBerry settings in the same way they view and manage other
connected app settings.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Developer, and Database.com
Editions

User Permissions Needed

“Customize Application”To edit your Chatter Mobile for BlackBerry settings:

“View Setup and Configuration”To view your Chatter Mobile for BlackBerry settings:

1. From Setup, click Manage Apps > Connected Apps.
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2. Click Edit next to the name of the app you want to modify. (To review information about an app on the connected app
Detail page, click the app name.)

• OAuth policies are available for every connected app.

◊ Permitted Users determines who can run the app.

- All Users may self-authorize: Default. Anyone in the organization can self-authorize the app. This means
each user has to approve the app the first time they access it.

- Admin-approved users are pre-authorized: Access is limited to those users with a profile or permission
set specified, but these users don’t need to approve the app before they can access it. Manage profiles for the app
by editing each profile’s Connected App Access list. Manage permission sets for the app by editing each permission
set’s Assigned Connected Apps list.

Note:  If you switch from All Users may self-authorize to Admin-approved users are
pre-authorized, anyone currently using the app will lose their access unless they belong to a permission
set or profile you have specified for the app.

◊ IP Restrictions refers to the IP restrictions that the users of the connected app are subject to. An administrator
can choose to either enforce or bypass these restrictions by choosing one of the following options.

- Enforce IP restrictions: Default. A user running this app is subject to the organization’s IP restrictions,
such as IP ranges set in the user’s profile.

- Relax IP restrictions with second factor: A user running this app bypasses the organization’s IP
restrictions if either of these conditions are true:

- The app has IP ranges whitelisted and is using the Web server OAuth authentication flow. Only requests coming
from the whitelisted IPs are allowed.

- The app has no IP range whitelist, is using the Web server or user-agent OAuth authentication flow, and the
user successfully completes Identity Confirmation.

- Relax IP restrictions: A user running this connected app is not subject to any IP restrictions.

◊ Require Users to Log In specifies how frequently a user must log in to maintain the permissions their client
application needs from the connected app. You may specify that they only need to log in the first time they use the
app, every time they use it, after a certain period of inactivity, or after a certain period of time.

◊ The current permissions for the connected app are also listed here.

• Session Level Policy is available for all connected apps. Select High Assurance session required to require users to enter a
time-based token during login to access the app.

• Mobile App settings are available for Chatter Mobile for BlackBerry.

◊ Session Timeout specifies how much time can pass while the app is idle before the app locks itself and requires the
PIN before continuing. Allowable values are none (no locking), 1, 5, 10, and 30 minutes.

◊ Pin Length sets the length of the identification number sent for authentication confirmation. The length can be
from 4 to 8 digits, inclusive.

Salesforce Mobile Rebranded to Salesforce Classic
Salesforce Mobile, the original Salesforce CRM mobile app, is now Salesforce Classic for Android™, BlackBerry®, and iPhone®

devices.

Salesforce Classic continues to help your teams succeed by allowing users to access their latest Salesforce data, whenever and
wherever they need it. The Salesforce Classic rebrand may affect your Mobile User administrator settings:
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Mobile Lite

The Mobile Lite user permission, which is the free version of Salesforce Classic, is disabled by default. To enable the
free version of Salesforce Classic:
1. From Setup, click Mobile Administration > Salesforce Classic > Settings.
2. Click Edit.
3. Select Enable Mobile Lite.
4. Click Save.

Mobile User Permission for Unlimited Edition

The Mobile User checkbox is disabled by default for new Unlimited Edition users.

Mobile Packaging
Mobile Packaging lets you seamlessly define, categorize, and deploy mobile apps to your organization through Connected
Apps. Mobile Packaging is currently available through a pilot program.

For information on enabling Mobile Packaging for your organization, contact salesforce.com.
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Chatter
Chatter helps everyone in your organization stay connected.

Chatter Groups

Chatter groups make it easy for users to communicate with each other.

New Chatter Profile Page—Generally Available

Chatter profile pages let you learn more about other Chatter users.

Salesforce Files—Pilot

Salesforce Files lets you securely sync files between Chatter and your desktop and some mobile devices.

Publisher Actions

Actions let users do more in Chatter, like create records and log calls directly in the feed.

Topics

Topics help you organize posts and see what people are talking about.

Chatter Feeds

Chatter Feeds make collaboration easy.

Email Notifications

Chatter works with your email so users can be easily notified about posts.

Chatter Groups
Chatter groups make it easy for users to communicate with each other.

Archived Chatter Groups

Archive Chatter groups with little or no feed activity to drive focus toward the more active groups in your organization.

@mention Chatter Groups

In addition to mentioning individual people, you can now mention groups in your posts and comments.

Using Email to Post to Chatter Groups — Pilot

Group members can post to a Chatter group by sending an email.

Archived Chatter Groups
Archive Chatter groups with little or no feed activity to drive focus toward the more active groups in your organization.

About Archived Groups in Chatter

Archiving a Chatter group suspends the ability to create new posts or share files with the group, while retaining the group
feed and files for future reference. Other group and feed functionality, such as joining or leaving the group, commenting on
an existing post, mentioning users, searching feeds, searching via global search, and reporting remains available.
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Preparing for Archived Groups in Chatter

With the introduction of Chatter group archiving, groups without new feed posts or comments in the last 90 days will be
automatically archived on the first Tuesday following the Winter ‘14 release. We recommend that administrators plan ahead
for archived groups to ensure a smooth transition for their organizations.

Enabling or Disabling Archiving for Chatter Groups

Archiving is enabled for Chatter groups by default.

Archiving Chatter Groups

By default, groups are set to archive automatically if there are no new feed posts or comments for 90 consecutive days. Groups
are reviewed for feed activity and automatically archived on a weekly basis. Group owners, group managers, and users with
the “Modify All Data” permission can manually archive or edit automatic archiving settings for groups.

Activating Archived Chatter Groups

Group owners, group managers, and users with the “Modify All Data” permission can activate an archived Chatter group
from the group detail page.

About Archived Groups in Chatter
Archiving a Chatter group suspends the ability to create new posts or share files with the group, while retaining the group
feed and files for future reference. Other group and feed functionality, such as joining or leaving the group, commenting on
an existing post, mentioning users, searching feeds, searching via global search, and reporting remains available.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

By default, groups are set to archive automatically if there are no new feed posts or comments for 90 consecutive days. Groups
are reviewed for feed activity and automatically archived on a weekly basis.Group owners, group managers, and users with the
"Modify All Data" permission can manually archive and activate groups, or enable and disable automatic archiving for a group
at any time.

Archiving a group offers several advantages. Archived groups are removed from the Active Groups list on the Groups tab and
moved to the My Archived Groups list, allowing users to focus on the more active groups in the organization. Archived groups
don’t appear in searches for sharing a file or feed post with a group. With the restriction on new posts in archived groups, feed
activity in Chatter is streamlined and focused on active group discussions. Note that you can always search for archived groups
and associated content in global search, and that archived groups count toward your group subscription limit.

Groups that have little or no feed activity, but contain useful information that you want to retain, are good candidates for
archiving. Some examples include:

• A group created by a sales team while pursuing a deal can be archived after lead conversion, especially if it contains important
information about the customer.

• A group for planning a company event can be archived after the event to reuse vendor information and planning discussions.

• A group intended to support a major customer deployment can be archived after issues are ironed out, so that customer
support can refer to this information for any future troubleshooting.

• When a legacy group is replaced by a new group that serves the same or broader purpose, the legacy group can be archived
to redirect traffic to the new group.

• Team groups can be archived after a team splits or team members leave the company, so that newer team members can
refer to the information in the old group.
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By contrast, consider turning off automatic archiving for high membership groups that are regularly used to share information
or make announcements without a predictable schedule. This will prevent the group from getting archived if there is a gap
longer than 90 days in feed activity.

Preparing for Archived Groups in Chatter
With the introduction of Chatter group archiving, groups without new feed posts or comments in the last 90 days will be
automatically archived on the first Tuesday following the Winter ‘14 release. We recommend that administrators plan ahead for
archived groups to ensure a smooth transition for their organizations.

• Communicate with group owners and managers in your organization about archiving for Chatter groups.

• Review the groups in your organization along with group owners and managers. Are there groups in your organization
that are inactive? Among these, are there groups that you’d like to keep active regardless of feed activity? Creating a new
post or commenting on existing posts is one way to prevent them from getting archived for another 90 days.

• Disable archiving for Chatter groups if you need more time to prepare. You must do this by or before 8 p.m. Pacific Time on
the first Tuesday following the Winter ‘14 release.

Note:  You can always activate groups after they’ve been archived, either individually from the group settings page
or in bulk using the Salesforce API (by setting IsArchived to false for the CollaborationGroup records
in question).

Archiving offers many benefits and we recommend that you re-enable this feature after you’ve reviewed your organization’s
groups.

Enabling or Disabling Archiving for Chatter Groups
Archiving is enabled for Chatter groups by default.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Customize Application”To disable or re-enable archiving for Chatter groups:

To disable or re-enable archiving for Chatter groups:

1. From Setup, click Customize > Chatter > Settings, then click Edit.
2. In Chatter Group Settings, deselect Allow Group Archiving to disable archiving for groups, or if applicable, select that

option to re-enable this feature.

Note:  Disabling archiving prevents automatic and manual archiving of groups, but previously archived groups
aren’t activated. If required, group owners, group managers, or users with the “Modify All Data” permission can
activate groups, even if archiving is disabled.

3. Click Save.

When this feature is enabled:

• By default, groups are set to archive automatically if there are no new feed posts or comments for 90 consecutive days.
Groups are reviewed for feed activity and automatically archived on a weekly basis.

• Group owners and managers can archive, activate, or edit the automatic archiving settings for their groups. Users with the
“Modify All Data” permission can perform these activities on any group.

75

Archived Chatter GroupsChatter



• Archived groups that you own, manage, or belong to display in the My Archived Groups filter on the Groups tab. To find
other archived groups in your organization, you can use global search, run a report, or use the Salesforce API. (The
isArchived field on the CollaborationGroup record is set to true when a group is archived.)

• Automatic archiving settings can only be updated at the individual group level, on the group settings page. To change the
archiving settings for multiple groups at once, use the Salesforce API.

Archiving Chatter Groups
By default, groups are set to archive automatically if there are no new feed posts or comments for 90 consecutive days. Groups
are reviewed for feed activity and automatically archived on a weekly basis. Group owners, group managers, and users with
the “Modify All Data” permission can manually archive or edit automatic archiving settings for groups.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

1. Click Group Settings on the group detail page.
2. You can configure archiving for the group in one of two ways:

• Click Archive to archive the group right away.
• Select Archive this group if there are no posts or comments for 90 days and click Save to set up automatic archiving.

After you archive a group, the publisher is hidden and members can’t create new posts or share files in the group. In addition,
archived groups are removed from the Active Groups filter on the Groups tab. Use the My Archived Groups filter on the
Groups tab to find the archived groups that you own, manage, or belong to. You can also use global search to find archived
groups or associated content. Note that archived groups count toward your group membership limit.You can also use global
search or run a report to find other archived groups in your organization.

Note:

• Group members don’t receive email notifications when a Chatter group they own, manage, or belong to is archived
or activated.

• If your administrator disables archiving for groups, you can’t archive groups or edit automatic archiving settings.
You can activate archived groups at any time, even if the feature is disabled.

Activating Archived Chatter Groups
Group owners, group managers, and users with the “Modify All Data” permission can activate an archived Chatter group from
the group detail page.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

1. Navigate to the group you want to activate.

• Use the My Archived Groups filter on the Groups tab to find the archived groups you own, manage, or belong to.
• To find other archived groups, use global search, run a report, or ask your administrator for help.

2. On the group detail page or on the group settings page, click Activate.

The group detail page displays with the publisher enabled so members can create new posts and share files with the group.
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Note:

• Group members don’t receive email notifications when a Chatter group they own, manage, or belong to is archived
or activated.

• You can only activate one group at a time. To activate multiple groups at once, use the Salesforce API.

Using Publisher Actions in Chatter Groups
If your administrator has enabled and configured publisher actions, group members with permissions can create records in the
group in addition to creating standard Chatter posts.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Create” on the objectTo create a record in Chatter groups:

All Chatter groups, except customer groups, use the global publisher layout defined for your organization. The publisher in
customer groups displays only the standard actions—Post, File, Link, and Poll..

Note the following about records created using the publisher in groups:

• A record created in the group displays as a link in a feed post in the group. A similar record creation feed post also displays
in the Chatter feed, the profile feed of the user who created the record, and in the record feed on the record detail page.
The feed filter must be set to Show All Updates to view record creation posts.

• The visibility of records created in groups respects user permissions and sharing access rules in your organization. Group
members without permissions, such as Chatter Free users, can’t see the record or the record feed in any context.

• Group members with permissions can view the record and comment on it from any context (group, owner’s profile, record,
Chatter).

• The group feed aggregates all the comments on the record creation feed post. These could include comments posted outside
the group, by users with permissions to view the record feed.

• Creating a record within a group doesn’t create a group-to-record association.

Note:  The ability to create group-to-record associations, follow record feeds in the group, and extend record
sharing access to eligible group members is available through a pilot program. For information on enabling this
feature for your organization, contact salesforce.com.

@mention Chatter Groups
In addition to mentioning individual people, you can now mention groups in your posts and comments.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

When writing a post, type @ followed by the first few letters of a group name, then select the group from the list of matches.
The list includes all matches for people, including the people you don't follow, public groups, and private groups you’re a
member of. You can’t mention archived groups, customer groups, and private groups you’re not a member of.

For groups you mention in a post or comment:

• Your update appears in the group feed and the What I Follow feed for each group member.
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• Group members who enabled the Email Every Post preference for the group, receive an email notification.

Using Email to Post to Chatter Groups — Pilot
Group members can post to a Chatter group by sending an email.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

Note:  The ability to post to a Chatter group by email is currently available through a pilot program. For information
on enabling this feature for your organization, contact salesforce.com.

1. Copy the email address of the group you want to post to from the group detail page, below the group description.

Tip:  Save the group’s email address as a contact in your mail client or mobile device for easy access in the future.

2. From the email account associated with your Salesforce user profile, create a new email addressed to the group’s email
address.

3. Type the message you want to post to the group in the email body and send the email.

The email content displays as a post on the group detail page. Any hashtags you include in the email body (for example,
#TeamExcellence) are converted to topics on the post.

The following limitations apply to posting to a group using email:

• The 5,000 character limit for Chatter posts applies to posts created using email. Any text in your email beyond this character
limit is not included in the post.

• The email’s subject field is not included in the post.
• You can only create text posts using email. You can’t mention people, attach files, or create polls when posting to the group

by email.

New Chatter Profile Page—Generally Available
Chatter profile pages let you learn more about other Chatter users.

New Chatter Profile Page (Profile Tabs)

The new Chatter profile page has all the same features as before, but now also includes profile tabs and an enhanced overall
look and feel. With profile tabs, administrators can now easily deploy custom content and apps on profiles. For users, this
means a more personalized and immersive experience.

Enabling Customization of Chatter User Profile Pages

The Enable Customization of Chatter User Profile Pages user interface setting enables administrators to
customize the tabs on the Chatter user profile page. This includes adding custom tabs or removing default tabs. This feature
is automatically enabled in Winter ‘14. If disabled, users see the Feed and Overview tabs only.

Introducing Subtab Apps (Apps on Profile)

Users can see different sets of tabs on the profile page depending on their context. Sutbtab apps are the various sets of tabs
available on users’ profile pages. By creating custom tabs and displaying them within subtab apps, administrators can display
additional content on profile pages.
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Managing Subtab Apps

View and customize the subtab apps on users’ profile pages.

Controlling Subtab App Visibility

Once you have configured subtab apps, you can specify which users can see specific tabs on the profile page.

New Chatter Profile Page (Profile Tabs)
The new Chatter profile page has all the same features as before, but now also includes profile tabs and an enhanced overall
look and feel. With profile tabs, administrators can now easily deploy custom content and apps on profiles. For users, this
means a more personalized and immersive experience.

User information is now organized in these default tabs.

• Feed tab—This tab displays your Chatter feed.

• Overview tab—This tab displays information about you, such as your groups, followers, recent topics, About Me section,
and also your activity in Communities.

Your administrator configures the tabs and may add custom tabs or remove the default tabs. With the addition of custom tabs,
your organization can add additional information as content within profile pages.

Other features on the profile page have been reorganized.

• If available to the user, Help for this Page, Edit Profile, User Detail, and My Settings are accessible from a drop-down

button ( ) in the upper-right corner.
• When viewing someone else’s profile, Send a Message and Start Chat are available at the top of the page.

• Contact Info is positioned above Contribution in the left column.
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Enabling Customization of Chatter User Profile Pages
The Enable Customization of Chatter User Profile Pages user interface setting enables administrators to
customize the tabs on the Chatter user profile page. This includes adding custom tabs or removing default tabs. This feature
is automatically enabled in Winter ‘14. If disabled, users see the Feed and Overview tabs only.

1. From Setup, click Customize > User Interface at the bottom of the Customize menu.
2. Select Enable Customization of Chatter User Profile Pages.
3. Click Save.

Introducing Subtab Apps (Apps on Profile)
Users can see different sets of tabs on the profile page depending on their context. Sutbtab apps are the various sets of tabs
available on users’ profile pages. By creating custom tabs and displaying them within subtab apps, administrators can display
additional content on profile pages.

An app is a group of tabs that work as a unit to provide application functionality. Similarly, a subtab app is a collection of tabs
that appears on the Chatter profile page. A subtab app can include both default and custom tabs.

These default subtab apps determine which tabs display, depending on the user’s context.

Displayed to the user when viewing...Subtab App

Another user inside their internal organizationProfile (Others)

Their own profile inside their internal organizationProfile (Self)

Another user while inside a community. It’s shown only if
Communities is enabled.

Profile in Communities (Others)

Their own profile inside a community. It’s shown only if
Communities is enabled.

Profile in Communities (Self)

Note: End users can’t customize the display of subtab apps. Administrators can hide tabs within subtab apps using
the Tab Hidden option in Tab Settings. Users can see tabs set to Default Off and Default On.

Managing Subtab Apps
View and customize the subtab apps on users’ profile pages.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

From Setup, click Create > Apps to display your organization’s subtab apps.
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You can do the following:

• To view details for a subtab app, click the name in the Subtab Apps section. This displays its properties, such as which
tabs are part of the app, including any tabs that are not yet deployed. Click custom tabs in the Included Tabs list to view
details.

• To change the properties of a subtab app, click Edit to choose the tabs to include in the subtab app, change their display
order, and set the Default Landing Tab.

Note:  Administrators can use profile settings to limit users’ access to each tab. This allows administrators to make
specific tabs available to some users, but not to others.

Controlling Subtab App Visibility
Once you have configured subtab apps, you can specify which users can see specific tabs on the profile page.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view apps:

“Customize Application”To manage apps:

To control the visibility of tabs within a subtab app:

1. From Setup, click Manage Users > Profiles.
2. Do one of the following:

• Original profile user interface—Click Edit next to the profile you want to modify and scroll to the Tab Settings section.
• Enhanced profile user interface—Click the profile you want to modify and click Object Settings. Click the object you

want to modify and click Edit.

Note:  Chatter External and Chatter Free users typically don’t have the permissions needed to view subtab apps,
but administrators can give them access.

3. Change the tab settings.

End users can’t customize the display of subtab apps. Administrators can hide tabs within subtab apps using the Tab
Hidden option in Tab Settings. Users can see tabs set to Default Off and Default On.

4. (Original profile user interface only) To reset users’ tab customizations to the tab visibility settings that you specify, select
Overwrite users’ personal tab customizations.

5. Click Save.

Salesforce Files—Pilot
Salesforce Files lets you securely sync files between Chatter and your desktop and some mobile devices.
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Note: Salesforce Files is currently available through a pilot program. For information on enabling Salesforce Files
for your organization, contact salesforce.com.

Any unreleased services or features referenced in this or other press releases or public statements are not currently
available and may not be delivered on time or at all. Customers who purchase our services should make their purchase
decisions based upon features that are currently available.

Publisher Actions
Actions let users do more in Chatter, like create records and log calls directly in the feed.

Default Publisher Actions Now Available

Default actions are create actions—actions that allow users to create new records—that are automatically set up to make the
process of configuring publisher actions much simpler.

Mobile Smart Actions Now Available

Mobile smart actions are sets of actions in the publisher on account, case, contact, lead, and opportunity pages, and on the
global publisher layout, in Salesforce1. They’re designed to make it possible to get publisher actions for mobile users set up
with very little effort.

Publisher Actions Available in Groups and on Topic Pages

Users working in groups and on topic pages can now use any actions you include in the global Chatter layout, making it
easier for them to create records and do other tasks in the feed.

New Publisher Action Types

There are two new types of publisher actions: log a call and custom canvas.

Lookup and Master-Detail Fields Supported for Predefined Field Values in Publisher Actions

Setting predefined values on fields you include in publisher action layouts helps ensure consistency and makes it faster and
easier to use those actions. You can now predefine values for lookup and master-detail fields.

Rich Text Area Fields Supported in Publisher Actions

You can now add rich text area fields to actions you create for the publisher, giving users the option to format text.

Default Publisher Actions Now Available
Default actions are create actions—actions that allow users to create new records—that are automatically set up to make the
process of configuring publisher actions much simpler.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

In organizations created after Winter ‘14, these actions are automatically added to the default global publisher layout and to
the default publisher layout on these objects:

• Account

• Case

• Contact

• Lead

• Opportunity
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In organizations created before Winter ’14, these actions are available in the palette on the page layout editor for these layouts,
but they’re not automatically added to any publisher layouts.

Here are the actions available on each of these layouts. On organizations where these actions are automatically added to
publisher layouts, they appear in the publisher in the order shown. (Italicized actions are standard Chatter actions, not create
actions.)

Default ActionsLayout

Global layout (also applies to custom objects) • Post

• File

• New Task

• New Contact

• Log a Call (logged calls are saved as completed tasks)

• New Opportunity

• New Case

• New Lead

• Thanks

• Link

• Poll

Account • Post

• File

• New Task

• New Contact

• New Case

• Log a Call (logged calls are saved as completed tasks)

• New Note

• New Opportunity

• Thanks

• Link

• Poll

Case • Post

• File

• New Child Case

• Log a Call (logged calls are saved as completed tasks)

• New Task

• New Event

• Thanks

• Link

• Poll

Contact • Post

• File

• New Task

• Log a Call (logged calls are saved as completed tasks)
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Default ActionsLayout

• New Case

• New Note

• New Event

• Thanks

• Link

• Poll

Lead • Post

• File

• New Task

• Log a Call (logged calls are saved as completed tasks)

• New Case

• New Note

• New Event

• Thanks

• Link

• Poll

Opportunity • Post

• File

• New Task

• Log a Call (logged calls are saved as completed tasks)

• New Case

• New Note

• New Event

• Thanks

• Link

• Poll

Create actions on the global layout are global actions, which means that records created using them aren’t associated with any
other record. Create actions added to publisher layouts on objects are object-specific; records created using these actions are
automatically associated with related records. For example, when a user creates a contact using the New Contact action on
the record detail page for the account Acme, Inc., the contact is automatically associated with Acme.

Each default create action has a predefined set of fields. You can change these fields and their order using the action layout
editor. You can also change the order in which the actions appear in the publisher, and can remove any unwanted actions,
using the page layout editor.

Mobile Smart Actions Now Available
Mobile smart actions are sets of actions in the publisher on account, case, contact, lead, and opportunity pages, and on the
global publisher layout, in Salesforce1. They’re designed to make it possible to get publisher actions for mobile users set up
with very little effort.
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Mobile smart actions appear as a single action element in the page layout editor, but appear in the publisher on Salesforce1
as distinct create actions, which allow users to create records directly in the feed. Here’s what the mobile smart action on each
supported object expands to include. (The actions appear in the publisher layout in the order shown.)

Actions Included in Mobile Smart Action BundleLayout

Global layout (also applies to custom objects) • New Task

• New Contact

• Log a Call (logged calls are saved as completed tasks)

• New Opportunity

• New Case

• New Lead

Account • New Task

• New Contact

• New Case

• Log a Call (logged calls are saved as completed tasks)

• New Note

• New Opportunity

Case • New Child Case

• Log a Call (logged calls are saved as completed tasks)

• New Task

• New Event

Contact • New Task

• Log a Call (logged calls are saved as completed tasks)

• New Case

• New Note

• New Event

Lead • New Task

• Log a Call (logged calls are saved as completed tasks)

• New Case

• New Note

• New Event

Opportunity • New Task

• Log a Call (logged calls are saved as completed tasks)

• New Case

• New Note

• New Event

Mobile smart actions are automatically populated with all of your organization’s required fields on the relevant object, regardless
of how many fields there are. For example, the New Case action in the mobile smart action bundle includes all required case
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fields. You can’t edit the fields on mobile smart actions; the fields that appear will change only if you change which fields on
an object are required.

You also can’t change which actions are included as part of a mobile smart actions bundle—removing “New Event” or adding
a custom action, for example. To create a more customized set of actions, create the actions you want and add them to the
relevant page layouts, and remove the mobile smart actions bundle.

Mobile smart actions appear in different ways for different organizations.

• If your organization existed prior to Winter ’14 but didn’t have publisher actions enabled when Winter ’14 was released,
mobile smart actions are automatically added to the publisher on all page layouts for account, case, contact, lead, and
opportunity, and to the global publisher layout.

◊ If you enable publisher actions, mobile smart actions are automatically replaced by default actions on each supported
object.

• If your organization was created after Winter ’14, or was an existing organization that had publisher actions enabled when
Winter ’14 was released, mobile smart actions are available in the page layout editor for all page layouts on the supported
objects, but they’re not automatically added to the publisher.

Note: Mobile smart actions don’t appear in the publisher on any page in the full Salesforce site, regardless of which
page layouts you add them to; they appear only to users on Salesforce1. As such, if you have users who access Salesforce
on mobile devices more frequently than they access the full site, you may want to create specific page layouts for them
and include mobile smart actions only on those layouts.

Publisher Actions Available in Groups and on Topic Pages
Users working in groups and on topic pages can now use any actions you include in the global Chatter layout, making it easier
for them to create records and do other tasks in the feed.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Database.com, and Developer
Editions

When a user creates a record in a group or on a topic page using a create action, a link to the record appears in the feed on the
group or topic page, as well as in the main Chatter feed, as the first entry in the feed for the new record, and in the user profile
feed of the user who created the record. For records created on topic pages, the topic is added to the resulting feed item
automatically.

New Publisher Action Types
There are two new types of publisher actions: log a call and custom canvas.

Publisher actions available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Database.com,
and Developer Editions

Custom canvas actions available in: Professional (with Force.com Canvas enabled), Enterprise, Performance, Unlimited,
and Developer Editions

• Log-a-call actions let users record the details of phone calls or other customer interactions. These call logs are saved as
completed tasks.

• Update actions let users make changes to a record from the record’s feed.
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• Custom canvas actions let users access canvas apps directly in the publisher.You can use as a custom action any canvas app
that uses Publisher as a location. For example, you might use an expense report app as a custom action to make it easy for
salespeople to submit expense reports directly from feeds. A custom action that includes a video conferencing canvas app
could help support agents communicate with customers visually for easier troubleshooting of technical issues.

Note:  Custom canvas actions are currently available through a pilot program. For information on enabling custom
canvas actions in your organization, contact salesforce.com.

Log a call actions can be either object-specific or global actions. Custom canvas actions can only be global actions.  Update
actions can only be object-specific.

For more information, see “Creating Object-Specific Actions,” “Creating Global Actions,” “Creating Custom Actions,” and
“Using Canvas Apps as Custom Actions” in the Salesforce Help.

Lookup and Master-Detail Fields Supported for Predefined Field
Values in Publisher Actions

Setting predefined values on fields you include in publisher action layouts helps ensure consistency and makes it faster and
easier to use those actions. You can now predefine values for lookup and master-detail fields.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Database.com, and Developer
Editions

For more information on using predefined field values, see “Setting Predefined Field Values for Publisher Actions” and “Notes
on Predefined Field Values for Publisher Actions” in the Salesforce Help.

Rich Text Area Fields Supported in Publisher Actions
You can now add rich text area fields to actions you create for the publisher, giving users the option to format text.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Database.com, and Developer
Editions

For example, if you have a Create Opportunity action, you might add a rich text area field called Detailed Comments to let
salespeople write notes that include bulleted lists, bold text, italics, and other formatting.

Note: Rich text area fields are supported only when you add them to one-column layouts, or as fields that span both
columns in two-column layouts. If you add a rich text area field to only one column in a two-column layout, it appears
as a plain text area, as there’s not enough space to display the full rich text editor.

For more information on adding fields—including rich text area fields—to actions, see “Customizing Publisher Actions with
the Action Layout Editor” in the Salesforce Help.

Topics
Topics help you organize posts and see what people are talking about.
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Feed Tracking Automatically Enabled for Topics

Immediately upon release, administrators can enable feed tracking for topics so users can follow topics. If an administrator
doesn’t manually enable feed tracking for topics within 24 hours after the release, a script will automatically enable it.

Following Topics

Follow topics so you can see updates in your Chatter feed.

New Topics User Permissions

Use the new topics permissions to give users the ability to assign, create, delete, and edit topics.

Editing Topic Names

You can now change spacing in addition to capitalization in topic names.

Topics with the Same Name Merged

Within 24 hours after the release, we’re automatically merging topics with names that differ only in capitalization and spacing.

Feed Tracking Automatically Enabled for Topics
Immediately upon release, administrators can enable feed tracking for topics so users can follow topics. If an administrator
doesn’t manually enable feed tracking for topics within 24 hours after the release, a script will automatically enable it.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, Developer, and Database.com
Editions

User Permissions Needed

“Customize Application”To customize fields tracked in feeds:

“View Setup and Configuration”To view the field tracking setup page:

A topic’s Description field is the only field you can track, and it’s tracked by default. Feed tracked changes for topics
(changes to a topic’s description) appear only on the profile page of the person who made the change, and not on the topic
page or in your feed, even if you’re following the topic.

1. From Setup, click Customize > Chatter > Feed Tracking.
2. Select Topic.
3. Select Enable Feed Tracking.

You must have the required user permissions to see this checkbox. To restore the default feed tracking settings for this
object, click Restore Defaults.

4. Ensure the Description field is selected.
5. Click Save.

If you disable feed tracking for topics, users can no longer follow new topics, but they continue to follow the ones they followed
when feed tracking was enabled. These topics count toward the maximum number of people, topics, and records that they
can follow. Use the Chatter REST API to stop following topics after feed tracking has been disabled.

Following Topics
Follow topics so you can see updates in your Chatter feed.
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Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

To follow a topic, click Follow on the:

• Topic detail page

• Topics list

Feed tracked changes for topics (changes to a topic’s description) appear only on the profile page of the person who made the
change, and not on the topic page or in your feed, even if you’re following the topic. You can follow a maximum combined
total of 500 people, topics, and records.

To stop following a topic, click  next to Following. After you stop following a topic, you don’t see future updates to the
topic in your Chatter feed.

If your administrator disables feed tracking for topics, you can’t follow new topics but you continue to follow the ones you
followed when feed tracking was enabled. These topics count toward the maximum number of people, topics, and records
that you can follow. To stop following a topic after your administrator disables feed tracking, you must use the Chatter REST
API.

New Topics User Permissions
Use the new topics permissions to give users the ability to assign, create, delete, and edit topics.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view system permissions:

“Manage Users”To edit system permissions:

In Winter ‘14, these new topics user permissions are available.

You can enable user permissions in permission sets and profiles. In permission sets and the enhanced profile user interface,
these permissions are listed in the System Permissions page. In the original profile user interface, they are listed under General
User Permissions.

Assign Topics
Assign existing topics to feed items. Remove topics from feed items.

Create Topics
Create new topics by assigning them to feed items.

Delete Topics
Delete topics and remove all topic assignments from feed items.

Consider these points when granting delete access:

• Topics are hard deleted. They aren’t sent to the Recycle Bin.
• Deleted topics are removed from search results, the topics list, all posts, Recently Talked About topics, Related

Topics, and your users’ favorites. Deleted topics are removed from Trending Topics after the next calculation.
• Deleted topics are not blacklisted. Users can reintroduce a topic after it’s been deleted.
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Edit Topics
Edit topic names and descriptions.

To use permission sets to grant topics permissions to users:

1. From Setup, click Manage Users > Permission Sets.
2. Click New and create permission sets that include the appropriate topics permissions.
3. Go to Manage Users > Users and assign the permission sets to the appropriate users.

Editing Topic Names
You can now change spacing in addition to capitalization in topic names.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

User Permissions Needed

“Edit Topics”To edit topic names:

• On the topic detail page next to Description, click .

Topics with the Same Name Merged
Within 24 hours after the release, we’re automatically merging topics with names that differ only in capitalization and spacing.

It can be confusing when the same topic goes by similar but different names, such as San Francisco, sanfrancisco, and
SanFrancisco. Existing topics with this type of variation are merged within 24 hours after the release. We choose the topic
with the most activity (the highest talking about number), and we merge the other topics’ posts and comments into the chosen
topic’s feed. If more than one topic had a description, we concatenate the descriptions. You can always change a topic’s
description and the capitalization and spacing of a chosen topic. See Editing Topic Names.

Now when users start typing a topic name that differs only in capitalization or spacing from an existing topic, we only allow
them to choose the existing topic, to ensure consistency. And hashtags are now space and capitalization insensitive. Clicking
#sanfrancisco, #SanFrancisco, and #San Francisco takes you to the same topic detail page.

Chatter Feeds
Chatter Feeds make collaboration easy.

Chatter Thanks
Increased Post and Comment Size
Combined Filter and Sort Options
New Preview Links
Relocated Feed Search
Record Updates in All Company Feed
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Chatter Thanks

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

We’ve added Thanks to Chatter.

Thanks is a Work.com feature that is now available directly from the Chatter publisher. Use Thanks to recognize your
coworkers. You can customize your post with one of twelve badges.

Administrators need to enable Thanks for all organizations.

Note:

• Work.com is a suite of sales performance management products that enable you to drive performance of your sales
organization.

• Enterprise, Professional, and Unlimited editions do not have full Chatter Thanks and Badging functionality.
This requires a separate Work.com license. The standard Salesforce license for the Performance Edition includes
a Perform Work.com license with full Thanks and Badging functionality.

Examples of actions that require a Work.com license:

• Modify, delete, or add custom badges

• View recognition received by a user with the Recognition tab

• Use Work.com Rewards

Enabling Chatter Thanks

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

1. In Setup, click Customize > Work.com > Settings.
2. Select Enable under Thanks Settings and click Save.

To disable Work.com features, in Setup, click Customize > Work.com > Settings and deselect Enable. Users will no longer
see the Thanks action in the Chatter publisher. However, they can still see previously created Thanks posts.

Configuring Thanks in the Chatter Publisher

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

Once Thanks is enabled, administrators can change the position of Thanks in the Chatter publisher or hide visibility for
specific profiles.

1. In Setup, click Customize > Chatter > Settings.
2. Confirm that Enable Publisher Actions is enabled in the Publisher Actions section.

If it isn’t enabled, select Enable Publisher Actions and click Save.
3. Click Setup > Customize > Chatter > Publisher Layouts.
4. On the Global Publisher Layout page, select Edit in the Action column for the Global Publisher Layout.
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5. Under Publisher Actions, click the Thanks button and drag it to the desired position.

You can also hide Thanks in the publisher based on user profiles. For more information, search for “Assigning Global Publisher
Layouts to User Profiles” in the Salesforce online help.

Giving Thanks to Your Coworkers

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

Thank someone if they’ve done a great job or recognize someone’s achievement.

1. From the Chatter publisher, click Thanks.
2. Type the name of the person you want to thank.

Currently, you can only thank one person at a time, but you can mention other people in your post.

3. Select Change Badge to select a different badge for your post or keep the default badge.

You can choose from twelve pre-defined badges. Select the badge image to see more information about the badge.

4. Type a message for the person you’re thanking.
5. Select your audience.

• My Followers to post to all your followers
• A Group to post to a specific group. Search for the group and select the group from the list. When you post to a private

group, only the group’s members can see your post.

6. Click Share.

Your Thanks post appears in your feed and the feed of the person you’re thanking. If you’re posting to a public group or a
record page, the post appears on the group or record feed. If you’re posting to a private group, only members of the private
group can see your post.

Increased Post and Comment Size

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

We’ve increased the length of posts and comments. Instead of 1000 characters, your posts and comments can now be up to
5000 characters long.

Combined Filter and Sort Options

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

We’ve combined the feed filter and sort options into one drop-down menu. The menu is available on:

• Your Chatter page

• Profile pages

• Group pages

• Record detail pages

• Chatter feed search result pages
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Above the feed, click  next to Show and select a filter or sort by option.

DescriptionFilter or Sort Option

Shows all posts and comments from people and records you
follow, posts from groups you’re a member of, and all
system-generated posts.

All Updates (Default)

Fewer Updates • Shows all posts and comments from people and records
you follow and groups you’re a member of

• Hides system-generated posts from records that nobody
has commented on

Shows only the posts and comments from people you follow.People

Shows only the posts in groups you’re a member of.Groups

Shows posts that include:Files
• Files you follow

• File posts that someone you follow has commented on

Sorts by most recent posts.Post Date

Sorts by posts with the most recent comments, including polls
with new comments.

Most Recent Activity

For example, your What I Follow feed shows posts from all people and records you follow, and groups you’re a member of.
If you select the People filter, your feed only shows posts from people you follow instead of all posts.

New Preview Links

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

In Winter ’14, we’ve added more previews for linked content:

• bbc.com

• bbc.uk.com

• brightcove.com

• ft.com

• gawker.com

• gizmodo.com

• hulu.com

• linkedin.com

• plus.google.com

• theverge.com

• twitpic.com

• twitter.com

• ustream.tv

• vidyard.com

• vine.com
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The previews are powered by Embed.ly, a third-party service, and include thumbnails, descriptions, and video players for links
to videos. We don’t share any content, user, organization, or account data with Embed.ly. We only share the URLs that are
on the domain whitelist. Additionally, all of our URL requests pass through a Salesforce proxy, meaning Embed.ly never
receives calls directly from the client and therefore doesn’t have information about who's making the URL request.

Relocated Feed Search

Available in: Group, Professional, Enterprise, Performance, Unlimited, Contact Manager, and Developer Editions

We moved the location of the feed search icon ( ). You’ll now see the icon on the left side of your feed below the publisher.

You can search for information in feeds on a user’s profile, on a record, in groups, and on the Chatter and Home tabs. A
contextual feed search is helpful when you want to find something that was once discussed in that specific feed.

Record Updates in All Company Feed
The All Company feed now only includes system-generated record posts, if they have likes or comments.

For example, if an account manager creates a new account or changes a feed tracked field on an existing account, Salesforce
automatically generates an update. This type of post no longer appears in the All Company feed, unless someone liked or
commented on the post.

Email Notifications
Chatter works with your email so users can be easily notified about posts.

Redesigned Email Notifications

Email notifications for posts, comments, and likes feature a new look and updated content.

Redesigned Email Notifications
Email notifications for posts, comments, and likes feature a new look and updated content.

The design and content changes include:

• A new layout optimized for both desktop and mobile

• A personalized From field that names the author of the post, comment, or like

• Footer text that identifies your organization and the type of notification, making it easier to change your email settings

• For like notifications in HTML emails, the email body includes the post or comment that was liked

Other notifications such as group digests and follow notifications haven’t changed. Custom branding for Communities is still
supported.

94

Relocated Feed SearchChatter



Communities
Communities helps companies share information with their customers and partners.

Communities Moderation

Moderate your communities to encourage the best content and interactions.

Default Profile for Communities Self-Registration

Self-registration allows users to join your community without requiring an administrator’s assistance.

Sharing Groups for High-Volume Community Users

Enable sharing settings so that you can easily grant high-volume community users access to the appropriate objects within
your communities. Additionally, you can create associated sharing groups, so that internal and external users can access
records created by those high-volume community users.

Configuring Group Digest Emails in Communities
Offline Communities No Longer Show Up in The Community Drop-Down Menu
View Global Header Permission Is No Longer On By Default
Maximum Number of Communities Listed in Setup

You can now easily find out how many communities are available in your organization.

Mention Suggestions Include Members and Groups Across Communities

When you’re writing a post and mention a person or a group, the list of mention suggestions now includes matches for people
and groups across all communities you’re a member of.

Case Visibility in Communities

New cases are now visible in communities, regardless of the New Cases Visible in Portal setting.

Improved Communities API Support

Winter ‘14 has improved API support for Communities.

Site.com Enhancements for Communities

Use Site.com to perform advanced customizations on your communities.

Communities Moderation
Moderate your communities to encourage the best content and interactions.

Communities Moderation Overview

Community moderation allows you to empower members of your community to monitor content and ensure that it is
appropriate and relevant.

What is a Community Moderator?

Moderators help ensure the success of your community.

Enabling Moderation in Your Community

Turn on moderation for your community to empower members to flag posts and comments that they deem inappropriate.
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Assigning a Community Moderator

Assign one or more people as moderators in your community. Moderators can be either employees from your company or
external users who are members of your community.

Flagging a Post or Comment in a Community

If another member of your community posts something inappropriate, you can flag it.

Moderating Your Community

If you are the moderator of a community, you can review a list of posts and comments that members of the community
flagged as inappropriate and take action. If you’re a group owner or manager, you can view and remove flags on items in your
groups.

Moderating Community Files

If you are the moderator of a community, you can delete files that shouldn’t be present in the community. Additionally,
group owners and managers can delete files in the groups they own and manage.

Communities Moderation Overview
Community moderation allows you to empower members of your community to monitor content and ensure that it is appropriate
and relevant.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

Moderation is crucial for a community to thrive. You need active moderators who are willing to spend time ensuring that the
members and content in your community are appropriate and helpful. You also need to empower members to speak up when
they view something as inappropriate or offensive.

With Communities Moderation, you can

• Designate specific users as moderators so that they can closely monitor the community

• Allow all members to flag posts and comments that are inappropriate

• Allow moderators to review flagged items and take action, such as deleting a post or comment

• Allow moderators to delete files

• Allow group owners and managers to moderate within their groups

What is a Community Moderator?
Moderators help ensure the success of your community.

In a successful community, members are actively engaged and communicating with others. A community moderator facilitates
knowledge sharing within a community to help members benefit and derive value from their participation. The moderator
also helps to ensure that all communications and content in the community are appropriate.

The moderator can be an employee from your internal organization or a trusted external member of the community. This
person should be accustomed to interfacing with customers, familiar with Salesforce and Chatter capabilities, and can spend
time regularly monitoring the community.

A moderator can:

• Manage the list of flagged posts and comments in the community

• Remove flags
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• Delete inappropriate posts, comments, and files

A moderator can also help drive the success of a community in many other ways.

• Sharing relevant and useful information in community posts

• Encouraging members to post and comment on each other’s posts

• Setting an example by their activity in the community

• Keeping discussions focused, spam-free, and non-controversial

• Redirecting email conversations to communities when it can benefit other community members

• Establishing the community as a reliable source of information and a forum for transparent discussions

You can choose to designate more than one moderator for a community, especially if the community has a large number of
members.

Note:  Although they share some similar capabilities, a community moderator is different than a Chatter moderator.

Enabling Moderation in Your Community
Turn on moderation for your community to empower members to flag posts and comments that they deem inappropriate.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Create and Manage Communities”To enable moderation in your community:

Community Moderation must be enabled for your organization before you can allow members to flag content. If you don’t
see the option to allow flagged content, contact your administrator.

Once an item is flagged, your community moderator can review it and take action.

1. From Setup, click Customize > Communities > Manage Communities.
2. Click Edit next to the community in which you want to enable moderation.
3. Click Members, then select Allow members to flag content.
4. Click Save.

With moderation enabled in a community:

• Members can flag posts and comments using the Flag as inappropriate option
• Group owners and managers can moderate groups they own or manage
• Users with “Moderate Communities Feeds” can moderate items they have access to in the community using the Flagged

feed filter
• Users with “Moderate Communities Files” can delete files they have access to in the community

Assigning a Community Moderator
Assign one or more people as moderators in your community. Moderators can be either employees from your company or
external users who are members of your community.
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Available in: Performance, Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Manage Users”To assign permission sets:

You can assign moderators by creating a permission set that includes one or both of the moderation permissions.

DescriptionPermission

Review flagged posts and comments and take action, such as
removing flags or deleting the post or comment. Sees a Flagged
filter and list view that they can use to manage flagged items

Moderate Communities Feeds

Delete filesModerate Communities Files

You can also add these permissions to a profile. These permissions are valid for all communities the user is a member of, but
don’t apply in your internal organization.

1. From Setup, click Manage Users > Permission Sets, then click New.
2. Create a permission set that includes the appropriate permissions.
3. From Setup, click Manage Users > Users.
4. Find the user you want to be a community moderator and add the permission set to their Permission Set Assignments

related list.

The user can now moderate any items they have access to in all communities they’re a member of. Moderators with the
“Moderate Communities Feeds” permission can also receive an email notification when a post or comment is flagged by
selecting the Flags an item as inappropriate email notification.

Flagging a Post or Comment in a Community
If another member of your community posts something inappropriate, you can flag it.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

The ability to flag a post or comment as inappropriate shows when Allow members to flag content is selected for a
community.

Flagged posts and comments are sent to the community moderator for review. Other members in the community can’t see
your flag.

Note:  Flagging items on record feeds within the community isn’t currently supported.

1. Click  at the top right corner of the post or comment you want to flag to expand the drop-down menu.
2. Click Flag as inappropriate.

The flag icon displays next to the post or comment date.

If you flagged the item by accident or decide you want to remove the flag, simply click , and click Remove flag.

You might want to flag a post if:
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• A member accidentally posts something company confidential to a public group
• A member posts or comments and uses language you find offensive

Moderating Your Community
If you are the moderator of a community, you can review a list of posts and comments that members of the community flagged
as inappropriate and take action. If you’re a group owner or manager, you can view and remove flags on items in your groups.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Moderate Communities Feeds”To view flagged items, remove flags, and delete posts or
comments:

“Moderate Communities Files”To delete files:

The Flagged filter shows when Allow members to flag content is selected for a community.

Flagged items have a small orange flag next to the post or comment date. The number next to the flag indicates how many
people have flagged the item. The moderator can review each item in the list and decide whether to take action.

Note:  Moderators can only view and act on items they have access to.

1. On the Chatter tab in your community, click the Flagged filter and review the flagged items.
2. Click Delete or Remove Flags, depending on whether you agree that the post or comment is inappropriate and should

be deleted or whether the post or comment was flagged in error.
3. Click OK.

Tip:  If you want to receive an email each time an item in your community is flagged, select the Flags an item
as inappropriate checkbox on the Chatter Email Notifications page.

Moderating Community Files
If you are the moderator of a community, you can delete files that shouldn’t be present in the community. Additionally, group
owners and managers can delete files in the groups they own and manage.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Moderate Communities Files”To view flagged items, remove flags, and delete posts or
comments:

Moderators can delete files only when Allow members to flag content is selected for a community.

Members of your community may post files that aren’t appropriate because they contain sensitive information or content that
may be offensive. Moderators can delete files in the community that they have access to.
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Groups owners and managers can delete files in the groups they own and manage, regardless of whether community moderation
is enabled.

1. Within the community, access the files details for the file you want to delete.
2. Click Delete.

The file is permanently deleted from the community.

Default Profile for Communities Self-Registration
Self-registration allows users to join your community without requiring an administrator’s assistance.

You can now select a default profile that is assigned to users who self-register for your community. You can continue to set
this value in the CommunitiesSelfRegController if desired. If profiles are set in both locations, the value in the
CommunitiesSelfRegController overrides the default value.

To enable self-registration:

1. From Setup, click Customize > Communities > Manage Communities.
2. Click Edit next to your community, then click Login Page.
3. Select Allow external users to self-register to enable self-registration for your community.
4. Optionally, select a profile to assign to users who self-register. If you don’t select a value, you must enter one in the

CommunitiesSelfRegController.

Note:  You can only select portal profiles that are associated with the community.

If a profile is selected as the default for users who self-register, and you remove it from the community, the
Default profile for users that self register is automatically reset to None.

To complete self-registration setup, you must specify in the default controller which account the self-registration process
should assign users to. For more information, see Getting Started With Salesforce Communities.

Sharing Groups for High-Volume Community Users
Enable sharing settings so that you can easily grant high-volume community users access to the appropriate objects within
your communities. Additionally, you can create associated sharing groups, so that internal and external users can access records
created by those high-volume community users.

Granting High-Volume Community Users Access to Records

You can create sharing sets to grant high-volume community users access to records.

Sharing Records Owned By High-Volume Community Users

Share groups allow you to share records owned by high-volume community users with internal and external users in your
communities.

Granting High-Volume Community Users Access to Records
You can create sharing sets to grant high-volume community users access to records.

Available in: Performance, Unlimited, Developer, and Enterprise Editions
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User Permissions Needed

“Customize Application”To grant high-volume community users access to records:

A sharing set allows high-volume users to access any record that has a lookup field to an account or contact that matches the
user’s account or contact. Sharing sets apply across all communities a high-volume community user is a member of.

High-volume community users have either the Customer Community or High-Volume Portal User license.

1. Click Customize > Communities > Settings.
2. In the Sharing Settings for High-Volume Community Users related list, click New to create a sharing set, or click Edit

next to an existing sharing set.
3. In the Sharing Set Edit page, enter a name and description.
4. Select the profiles of the users you want to have access.
5. Select the objects you want to grant access to.

The Available Objects list excludes:

• Objects with an organization-wide sharing setting of Public Read/Write
• Custom objects that don’t have an account or contact lookup field

6. In the Configure Access section, click Set Up or Edit next to an object name to configure access for the selected profiles,
or click Del to remove access settings for an object.

Note:  Objects with Set Up in the Action column aren’t configured for high-volume user access. Until you configure
an object, high-volume users have limited or no access to its records.

7. Grant access based on an account or contact lookup:

• Select All records where the high-volume community user’s account matches to give high-volume
community users access to all records associated with their accounts. For example, choosing this option for cases would
give users access to all cases associated with their accounts.

• Select Only records where the high-volume community user’s contact matches to give high-volume
community users access only to the records that are associated with their contacts. For example, choosing this option
for cases would give users access only to the cases that they filed, or cases that were filed on their behalf by a support
representative.

Note:  One of these options may be unavailable if the object doesn’t contain the relevant fields.

8. Choose an access level of Read Only or Read/Write. (If the object’s organization-wide sharing setting is Public Read Only,
then only Read/Write is available.)

9. Click Update, then click Save.

After creating a sharing set, create share groups to give other users access to records created by high-volume community users.

Sharing Records Owned By High-Volume Community Users
Share groups allow you to share records owned by high-volume community users with internal and external users in your
communities.

Available in: Performance, Unlimited, Developer, and Enterprise Editions
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User Permissions Needed

“Customize Application”To share records owned by high-volume community users to
other users:

High-volume users are limited-access users intended for organizations with many thousands to millions of external users.
Unlike other external users, high-volume users don’t have roles, which eliminates performance issues associated with role
hierarchy calculations. Because high-volume community users are not in the role hierarchy while Salesforce users are, a share
group allows you to specify the Salesforce other external users who can access records owned by high-volume community users.

Share groups apply across communities.

To set up share groups for your communities:

1. Click Customize > Communities > Settings.
2. In the Sharing Settings for High-Volume Community Users related list, click Edit next to an existing sharing set.
3. Click the Share Group Settings tab.
4. Click Activate to turn on the share group.

Activating the share group can take a while. An email is sent to you when the process finishes.

Note:  Deactivating a share group removes all other users’ access to records owned by high-volume community
users. An email isn’t sent to you when the deactivation process finishes.

5. Click Edit to add users to the share group. You can add both internal users from your organization as well as external users
from the same parent account as the high-volume user.

a. From the Search drop-down list, select the type of member to add.
b. If you don’t see the member you want to add, enter keywords in the search box and click Find.
c. Select members from the Available Members box, and click Add to add them to the group.
d. Click Save.

Configuring Group Digest Emails in Communities
To receive group digest emails, your administrator must enable email notifications for your community.

Use group digests to keep up with activity in your groups. This feature is now available in Communities.

1. Click a group’s name.
2. Click Email Me... and choose to receive a daily or weekly digest email or an email every time someone posts.

To stop receiving email for the group, click Turn Off Group Email.

Note: In Communities, the Email on Each Post option is disabled once a group exceeds 10,000 members.
All members who had this option selected are automatically switched to Daily Digests.

102

Configuring Group Digest Emails in CommunitiesCommunities



Offline Communities No Longer Show Up in The
Community Drop-Down Menu

Starting in Winter ‘14, only Published communities that you’re a member of will show up in the drop-down menu. Offline
communities won’t be listed.

View Global Header Permission Is No Longer On By Default
Starting in Winter ‘14, the View Global Header permission is now disabled by default for all standard profiles. Previously,
this permission was automatically enabled for all profiles in an organizations when Salesforce Communities was enabled.
Administrators in organizations already using Salesforce Communities can now manually disable this permission in standard
profiles.

When Salesforce Communities is enabled, the global header allows you to easily switch between your communities and your
internal organization.

• To access communities from within your organization, click  next to Organization Name in the drop-down and select
the community you want to switch to. The drop-down shows Published communities that you’re a member of. If you
have the “Create and Manage Communities” permission, you also see Preview communities that you’re a member of.

• To return to your internal organization, click  next to Community Name in the drop-down and select your organization
name.

Internal users who aren’t members of any community just see the company name. External users see the drop-down menu
only if they belong to more than one published community.

The Your Name menu on the right side contains links to edit your contact information and log out. For internal users, it also
contains a link to Help & Training and may also contain links to Setup and other tools depending on user permissions and
enabled features.

You can use permission sets to turn on the global header for the appropriate users.

1. From Setup, click Manage Users > Permission Sets.
2. Click New and create a permission set that includes the System Permission View Global Header.
3. Go to Manage Users > Users and assign the permission set to the appropriate users.

Users with the permission set see the global header at the top of all pages.

Maximum Number of Communities Listed in Setup
You can now easily find out how many communities are available in your organization.
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The number of communities available is based on the number purchased for your organization. To find out that number, go
to Customize > Communities > Manage Communities. The Maximum number of active communities field shows the
total number of Published and Preview communities your organization can have. Offline communities don’t count
against this total.

Mention Suggestions Include Members and Groups Across
Communities

When you’re writing a post and mention a person or a group, the list of mention suggestions now includes matches for people
and groups across all communities you’re a member of.

In previous releases, the list only included matches for people who have sharing access to the record. If you select a person or
group from the list of matches who doesn't have sharing access to the post or record, you’ll see an error message explaining
that the person or group members can’t see your post.

Case Visibility in Communities
New cases are now visible in communities, regardless of the New Cases Visible in Portal setting.

Visibility of new cases for partner or customer users is controlled by the New Cases Visible in Portal field in an
organization’s Case Support Settings. Starting in the Winter ‘14 release, this setting will no longer apply for partner users and
customer users in communities. Case visibility in communities will be controlled by sharing rules. This setting will still apply
in partner portals and Customer Portals.

Improved Communities API Support
Winter ‘14 has improved API support for Communities.

Some of the updates include:

• Access the SOAP or REST API through the community endpoint URL. To do so, you must have an API session. Login
is not supported.

• AJAX Toolkit support

• Streaming API support within a community

• Chatter REST API support for Communities Moderation

For information on additional API updates, see API on page 304.

Site.com Enhancements for Communities
Use Site.com to perform advanced customizations on your communities.

Use Site.com Pages Instead of Standard Tabs

You can override the standard tabs in your community and replace them with your Site.com pages.

Use Salesforce Header and Footer on Site.com Pages

You can choose whether Site.com pages should have the Salesforce header and footer.
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Adding Site.com Pages as Tabs in Your Community

Create Site.com pages and include them in your community using web tabs.

New Communities Widgets

Widgets can be used to easily add elements to your Site.com pages.

Use Site.com Pages Instead of Standard Tabs
You can override the standard tabs in your community and replace them with your Site.com pages.

When creating your community, you can select tabs to display or you can choose to use Site.com pages instead. If you choose
to use Site.com, you must create pages in your community’s associated Site.com site. When external users log in to this
community or internal users access the community using the community drop-down menu, they will be redirected to the
Site.com home page in full-screen mode, meaning that your community members won’t see the standard Salesforce header,
footer, or tabs.

To use Site.com pages instead of tabs:

1. From Setup, click Customize > Communities > Manage Communities.
2. Click Edit next to the community name.
3. Click Tabs & Pages.
4. Select Use Site.com to create custom community pages.

All tabs will disappear from your community. You must now go to Site.com and create the pages for your community.

Use Salesforce Header and Footer on Site.com Pages
You can choose whether Site.com pages should have the Salesforce header and footer.

If you want to take advantage of the standard Salesforce layout and tabs functionality in your community, you can enable it
in the properties for your Site.com pages. When enabled, you can also select a tab name for your page so that you can expose
it in a tab within your community.

When you enable this feature on your page, you will see the standard Salesforce header, footer, and tabs when you publish
your Site.com page.

To use the Salesforce header and footer on your page, in the page Properties pane, select Show Salesforce Header.

Adding Site.com Pages as Tabs in Your Community
Create Site.com pages and include them in your community using web tabs.

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:
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You can now easily expose Site.com pages in your community. Simply associate the page with a web tab and add the tab to
your community.

1. In the Properties pane for your page, select Show Salesforce Header.

Selecting this option ensures that you see tabs in your community.

2. Enter the tab name as it should appear on the tab in your community.

The web tab you create must have the same name.

3. Determine the correct URL for the page.

The URL must be in the following format https://mydomain.force.com/mycommunity/s/<pagename>, where
pagename matches the name of your page.

4. From Setup, click Create > Tabs.
5. In Web Tabs, click New and enter the name of the tab as it appears in the Tab Name field in your page properties.
6. On the Step 3 screen, paste the URL you created in the Button or Link URL text box.
7. Return to the Create Community wizard and add the new tab to your community.

New Communities Widgets
Widgets can be used to easily add elements to your Site.com pages.

Widgets are page elements that can be reused throughout your community Site.com sites. In Winter ‘14, we’re introducing
two out-of-box widgets for community Site.com sites. Use these widgets to add the Chatter News Feed or Group Feed to
your Site.com pages. For example, if you add the News Feed widget to your page, the Chatter feed displays when the page is
rendered.

Adding Chatter News or Group Feeds to Community Site.com Pages

Use the Chatter News Feed to display a Chatter feed on your site pages, or display the feeds of a particular group using the
Chatter Group Feed.

Adding Chatter News or Group Feeds to Community Site.com Pages
Use the Chatter News Feed to display a Chatter feed on your site pages, or display the feeds of a particular group using the
Chatter Group Feed.

Available in: Performance, Unlimited, Developer, and Enterprise Editions

User Permissions Needed

“Create and Manage Communities”

OR

Site.com Publisher User field enabled on the user detail
page

AND

Site administrator or designer role assigned at the site level

To build, edit, and manage a community’s custom pages:

1. Drag the News Feed or Group Feed from the Widgets section of the Page Elements pane onto the page.
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When you add a widget to a page, it creates a copy or instance of the widget. You can’t edit the content of a widget, but
you can edit the properties.

2. If you’re adding a group feed, enter the Group ID in the Properties pane.

The Group ID determines which group feed is displayed on your page. You can include more than one group feed on a
page if you want to show the feeds for multiple groups.

3. Preview the page to test the feed, or use Live Mode to see how the feed renders in different mobile devices.

Consider the following limitations when using a news or group feed in your community Site.com sites:

• Chatter news and group feeds only appear if a user is logged in to the community. They don’t appear to guest users or in
anonymous preview mode.

• Chatter news and group feeds may not render appropriately on pages less than 700px wide. We recommend a minimum
page width of 700px to view full content. We also recommend using a white background.

• Chatter news and group feeds only inherit some page branding elements.
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Sales
Salesforce is the world’s #1 sales and CRM application. Our latest features help your sales reps close bigger deals with even
more efficiency.

Introducing the Salesforce Console for Sales

Who has time for clicking around when you're trying to close a deal? The Salesforce Console for Sales gives you easy access
to sales intelligence and helps you quickly contact leads, assess companies, and identify key contacts—all in a dashboard-like
interface that means more access to contextual data with fewer clicks and less scrolling.

Opportunities and Collaborative Forecasting

Accurately predict outcomes across sales teams and product lines.

Price Books

Price books help you organize product data for records like opportunities, quotes, and contracts.

Salesforce for Outlook

We’ve taken a great thing and made it even better. By now, we hope you know about the Salesforce Side Panel—a
Salesforce for Outlook feature that helps users view and work with Salesforce records directly in Microsoft® Outlook® 2007,
2010, and 2013. We’ve made important improvements to the side panel that will further increase your users’ productivity.

Social Accounts and Contacts

Social Accounts and Contacts provides easy access to social network profiles and other social information for your accounts,
contacts, and leads, directly in Salesforce.

Additional Sales Cloud Enhancements

We’ve made additional enhancements to email templates and accounts.

Partner Users

Partner users can access Salesforce through partner portals or communities you create.

Improved Security For Salesforce to Salesforce

Introducing the Salesforce Console for Sales
Who has time for clicking around when you're trying to close a deal? The Salesforce Console for Sales gives you easy access
to sales intelligence and helps you quickly contact leads, assess companies, and identify key contacts—all in a dashboard-like
interface that means more access to contextual data with fewer clicks and less scrolling.

Available in: Performance and Developer editions

Available in: Enterprise and Unlimited editions for an additional cost

The Salesforce Console improves on the Agent Console in the Console tab. Previously, the Salesforce Console was available
only to Service Cloud users. Now optimized for inside sales, the fully developed Salesforce Console for Sales helps streamline
sales and boost productivity by putting the records and features you need most in one place.

• Easily spot important fields on records.

• See records and their related items as tabs on one screen.

• Find helpful information through quick access to sales intelligence.
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• Quickly jot notes or log interactions for each record.

• Manage calls using a SoftPhone without leaving critical data behind.

The Salesforce Console helps you meet your business’s unique needs with powerful customization options.

• Create custom console components to display critical information or top actions across pages or tabs.

• Develop advanced programmatic features using the Salesforce Console Integration Toolkit API.

Tip:  Live Agent can’t be enabled in a Salesforce Console for Sales unless Service Cloud is enabled for your organization.
To use Live Agent in a console, use the Salesforce Console for Service.

1. Select an object to view in the Salesforce console navigation list. For example, select Leads to view leads. The administrator
can choose which objects are available.

2. Records are displayed in a list, which you can pin at the left or top of the screen. Select one or more records to display in
primary tabs.

3. Selected records appear in primary tabs. You can work with multiple tabs simultaneously.
4. The highlight panel can be configured separately for each object to show key information related to the record in the

primary tab.
5. Open more than one subtabs to quickly switch between multiple related records.
6. View and interact with subtab content in the detail area.

Enabling the Salesforce Console for Sales for Users

Before you can create a console app, Salesforce Console for Sales must be enabled for your org, and the corresponding
permission set license and user permission assigned.

Assigning the Sales Console User Permission Set License

The Salesforce Console for Sales is licensed per-user.
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Enabling the Sales Console User Permission

After users are licensed for the Salesforce Console for Sales, add the Sales Console permission to a permission set.

Creating a Salesforce Console for Sales App

Create a Salesforce Console for Sales as a custom app that users select from the Force.com app menu.

Enabling the Salesforce Console for Sales for Users
Before you can create a console app, Salesforce Console for Sales must be enabled for your org, and the corresponding permission
set license and user permission assigned.

Available in: Performance and Developer editions

Available in: Enterprise and Unlimited editions for an additional cost

User Permissions Needed

“Manage Users”To assign permission set licenses:

“Customize Application”

AND

“Sales Console”

To create a Salesforce Console app:

1. Contact salesforce.com to have the Salesforce Console for Sales enabled for your organization.
2. Assign the Sales Console User permission set license to a user.
3. Enable the “Sales Console” permission on the permission set.
4. Assign the user to the permission set.

Only users with a Sales Console User permission set license can be assigned to permission sets that include the “Sales
Console” permission.

5. Create a Salesforce Console app and make it available in the user’s profile.

Assigning the Sales Console User Permission Set License
The Salesforce Console for Sales is licensed per-user.

User Permissions Needed

“Manage Users”To assign permission set licenses:

The Sales Console User permission set license is available in orgs that have the Salesforce Console for Sales. For information
about permission set licenses, see Permission Set Licenses on page 218.

1. From Setup, click Manage Users > Users.
2. Click the name of the user to whom you want to assign the permission set license.
3. In the Permission Set License Assignments related list, click Edit Assignments.
4. Select the Sales Console User permission set license, and click Save.
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Enabling the Sales Console User Permission
After users are licensed for the Salesforce Console for Sales, add the Sales Console permission to a permission set.

Available in: Performance and Developer editions

Available in: Enterprise and Unlimited editions for an additional cost

User Permissions Needed

“Manage Users"To create permission sets:

1. On Setup, go to Manage Users > Permission Sets.
2. Create a permission set.

When creating the permission set, select the user license type None. (If another license types is selected, you won’t be able
to add the Sales Console user permission for this permission set.)

3. On the Permission Set page, click App Permissions.
4. Select the Sales Console permission and click Save.

Creating a Salesforce Console for Sales App
Create a Salesforce Console for Sales as a custom app that users select from the Force.com app menu.

Available in: Performance and Developer editions

Available in: Enterprise and Unlimited editions for an additional cost

User Permissions Needed

“Customize Application”

AND

“Sales Console”

To create a Salesforce Console for Sales app:

The number of Salesforce Console apps you can create is based on your custom app limits.

1. From Setup, click Create > Apps.
2. Click New.
3. Select Console and click Next.
4. Specify a label for the app. The label can have a maximum of 40 characters, including spaces. This label is the app’s name

in the Force.com app menu.
5. Optionally, enter a description of the app.
6. Click Next.
7. Optionally, specify a custom logo for the app. Click Insert an image to choose an image file from the document library.

Consider these requirements when choosing a custom app logo from the document library:

• The image must be in GIF or JPEG format and less than 20 KB in size.
• If the image is larger than 300 pixels wide by 55 pixels high, then it will be scaled to fit.
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• For the best on-screen display, we recommend you use an image with a transparent background.
• The Externally Available checkbox must be selected on the document’s properties so that users can view the

image.

8. Click Next.
9. Select the items to include in the navigation tab. For example, if you want users to choose accounts from the navigation

tab, move Accounts from Available Items to Selected Items.

• Click the left and right arrow buttons to add or remove items.
• Click the up and down arrow buttons to define the order in which items display on the navigation tab when it's clicked.

Note:

• You can't add the following to the navigation tab: forecasts, ideas, answers, connections, portals, console,
activities (tasks and events), or buttons for customizing your organization.

• Tab visibility settings, and the Overwrite users' personal tab customizations setting, don't
apply to the navigation tab. For example, users can access Accounts from the navigation tab even if Accounts
are Tab Hidden on user profiles.

10. Click Next.
11. Choose how items display in the console when they're not selected from a primary tab or subtabs. For example, when users

select cases from list views, search results, or screen pops, you can choose whether cases display as primary tabs or as subtabs
on parent records.

Next to an object, click:

• As a primary tab to display the object's records as primary tabs.
• As a subtab of to display the object's records as subtabs. From the drop-down list, choose the parent record where

the subtabs will appear. For example, if you want contacts to appear as subtabs on accounts, select Account Name
(Account) in the Contact row. If parent records don't apply, subtabs appear as primary tabs. For example, if you make
campaigns a subtab of leads but a lead doesn't belong to a campaign, that campaign appears as a primary tab.

12. Click Next.
13. Optionally, if Service Cloud has been enabled for your organization, you may enable Live Agent and click Next.

Organizations without Service Cloud cannot add Live Agent to a Salesforce Console app.
14. Assign the Salesforce Console to user profiles:

a. Check the Visible box to choose the user profiles for which the app will be available.
b. Check the Default box to set the app as that profile’s default app. This means that new users who have the profile

will see this app when they log in for the first time. Profiles with limits are excluded from this list.

15. Click Save.

Tip:  You must refresh your browser to see any setup changes to a Salesforce Console.

Opportunities and Collaborative Forecasting
Accurately predict outcomes across sales teams and product lines.

See Opportunity Splits in Sales Forecasts
Integrate Product Families in Forecasts
Change to Data Sources in Forecast Settings
Opportunity Splits and Opportunity Product Objects Available in Custom Report Types
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Forecasts 1.0 (Classic) Will Be Retired in Summer ’14

See Opportunity Splits in Sales Forecasts
In Summer ’13, Salesforce released Opportunity Splits, letting you share sales credit across multiple opportunity team members.
In Winter ’14, Collaborative Forecasts reflect these splits, giving sales management a more complete view of the business and
insight into their team's contribution.

Until now, sales managers saw forecasts only for opportunities their reports directly owned. But when sales reps are part of a
larger opportunity team, they can split a percentage of an overall deal. With Collaborative Forecasts, managers see those
percentages in forecasts too, getting a clearer prediction of overall performance.

To enable opportunity splits in forecasts:

1. Enable Opportunity Splits and a split type that totals 100%. (Split types that total any percentage don’t appear in forecasts.
For more information, search for “Enabling Opportunity Splits” in the Salesforce online Help.)

2. From Setup, click Customize > Forecasts > Settings.
3. For Data Source, choose Opportunity Splits. With this data source, you can forecast on revenue, but not quantity.

Now, when your users access Forecasts, the forecasted amount and split percentage automatically appear in the opportunity
list in the lower half of the page.

Note:  This feature is available only in Collaborative Forecasts.

Integrate Product Families in Forecasts
If your organization groups its products and services into families (like “Hardware” and “Software”), product family forecasts
help you better predict revenue and sales reps’ quota attainment. With Collaborative Forecasts in Winter ’14, sales managers
can view the forecast and related opportunities separately for each product family, and they can see individual sales reps’
forecasts for each family too.

To enable product family forecasts:

1. From Setup, click Customize > Forecasts > Settings.
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2. For Data Source, choose Product Family. With this data source, you can forecast on revenue, quantity, or both.

When a sales manager wants to see which product family is bringing in the most revenue, she can expand the forecast for her
direct reports to see closed opportunities, committed deals, best case scenarios, and pipeline for each family. Individual
opportunity amounts appear in the lower half of the Forecasts page.

With product family forecasts, keep in mind the following.

• Your organization must use Opportunity Products and Product Families.
• The Product Family field should be populated on each product record. If this field is empty, the product appears in a

forecast row titled Products Not Categorized.
• Adjustments can be made to individual product family forecasts for a sales rep, but not directly to their total forecast for

all product families.

Change to Data Sources in Forecast Settings
In Summer ’13, the Forecast Data Source controlled whether forecasts were based on revenue, quantity, or both. In Winter
’14, the Data Source controls whether your forecasts are based on opportunities, opportunity splits, or product families.

To set the Data Source:

• In Setup, click Customize > Forecasts > Settings, and choose an option from the Data Source drop-down menu.

To enable revenue or quantity forecasts, use the Forecast On setting, located immediately beneath the Data Source setting on
the Forecast Settings page.

Opportunity Splits and Opportunity Product Objects Available
in Custom Report Types

In Summer ’13, when creating a custom report type based on the Forecasting Items object, you could only choose Opportunities
as the related object. In Winter ’14, you can also choose Opportunity Product or Opportunity Splits as the related object.

Forecasts 1.0 (Classic) Will Be Retired in Summer ’14
With the Summer ’14 release, Forecasts 1.0 (Classic) will be officially retired. For more information, please contact salesforce.com
Customer Support.

We recommend using Collaborative Forecasts to manage your forecasts. To get started, see the Forecasts Administrator's
Workbook, which provides a full step-by-step description of how to set up Collaborative Forecasts for your organization.

Note:  Customizable Forecasts is not affected by this announcement. Only Forecasting 1.0 (Classic) is being retired.

Price Books
Price books help you organize product data for records like opportunities, quotes, and contracts.

Creating Lookup Relationships

Price books are now available in lookup relationships on standard and custom objects.
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Customizing Search Layouts

You can now customize search layouts for price books to specify which fields your users see in search results, lookup dialogs,
lookup phone dialogs, and the Price Books tab.

Creating Lookup Relationships
Price books are now available in lookup relationships on standard and custom objects.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or change custom fields:

Previously, when creating a custom lookup relationship field on an object, Price Book was not an option.

Now, you can link two objects together using a lookup relationship. For example, your organization may want to associate
each account with a specific price book. With a custom field on your account page layout that provides a lookup relationship
to a price book, you can create a trigger to automatically populate the price book on opportunities and opportunity products
to match the associated account. With this automation, your sales representatives don’t have to remember which price book
matches which account when they create an opportunity.

To create a lookup relationship:

1. Navigate to the fields area of the object you want to link to price books.

• For standard objects, from Setup, click Customize > Object > Fields.
• For custom objects, from Setup, click Create > Objects and select the appropriate custom object.

2. In Custom Fields & Relationships, click New.
3. Select Lookup Relationship, and click Next.
4. Select Price Book, and then click Next.
5. Enter a field label, and press Tab to populate the field name.
6. If you want this field to be required, select the Required checkbox.
7. Indicate what Salesforce should do if the price book that an account is linked to is deleted, and click Next.
8. In Enterprise, Performance, Unlimited, and Developer Editions, specify the field’s access settings for each profile, and

click Next.
9. Select the page layouts that you want to display the field, and click Next.
10. Optionally, add a custom related list to one or more price book layouts.

a. Enter a name for the related list.
b. Select each layout you want the related list to display on.
c. Click Save.

Customizing Search Layouts
You can now customize search layouts for price books to specify which fields your users see in search results, lookup dialogs,
lookup phone dialogs, and the Price Books tab.

For example, if you want your users to know whether a price book is active or inactive when selecting one through a lookup
dialog, you can add Active to the selected fields.
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1. From Setup, click Customize > Price Books > Search Layouts.
2. Click Edit next to the layout you want to customize.

You can specify a different set of items to display for each layout.

3. Select fields in Available Fields that you want to display in the layout and click Add.

To select multiple fields, press CTRL and click the individual fields.

4. If there are fields in Selected Fields that you don’t want to display, select them and click Remove.
5. To reorder the fields, select them and click Up or Down.

Salesforce for Outlook
We’ve taken a great thing and made it even better. By now, we hope you know about the Salesforce Side Panel—a
Salesforce for Outlook feature that helps users view and work with Salesforce records directly in Microsoft® Outlook® 2007,
2010, and 2013. We’ve made important improvements to the side panel that will further increase your users’ productivity.

And if you still have folks in your organization using Connect for Outlook, now’s a great time to upgrade them to
Salesforce for Outlook, because in addition to including Connect for Outlook features your users know, Salesforce for Outlook
includes:

• Support for Microsoft Exchange Online—the Microsoft-hosted service that integrates with Office 365™

• The Salesforce Side Panel

• Options to sync only some or all contacts, events, and tasks

• Automatically scheduled sync cycles

Take a look at our latest enhancements to Salesforce for Outlook and the side panel.

Support for Microsoft® Exchange Online

You’ve been waiting for us to support Exchange Online, and now we do!

Send and Add Emails

We know that users love using the Send and Add feature that’s available outside of the side panel. And we know that not
having Send and Add available in the side panel was a serious deterrent for users adopting it. But Send and Add in the side
panel is here now!

Add Events to Salesforce Records with Event Association

When users select single, non-recurring events in their Outlook calendars, the side panel displays related contacts and
leads—the same way it does for emails. Regardless of whether the events are set to sync with Salesforce, if users add Outlook
events to Salesforce records, the side panel triggers a sync to Salesforce calendar for the one event.

View and Work with More Salesforce Records

The side panel now displays more contacts and leads for the emails—and now events—that users select in Outlook. Depending
on the size of users’ Outlook windows and monitors, the side panel displays up to 10 related contacts and leads that fit in
the available vertical space. This makes it quicker and easier to add emails and events to more Salesforce records at the same
time.

Hide and Disable the Salesforce Side Panel

If any of your users want to temporarily hide and disable the Salesforce Side Panel, they’ll do so directly in Outlook.
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Support for Microsoft® Exchange Online
You’ve been waiting for us to support Exchange Online, and now we do!

We support using the desktop versions of Microsoft Outlook 2007, 2010, and 2013 with Exchange Online—the
Microsoft-hosted service that integrates with Office 365™. Keep in mind that Salesforce for Outlook doesn’t support Outlook
installed using Click-to-Run (a streaming installer for Microsoft Office).

Send and Add Emails
We know that users love using the Send and Add feature that’s available outside of the side panel. And we know that not
having Send and Add available in the side panel was a serious deterrent for users adopting it. But Send and Add in the side
panel is here now!

Here’s how users can send and add emails at the same time.
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1. Create an Outlook email, and then enter recipients in the To field (and if necessary, the Cc field). The side panel displays
related Salesforce records.

2. Add the email to Salesforce records when you click  next to the records of your choice.
3. Keep track of the records to which you’re adding the new email. After you send the email, we’ll add it to the Salesforce

records.

Add Events to Salesforce Records with Event Association
When users select single, non-recurring events in their Outlook calendars, the side panel displays related contacts and leads—the
same way it does for emails. Regardless of whether the events are set to sync with Salesforce, if users add Outlook events to
Salesforce records, the side panel triggers a sync to Salesforce calendar for the one event.
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Here’s how users can add events to Salesforce records.

1. In the Outlook calendar, select an event. The side panel displays related Salesforce records.

2. Add the event to Salesforce records when you click  next to the records of your choice.
3. Keep track of the records you’ve added the event to.

View and Work with More Salesforce Records
The side panel now displays more contacts and leads for the emails—and now events—that users select in Outlook. Depending
on the size of users’ Outlook windows and monitors, the side panel displays up to 10 related contacts and leads that fit in the
available vertical space. This makes it quicker and easier to add emails and events to more Salesforce records at the same time.

Here’s how it works.
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1. Select an Outlook email or event. In this example, the email includes seven recipients, five of whom are already in set up
as contacts Salesforce.

2. The side panel displays those five contacts.

Hide and Disable the Salesforce Side Panel
If any of your users want to temporarily hide and disable the Salesforce Side Panel, they’ll do so directly in Outlook.

Here’s how they’ll do it in Outlook 2010 and 2013.

1. Select the View tab.
2. Click Show / Hide.

For Outlook 2007, users will click View > Salesforce Side Panel > Show / Hide.
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Social Accounts and Contacts
Social Accounts and Contacts provides easy access to social network profiles and other social information for your accounts,
contacts, and leads, directly in Salesforce.

Contact, Account, and Lead Profile Image Visibility

Profile images from Facebook or Twitter for contacts, accounts, or leads may be visible even if you are not currently logged
in to those services.

Social Network Fields Available on List Views

Add social network fields to account and contact list views to give users an overall look at which social networks are connected
to their records.

Contact, Account, and Lead Profile Image Visibility
Profile images from Facebook or Twitter for contacts, accounts, or leads may be visible even if you are not currently logged
in to those services.

If you have previously logged in to Facebook or Twitter and associated a Facebook or Twitter account with a Salesforce.com
contact, account, or lead, the profile image will remain viewable even if you are no longer logged in. You can also view a
Facebook or Twitter profile image if it was associated with a contact, account, or lead by another user. This change does not
affect profile images from other social networks.

Social Network Fields Available on List Views
Add social network fields to account and contact list views to give users an overall look at which social networks are connected
to their records.

If your organization uses Social Accounts and Contacts, you and your users can add social networks as fields on account and
contact list views. The field for a particular social network is available only if you have that social network enabled. The social
network fields that are available depend on the object you’re creating a list view for.

• Accounts: Twitter and Facebook

• Contacts: LinkedIn®, Twitter, and Facebook

• Leads: none

For more information about list views, see “Creating Custom List Views” in the Salesforce Help.
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Additional Sales Cloud Enhancements
We’ve made additional enhancements to email templates and accounts.

Hiding the Account Hierarchy Link
Email Template Access

Users with “Manage Public Template” permission might experience some changes in read/write access to email templates.

Hiding the Account Hierarchy Link

Business accounts available in: All Editions except Database.com

User Permissions Needed

“Customize Application”To change account settings:

Want to simplify your view of accounts? Previously, a link to the account hierarchy appeared on the detail page for all business
accounts. Now you can hide the View Hierarchy link.

Enabling this setting doesn’t disable the account hierarchy, just removes the default link from account detail pages. If you hide
the default link, you can choose to allow selected users to view the hierarchy by adding a custom link or button. For example,
if you want only key managers in your organization to view the account hierarchy, turn off the default account hierarchy link,
then add a custom button only to those managers’ account detail pages.

When this setting is enabled, all users can see the View Hierarchy link on business account detail pages. When it’s disabled,
the link is removed.

1. From Setup, click Customize > Accounts > Settings.
2. Click Edit.
3. Unselect Show View Hierarchy Link, then click Save.

Email Template Access
Users with “Manage Public Template” permission might experience some changes in read/write access to email templates.

Available in: All Editions except Database.com

HTML and Visualforce email templates not available in: Personal Edition

User Permissions Needed

“Edit HTML Templates”To create or change HTML email templates:

“Customize Application”To create or change Visualforce email templates:

“Manage Public Templates”To create or change public email template folders:
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Users with the “Manage Public Template” permission can no longer access the hidden email template folders of other users
and can’t save templates in the hidden folders of other users. In addition, these users can no longer access all shared folders.
Now, the owner of a shared folder must specifically add other users to the folder’s sharing group.

Administrator permissions aren’t affected but administrators may receive access requests from users for files they could previously
read and edit. Administrators can modify access by changing a folder’s global settings to Public (so all users can access it) or
Shared (and adding the requesting user to the shared group).

Partner Users
Partner users can access Salesforce through partner portals or communities you create.

Removed Change My Password Button For Partner Users with Single Sign-On
Change in Behavior For The Username Field On Partner Users

Removed Change My Password Button For Partner Users with
Single Sign-On

If a partner user with Single Sign-On views their profile from the Welcome Component in their portal, the Change My
Password button is no longer visible. Partner users with single sign-on must contact their portal administrator for help resetting
their password.

Change in Behavior For The Username Field On Partner Users
Delegated external user administrators can now edit the Username field for partner users, if the partner user doesn’t have the
Single Sign-On permission. Their ability to edit this field is not affected by whether they are assigned the Single Sign-On
permission or not. Prior to the ‘Winter 14 release, delegated administrators with the Single Sign-On permission weren’t able
to edit this field for partner users.

Improved Security For Salesforce to Salesforce
Starting in ‘Winter 14, users must have the “Manage Connections” permission to view Salesforce to Salesforce connections
and templates. Users without this permission will get an error when they try to access the Connections Home Page. We added
this requirement to ensure that only people with proper permissions can see the Salesforce to Salesforce connections in your
organization. As in previous releases, users with the “Manage Connections” permission can manage connections and templates.
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Data.com
Data.com is the solution for delivering leading business data inside Salesforce. The Data.com product suite includes Data.com
Prospector  and Data.com Clean, as well as related Data.com features: Social Key, Data.com Reports, and Data.com Data
Assessments.

Data.com Prospector

Use Data.com Prospector to search for Data.com accounts and contacts directly on the Data.com tab, and if you have
a Data.com license, you can add records to Salesforce.

Data.com Clean

Data.com Clean is an important part of the Salesforce Data.com product suite. With Data.com Clean, users can clean
individual records manually or clean groups of records from a list view. Your organization can also clean batches of records
using automated Clean jobs. There are two versions of Data.com Clean: Corporate Clean and Premium Clean. They differ
based on the D&B fields that are available when you clean account or lead records, either manually or via automated jobs.

Data.com Social Key—Generally Available

Data.com Social Key, which is now generally available,  works with Social Accounts and Contacts and Data.com Clean to
make it easier to follow your contacts and leads on social networks. 

Data.com Prospector
Use Data.com Prospector to search for Data.com accounts and contacts directly on the Data.com tab, and if you have a Data.com
license, you can add records to Salesforce.

Get to Salesforce Records Directly from Data.com Search Results
Expanded Definition of What’s Considered a Duplicate Record
Increased Export Limit
Simplified Definition of “Inactive” for Account Records
Data.com Licenses & Limits Page Rebranded with Data.com Prospector Name
Data.com Prospector Additional Enhancements

Get to Salesforce Records Directly from Data.com Search Results
In previous releases, a green dot ( ) next to a record in Data.com search results indicated that the record was already in
Salesforce. With Winter ’14, the green dot also takes you directly to the Salesforce record. Users can simply hover over the
green dot and click the link that appears. If Salesforce has duplicate entries for a particular record, the link takes users to a list
of records.
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Expanded Definition of What’s Considered a Duplicate Record
If users add a contact from Data.com that’s already in Salesforce as a lead, it will now be considered a duplicate record. The
same is true if users add a lead that’s already in Salesforce as a contact. By default, users cannot add duplicate records from
Data.com, but you can allow duplicates for your organization.

For existing organizations, the preferences to allow duplicates for contacts that are already in Salesforce as leads and leads that
are already in Salesforce as contacts are automatically selected.

Allowing Duplicate Data.com Records in Salesforce

Allowing Duplicate Data.com Records in Salesforce

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Organizations that use a sharing model may want to allow Data.com users to add duplicate account, contact, or lead records
to Salesforce. Keep these things in mind when setting your duplicate preferences.

• Records are considered duplicates when they have the same Data.com ID number in the Data.com Key field. This
includes records that were added from Data.com as both contacts and leads.

• You can allow duplicates by object for the entire organization—not for individual users. If, however, you want to prevent
a user or profile from being able to add duplicates, you can create a trigger.

• Records that are already in Salesforce are marked with an icon ( ) in the search results and can be re-added by any Data.com
user if duplicates are allowed by the organization.

• Records that have been added to Salesforce from Data.com are marked with an icon ( ) in the search results. Adding a
record counts against the record addition limit only the first time it’s added to Salesforce. When a record is added as a
duplicate, it will not be counted against the record addition limit.

To set up your duplicate preferences, follow these steps.

1. From Setup, click Data.com Administration > Preferences.
2. In the Duplicate Preferences section of the page, select the objects for which you want to allow duplicates.
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Increased Export Limit
We increased the Data.com export limit from 50,000 records to 100,000 records. This aligns with the limit for adding records.
Records are exported in batches of up to 50,000. If two batches are needed, the records are sent in a .zip file. Users can still
export only as many records as their record limit allows.

Simplified Definition of “Inactive” for Account Records
In previous releases, Data.com considered an account inactive if its record had out-of-date or inaccurate information, or if the
company was identified by Dun & Bradsteet (D&B) as being non-marketable. In Winter ’14, an account is considered inactive
if D&B has marked it as out of business. This simplified definition of inactive makes reviewing records easier.

Data.com Licenses & Limits Page Rebranded with Data.com
Prospector Name

We updated the prospecting section of the Data.com Licenses & Limits page with the new Data.com Prospector name.

As in past releases, you can access the page by clicking Data.com Administration > Licenses & Limits. From there, you can
see which version of Data.com Prospector you have (Corporate or Premium), the number of Prospector licenses your organization
has, and your organization’s record addition limits.

Data.com Prospector Additional Enhancements
Using Data.com Prospector with State and Country Picklists

Using Data.com Prospector with State and Country Picklists
State and country picklists (now generally available) allow users to select states and countries from predefined, standardized
lists, making data entry easier and helping ensure cleaner data. If you use Data.com Prospector with state and country picklists,
be aware of the following.

• Data.com records may contain states and countries that are not included in the standard state and country picklists. You’ll
need to add these states and countries to the picklist before Data.com users can add or clean these records. The states and
countries that you may need to add to the picklist are:

◊ American Samoa (AS)

◊ Guam (GU)

◊ Hong Kong (HK)

◊ Marshall Islands (MH)

◊ Netherlands Antilles (AN)

◊ Northern Mariana Islands (MP)

◊ Serbia and Montenegro (CS)

◊ United States Minor Outlying Islands (UM)

• When you export files from the Data.com tab, additional fields are included in the export file. BillingState and
BillingCountryCode are on the export file for account records. MailingState and MailingCountryCode are on
the export file for contact records.
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For more information about state and country picklists, see “State and Country Picklists Overview” in the Salesforce Help.

Data.com Clean
Data.com Clean is an important part of the Salesforce Data.com product suite. With Data.com Clean, users can clean individual
records manually or clean groups of records from a list view. Your organization can also clean batches of records using automated
Clean jobs. There are two versions of Data.com Clean: Corporate Clean and Premium Clean. They differ based on the D&B
fields that are available when you clean account or lead records, either manually or via automated jobs.

Clean Info Objects
Clean Info Custom Report Types
Record Cleaning from List Views
Reporting an Account, Contact, or Lead as Inactive or Active to Data.com

When you use Data.com Clean to clean a Salesforce record, if you know the related account, contact, or lead is either out of
business or not active at a company, you can report that information to Data.com. If an account, contact, or lead has been
reported as Inactive to Data.com, we’ll let you know. If you believe the account, contact, or lead is Active, you can tell
us that, too.

Flagging an Account, Contact, or Lead Field Value as Wrong or Right to Data.com

When you use Data.com Clean to clean a Salesforce record, if you know that one of its fields has an incorrect, or “wrong”
value, you can report that information to Data.com. If a field value has been reported as wrong, we’ll let you know. If you
believe the field value is correct, or “right,” you can tell us that, too.

Data.com Clean Additional Enhancements

Clean Info Objects
We’ve created a set of background objects that store the metadata used to determine a record’s clean status. There’s a clean
info object for accounts, one for contacts, and one for leads.

Understanding the Account Clean Info Object

Account Clean Info is a background object that stores the metadata used to determine an account record’s clean status.
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Understanding the Contact Clean Info Object

Contact Clean Info is a background object that stores the metadata used to determine a contact record’s clean status.

Understanding the Lead Clean Info Object

Contact Clean Info is a background object that stores the metadata used to determine a lead record’s clean status.

Understanding the Account Clean Info Object
Account Clean Info is a background object that stores the metadata used to determine an account record’s clean status.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Account Clean Info provides a snapshot of the data in your Salesforce account record and its matched Data.com record at the
time the Salesforce record was cleaned.

Account Clean Info includes a number of bit vector fields, whose component fields each correspond to individual object fields
and provide related data or status information about those fields. For example, the bit vector field IsDifferent has an
IsDifferentState field. If the IsDifferentState field’s value is False, that means the State field value is the same
on the Salesforce account record and its matched Data.com record.

These are the bit vector fields.

• CleanedBy indicates who (a user) or what (a Clean job) cleaned the account record.

• IsDifferent indicates whether or not a field on the account record has a value that differs from the corresponding field
on the matched Data.com record.

• IsFlaggedWrong indicates whether or not a field on the account record has a value that is flagged as wrong to Data.com.

• IsReviewed indicates whether or not a field on the account record is in a Reviewed state, which means that the value
was reviewed but not accepted.

Administrators can modify a limited set of Account Clean Info fields from the Account Clean Info page.

Developers can create triggers that read the Account Clean Info fields to help automate the cleaning or related processing of
account records. For example, you might create a trigger that reads the Clean Status field on the Account object. If an
account record’s Clean Status field value is Different but the record has no Billing Street value, the trigger could
update the record’s status to Not Compared.

Understanding the Contact Clean Info Object
Contact Clean Info is a background object that stores the metadata used to determine a contact record’s clean status.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Contact Clean Info provides a snapshot of the data in your Salesforce contact record and its matched Data.com record at the
time the Salesforce record was cleaned.
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Contact Clean Info includes a number of bit vector fields, whose component fields each correspond to individual object fields
and provide related data or status information about those fields. For example, the bit vector field IsDifferent has an
IsDifferentEmail field. If the IsDifferentEmail field’s value is False, that means the Email field value is the same
on the Salesforce contact record and its matched Data.com record.

These are the bit vector fields.

• CleanedBy indicates who (a user) or what (a Clean job) cleaned the contact record.

• IsDifferent indicates whether or not a field on the contact record has a value that differs from the corresponding field
on the matched Data.com record.

• IsFlaggedWrong indicates whether or not a field on the contact record has a value that is flagged as wrong to Data.com.

• IsReviewed indicates whether or not a field on the contact record is in a Reviewed state, which means that the value
was reviewed but not accepted.

Developers can create triggers that read the Contact Clean Info fields to help automate the cleaning or related processing of
contact records.

Understanding the Lead Clean Info Object
Contact Clean Info is a background object that stores the metadata used to determine a lead record’s clean status.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Lead Clean Info provides a snapshot of the data in your Salesforce lead record and its matched Data.com record at the time
the Salesforce record was cleaned.

Lead Clean Info includes a number of bit vector fields, whose component fields each correspond to individual object fields
and provide related data or status information about those fields. For example, the bit vector field IsDifferent has an
IsDifferentTitle field. If the IsDifferentTitle field’s value is False, that means the Title field value is the same
on the Salesforce lead record and its matched Data.com record.

These are the bit vector fields.

• CleanedBy indicates who (a user) or what (a Clean job) cleaned the lead record.

• IsDifferent indicates whether or not a field on the lead record has a value that differs from the corresponding field on
the matched Data.com record.

• IsFlaggedWrong indicates whether or not a field on the lead record has a value that is flagged as wrong to Data.com.

• IsReviewed indicates whether or not a field on the lead record is in a Reviewed state, which means that the value was
reviewed but not accepted..

Developers can create triggers that read the Lead Clean Info fields to help automate the cleaning or related processing of lead
records.

Clean Info Custom Report Types
Clean Info custom report types and the reports you create from them can help you view clean information for multiple records
at a time. Use this information to identify patterns and trends in your data and to manage or modify how your records are
cleaned.
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Creating a Custom Report Type for Account, Contact, or Lead Clean Info

Create custom report types to report on clean information for accounts, contacts, and leads.

Creating a Custom Report Type for Account, Contact, or Lead Clean Info
Create custom report types to report on clean information for accounts, contacts, and leads.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Manage Custom Report Types”To create or update custom report types:

“Modify All Data”To delete custom report types:

Clean Info custom report types can help you easily see clean information for multiple records in one report. Use that information
to identify patterns and trends in your data and to manage or modify how your records are cleaned.

1. From Setup, click Create > Report Types.
2. Click New Custom Report Type.
3. For Primary Object, select Accounts, Contacts, or Leads—whatever object you want to report on—and define the

other required fields.
4. For Category, select either Accounts & Contacts or Leads, as appropriate.
5. Click Next.
6. Relate the companion Clean Info object (Account Clean Info, Contact Clean Info, or Lead Clean Info) to the primary

object you selected. Accept the default for A to B Relationship.
7. Select a deployment status.
8. Click Save.

Now you can create custom reports based on your new custom report types.

Report on Salesforce Records with a Specific Clean Status
Create a custom report to show Salesforce account, contact, or lead records that have a specific clean status (such as
Different).

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:
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Choose fields to display from the Account, Contact, or Lead objects. Using data from companion Clean Info objects, show
Salesforce and Data.com record values side by side. Report results can help you identify consistent reasons records might have
a specific clean status. Use what you learn to manage how records are cleaned in your organization.

For example, you can create a report to show all records whose clean status is Different side by side with their matched
Data.com records. If you identify patterns in your data that cause this status, you might create triggers or API customizations
to adjust your data and have more records with In Sync status..

Let’s create a Contacts by Clean Status report.

1. Before you can create the Contacts by Clean Status report, make sure your organization has a custom report type that links
the Contact object to the Contact Clean Info object and makes fields from both objects available to report on.

2. Create your report: click the Reports tab, then click New Report.
3. Select Contacts by Clean Status as the report type.
4. Click Create.
5. From the parent object, Contacts, select the fields you want to report on. For example, you might choose:

• Contact ID

• Clean Status

• Full Name

• Mailing Address

• Phone

• Email

6. From the related object, Contact Clean Info, select fields that correspond to the Contact object fields. For contact clean
info, you might choose:

• Contact Clean Info ID

• First Name

• Last Name

• Address

• Phone

• Email

• Last Match Date

7. Add a field filter to the report: For the field, select Clean Status. For the operator, select equals, and for the value,
select Different.

8. Define the remaining fields.
9. Save the report and run it.
10. Examine the report to see if you can identify patterns in your data that cause certain records to have a clean status of

Different.

Record Cleaning from List Views
Clean multiple account, contact, and lead records at a time directly from list views.

Configuring List Views for Data.com Clean

Before your Data.com Clean users can clean records from a list, you’ll need to add the Clean Status field to your
organization’s list views.
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Cleaning a List of Salesforce Records with Data.com Clean

With Data.com Clean, you can select account, contact, and lead records from a list, and clean them all at one time.

Configuring List Views for Data.com Clean
Before your Data.com Clean users can clean records from a list, you’ll need to add the Clean Status field to your organization’s
list views.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

1. Click the tab (Accounts, Contacts, or Leads) for the object whose records you want to clean from your list.

Note:  If your organization uses DUNSRight matching to clean account records, list view cleaning is not available
for account records.

2. Select a view from the drop-down and click Edit.
3. Scroll down the Available Fields list to find the Clean Status field, then add it to the list of Selected Fields.

The Clean button will automatically be added to the list view.
4. If you use Data.com Social Key, you can also add the fields for the social networks you’ve enabled (LinkedIn®, Twitter,

or Facebook) to your contact list views.

The social network fields aren’t available on the lead list views.

Cleaning a List of Salesforce Records with Data.com Clean
With Data.com Clean, you can select account, contact, and lead records from a list, and clean them all at one time.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

Data.com Clean offers a number of ways to clean records. Users can clean individual records manually or clean groups of
records from a list view. Your organization can also clean batches of records using automated Clean jobs.
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Cleaning from a list works for all the account, contact, and lead records you have access to in Salesforce—not just those you
previously added from Data.com. When you click the Accounts, Contacts, or Leads tab, you can select a view to see a list of
the records you’re allowed to view. The results you see are called a list view. From the list view, simply select the records you
want to clean and Data.com Clean does the rest.

Note:  If you’re cleaning records from a standard list view, make sure your system administrator has added the Clean
Status field to the view. If you’re cleaning records from a custom list view you’ve created, you’ll need to add the
Clean Status field yourself. If you use Data.com Social Key together with Social Accounts and Contacts, you or
your administrator can also add the fields for the applicable social networks (LinkedIn, Twitter, or Facebook) to your
contact list views.

1. Click the tab (Accounts, Contacts, or Leads) for the object whose records you want to clean from your list.
2. Select a view from the drop-down and click Edit.
3. From the list, select the records you want to clean, and click Clean.
4. Select one of these Clean options.

• Update Clean Status will update each record’s Clean Status field. If you use Social Key, social handles will be
added to the record, if available.

• Update Clean Status and Fill Blank Fields will update each record’s Clean Status field and fill blank
fields with Data.com data. If you use Social Key, social handles will be added to the record, if available.

5. Click Update.
We’ll provide a confirmation message telling you how may records were matched, updated, and whether any errors occurred.
If your organization uses Social Key with contacts and leads, we’ll also let you know if we were able to supply social handles.

6. Review the changes to your records.

If you selected the option to update only the Clean Status field and now find records with a clean status of Different,
you can manually clean each record from its detail page.

Reporting an Account, Contact, or Lead as Inactive or Active to
Data.com

When you use Data.com Clean to clean a Salesforce record, if you know the related account, contact, or lead is either out of
business or not active at a company, you can report that information to Data.com. If an account, contact, or lead has been
reported as Inactive to Data.com, we’ll let you know. If you believe the account, contact, or lead is Active, you can tell
us that, too.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

An account, contact, or lead may be designated as Active or Inactive by either Data.com or a Data.com Clean user. For
accounts, Inactive means out of business, and for contacts or leads, it means the associated person no longer works at the
company.
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If a record is Inactive, we’ll let you know the source of that status, and if the source is Data.com, we’ll tell you why. For
example, we’ll tell you if an account is out of business, a contact is no longer employed at the company, or a contact or lead’s
phone or email is invalid.

1. From the account, contact, or lead record, click Clean to open the comparison page.
2. If the account, contact, or lead is inactive, click Report as Inactive.
3. Click Save.

The record’s Clean Status field now shows that it’s Inactive.
4. If an account has been reported as inactive, but the company remains in business, or a contact or lead has been reported

as inactive, but the person still works at the company, you can clean its record again. On the comparison page, you’ll see
a message telling you the record’s current reported status—out of business for accounts or Inactive for contacts
and leads—and who reported it: Data.com or a user.

5. Click Report as Active.
The record’s Clean Status field reverts to the value it had before the record was reported as Inactive. For example,
if a contact’s Clean Status is Reviewed, and then the contact is reported as Inactive, its clean status will change
to Inactive. If the contact is later reported as Active, its clean status reverts to Reviewed.

Flagging an Account, Contact, or Lead Field Value as Wrong or
Right to Data.com

When you use Data.com Clean to clean a Salesforce record, if you know that one of its fields has an incorrect, or “wrong”
value, you can report that information to Data.com. If a field value has been reported as wrong, we’ll let you know. If you
believe the field value is correct, or “right,” you can tell us that, too.

Data.com Prospector license available in: Contact Manager (no Lead object), Group, Professional, Enterprise, Performance,
and Unlimited Editions

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Edit” on accountsTo clean account records:

“Edit” on contactsTo clean contact records:

“Edit” on leadsTo clean lead records:

When you clean an account, contact, or lead record, if you know that a particular field value is incorrect, you can flag that
value as wrong to Data.com. If the value has been flagged as wrong, but you know the value is correct, you can flag it as
right. On the comparison page, most fields offer the flagging option.

Note:  If your account, contact, or lead record’s Clean Status value is In Sync, and you flag a field value as
wrong on the comparison page, the record’s Clean Status value changes to Reviewed.

1. From the record, click Clean to open the comparison page.
2. If you want to flag a field value as wrong, click the down arrow next to the field and select Flag as wrong to Data.com.

A red flag ( ) appears next to the field.
3. Click Save.
4. If a field value has been flagged as wrong, but you know it’s right, click the down arrow next to the field and select Flag

as right to Data.com.
The red flag disappears.
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5. Click Save.

When an email field value is flagged as wrong, that information is immediately submitted to Data.com’s automated fact
processing system. If enough Data.com users flag the same email, the record may ultimately be marked as Inactive by
Data.com. When other fields are flagged as wrong, the information is reviewed by data stewards at Data.com or D&B.

Data.com Clean Additional Enhancements
Enhanced CleanStatus API Field on Account, Contact, and Lead Objects
Clean Status Value: Skipped
Account Site Field on Comparison Page for Selecting a Data.com Match
Using Data.com Clean with State and Country Picklists

Enhanced CleanStatus API Field on Account, Contact, and Lead
Objects

The CleanStatus field on the Account, Contact, and Lead objects supports the update() call. Each object’s CleanStatus
field also offers a new picklist value: Skipped. See the Salesforce SOAP API Developer’s Guide for complete details on these
fields.

Clean Status Value: Skipped
We’ve added a new Data.com clean status value: Skipped. Data.com sets the status value under certain conditions, but
developers can also set this value using the API. Records with Skipped status are always skipped during incremental sync
Clean jobs, and always processed during full sync Clean jobs.

Data.com sets aSalesforce account, contact, or lead record’s clean status to Skipped under these conditions.

• The record previously had a clean status of Not Compared

and

• When the record was last saved, it encountered an error related to a validation rule, trigger, or other customization.

If both of these conditions are met, the record is skipped during the next incremental sync Clean job or when it is next manually
cleaned by a user.

If you want to deliberately skip a set of records during incremental syncs, you can update their Clean Status field values to
Skipped using the API. For example, you might need to adjust your organization’s data or validation rules and have that
set of records cleaned by the next full sync Clean job after those adjustments are complete.

Full sync Clean jobs process Salesforce records with any clean status, even if they encountered errors related to validation rules,
triggers, or other customizations when last saved.

For more information, check out “Understanding Data.com Clean Status” in the Salesforce Help.

Account Site Field on Comparison Page for Selecting a Data.com
Match

If you need to select a matching Data.com record for a Salesforce account record, you’ll see the Account Site field has
replaced the Ownership field. We’ve made the Account Site field available on the comparison page in response to customer
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requests because it is more useful for selecting the right match. For complete details about selecting a matching Data.com
record for an account, see “Selecting a Matching Data.com Record for a Salesforce Account” in the Salesforce Help.

Using Data.com Clean with State and Country Picklists
State and country picklists (now generally available) allow users to select states and countries from predefined, standardized
lists, making data entry easier and helping ensure cleaner data. Implementing state and country picklist includes converting
your existing data to the standard picklist values. If your organization uses Data.com Clean you need to suspend Clean jobs
until the picklist conversion is finished.

For more information about state and country picklists, see “State and Country Picklists Overview” in the Salesforce Help.

Data.com Social Key—Generally Available
Data.com Social Key, which is now generally available,  works with Social Accounts and Contacts and Data.com Clean to
make it easier to follow your contacts and leads on social networks. 

Data.com Social Key Overview

Data.com Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to learn more about
your contacts and leads in Salesforce or on social network sites. Your organization must have Data.com Clean enabled to
use Social Key.

Implementing Social Key

Implementing Data.com Social Key is easy. Just follow a few simple steps.

Enabling Social Key

Before your organization can use Social Key to find and associate social handles for your contact and lead records, you must
enable the feature.

Enabling and Configuring Social Accounts and Contacts

There are a few steps you need to complete before your users will have access to social data on their accounts, contacts, and
leads.

Configuring Data.com Clean Jobs for Social Key

Social Key provides social handles through Data.com Clean jobs. You need to make sure your Clean jobs are configured for
Social Key.

Configuring Data.com Clean List View Cleaning for Social Key

Social Key provides social handles when users clean contact or lead records from a list. You’ll need to add a few fields to your
organization’s list views.

Viewing Data.com Social Key Job History

The Data.com Social Key Job History lets you review your current jobs and access job error logs.

Viewing Your Data.com Social Key Update Rates

Data.com Social Key metrics and analytics tell you how your organization’s contacts and leads have been updated with social
data, so it’s important to check your update rates on a regular basis.
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Data.com Social Key Overview
Data.com Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to learn more about
your contacts and leads in Salesforce or on social network sites. Your organization must have Data.com Clean enabled to use
Social Key.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

When Clean jobs are run or records are cleaned from a list, Social Key finds and associates social handles for your contacts
and leads. Social Key currently provides social handles for LinkedIn®, Twitter®, and Facebook® for contacts and leads in the
United States only.

Users log in to a social network from a contact or lead’s detail page and view the associated profile from within the Social
Accounts and Contacts viewer. There’s no manual search required.

Note:  Depending on contacts’ and leads’ privacy settings, as well as the permissions set by their friends or connections
and the site’s terms of use, users might not see as much information as they would if logged in to their social network
accounts directly.

Implementing Social Key
Implementing Data.com Social Key is easy. Just follow a few simple steps.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

1. Enable Social Key.
2. If you haven’t yet, enable Social Accounts and Contacts and select the social networks you want to get social profiles from.
3. Make sure your Data.com Clean settings, preferences, and job schedule are configured for Social Key.
4. Make sure the Clean Status field has been added to your contact and lead list views, and, optionally, add the fields for

the social networks that you’ve enabled to your contact list views.
5. After jobs have run, you can check out their Social Key job history.

Enabling Social Key
Before your organization can use Social Key to find and associate social handles for your contact and lead records, you must
enable the feature.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions
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User Permissions Needed

“Customize Application”To implement Social Key:

1. From Setup, click Data.com Administration > Social Key > Settings.
2. Click Enable Social Key.

If you also need to enable and set up Social Accounts and Contacts, we’ll let you know after you enable Social Key.

Enabling and Configuring Social Accounts and Contacts
There are a few steps you need to complete before your users will have access to social data on their accounts, contacts, and
leads.

Business accounts available in: All Editions except Database.com

Person accounts available in: Enterprise, Performance, Unlimited, and Developer Editions

Contacts available in: All Editions except Database.com

Leads available in: Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

Data.com Clean available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To enable, configure, or disable Social Accounts and Contacts:

Enable Social Accounts and Contacts so your users can keep up to date on their accounts', contacts', and leads' social
information—right within Salesforce. After you enable the feature, select the networks your organization can use. Your
organization’s users can also configure Social Accounts and Contacts for their own use: they can turn the feature on and off
and select the networks they want.

If your organization also uses Data.com Social Key, enable that feature to get your contacts’ and leads’ social handles automatically
when Clean jobs are run or records are cleaned from a list.

Note: The Social Accounts and Contacts feature is enabled by default for organizations created after the Spring ’12
release. If your organization was created before that, you need to enable the feature yourself.

1. From Setup, click Customize > Social Accounts and Contacts > Settings.
2. Select Enable Social Accounts and Contacts.
3. Select the social networks that your organization can use. By default, all social networks are selected.
4. Click Save.
5. Let your users know they can configure Social Accounts and Contacts for their individual use.

Enable Social Key if your organization will use it.

Configuring Data.com Clean Jobs for Social Key
Social Key provides social handles through Data.com Clean jobs. You need to make sure your Clean jobs are configured for
Social Key.
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Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads
on social networks. From Social Accounts and Contacts, select the social networks you want. The Social Key process runs
during your automated Clean jobs, so to use Social Key, you need to make sure Clean is enabled, and select and schedule the
jobs you’ll need.

When you enable Social Key, the next scheduled Clean job will run a full sync with Data.com for the objects you’ve enabled
for clean jobs (contacts, leads, or both). Social Key will provide social handles at regular intervals after that, at the same time
as your Clean jobs. For example, if you run your clean jobs once per week, on Wednesday, the Social Key job will do a full
sync every other Wednesday.

Note: If a Clean job fails, the Social Key process fails, as well. To view Clean and Social Key job histories, from
Setup, click Data.com Administration > Clean > Jobs..

If you need guidance on setting up Data.com Clean or verifying your preferences or settings, just click Help for this Page on
any Clean setup page.

1. From Setup, click Data.com Administration > Clean > Settings.
2. Confirm that Data.com Clean is enabled.
3. From Setup, click Data.com Administration > Clean > Preferences.
4. Confirm that Clean jobs are enabled for the objects for which you want to get social handles. We provide them for contacts

and leads.
5. From Setup, click Data.com Administration > Clean > Jobs.
6. Confirm that Clean jobs are scheduled.

Configuring Data.com Clean List View Cleaning for Social Key
Social Key provides social handles when users clean contact or lead records from a list. You’ll need to add a few fields to your
organization’s list views.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key

“Read” on the type of record included in the listTo create custom list views:

“Manage Public List Views”To create, edit, or delete public list views:

Social Key works with Social Accounts and Contacts and Data.com Clean to make it easier to follow your contacts and leads
on social networks. From Social Accounts and Contacts, select the social networks you want. The Social Key process runs
when users clean records from a list.
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1. Click the tab for the object whose records you want to clean from a list: Contacts or Leads.
2. Select a view from the drop-down and click Edit.
3. Make sure the Clean Status field has been added to the Selected Fields.

Adding this field automatically adds the Clean button to the list view.
4. Optionally, add the fields for the social networks you’ve enabled (LinkedIn, Twitter, or Facebook) to your contact list

views.

The social network fields aren’t available on the lead list views.

Viewing Data.com Social Key Job History
The Data.com Social Key Job History lets you review your current jobs and access job error logs.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To implement Social Key:

The Data.com Social Key process runs during your automated Data.com Clean jobs to find and associate social handles for
contacts and leads. The Social Key Jobs History table lists recent clean jobs and provides details related to Social Key. If a
Clean job fails, the Social Key process fails, as well.

1. From Setup, click Data.com Administration > Clean > Jobs.
2. Review general Clean job history if you need to.
3. View job details in the Social Key Jobs History section.
4. If the job encountered any errors when processing one or more records, click the link in the Entity Errors column to

download the job log .csv file.

We store job logs for seven days.

Here are the definitions for the table columns.

Definition and Troubleshooting GuidelinesColumn Heading

The date the job was run.Date

The time the job was submitted to the job queue. Jobs run
independently, so this might not be the exact time the job was
run.

Time Submitted

The type of job: Contacts or Leads.Job Type

The status of the job:

Processing: the job is in process.

Job Status

Completed: the job has finished running (with or without
errors).

Failed: the job failed to run.

Aborted: the job was aborted before or while it ran.
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Definition and Troubleshooting GuidelinesColumn Heading

The number of Salesforce records processed and matched by
the Clean job.

Records

The number of Salesforce records processed that were updated
with one or more social handles.

Records with Handle

The number of Salesforce records processed that weren’t
updated with any social handles.

Records without Handle

The number of LinkedIn social handles the job attempted to
update Salesforce records with.

LinkedIn Handles

The number of Twitter social handles the job attempted to
update Salesforce records with.

Twitter Handles

The number of Facebook social handles the job attempted to
update Salesforce records with.

Facebook Handles

The total number of entity errors a job encountered while it
ran. A dash indicates either no errors or no data. If the job

Entity Errors

produces an entity error job log, click the link to download
and open its .csv file. There you’ll find an explanation of any
entity error that was produced because a record failed to
save—for example, because of a validation rule failure. Entity
errors usually result from validation rule failures or required
field violation. If an explanation exists, we’ll provide it.

The unique ID of a record that produced an error during the
job. To open the record, append the 15-digit ID to the URL
of your salesforce instance. For example:
https://na1.salesforce.com/0013000000hKBTq.

Viewing Your Data.com Social Key Update Rates
Data.com Social Key metrics and analytics tell you how your organization’s contacts and leads have been updated with social
data, so it’s important to check your update rates on a regular basis.

Data.com Clean license available in: Professional, Enterprise, Performance, and Unlimited Editions

Social Key available in: Professional, Enterprise, Performance, and Unlimited Editions

User Permissions Needed

“Customize Application”To view Social Key update rates:

Social Key update rates are organized by both record type (so you can see how many contacts and leads in your organization
were updated with social handles) and social handle (so you can see which handles were available most often).

1. From Setup, click Data.com Administration > Clean > Metrics & Analytics.
2. To find out when the last calculation occurred, check the Last Calculated field above the table.

Note:  The data in the tables is calculated daily, but we store the time and calculate the date based on GMT, so
depending on time adjustments, the date shown may be different from the date when the calculations occurred.
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Also, because this data is calculated once per day, it may differ slightly from the data in Data.com dashboards and
reports.

3. View update information in the Social Key Update Rates section.

The data represents records that have been updated since your organization started using Social Key. Here are the definitions
for the table columns.

Table 1: Records Updated

DefinitionColumn

The object for which Social Key jobs ran (contacts or leads).Records

The number of each type of Salesforce record (contacts or
leads) processed by Social Key.

Processed

The number of each type of processed Salesforce record
(contacts or leads) that have been updated with at least one
social handle.

Updated

The percentage of each type of processed Salesforce record
(contacts or leads) that have been updated with at least one
social handle.

Update Rate (% of Processed)

Table 2: Social Handles Updated

DefinitionColumn

The social handles enabled for Social Key (LinkedIn®,
Twitter®, or Facebook®).

Social Handle

The number of social handles (LinkedIn, Twitter, or
Facebook) that have been added to contact records.

Contacts

The number of social handles (LinkedIn, Twitter, or
Facebook) that have been added to lead records.

Leads

The number of social handles (LinkedIn, Twitter, or
Facebook) that have been added to contact and lead records.

Total

Table 3: Social Handle Update Rate (by Social Network)

DefinitionColumn

The social network for which we provide the social handles
(LinkedIn, Twitter, or Facebook).

Social Network

The percentage of total updated social handles that are from
LinkedIn, Twitter, or Facebook.

Update Rate
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Service
Salesforce’s Service Cloud gives you the tools to provide a comprehensive customer service experience to your customers.

Case Feed

Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases. It includes publishers,
which let agents create case notes, log calls, change the status of cases, and communicate with customers in a Chatter-like
feed.

Chatter Answers

Chatter Answers is a self-service and support community where users can post questions and receive answers and comments
from other users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce
Knowledge articles in a unified experience. Chatter Answers has several new and improved features in Winter '14.

Entitlement Management

Entitlement Management lets you and your support agents verify and fulfill customers’ support contracts. Entitlement
Management has several new and improved features in Winter '14.

Ideas

Ideas is a community of users who post, vote for, and comment on ideas. An Ideas community provides an online, transparent
way for you to attract, manage, and showcase innovation. Ideas has several new and improved features in Winter '14.

Knowledge

Salesforce Knowledge, your Knowledge Centered Support certified knowledge base, has several new and improved features
in Winter '14.

Live Agent

Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based, text-only
live chat. Live Agent has several new and improved features in Winter '14.

Open CTI

Open CTI helps partners integrate Salesforce with computer-telephony integration systems without installing adapter
programs on call center users’ machines. Open CTI has several new and improved features in Winter '14.

Salesforce Console for Service

The Salesforce Console for Service is an app that’s designed for users in fast-paced environments who need to find, update,
and create records quickly to support their customers. The Salesforce Console for Service has several new and improved
features in Winter '14.

Console Tab

The Agent console in the Console tab combines information to help service agents do more.

Customer Users

Customer users can access Salesforce through Customer Portals or communities you create.

Case Feed
Case Feed gives support agents a more streamlined way of creating, managing, and viewing cases. It includes publishers, which
let agents create case notes, log calls, change the status of cases, and communicate with customers in a Chatter-like feed.
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Available in: Enterprise, Performance, Unlimited, and Developer Editions

Case Feed Automatically Enabled in New Organizations

Case Feed is automatically enabled and assigned to all standard profiles in Salesforce organizations created after the Winter
’14 release.

New Publisher JavaScript API Events Let Custom Salesforce Console Components Interact with Case Feed

Four new events that can be published through the publish method on the Sfdc.canvas.publisher object let you
create custom Salesforce console components that interact with actions in the Case Feed publisher.

Add Visualforce Pages to Case Detail Pages in Case Feed

You can now customize and add functionality to case detail pages for Case Feed users by adding Visualforce pages to those
layouts with the page layout editor.

Updated Look for Feed Items in Case Feed

The details that appear below certain feed items in Case Feed now appear surrounded by a light grey box.

Combined Filter and Sort Options in Case Feed

If your Case Feed layout includes feed filters as a drop-down list in the center column, that list is now combined with the
list of feed sorting options.

New Labels for Portal-Related Buttons in Case Feed

We’ve renamed the button in the Case Feed portal publisher and the button that appears below the feed items for portal
posts.

Case Feed Automatically Enabled in New Organizations
Case Feed is automatically enabled and assigned to all standard profiles in Salesforce organizations created after the Winter
’14 release.

If you don’t want to use Case Feed, you can disable it: from Setup, click Cases > Support Settings and deselect Case Feed
Enabled.

For information on customizing Case Feed based on your company’s needs, see “Setting Up Case Feed” in the online help.

New Publisher JavaScript API Events Let Custom Salesforce
Console Components Interact with Case Feed

Four new events that can be published through the publish method on the Sfdc.canvas.publisher object let you create
custom Salesforce console components that interact with actions in the Case Feed publisher.

For example, you could create a console component that lets support agents browse Salesforce Knowledge articles and then,
with one click, include the full, formatted text of an article in a new message in the Case Feed email action.

These events support interaction with Case Feed:

DescriptionName

Selects the specified action and puts it in focus.publisher.selectAction
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DescriptionName

Specifies which fields on the action should be populated with
specific values, and what those values are.

publisher.setActionInputValues

Triggers the submit function (such as sending an email or
posting a portal comment) on the specified action.

invokeAction

Passes a custom event to a custom action. Supported for
Visualforce-based custom actions only.

customActionMessage

For more information on using these events, see Customizing Case Feed with Visualforce.

Add Visualforce Pages to Case Detail Pages in Case Feed
You can now customize and add functionality to case detail pages for Case Feed users by adding Visualforce pages to those
layouts with the page layout editor.

You can use any Visualforce page that includes the standard case controller.

To edit Case Feed layouts, click Customize > Cases > Page Layouts and choose a layout from Page Layouts for Case
Feed Users.

Updated Look for Feed Items in Case Feed
The details that appear below certain feed items in Case Feed now appear surrounded by a light grey box.

These items have the updated look.

• Email messages

• Portal posts

• Call logs

• Case status changes

• Case comments

• Articles

• Live chat transcripts
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Combined Filter and Sort Options in Case Feed
If your Case Feed layout includes feed filters as a drop-down list in the center column, that list is now combined with the list
of feed sorting options.

The filter options are listed first in the combined list, followed by the sort options.

If your layout includes feed filters as a fixed or floating list in the left column, that list and the sort options list remain separate.

New Labels for Portal-Related Buttons in Case Feed
We’ve renamed the button in the Case Feed portal publisher and the button that appears below the feed items for portal posts.
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The portal publisher button, which was labeled Answer via Portal, is now Post Answer. The button that appears with
portal-related feed items has been renamed from Remove from Portal to Remove Answer.

For more information on using the portal publisher, see “Communicating with Customers via the Customer Portal and Chatter
Answers” in the Salesforce Help.

Chatter Answers
Chatter Answers is a self-service and support community where users can post questions and receive answers and comments
from other users or your support agents. Chatter Answers brings together Case, Questions and Answers, and Salesforce
Knowledge articles in a unified experience. Chatter Answers has several new and improved features in Winter '14.

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

Activity History

You can view user activity for Questions and Ideas on Chatter profile pages.

Rich Text and Images in Chatter Answers Replies

The rich text editor is now available for users when they reply to a question.

Updated User Interface for Questions

We’ve made several important improvements to the Q&A tab so that it’s even easier for your customers to ask a question
and get an answer. These changes increase the usability of the Chatter Answers user experience and don’t affect the behavior
of Chatter Answers.

Reply to Questions with Email

Now you can reply to a question directly from an email notification without having to go to the Q&A tab.

Update Needed for Notification URLs When Enabling My Domain

Existing organizations with Chatter Answers must update email notification URLs when they enable My Domain.

Customize Chatter Answers with Visualforce Components

Structure your Chatter Answers zones in all new ways with Chatter Answers Visualforce components.

Customize the Account Creation Experience for Chatter Answers Portal Users

Implement the ChatterAnswers.AccountCreator interface with the ChatterAnswersRegistration Apex class
to create a custom account creation and registration experience for Chatter Answers portal users.

Build the Chatter Answers Search into Your Applications

We’ve exposed the Chatter Answers search through Chatter in Apex and the Chatter REST APIs.

Customize Component Events with the Chatter Answers JavaScript API—Pilot

The Chatter Answers JavaScript API lets you add additional functionality to actions in Chatter Answers.

Activity History
You can view user activity for Questions and Ideas on Chatter profile pages.

In Winter ’14, activity statistics, such as how many posts you’ve made and how many likes you’ve received in Ideas and Questions
appear on your profile page so that others can learn about your participation in the community.
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Click your name anywhere around the application to view your profile. If available, you can also click the Profile tab or Your
Name > My Profile at the top of the page. View other people's profiles by clicking their name.

Activity history appears on the Overview tab of your profile and shows how your activity stacks up to other people’s. You can
also evaluate the activity of other members of the community when you look at their profile.

When Chatter Answers is enabled for your organization, the total numbers for the following activities appear on your profile
page:

• Questions you’ve asked

• Questions you’ve answered

• Questions you’ve solved with a best answer

Click Questions to navigate back to the Q&A tab.

When Reputation in Ideas is enabled by your administrator, the total numbers for the following activities appear on your
profile page:

• Ideas you’ve created

• Comments you’ve received

• Comments and ideas you’ve voted on

Click Ideas to navigate back to the Ideas tab.

Rich Text and Images in Chatter Answers Replies
The rich text editor is now available for users when they reply to a question.
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User Permissions Needed

“Customize Application”

AND

“Manage Users”

AND

“Edit Self-Service Users”

To set up Chatter Answers:

Administrators can give community members access to a rich text editor for replies, enabling them to format text and add
images when answering questions. Images can be up to 1 MB in size. There is a 32,000 character limit for public replies. The
rich text editor is enabled by default for new organizations. For existing organizations, if rich text is enabled for questions, it’s
automatically enabled for replies. Enabling the rich text editor makes the rich text available for both questions and replies.

To enable rich text for users in your organization, from Setup, click Customize > Chatter Answers > Settings, then select
Enable Rich Text Editor.

Updated User Interface for Questions
We’ve made several important improvements to the Q&A tab so that it’s even easier for your customers to ask a question and
get an answer. These changes increase the usability of the Chatter Answers user experience and don’t affect the behavior of
Chatter Answers.

When the Optimize Question Flow preference is enabled, users can see more information to help them find an answer when
asking a question.

We’ve updated the Chatter Answers Q&A tab to bring you the following improvements:

1. Additional filter and sort options have been added to make viewing questions and answers even easier. The filter and sort
options have been combined into one drop-down list. Community members and support agents can select different viewing
options for questions in the feed.

Searches in the Chatter Answers Q&A tab can be filtered to show questions based on:

• All Questions shows all questions in the zone, as well as Salesforce Knowledge articles, when enabled.
• Unanswered Questions shows all questions that don’t have replies.
• Unsolved Questions shows all questions that don’t have a best answer.
• Solved Questions shows all questions that have a best answer, as well as Salesforce Knowledge articles, when enabled.
• My Questions shows all questions you’ve asked and are following.

You can then sort the results based on the following options:

• Date Posted sorts questions with the most recently asked questions appearing first.
• Recent Activity sorts questions with the most recent replies and comments appearing first.
• Most Popular sorts questions that have received the most likes, upvotes, and followers appearing first.

Administrators can edit the labels for All Questions, Solved Questions, Unanswered Questions, and Unsolved to meet
the needs of the community.

2. The text color for titles of questions has changed from blue to black. Clicking on the title or the body of the question
switches to the single item view of the question.

3. Questions have been condensed to show the first few lines of the post. Click see more to view the entire question and click
see less to collapse the section back to a text area that is 100 pixels high.
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Reply to Questions with Email
Now you can reply to a question directly from an email notification without having to go to the Q&A tab.

When you receive email notifications related to a question, you can conveniently reply directly from your email and the reply
appears as an answer on the Q&A tab. You’ll receive an email notification for the following events:

• Someone answers a question you’ve asked or are following.

• Customer support or a moderator selects a best answer for a question you’ve asked or are following.

Note:  To reply to email notifications, your administrator must enable email replies on the Chatter Answers Settings
page.

Consider these tips when sending email replies:

• Replies must be sent from the email address specified on your profile. If you use email aliases or email forwarding services
that send replies from a different email address, your replies won't be processed.

• If replies contain your personal email signature, the signature text is treated as part of your comment. Default signatures
inserted by mobile devices, such as Sent from my iPhone, are automatically removed from replies. Before replying,
delete custom signatures and any extra text you don't want posted to the community.

• Attachments in replies are ignored.

• Before replying, check the email address that displays in the To field of your email. Valid addresses contain tokens, or long
character strings, both before and after the @ symbol, such as
w8t27apy1@j321imd9gbs.d8rx.d.chatter.salesforce.com. Some email applications may automatically
use the From address from the original email, such as ReplyToQ&A@<your.company>.com, which is not a valid
address for receiving replies. If you see this shortened address in the To field of your reply email, replace it with the valid
reply-to address in the email header information. For example, in an application such as IBM® Lotus Notes®:

1. Open the original email.
2. Click View > Show > Page Source.
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3. In the ReplyToQ&A section, copy the email address that looks like:
w8t27apy1@j321imd9gbs.d8rx.d.chatter.salesforce.com.

4. Paste the reply-to address in the To field of your reply email.

Update Needed for Notification URLs When Enabling My Domain
Existing organizations with Chatter Answers must update email notification URLs when they enable My Domain.

User Permissions Needed

“Customize Application”To create or edit a zone and to set up a domain name:

When you set up a domain name for your organization using My Domain, all of your application URLs change. If you have
an existing URL for email notifications in an internal zone and subsequently set up a custom domain using My Domain, you
must manually update the Email Notification URL field for the internal zone.

1. From Setup, click Customize > Chatter Answers > Zones.
2. In the Email Notification URL field, clear the existing URL so that the field is blank.
3. Click Save.

The system populates the field with the My Domain URL.

Customize Chatter Answers with Visualforce Components
Structure your Chatter Answers zones in all new ways with Chatter Answers Visualforce components.

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

In Winter '14, you can control the arrangement of Chatter Answers elements such as the feed, sign in, filters, and the Search/Ask
bar. Add any of the Chatter Answers components to the Visualforce page that customizes your zone. You can include the
following components, in any order:

• chatteranswers:aboutme

• chatteranswers:guestsignin

• chatteranswers:feedfilter

• chatteranswers:feeds

• chatteranswers:searchask

• chatteranswers:datacategoryfilter

For example, the following Visualforce page includes all of the standard Chatter Answers elements, but they appear in a
different order on the resulting page than they do when you use the chatteranswers:allfeeds component. In this
example, the Search/Ask component and the feed filter appear below the feed instead of above it.

<apex:page language="en_US" showHeader="false" cache="true">
<body>
<div class="csMini">
<div class="threecolumn">
<div class="leftContent">
<chatteranswers:guestsignin />
<chatteranswers:aboutme communityId="09aD00000000cfE"/>
<chatteranswers:datacategoryfilter communityId="09aD00000000cfE"/>
</div>
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<div class="mainContent">
<div class="lowerMainContent" id="lowerMainContent">
<div id="rightContent" class="rightContent"></div>
<div id="centerContent" class="centerContent">
<chatteranswers:feeds communityId="09aD00000000cfE"/>
<chatteranswers:searchask communityId="09aD00000000cfE"/>
<chatteranswers:feedfilter />
</div>
</div>
</div>
<div class="clearingBox"></div>
</div>
</div>
</body>
</apex:page>

Customize the Account Creation Experience for Chatter Answers
Portal Users

Implement the ChatterAnswers.AccountCreator interface with the ChatterAnswersRegistration Apex class to
create a custom account creation and registration experience for Chatter Answers portal users.

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

The ChatterAnswers.AccountCreator interface has one method, createAccount, which accepts basic user information
and creates an Account record. The implementation of this method returns the user ID. Specify the class name of the
ChatterAnswers.AccountCreator interface implementation in the registrationClassName attribute in the
<chatteranswers:registration> Visualforce component.

For information on creating a custom registration experience for your Chatter Answers portal users, see
ChatterAnswers.AccountCreator Interface on page 286 and registrationClassName Attribute Added to the
<chatteranswers:registration> Component on page 271.

Build the Chatter Answers Search into Your Applications
We’ve exposed the Chatter Answers search through Chatter in Apex and the Chatter REST APIs.

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

The Chatter Answers search returns questions and articles with special relevancy scores, such as number of votes and best
answers. Now you can integrate the same rich Chatter Answers search that’s in the user interface into you applications using
Chatter in Apex and the Chatter REST APIs.

For information on building the Chatter Answers search into your applications, see “Zones resources” in New and Changed
Resources.

Customize Component Events with the Chatter Answers
JavaScript API—Pilot

The Chatter Answers JavaScript API lets you add additional functionality to actions in Chatter Answers.
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Note:

The Chatter Answers JavaScript API is currently available through a pilot program. For information on using the
Chatter Answers JavaScript API, contact salesforce.com.

You can create custom Chatter Answers community experiences using Chatter Answers components in a Visualforce page.
The Chatter Answers JavaScript API exposes four events for modifying the behavior of Chatter Answers components or the
interaction of Chatter Answers components with components you create.

• FEED_READY—Indicates that the Chatter Answers feed has finished loading. You can trigger other events after this event
is fired.

• EDIT_MY_SETTINGS_CLICK—Handles the opening of the My Settings overlay.

• FEED_ITEM_SELECTED—Opens a specific feed item in single item view and is triggered by the action of a feed item
selected from the Search/Ask component.

• HOVER_USER—Handles the behavior for the hover overlay, which can display reputation or user information, when you
hover over a user’s user name. You can override this event.

For documentation on using the Chatter Answers JavaScript API, see the Chatter Answers JavaScript API Developer’s Guide
(English only).

Entitlement Management
Entitlement Management lets you and your support agents verify and fulfill customers’ support contracts. Entitlement
Management has several new and improved features in Winter '14.

Available in: Enterprise, Performance, Unlimited, and Developer Editions with the Service Cloud

Create More Flexible Entitlement Processes with Recurring Milestones

Recurring milestones allow milestones to repeat within an entitlement process whenever the milestone criteria match the
case criteria.

Entitlement Versioning—Generally Available

Entitlement versioning is generally available. Entitlement versioning saves you time by letting you update an entitlement
process and all of the entitlements and cases associated with it with a single click.

Monitor Case Activity with Milestone Feed Items

Milestone feed items provide an additional way for support agents to monitor case activity.

View Milestones on the Case Feed Page with the Milestone Tracker

We’ve created a component that you can add to the Case Feed page that shows the countdown time to an active milestone’s
Target Date or how long a milestone has been in violation.

Show the Time Since a Milestone Target Was Violated

Add Time Since Target fields to the Case Milestones related list and the Case Milestone Detail page to quickly view
how much time has passed since a milestone’s target date was violated.

Change the Account Associated with an Entitlement

Support agents can now change the account associated with an entitlement, making it easy to update the entitlement if an
asset covered by the entitlement changes owner or to correct the account associated if the case covered by the entitlement
was assigned the wrong account or contact.
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Create More Flexible Entitlement Processes with Recurring
Milestones

Recurring milestones allow milestones to repeat within an entitlement process whenever the milestone criteria match the case
criteria.

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include First Response and Resolution Times on cases. You can set up a milestone to occur
once in an entitlement process or to recur until the entitlement process exits. The following recurrence types are available for
milestones:

DescriptionRecurrence Type

The milestone occurs only once for the case.None

The milestone occurs whenever the milestone criteria match the case criteria.Independent

The milestone occurs whenever the case criteria match the milestone criteria and
the previous occurrence’s Target Date has passed.

Sequential

For more information on setting up recurring milestones, see “Creating Milestones” in the Salesforce Help.

Milestones with Independent Recurrence
Independent recurring milestones always use the current time as the Start Date.

For milestones with independent recurrence, the milestone occurs whenever the milestone criteria match the case criteria until
the entitlement process exits. Only one occurrence of a milestone can be active at a time. For all occurrences, the Start Date
is the current time when the milestone criteria match the case criteria, regardless of when the previous occurrence was complete.

For example, a milestone called Engineer Solution Proposed is set up to track case escalation to Engineering. When the
Engineer Solution Proposed milestone occurs, the support agent expects a proposed solution from Engineering within four
hours.

At 10 a.m., the support agent escalates a case to Engineering by changing a field that, due to workflow rules, causes the
milestone criteria to match the case criteria. As a result, the Engineer Solution Proposed milestone is created with a Start Date
of the current time, which is 10 a.m. The milestone’s Target Date is 2 p.m., four hours from the Start Date. At 11 a.m., well
before the target date, an engineer proposes a solution that’s sent to the customer and the Engineer Solution Proposed milestone
is complete.

However, the solution proposed doesn’t solve the customer’s issue. At 1 p.m., the support agent escalates the case to Engineering
and the Engineer Solution Proposed milestone is created again—this time with a Target Date of 5 p.m.

After the second occurrence of the Engineer Solution Proposed milestone, the case has two milestones:

• One milestone that started at 10 a.m. and is now complete
• One milestone that started at 1 p.m. and is incomplete with a Target Date of 5 p.m.

The milestone can recur as many times as necessary until the entitlement process is completed.

Milestones with Sequential Recurrence
Sequential recurring milestones have a start time that’s based on the Target Date of the preceding occurrence of the milestone.

For milestones with sequential recurrence, the milestone occurs whenever the case criteria match the milestone criteria and
the previous occurrence’s Target Date has passed, until the entitlement process exits. Only one occurrence of a milestone can
be active at a time. For the first occurrence, the Start Date is the current time when the milestone criteria match the case
criteria. For subsequent occurrences, the Start Date must be after the Target Date of the previous occurrence. If an occurrence
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is completed before its Target Date and the milestone criteria match the case criteria again, then the next occurrence will start
at the previous occurrence’s Target Date. If an occurrence is completed after its Target Date, the next occurrence’s Start Date
will be the current time when the milestone criteria match the case criteria.

For example, a milestone called Customer Contact Made is set up to track daily contact with a customer as part of an SLA.
The milestone is complete when the support agent communicates with the customer. The Customer Contact Made milestone
has a target time of 24 hours.

At 10 a.m. on Monday, a case is created with the Customer Contact Made milestone. The Target Date for the milestone is
24 hours from the start time, 10 a.m. on Tuesday. At 11 a.m. on Monday, the support agent communicates with the customer.
The Customer Contact Made milestone is complete. In addition, the next occurrence of the Customer Contact Made milestone
is created. However, because the previous occurrence’s Target Time is still in the future, the Start Date of this occurrence is
10 a.m. on Tuesday.

After the second occurrence of the Customer Contact Made milestone, the case has two milestones:

• One milestone that started at 10 a.m. on Monday and is now complete
• One milestone scheduled to start at 10 a.m. on Tuesday. that’s incomplete with a Target Date of 10 a.m. on Wednesday.

If the support agent communicates with the customer multiple times on Monday, it won’t have any effect on the Tuesday
milestone.

Entitlement Versioning—Generally Available
Entitlement versioning is generally available. Entitlement versioning saves you time by letting you update an entitlement
process and all of the entitlements and cases associated with it with a single click.

Entitlement versioning lets you make changes to existing entitlement processes, even if they’re assigned to active entitlements
and cases. This can be useful if the business rules behind your entitlement processes change, for example, or if you need to
create multiple versions of the same entitlement process that have only minor differences. With entitlement versioning, you
don’t need to create entirely new processes; you can simply create new versions of existing ones.

For information on creating multiple versions entitlement processes, see “Entitlement Versioning Overview” in the Salesforce

Help or watch a demo (2:20 minutes).

Monitor Case Activity with Milestone Feed Items
Milestone feed items provide an additional way for support agents to monitor case activity.

User Permissions Needed

“Manage Entitlements”To enable milestone feed items:

When you enable milestone feed items, your support agents see notifications in the Case Feed when a milestone is completed
or violated. Milestone feed items for cases a user owns or follows also appear on the user profile page.

This setting applies only if you have Chatter and entitlement management enabled.

1. From Setup, click Customize > Entitlement Process > Settings.
2. Select Enable milestone feed items.

Note:  Enabling milestone feed items doesn't create feed items for milestones that have already been completed or
violated.
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View Milestones on the Case Feed Page with the Milestone
Tracker

We’ve created a component that you can add to the Case Feed page that shows the countdown time to an active milestone’s
Target Date or how long a milestone has been in violation.

User Permissions Needed

“Customize Application”To create and edit page layouts:

“Manage Users”To assign page layouts:

Agents working on cases need to be aware of how much time they have until their milestones are due because their performance
is often measured based on how often they miss milestones. The milestone tracker lets agents see the time remaining on an
active milestone or how overdue the milestone is if its Target Date has passed, along with a list of upcoming milestones and
closed milestones, all on the Case Feed page.

To enable the milestone tracker for your support agents:

1. From Setup, click Customize > Cases > Page Layouts.

2. In Page Layouts for Case Feed Users, click  next to a layout and choose Edit feed view.
3. In the Other Tools and Components area, select the Milestone Tracker, and specify where on the page you want it to

appear.
4. Click Save.

You can add the milestone tracker to your custom pages by including the <apex:milestoneTracker> component in a
Visualforce page. For information on the new <apex:milestoneTracker> component, see the New
<apex:milestoneTracker> Component.

Show the Time Since a Milestone Target Was Violated
Add Time Since Target fields to the Case Milestones related list and the Case Milestone Detail page to quickly view
how much time has passed since a milestone’s target date was violated.

User Permissions Needed

“Read” on casesTo view case milestones:

“Edit” on casesTo edit case milestones:

Milestones are required steps in your support process. They're metrics that represent service levels to provide to each of your
customers. Examples of milestones include First Response and Resolution Times on cases. A milestone’s target date is the
date or time by which the milestone should be completed.

The Time Since Target fields on cases calculate the time that has elapsed since a milestone target was violated. You can
choose to display the time in days, hours and minutes, or minutes and seconds. You can add these fields to the Case Milestones
related list on the Case Detail page and to the Case Milestone Detail page.

To show Time Since Target in the Case Milestones related list on the Case Detail page:

1. From Setup, click Customize > Cases > Page Layouts.
2. Under Case Page Layouts, click Edit next to a page layout .
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3. In the page layout palette, click Related Lists.
4. Click the wrench icon above the Case Milestones related list.
5. Add any of the Time Since Target fields to the Selected Fields list.
6. Click OK.

When you add Time Since Target to the Case Milestone related list, the field is visible to agents on the Case Detail page
when a case includes the milestone and the milestone target is violated.

To show the Time Since Target field on a Case Milestone Detail page:

1. From Setup, click Customize > Cases > Case Milestones > Page Layouts.
2. Click Edit next to a page layout.
3. From the Fields list in the palette, , drag the Time Since Target fields you want to the page layout.
4. Click Save.

When you add Time Since Target to a Case Milestone Detail page, the field is visible to agents when a case includes the
milestone and the milestone target is violated.

The time since target remains fixed after the milestone is complete. The time since target calculates the completion date minus
the target date when a milestone is completed after the target date.

Change the Account Associated with an Entitlement
Support agents can now change the account associated with an entitlement, making it easy to update the entitlement if an
asset covered by the entitlement changes owner or to correct the account associated if the case covered by the entitlement was
assigned the wrong account or contact.

User Permissions Needed

“Read” on entitlementsTo view entitlements:

“Edit” on entitlementsTo change entitlements:

To change the account associated with an entitlement:

1. Click Edit on the entitlement you want to change.
2. Select the Account Name. To quickly find an asset in the lookup dialog box, select criteria from the Filter by fields.

Administrators can set lookup filters to restrict filter values and results.
3. Click Edit.

For information on editing entitlements, see “Editing Entitlements” in the Salesforce Help.

Ideas
Ideas is a community of users who post, vote for, and comment on ideas. An Ideas community provides an online, transparent
way for you to attract, manage, and showcase innovation. Ideas has several new and improved features in Winter '14.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Activity History

You can view user activity for Questions and Ideas on Chatter profile pages.
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“Like” Comments

Community members can like a comment.

Set a Profile Type for Your Ideas Users

Show all user profiles in the same way within a zone with the Ideas User Profile setting.

Activity History
You can view user activity for Questions and Ideas on Chatter profile pages.

In Winter ’14, activity statistics, such as how many posts you’ve made and how many likes you’ve received in Ideas and Questions
appear on your profile page so that others can learn about your participation in the community.

Click your name anywhere around the application to view your profile. If available, you can also click the Profile tab or Your
Name > My Profile at the top of the page. View other people's profiles by clicking their name.

Activity history appears on the Overview tab of your profile and shows how your activity stacks up to other people’s. You can
also evaluate the activity of other members of the community when you look at their profile.

When Chatter Answers is enabled for your organization, the total numbers for the following activities appear on your profile
page:

• Questions you’ve asked

• Questions you’ve answered

• Questions you’ve solved with a best answer

Click Questions to navigate back to the Q&A tab.
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When Reputation in Ideas is enabled by your administrator, the total numbers for the following activities appear on your
profile page:

• Ideas you’ve created

• Comments you’ve received

• Comments and ideas you’ve voted on

Click Ideas to navigate back to the Ideas tab.

“Like” Comments
Community members can like a comment.

Now you can like a comment to show your support for great input related to an idea.

Below a comment, click Like. To stop liking a comment, click Unlike.

Comments now show the number of people who like the comment. When a comment receives a like, it adds to the comment’s
total score.

Set a Profile Type for Your Ideas Users
Show all user profiles in the same way within a zone with the Ideas User Profile setting.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Customize Application”To create or edit a zone:

There are three profile types you can set for all of the Ideas users for a zone. You can choose between users’ Chatter profile,
the Ideas zone profile that they set up on their profile page, and a custom user profile with a Visualforce page. You can access
a user's profile page by clicking on their username.

To set a profile type for Ideas users in a zone:

1. From Setup, click Customize > Ideas > Settings.
2. Click Edit.
3. Select an Ideas User Profile type for all user profiles in the zone.

DescriptionUser Profile Type

The user’s Chatter profile is the default user profile type. If
you select this option and a user doesn’t have a Chatter
profile, then the Ideas zone profile is used.

Chatter profile

The profile that the user sets up for the Ideas zone. This
profile type is used for Ideas zones in portals.

Ideas zone profile

You can specify a Visualforce page for a custom profile for
all Ideas users in the zone. If you select this profile type, you
must specify a Visualforce page in Custom Profile Page.

Custom profile with a Visualforce page
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4. Click Save.

For new organizations starting with the Winter ’14 release, the default for the user profile type is the Chatter profile. For
organizations created prior to the Winter ’14 release, the Ideas zone profile is used.

You can customize these Ideas settings using the enableChatterProfile and ideasProfilePage fields in the
IdeasSettings metadata type. For information on modifying these settings in the user interface, see the Metadata API Developer’s
Guide.

Knowledge
Salesforce Knowledge, your Knowledge Centered Support certified knowledge base, has several new and improved features
in Winter '14.

Salesforce Knowledge is available in Performance and Developer editions.

Salesforce Knowledge is available for an additional cost in Enterprise and Unlimited editions.

Salesforce Knowledge Access for Internal Users

Full Salesforce license users no longer need a Knowledge User license to view articles.

Knowledge One with Federated Search

Knowledge One, on the new Knowledge tab, lets you search both published and draft articles plus any external data sources
you’ve connected to Salesforce.

More Custom Fields for Article Types

Now you can include nine more custom fields on your article types.

Search Articles to Create Smart Article Links

While writing an article, you can quickly search your existing Salesforce Knowledge Articles and add a smart link, which
automatically adjusts when the name or URL of the article is changed.

Chatter Feed Available on Article Toolbar

You can view and post comments and follow articles before they are published.

Topics on Salesforce Knowledge Articles—Pilot

Articles, with draft or published status, support topics through a pilot program in Winter ‘14.

Metadata API Support for Article Approval Actions

On deployed article types, you can use the metadata API to set article actions and workflow rules.

Play Videos from Any Provider with a Custom Visualforce Page

Using a custom Visualforce page and the HTML editor, you can insert a video from any provider into your Salesforce
Knowledge articles.

Salesforce Knowledge Access for Internal Users
Full Salesforce license users no longer need a Knowledge User license to view articles.
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In Winter’14, Salesforce Knowledge read access is available for full Salesforce licenses without the Knowledge User license.
However, other actions (create, edit, delete, and publish) require the Knowledge User license, the Manage Articles permission,
and the article action on the article type.

Tip:   If you were previously managing both users with and without Knowledge access on the same profile, permission
set, or role, duplicate the profile, permission set, or role and remove create, read, update, and delete access for those
you do not want to see Knowledge articles.

Create, Edit, Delete, and Publish
Access

Read AccessLicense

Users need:Read on the article typeService cloud (Enterprise and Unlimited
editions) • Knowledge User license

• Manage Articles permission

• Article action on the article type

Users need:Read on the article typeService cloud (Performance edition)
• Manage Articles permission

• Article action on the article type

Users need:Read on the article typeSales cloud (Enterprise, Unlimited, and
Performance editions) • Knowledge User license

• Manage Articles permission

• Article action on the article type

Not applicableRead on the article typeSocial Intranet

Not applicableRead on the article typeCommunity and Portals

Users need:Users need:Chatter Plus
• Knowledge User license• Knowledge User license

• •Read on the article type Manage Articles permission

• Article action on the article type

Users need:Users need:Force.com
• Knowledge User license• Knowledge User license

• •Read on the article type Manage Articles permission

• Article action on the article type

Knowledge One with Federated Search
Knowledge One, on the new Knowledge tab, lets you search both published and draft articles plus any external data sources
you’ve connected to Salesforce.

Knowledge One displays all your Salesforce Knowledge articles and any of your external data sources, such as Microsoft®

SharePoint®. Also, if you use case feed, the Knowledge tab layout is applied to the article sidebar. Knowledge One merges
functionality of the old Articles tab and the Article Management tab and uses federated search to search all your resources at
once so you can:
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1. Search all your Salesforce Knowledge articles (both drafts and published) and any of your external data sources, such as
Microsoft® SharePoint®.

2. Select filters to refine your search results.

• When All is selected, you can filter by language and data category, depending on what your organization supports.
• When Articles or My Draft is selected you can filter by:

◊ Article status: Published, Draft, and Draft Translations
◊ Language: Values depend on those supported in your organization
◊ Data categories: Values depend on those created in your organization
◊ Article type: Values depend on those created in your organization
◊ Validation Status: No Filter (all articles), Not Validated (articles that are not validated), Validated (validated articles),

and any other values supported in your organization such as in review.

• When an external source is selected, there are no filters and the general article information displayed is controlled by
your external object search layout.

3. Click Reset to return all filters to their default setting.
4. Sort articles by published date, rating, most viewed, and title.
5. View information by clicking on the article or external source title. Below the title you can find general article information

such as: new article indication, article number, article type, validation status, last published date, article view comparison,
and article rating comparison.

6. Use the drop-down by each article to follow or unfollow, edit, publish, and delete an article, depending on your permissions.
7. Use the Create Article drop-down to select an article type and create an article.

Enabling Knowledge One

For organizations new to Salesforce Knowledge in Winter ‘14 and later, Knowledge One is already enabled. To switch to
Knowledge One in older organizations, add the Knowledge One permission to your profiles or permission sets.
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To add the Knowledge One permission to a profile:

1. From Setup, click Administration Setup > Manage Users > Profiles.
2. Click the profile you want to add the Knowledge One permission to.

3. In the Find Settings... box, enter Knowledge.
4. Select Knowledge One from the list of suggestions.
5. Click Edit.
6. Under Knowledge Management, check Knowledge One.
7. Click Save.

To add the Knowledge One permission to a permission set:

1. From Setup, click Administration Setup > Manage Users > Permission Sets.
2. Click the permission set you want to add the Knowledge One permission to.

3. In the Find Settings... box, enter Knowledge.
4. Select Knowledge One from the list of suggestions.
5. Under Knowledge Management, check the Enabled check box for Knowledge One.
6. Click Save.

Once Knowledge One is available for your users, you’ll need to define your external data sources. Your external data sources
appear under your articles both in the search results and the left-side panel.

Note:  External data sources are available in beta. Log a salesforce.com support ticket to enable your external objects.

More Custom Fields for Article Types
Now you can include nine more custom fields on your article types.

The new fields are:

DescriptionField Type

In a multiple currency organization, an article can have an article currency field to set the
article’s currency ISO code.

Article Currency

Allows users to enter a currency amount. The system automatically formats the field as a
currency amount. This can be useful if you export data to a spreadsheet application.

Currency

Note: Salesforce uses the round-half-to-even tie-breaking rule for currency fields.
For example, 23.5 becomes 24, 22.5 becomes 22, −22.5 becomes −22, and −23.5
becomes −24.

Values lose precision after 15 decimal places.

Allows users to enter an email address, which is validated to ensure proper format. Character
limit is 80. If this field is specified for contacts or leads, users can choose the address when
clicking Send an Email. Note that you can't use custom email addresses for mass emails.

Email
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DescriptionField Type

Allows users to automatically calculate values based on other values or fields such as merge
fields.

Formula

Note: Salesforce uses the round half up tie-breaking rule for numbers in formula
fields. For example, 12.345 becomes 12.35 and −12.345 becomes −12.35.

In Database.com, the Formula editor does not provide a Check Syntax button.
Syntax checking occurs when the user attempts to save the formula.

Creates a relationship between two records so you can associate them with each other. For
example, opportunities have a lookup relationship with cases that lets you associate a particular

Lookup Relationship

case with an opportunity. A lookup relationship creates a field that allows users to click a
lookup icon and select another record from a popup window. On the associated record, you
can then display a related list to show all of the records that are linked to it. You can create
lookup relationship fields that link to users, standard objects, or custom objects. If a lookup
field references a record that has been deleted, Salesforce clears the value of the lookup field
by default. Alternatively, you can choose to prevent records from being deleted if they’re in
a lookup relationship.

Lookup relationship fields are not available in Personal Edition.

Lookup relationship fields to campaign members are not available; however, lookup relationship
fields from campaign members to other objects are available.

Allows users to enter any number. This is treated as a real number and any leading zeros are
removed.

Number

Note: Salesforce uses the round half up tie-breaking rule for number fields. For
example, 12.345 becomes 12.35 and −12.345 becomes −12.34. Salesforce rounds
numbers referenced in merge fields according to the user’s locale, not the number of
decimal spaces specified in the number field configuration.

Allows users to enter a percentage number, for example, '10'. The system automatically adds
the percent sign to the number.

Percent

Note:  If the decimal value is greater than 15, and you add a percent sign to the
number, a runtime error occurs.

Values lose precision after 15 decimal places.

Allows users to enter any phone number. Character limit is 40.

Salesforce automatically formats it as a phone number.

Phone

If you are using Salesforce CRM Call Center, custom phone fields are displayed with the 
button, allowing click-to-dial functionality. Consequently, salesforce.com recommends that
you do not use a custom phone field for fax numbers.

Allows users to select a value from a list dependent on the value of another field.Picklist (Dependent)

Allows users to enter up to 255 characters of any valid website address. When users click the
field, the URL opens in a separate browser window. Note that only the first 50 characters are
displayed on the record detail pages.

URL
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Search Articles to Create Smart Article Links
While writing an article, you can quickly search your existing Salesforce Knowledge Articles and add a smart link, which
automatically adjusts when the name or URL of the article is changed.

User Permissions Needed

“Manage Articles”

AND

“Create” and “Read” on the article type

To create articles:

“Manage Articles”

AND

“Read” and “Edit” on the article type

To edit draft articles:

“Manage Articles”

AND

“Create,” “Read,” and “Edit” on the article type

To edit published or archived articles:

In Winter ’14, authors can search for an article to reference in another article and create a smart link all within the rich text
editor. Smart links automatically adjust when the name or URL of an article is changed. For example, when the URL Name
of an article is changed, Salesforce Knowledge automatically updates the article’s URL based on the channel, adds the site
prefix for a public knowledge base, and adds the community name for the community portal.

To use a keyword search to create a smart link in a rich text area field:

1. Place your cursor where you’d like to place the link.

2. Click the link icon, .

The Link Article dialog appears.
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3. Optionally, select which language to search. If no language is selected, Salesforce Knowledge returns those articles in your
knowledge base’s default language that are related to your keyword search.

4. Optionally, select the publish status type to search.

• Online (default if no publish status is selected)
• Draft
• Draft translations (if your knowledge base supports multiple languages)

5. Enter article keywords into the search bar.
6. Click the search icon at the end of the search bar. The top 20 related articles display.
7. Select the article to reference in a smart link from the article list.

Important:  Smart links are based on the channels they are in. Therefore, you can’t add a smart link to an article
in another channel. For example, an article on your public knowledge base can’t link to an article only published
in your internal channel.

8. Optionally, click Go to Article to view the article in another window and ensure it is the correct reference.
9. Optionally, click the Target tab and select where the referenced article will display.

• Not Set: Opens the linked article in the same frame as it was clicked.
• Frame: Opens the linked article in a designated frame.
• New Window (_blank): Opens the linked article in a new window or tab.
• Topmost Window (_top): Opens the linked article in the full body of the window.
• Same Window (_self): Opens the linked article in the same frame as it was clicked.
• Parent Window (_parent): Opens the linked article in the parent frame.

10. Click OK.
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Chatter Feed Available on Article Toolbar
You can view and post comments and follow articles before they are published.

Now the Chatter feed is available on the article detail page. You can follow an article and view and add Chatter posts, while
it is still in draft status. If you are part of the Topics on Salesforce Knowledge Articles pilot, you can add topics as well.

Topics on Salesforce Knowledge Articles—Pilot
Articles, with draft or published status, support topics through a pilot program in Winter ‘14.

With the topics on articles pilot, you can classify and search articles by assigning topics. Topics are terms extracted from the
article, so that they are more concrete and precise than a data category assignment. When searching, topics can be used to
index the article, so the matched articles are more relevant to keyword searches.

Once your organization is part of the pilot program, your administrators can allow users to create, assign, delete, and edit
topics with profile permissions.

Note:  For information on enabling topics on articles for your organization, contact salesforce.com.

Metadata API Support for Article Approval Actions
On deployed article types, you can use the metadata API to set article actions and workflow rules.

Salesforce Knowledge article approval actions and workflow rules are now supported in the Metadata API on deployed article
types. For article version (_kav) in approval processes, the supported action types are:

• Knowledge Action

• Email Alert

• Field Update

• Outbound Message

Creating approval processes and workflow rules lets your organization automate many of the tasks involved with managing
its knowledge base. Approval processes automate the approval of published articles. When implemented with Salesforce
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Knowledge, approval processes give you additional control over the content of your articles and the process used to approve
them. For example, you can create a process that requires legal and management teams to approve articles containing sensitive
information. Workflow rules let you create email alerts, update fields, or send outbound API messages when an article meets
certain criteria. For example, you could create a workflow rule that sends an email alert to the article type owner when a new
article is created from a case.

Note:  Tasks are not supported by article type workflow.

Play Videos from Any Provider with a Custom Visualforce Page
Using a custom Visualforce page and the HTML editor, you can insert a video from any provider into your Salesforce Knowledge
articles.

For example, create a Visualforce page:

<apex:page showHeader="false" showChat="false" sidebar="false">
<iframe width="560" height="315"

src="http//myvideo.provider.com/embed/{!$CurrentPage.parameters.VideoID}"
frameborder="0" allowfullscreen="true">

</iframe>
</apex:page>

Then, with the HTML editor, authors can reference videos using this code:

<iframe frameborder="0" height="315"
src="https://<salesforce_instance>/apex/Video?videoID=12345"
width="560">

</iframe>

Live Agent
Live Agent lets service organizations connect with customers or website visitors in real time through a Web-based, text-only
live chat. Live Agent has several new and improved features in Winter '14.

Live Agent is available in: Performance Editions and Developer Edition organizations created after June 14, 2012

Live Agent is available for an additional cost in: Enterprise and Unlimited Editions

Automated Chat Invitations—Generally Available

Create and customize automated chat invitations to invite visitors to your website to chat with an agent. With this release,
Live Agent automated chat invitations are generally available.

Customize Supervisor Settings

Customize supervisors’ settings for all of your Live Agent configurations to give supervisors the permissions they need to
monitor their agents effectively.

Merge Fields Available for Custom Agent Name and Auto Greetings

Incorporate merge fields into your Live Agent custom agent name and automatic chat greetings to personalize the chat
experience for agents and customers.
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Customize Agent Names

Customize an agent’s name as it appears to customers to personalize the chat experience.

Create, Delete, and Edit Live Agent Session Records

Create, delete, and edit Live Agent session records to keep your organization’s customer service information up-to-date.

Critical Wait Alerts for Unanswered Chats

Optimize agents’ response times by alerting them to answer an engaged chat after a certain amount of time while they chat
with customers in the Salesforce console.

Filter Agents by Button and Status in the Supervisor Panel

Filter the Agent Status List in the Supervisor panel using enhanced filters to better monitor agents’ activities.

Enable Live Agent’s Pre-Chat API

Protect sensitive customer information by controlling developers’ access to the Pre-Chat API.

User Interface Improvements for Live Agent Components

There are several changes to the look and feel of the Live Agent application in the Salesforce console, making Live Agent
more modern and easier to use.

API Improvements for Live Agent

The Live Agent APIs include new methods to make developing for Live Agent incredibly powerful, giving your developers
more control to customize how Live Agent works for your organization.

Automated Chat Invitations—Generally Available
Create and customize automated chat invitations to invite visitors to your website to chat with an agent. With this release,
Live Agent automated chat invitations are generally available.

Automated chat invitations are animated pop-ups that appear on your website inviting customers to chat with an agent. These
invitations are highly customizable, letting you adapt them to serve your company’s exact needs. Let’s take a look at some of
the custom options available for invitations.

• Associate invitations with agents’ skills. Route chats to the appropriate agent when a customer accepts a chat invitation
by associating invitations with specific skills. For example, an invitation that appears on a customer checkout page may be
associated with agents that have sales skills.

• Associate invitations with specific deployments. Create customized invitations for different areas of your website by
associating different invitations with different Live Agent deployments.

• Animate your invitations. Customize how invitations appear–for example, by fading gradually onto the screen or sliding
from one area of the screen to another. If you’re feeling ambitious, use JavaScript to create custom animations.

Note:  The default animation options are available in the latest versions of the Chrome, Firefox, Safari, and
Internet Explorer Web browsers. They aren’t available in earlier versions of Internet Explorer.

• Customize your invitation with images. Using a Force.com site, upload images to customize your invitation.

• Use logical operators to create sending rules. Customize the criteria for your sending rule to define how and when
automated invitations are sent to customers. With sending rules, you can set invitations to trigger based on certain criteria,
such as whether a customer has a certain amount of merchandise in their shopping cart.

Here’s an example of what an automated invitation might look when it appears to customers:

169

Automated Chat Invitations—Generally AvailableService



To get started with automated chat invitations, from Setup, click Customize > Live Agent > Chat Buttons & Invitations.

For more information on setting up and customizing automated chat invitations, see the “Live Agent Automated Chat
Invitation Overview” in the Salesforce Help in the Salesforce Help.

Customize Supervisor Settings
Customize supervisors’ settings for all of your Live Agent configurations to give supervisors the permissions they need to
monitor their agents effectively.

On the Live Agent Configurations page, administrators can now customize supervisors’ settings to make it easier for them to
monitor their agents’ activities. For example, you can select whether or not supervisors can monitor their agents’ ongoing chats
or send whisper messages to agents during their chats with customers, and define default filters to sort agents in the Agent
Status list in the Supervisor Panel.

To get started with supervisor settings, in Setup, click Customize > Live Agent > Live Agent Configurations.

Merge Fields Available for Custom Agent Name and Auto
Greetings

Incorporate merge fields into your Live Agent custom agent name and automatic chat greetings to personalize the chat
experience for agents and customers.

These merge fields let you personalize the agent name and greeting as they appear to customers when they start a chat with
an agent. For example, you can use merge fields to display the custom agent name as the agent’s first name using the First
Name merge field, or incorporate the Visitor Name merge field into your message to greet the customer by name. You can
use merge fields in the Custom Agent Name and Auto Greeting fields associated with Live Agent Configurations, chat
buttons, or automated invitations.

To see a full list of the merge fields you can use in your Live Agent configurations, in Setup, click Customize > Live Agent
> Live Agent Configurations > Available Merge Fields.
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To see a full list of merge fields available for your chat buttons or invitations, in Setup, click Customize > Live Agent > Chat
Buttons and Invitations > Available Merge Fields.

For more information about customizing agent names, see Customize Agent Names.

Customize Agent Names
Customize an agent’s name as it appears to customers to personalize the chat experience.

On the Live Agent Configurations page, you can now customize the name of the agents associated with that configuration
using merge fields in the Custom Agent Name field.

To customize agent names associated with Live Agent Configurations, in Setup, click Customize > Live Agent > Live Agent
Configurations.

On the Chat Buttons and Invitations page, you can customize agent names that are associated with specific buttons or chat
invitations.

Note:  The custom agent name associated with a chat button or invitation will override the custom agent name
associated with a Live Agent configuration.

To customize agent names associated with chat buttons or invitations, in Setup, click Customize > Live Agent > Chat Buttons
and Invitations.

Merge fields let you personalize the agent’s name as it appears to customers and in the associated chat transcript. For example,
use the First Name merge field for your custom agent name to display an agent’s first name in customer chats.

For more information on merge fields, see Merge Fields Available for Custom Agent Name and Auto Greetings.

Create, Delete, and Edit Live Agent Session Records
Create, delete, and edit Live Agent session records to keep your organization’s customer service information up-to-date.

Previously, session records were created automatically whenever an agent logged into Live Agent. However, you could not
create a new record from scratch, delete an old record, or edit standard fields on existing records.

These changes give your agents and supervisors more power to control session records and their content, letting you keep
session records relevant and up-to-date.

To start working with Live Agent session records, click the Live Agent Sessions tab.

Critical Wait Alerts for Unanswered Chats
Optimize agents’ response times by alerting them to answer an engaged chat after a certain amount of time while they chat
with customers in the Salesforce console.

On the Agent Configuration page in Setup, we’ve added the Critical Wait Alert Time field, which allows you to select how
many seconds an agent has to answer a customer’s chat before the chat tab alerts the agent to answer it. Your agents no longer
have to guess how long they can wait to answer a chat, optimizing their time to help customers solve their problems more
quickly.

To get started with these alerts, from Setup, click Customize > Live Agent > Agent Configurations.
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Filter Agents by Button and Status in the Supervisor Panel
Filter the Agent Status List in the Supervisor panel using enhanced filters to better monitor agents’ activities.

Previously, supervisors could only filter their Agent Status list by the skills that were associated with their agents. Now,
supervisors are able to filter their Agent Status list by their agents’ skills plus the following new criteria:

• Buttons—Lets you view a list of agents who are associated with a specific button.

• Status—Lets you view a list of agents who have a particular status, such as Online, Away, or Offline.

With these enhanced filtering options, supervisors can more closely monitor agents’ activities, choosing to view only lists of
agents that are relevant to their interests. The new filters appear at the top of the Agent Status list:

Enable Live Agent’s Pre-Chat API
Protect sensitive customer information by controlling developers’ access to the Pre-Chat API.

The Pre-Chat API is a Live Agent API that allows developers to access information that customers provide in the pre-chat
forms they complete before they begin chatting with an agent. Because the API gives developers access to potentially sensitive
customer information, an administrator must first enable access to the Pre-Chat API on a particular deployment.

To give developers access to the Pre-Chat API, in Setup, click Customize > Live Agent > Deployments, then select Allow
Access to Pre-Chat API.

User Interface Improvements for Live Agent Components
There are several changes to the look and feel of the Live Agent application in the Salesforce console, making Live Agent
more modern and easier to use.

Chat Tab Alerts for Waiting and Ended Chats

Notifications in chat tabs for Live Agent in the Salesforce console alert agents who haven’t answered a customer’s chat in a
certain amount of time, or if the customer terminates the chat.

Preview Chat Requests and Transfers

Preview customer information for new chat requests and chat transfers to get up to speed on the customer’s issue before
accepting a request in the Salesforce console.

Updated Look for the Chat Request List

The Live Agent chat request list in the Salesforce console got a facelift to make it easier to use.

Updated Look for the Agent Chat Window

The chat window for agents using Live Agent in the Salesforce console now has a more modern look to improve agents’ chat
experience.
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Setup Label Changed from “Agent Configurations” to “Live Agent Configurations”

The former “Agent Configurations” label has been changed to “Live Agent Configurations” in the Live Agent setup menu
to better describe the functionality of the page.

Chat Tab Alerts for Waiting and Ended Chats
Notifications in chat tabs for Live Agent in the Salesforce console alert agents who haven’t answered a customer’s chat in a
certain amount of time, or if the customer terminates the chat.

If an agent leaves a customer’s chat unanswered for a certain amount of time, the tab associated with that chat flashes red with
an exclamation point to alert the agent to attend to that customer. You can customize how long an agent can wait to answer
a chat before they receive this alert by editing the Critical Wait Alert Time on the Agent Configuration page in Setup.
For more information on this new setting, see Critical Wait Alerts for Unanswered Chats.

If a customer terminates a chat with an agent, the tab associated with that tab displays an icon to show that the customer left
the chat.

With these tab alerts, your agents can optimize their time as they chat with multiple customers without switching from tab
to tab. Here’s how the new tab alerts appear to agents:

Preview Chat Requests and Transfers
Preview customer information for new chat requests and chat transfers to get up to speed on the customer’s issue before
accepting a request in the Salesforce console.

Your agents can get up to speed on the customer’s issues and concerns before they accept a chat with a customer. When agents
receive a new chat request, they can hover over the request in the chat request window and preview details about the customer,
such as the customer’s name, email address, and the last page they viewed on your website. When agents receive a chat transfer
request, they can hover over the request and see the customer’s details as well as the transcript of the customer’s previous chat,
if applicable. This ensures that your agents are prepared to answer a customer’s questions as quickly as possible.
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Here’s what an agent might see when they hover over a chat or transfer request in the Salesforce console:
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Updated Look for the Chat Request List
The Live Agent chat request list in the Salesforce console got a facelift to make it easier to use.

Here are some of the updates we made to the chat request list to improve your agents’ chatting experience:

• The name of the chat button from which the chat was initiated is now displayed on every request. Previously, agents could
only see the name of the deployment from which the chat was initiated.

• Action items display directly on each request. Previously, agents had to click on the request to accept or reject a chat.

• We’ve improved the organization of elements in the list. For example, the Status drop-down list is now on the right side,
and the number of pending chat requests is displayed to the left of the Requests label.

• Unanswered chat requests are highlighted in yellow. Previously, requests were highlighted in blue when agents clicked on
them.

Here’s how the new chat request list compares to the old one:
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Updated Look for the Agent Chat Window
The chat window for agents using Live Agent in the Salesforce console now has a more modern look to improve agents’ chat
experience.

We made several small changes to the design of the agent chat window to make it sleeker and easier to use:
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• The customer name now appears in red, and the visitor name appears in blue.

• The Transfer button in the upper right part of the chat window has been changed to a transfer icon in the upper left part
of the window. The new icon is grayed out if agents don’t have permission to transfer chats.

• The gray border around the chat in the window has been removed.

• “Write a message...” now appears in the agent’s input area.

Note:  This doesn’t appear in the chat log if you’re using Internet Explorer versions 8 or 9.

Here’s how the agent chat log has changed since the last release:

Setup Label Changed from “Agent Configurations” to “Live Agent
Configurations”

The former “Agent Configurations” label has been changed to “Live Agent Configurations” in the Live Agent setup menu to
better describe the functionality of the page.
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To access the Live Agent Configurations page, in Setup, click Customize > Live Agent > Live Agent Configurations.

API Improvements for Live Agent
The Live Agent APIs include new methods to make developing for Live Agent incredibly powerful, giving your developers
more control to customize how Live Agent works for your organization.

Live Agent API Versions

The Live Agent Deployment API and Pre-Chat API are now versioned to match other Salesforce APIs.

Access Your Live Agent API Endpoint

Access your organization’s Live Agent API endpoint to allow your developers to customize Live Agent.

Live Agent Deployment API: New Methods

Several methods have been added to Live Agent’s Deployment API to let you to search for or create new customer records
automatically when an agent accepts a chat request.

Live Agent Pre-Chat API: Generally Available

The Live Agent Pre-Chat API allows you to access customer details from pre-chat forms to better incorporate them into
the customer service experience. With this release, the Live Agent Pre-Chat API is generally available.

Live Agent REST API: Generally Available

The Live Agent Pre-Chat API allows you to access customer details from pre-chat forms to better incorporate them into
the customer service experience. With this release, the Live Agent Pre-Chat API is generally available.

Live Agent API Versions
The Live Agent Deployment API and Pre-Chat API are now versioned to match other Salesforce APIs.

Different methods and parameters are available in different versions of Live Agent’s APIs. Before you begin developing with
these APIs, make sure you’re using the correct version number in your code.

Deployment API Versions

You can find out what version of the Deployment API your organization uses from the deployment code that’s generated after
you create a deployment.

Summer ’13 and earlier releases support version 28.0 of the Deployment API. The URL for API version 28.0 looks like this:
https://hostname.salesforceliveagent.com/content/g/deployment.js

Winter ’14 supports version 29.0 of the Deployment API. The URL for API version 29.0 contains the version number:
https://hostname.salesforceliveagent.com/content/g/js/29.0/deployment.js

Note:  To use new methods and parameters in your deployments, you must update the deployment code on each of
your Web pages to use the URL for version 29.0 of the Deployment API.

For more information about updates to the Deployment API, see Live Agent Deployment API: New Methods on page 179.

Pre-Chat Information API Versions

Winter ’14 supports version 29.0 of the Pre-Chat API. The URL for API version 29.0 contains the version number:
https://hostname.salesforceliveagent.com/content/g/js/29.0/prechat.js

You can find your organization’s hostname by looking in the deployment code that’s generated after you create a deployment.
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Access Your Live Agent API Endpoint
Access your organization’s Live Agent API endpoint to allow your developers to customize Live Agent.

We’ve included the non-editable Live Agent API Enpoint field on the Live Agent Settings page. Use this Live Agent
API endpoint to complete the URLs to call Live Agent REST API resources.

To find your organization’s Live Agent API endpoint, from Setup, click Customize > Live Agent > Settings.

Live Agent Deployment API: New Methods
Several methods have been added to Live Agent’s Deployment API to let you to search for or create new customer records
automatically when an agent accepts a chat request.

DescriptionMethod

Finds or creates a record of the specified type when an agent accepts a chat
request.

findOrCreate

Searches for or creates records that contain customer data specified by the
addCustomDetail Deployment API method.

findOrCreate.map

Saves the record that you found or created using the findOrCreate and
findOrCreate.map Deployment API methods to the chat transcript
associated with the chat.

findOrCreate.saveToTranscript

Opens the record you found or created using the findOrCreate and
findOrCreate.map Deployment API methods automatically in a subtab in
the to the Salesforce console.

findOrCreate.showOnCreate

Links the record that you found or created using the findOrCreate and
findOrCreate.map Deployment API methods to another record of a different
record type that you created using a separate findOrCreate API call.

findOrCreate.linkToEntity

For more information (English only) about the Live Agent Deployment API, see the Live Agent Developer’s Guide.

Live Agent Pre-Chat API: Generally Available
The Live Agent Pre-Chat API allows you to access customer details from pre-chat forms to better incorporate them into the
customer service experience. With this release, the Live Agent Pre-Chat API is generally available.

The following Live Agent Pre-Chat API methods are available in API version 29.0 and later.

DescriptionResource

Searches for or creates records that contain the customer data specified in the
pre-chat form completed by the customer. This method maps the value of the
custom details to the fields on the specified record in the Salesforce console.

findOrCreate.map

Specifies which fields in your findOrCreate.map method to use to search
for an existing record. You can search for one or more fields within records.

findOrCreate.map.doFind
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DescriptionResource

Specifies which fields in your findOrCreate.map method require an exact
field name match when you search for existing records. You can specify this for
one or more fields within records.

findOrCreate.map.isExactMatch

Specifies which fields in your findOrCreate.map method to use to create a
new record if an existing record isn’t found. You can specify one or more fields
for creating new records.

findOrCreate.map.doCreate

Saves the record that you found or created using the
findOrCreate.map.doCreate or findOrCreate.map.doFind Pre-Chat

findOrCreate.saveToTranscript

API methods to the chat transcript associated with the chat when the chat
ends.

Opens the record you found or created using the
findOrCreate.map.doCreate and findOrCreate.map.doFind
Pre-Chat API methods automatically in a subtab in the to the Salesforce console.

findOrCreate.showOnCreate

Links the record that you found or created using the
findOrCreate.map.doFind and findOrCreate.map.doCreate

findOrCreate.linkToEntity

Pre-Chat API methods to another record of a different record type that you
created using a separate findOrCreate.map API call.

Specifies which pre-chat details to display to an agent in the Details tab in
Salesforce console when the agent receives a chat request.

findOrCreate.displayToAgent

Extracts the custom details that have been passed into the chat through the
addCustomDetail Deployment API method and integrates them into a
pre-chat form.

preChatInit

For more information (English only) about the Live Agent Pre-Chat API, see the Live Agent Developer’s Guide.

Live Agent REST API: Generally Available
The Live Agent REST API allows you to customize and extend the functionality of Live Agent chat windows in your company’s
mobile and Web applications. With this release, the Live Agent REST API is generally available.

With the Live Agent REST API, you no longer have to rely on Visualforce to develop customized chat windows. The Live
Agent REST API resources let your developers extend the functionality of chat windows beyond simple HTML and JavaScript
environments, allowing them to develop chat windows that merge seamlessly into your company’s own applications.

The following Live Agent REST API resources are available in API version 29.0 and later.

DescriptionResource

Initiates a new chat visitor session.ChasitorInit

Indicates that the chat visitor is not typing in the chat window.ChasitorNotTyping

Reestablishes the chat visitor’s state, including the details of the chat, after
aResyncSession request is completed.

ChasitorResyncState

Provides a chat visitor’s message that is viewable through Sneak Peek.ChasitorSneakPeek

Indicates that a chat visitor is typing a message in the chat window.ChasitorTyping
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DescriptionResource

Indicates that a chat visitor has ended the chat.ChatEnd

Returns the body of the chat message sent by the chat visitor.ChatMessage

Indicates a custom event was sent from the chat visitor during the chat.CustomEvent

Returns all events that were sent between agents and chat visitors during a chat
session.

Messages

Batches multiple POST requests together if you’re sending multiple messages
at the same time.

MultiNoun

Reestablishes a customer’s chat session on a new server if the session is
interrupted and the original server is unavailable.

ResyncSession

Establishes a new Live Agent session on the Live Agent servers.SessionId

For more information (English only) about the Live Agent REST API, see the Live Agent REST API Developer’s Guide.

Open CTI
Open CTI helps partners integrate Salesforce with computer-telephony integration systems without installing adapter programs
on call center users’ machines. Open CTI has several new and improved features in Winter '14.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Force.com Canvas for Open CTI

Now you can add Force.com Canvas applications to Open CTI.

New Open CTI Method: notifyInitializationComplete()

Advanced administrators and developers can now specify a standby URL for a SoftPhone.

Force.com Canvas for Open CTI
Now you can add Force.com Canvas applications to Open CTI.

This means you can take your new or existing applications and make them available to users as part of their call-control tool
with Salesforce.

Open CTI and Force.com Canvas are similar—they’re a set of tools and JavaScript APIs that developers can use to add
third-party systems to Salesforce. Together, they let developers add applications to computer-telephony integration (CTI)
systems that are fully integrated parts of Salesforce. Note that after you add a canvas app to Open CTI, you must add it to
your call center’s definition file for it to appear.

For more information (English Only), see the Force.com Canvas Developer’s Guide and the Open CTI Developer’s Guide.

New Open CTI Method: notifyInitializationComplete()
Advanced administrators and developers can now specify a standby URL for a SoftPhone.
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Open CTI is an API that provides programmatic access to Salesforce for computer-telephony integration (CTI) systems.
Open CTI lets developers:

• Build CTI systems that integrate with Salesforce without the use of CTI adapters.
• Create customizable SoftPhones (call-control tools) that function as fully integrated parts of Salesforce and the Salesforce

console.
• Provide users with CTI systems that are browser and platform agnostic, for example, CTI for Microsoft® Internet Explorer®,

Mozilla® Firefox®, Apple® Safari®, or Google Chrome™ on Mac, Linux, or Windows machines.

With Winter '14, the following new method is available.

DescriptionMethod

Notifies Salesforce that the SoftPhone initialization is
complete and that Salesforce should not switch to a standby

notifyInitializationComplete()

URL. While the SoftPhone initializes, a loading icon displays
in the SoftPhone area.

To use a standby URL, you must specify it in the call center’s
definition file.

For information (English only) on customizing and building CTI systems with Open CTI, see the Open CTI Developer’s
Guide.

Salesforce Console for Service
The Salesforce Console for Service is an app that’s designed for users in fast-paced environments who need to find, update,
and create records quickly to support their customers. The Salesforce Console for Service has several new and improved features
in Winter '14.

Available in: Enterprise, Performance, Unlimited and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

Service Cloud Console Name Change

Console apps are available in both Service Cloud and Sales Cloud. To simplify support and documentation, the Service
Cloud Console has been renamed Salesforce Console for Service.

Salesforce Console Supports Microsoft® Internet Explorer 10®

The Salesforce console is available for use with Microsoft’s Internet Explorer® 10 browser.

Lookup Components for the Salesforce Console

You can use point-and-click to add lookup fields as custom console components.

Home Tab for the Salesforce Console

Administrators can add the Home tab to a Salesforce console.

Most Recent Items

You can quickly access the last ten tabs you viewed or edited in the Salesforce console, without having to search Salesforce.
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Keyboard Shortcuts Panel

Now you can open a panel in the Salesforce console to refer to a list of keyboard shortcuts.

Force.com Canvas for the Salesforce Console

Now you have a new option to add external applications to a Salesforce console.

Salesforce Console Integration Toolkit: New Methods

The Salesforce Console Integration Toolkit is an API that provides advanced administrators and developers programmatic
access to the console so they can extend it to meet your business needs.

Service Cloud Console Name Change
Console apps are available in both Service Cloud and Sales Cloud. To simplify support and documentation, the Service Cloud
Console has been renamed Salesforce Console for Service.

In the Setup area, the menu names have changed to reflect the console app’s name change. From Setup, administrators should
click Customize > Console to administer console apps.

Salesforce Console Supports Microsoft® Internet Explorer 10®

The Salesforce console is available for use with Microsoft’s Internet Explorer® 10 browser.

Lookup Components for the Salesforce Console
You can use point-and-click to add lookup fields as custom console components.

Custom console components let you customize, extend, or integrate the footer, sidebars, highlights panels, and interaction
logs of a Salesforce console. Previously, you had to create a Visualforce page to display a lookup field as a component related
to a record on a primary tab or subtab. Now you can add the same functionality with the click of a few buttons.

Adding Lookup Components

Adding Lookup Components

User Permissions Needed

“Customize Application”To add custom console components:

“Customize Application”To create Visualforce pages:

“Customize Application”To manage canvas apps:

To add a lookup field as a custom console component:

1. For standard objects, from Setup, click Customize > Object > Page Layouts.

For custom objects, from Setup, click Create > Objects, then choose the object.

2. Click Edit next to a page layout.
3. Click Custom Console Components.
4. Next to the sidebar in which you want to add a lookup field component, choose Lookup from Type.
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5. Select the lookup field’s name.
6. Enter the height or width of the component as it should display in a console.
7. Click Save.

Optionally, you can add more fields to the lookup component by defining the object’s mini page layout. For more information,
see “Defining Mini Page Layouts for the Agent Console” in the Salesforce Help.

Note:  You can’t add lookup components to packages on the AppExchange.

Home Tab for the Salesforce Console
Administrators can add the Home tab to a Salesforce console.

The Home tab lets users create Chatter posts, view dashboard snapshots, and view tasks on a calendar. To include the Home
tab on a console, administrators must add the Home tab to the console’s navigation tab. For more information see “Creating
a Salesforce Console App” in the Salesforce Help.

Most Recent Items
You can quickly access the last ten tabs you viewed or edited in the Salesforce console, without having to search Salesforce.

Most recently used items are just a click away in the console’s footer—just click Most Recent.

Here’s what Most Recent Tabs looks like:

1. Primary tab
2. Subtab
3. Link to share

Viewing Recently Used Tabs
Turning on the Most Recent Tabs Component
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Viewing Recently Used Tabs

Available in: Enterprise, Performance, Unlimited and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

If set up by your administrator, you can quickly access the last ten primary tabs that you recently used in a Salesforce console.
This saves you time from searching for tabs you just viewed or edited. In addition, you can access ten subtabs from each primary
tab. To access recently used tabs, click Most Recent in the console’s footer.

• To display a recently used tab with its subtabs, click the tab’s name.
•

To display a recently used tab as a primary tab without subtabs, click  and Open in primary tab.
•

To copy the URL of a recently used tab and send it to another user, click  and Get link to share.
• To view a list of subtabs for a recently used tab, click subtab(s). When the list displays, you can click a subtab to view it;

or you can click  to copy a subtab’s URL and send it to another user.
• To clear the list of recently used tabs and start fresh, click Clear.

Items that don’t display as tabs, such as meeting request overlays, don’t display in the Most Recent footer.

Turning on the Most Recent Tabs Component

Available in: Enterprise, Performance, Unlimited and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

User Permissions Needed

“Customize Application”To turn on Most Recent Tabs:

If a Salesforce console is set up, you can add the Most Recent Tabs component to the footer. The component saves users time
by letting them quickly access the last ten primary tabs that they viewed or edited, without having to search Salesforce.

1. From Setup, click Create > Apps.
2. Select a Salesforce console app.
3. Click Edit.
4. In Choose Console Components, add Most Recent Tabs to Selected Items.
5. In Align Custom Console Component, choose whether the component will appear in the footer’s right or left side.
6. Click Save.

Keyboard Shortcuts Panel
Now you can open a panel in the Salesforce console to refer to a list of keyboard shortcuts.
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Shortcuts help you work more efficiently with a console because they let you perform actions without a mouse. When you

click  and select Show Keyboard Shortcuts in a console, you can now see combinations of keys and their actions.
Alternatively, if turned on by administrators, you can open the panel by pressing SHIFT+K. If a shortcut appears dimmed, it
hasn’t been enabled or it’s been customized.

Here’s what the keyboard shortcut panel looks like:

For more information, see “Default Keyboard Shortcuts for a Salesforce Console” and “Customizing Keyboard Shortcuts for
a Salesforce Console” in the Salesforce Help.

Force.com Canvas for the Salesforce Console
Now you have a new option to add external applications to a Salesforce console.

Previously, you had the option to integrate and extend console functions using Visualforce or the Salesforce Console Integration
Toolkit. Now, you have the additional option of using Force.com Canvas to extend or integrate a console.

Force.com Canvas and the Salesforce Console Integration Toolkit are similar—they’re a set of tools and JavaScript APIs that
developers can use to add third-party systems to Salesforce. Together, they let developers add applications to a console that
are fully integrated parts of Salesforce. One of the benefits of Force.com Canvas, however, is the ability to choose an
authentication method, such as a signed request or OAuth 2.0 protocol. Note that for a canvas app to appear in a console, you
must add it to the console as a custom console component.

For more information (English Only), see the Force.com Canvas Developer’s Guide and the Salesforce Console Integration
Toolkit Developer's Guide.
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Salesforce Console Integration Toolkit: New Methods
The Salesforce Console Integration Toolkit is an API that provides advanced administrators and developers programmatic
access to the console so they can extend it to meet your business needs.

Available in: Enterprise, Performance, Unlimited and Developer Editions with the Service Cloud

Available in: Performance and Developer Editions with the Sales Cloud

Available in: Enterprise and Unlimited Editions with the Sales Cloud for an additional cost

For example, developers can use the toolkit to open and close tabs in the console to streamline a business process.

With Winter '14, the following new methods are available.

DescriptionLive Agent Method

Accepts a chat request. Available in API version 29.0 or later.acceptChat()

Declines a chat request. Available in API version 29.0 or later.declineChat()

Ends a chat in which an agent is currently engaged. Available in API version
29.0 or later.

endChat()

Returns the string of text which is currently in the agent’s text input area in the
chat log of a chat with a specific chat key. Available in API version 29.0 or
later.

getAgentInput()

Returns the agent's current Live Agent status, such as Online, Away, or Offline.
Available in API version 29.0 or later.

getAgentState()

Returns the chat log of a chat associated with a specific chat key. Available in
API version 29.0 or later.

getChatLog()

Returns the chat keys of the chat requests that have been assigned to an agent.
Available in API version 29.0 or later.

getChatRequests()

Returns the details of the chat associated with a specific chat key. Available in
API version 29.0 or later.

getDetailsByChatKey()

Returns the details of the chat associated with a specific primary tab ID.
Available in API version 29.0 or later.

getDetailsByPrimaryTabId()

Returns the chat keys of the chats in which the agent is currently engaged.
Available in API version 29.0 or later.

getEngagedChats()

Returns the maximum chat capacity for the current agent, as specified in the
agent's assigned agent configuration. Available in API version 29.0 or later.

getMaxCapacity()
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DescriptionLive Agent Method

Registers a function to call when an agent sends a chat message through the
Salesforce console. This method intercepts the message and occurs before it is
sent to the chat visitor. Available in API version 29.0 or later.

onAgentSend()

Registers a function to call when agents change their Live Agent status, such
as from Online to Away. Available in API version 29.0 or later.

onAgentStateChanged()

Registers a function to call when a chat visitor cancels a chat request. Available
in API version 29.0 or later.

onChatCanceled()

Registers a function to call when a chat becomes critical to answer or a waiting
chat is answered. Available in API version 29.0 or later.

onChatCriticalWaitState()

Registers a function to call when an agent declines a chat request. Available in
API version 29.0 or later.

onChatDeclined()

Registers a function to call when an engaged chat ends. Available in API version
29.0 or later.

onChatEnded()

Registers a function to call when an agent receives a chat request. Available in
API version 29.0 or later.

onChatRequested()

Registers a function to call when an agent starts a new chat with a customer.
Available in API version 29.0 or later.

onChatStarted()

Registers a function to call when an engaged chat is transferred out to another
agent. Available in API version 29.0 or later.

onChatTransferredOut()

Registers a function to call when an agent's capacity for accepting chats
changes—for example, if an agent accepts a new chat, ends a currently engaged

onCurrentCapacityChanged()

chat, or otherwise changes the number of chats to which they are assigned, or
if a chat request is pushed to their chat queue. Available in API version 29.0
or later.

Registers a function to call when a custom event takes place during a chat.
Available in API version 29.0 or later.

onCustomEvent()

Registers a function to call when a new message is sent from a customer, agent,
or supervisor. Available in API version 29.0 or later.

onNewMessage()

Registers a function to call when the customer’s text in the chat window changes.
If Sneak Peek is enabled, this function is called whenever the customer edits

onTypingUpdate()

the text in the chat window. If Sneak Peek is not enabled, this function is called
whenever a customer starts or stops typing in the chat window. Available in
API version 29.0 or later.
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DescriptionLive Agent Method

Sends a custom event to the client-side chat window for a chat with a specific
chat key. Available in API version 29.0 or later.

sendCustomEvent()

Sends a new chat message from the agent to a chat with a specific chat key.
Available in API version 29.0 or later.

sendMessage()

Sets an agent's Live Agent status, such as Online, Away, or Offline. Available
in API version 29.0 or later.

setAgentState()

For more information (English only) about the toolkit, see the Salesforce Console Integration Toolkit Developer's Guide.

Console Tab
The Agent console in the Console tab combines information to help service agents do more.

New Location of Agent Console in Setup

To access the Agent Console from Setup, click Customize > Agent Console.

New Location of Agent Console in Setup
To access the Agent Console from Setup, click Customize > Agent Console.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Previously, the path from Setup was Customize > Console. This path now leads to setup for the Salesforce Console.

Customer Users
Customer users can access Salesforce through Customer Portals or communities you create.

Removed Change My Password Button For Customer Users with Single Sign-On
Change in Behavior For The Username Field On Customer Users

Removed Change My Password Button For Customer Users with
Single Sign-On

If a customer user with Single Sign-On views their profile from the Welcome Component in their portal, the Change My
Password button is no longer visible. Customer users with single sign-on must contact their portal administrator for help
resetting their password.
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Change in Behavior For The Username Field On Customer Users
Delegated external users administrators can now edit the Username field for customer users, if the customer user doesn’t have
the Single Sign-On permission. Their ability to edit this field is not affected by whether they are assigned the Single Sign-On
permission or not. Prior to the ‘Winter 14 release, delegated administrators with the Single Sign-On permission weren’t able
to edit this field for customer users.
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Analytics
The Winter ’14 release brings even more power and flexibility to reports and dashboards. You can analyze historical trends,
embed report charts in object records, and use the new analytics API to develop your own Salesforce analytics applications.

Historical Trend Reporting

On top of the standard up-to-the-minute reporting on the current state of your business, Winter ’14 adds the ability to
analyze day-to-day and week-to-week change in the Opportunities object and up to three custom objects.

Embedded Analytics

Users can now get the data they need right on their most-visited pages, without having to go to the Reports tab. You can
embed report charts in record detail pages for any standard or custom object. Users are empowered to make decisions based
on data they see in the context of the page.

Analytics API

The REST-based Analytics API will revolutionize the way you access and visualize your Salesforce data. The API gives you
programmatic access to report data defined using the report builder. You can easily integrate report data into any web or
mobile application, inside or outside the Salesforce platform. And you can define rich visualizations on top of the API to
animate the data.

Show or Hide Role Hierarchy in Reports

Salesforce hierarchies are powerful, but if yours is a little complex, it takes up valuable space in the header of your reports.
Now, a simple click lets you show or hide hierarchies on Salesforce reports.

Report Types Support for User Sharing

With Winter ’14, User Sharing is automatically available in new organizations. If your organization has enabled User Sharing,
and the internal organization-wide default for the User object is set to Private, you can allow some report users to see data
belonging to users they wouldn’t normally be able to see.

Restrict List View Creation

You can restrict some users’ ability to create list views, so you don’t have too many list views cluttering users’ screens.

Analytics Folder Sharing is On By Default

The new report and dashboard folder sharing model, introduced in Summer ’13, is enabled by default for new organizations
created in Winter ’14 or later. In existing organizations, you must use the Setup menu to activate it.

Resize the Reports and Dashboards Folder List

On the Reports tab, you can now drag to resize the left pane, where report and dashboard folders are listed, so you can see
the full name of any report folder.

Report Charts from Page Layouts in the Metadata API

The metadata for report charts added to standard or custom object detail page layouts (LayoutItem) is now available for
packaging via the Metadata API.

Format of Report Object in the SOAP API

When you query the Salesforce Report object in the SOAP API using SOQL, you can filter or sort by the Format of the
report.
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Historical Trend Reporting
On top of the standard up-to-the-minute reporting on the current state of your business, Winter ’14 adds the ability to analyze
day-to-day and week-to-week change in the Opportunities object and up to three custom objects.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Creating historical views of your organization’s data has never been easier. As you work towards your sales goal, what deals
are pushing out? Pulling in? Getting bigger? Historical trending helps you analyze this kind of change as you work in Salesforce.

Historical trending comes with a new custom report type designed to highlight changes between five snapshot dates, such as
five business days or five business weeks. You can visually represent the data changes in charts and on dashboards. You can
also create and customize historical trending reports via the Metadata API and the new Analytics API.

For existing organizations, you must activate historical trend reporting in the Setup menu. For new organizations created in
Winter ’14 and thereafter, it is activated by default.

Figure 1: (1) Snapshot up to five dates to track day-to-day or week-to-week trends. (2) Current and historical values
are shown side by side for easy comparison. (3) Changed dates and amounts are highlighted in red or green.

Important:  Historical trend reporting in Salesforce is not a replacement for a data warehouse and will not be extended
in the future to serve warehouse requirements. Hard system limits are enforced to ensure its usefulness for the purpose
for which it was built. This includes limits on the time duration of tracking, limits on row count, and limits on fields
and objects that are tracked.

Report on Historical Trends

Suppose you want to monitor your company’s sales pipeline to make sure it contains enough activity to meet current and
future sales goals. You'll need to compare historical and current values of key Opportunity attributes, such as dates, amounts,
and status changes, to see how the pipeline has changed over time. You may want to focus on deals whose value grew or
shrank, or deals that moved into or out of a given target period.

Watch Your Pipeline Change Over Time

Let’s say you want to know how the total value of your pipeline today compares with its value yesterday. Create a simple
report to compare the two dates.
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Limitations on Historical Trend Reporting

Historical trending in Salesforce is subject to certain limits on the time during which data is tracked, the number of rows of
data, and the fields and objects you can track. These limits are designed to restrict the data set so that reports return data
quickly.

Report on Historical Trends
Suppose you want to monitor your company’s sales pipeline to make sure it contains enough activity to meet current and future
sales goals. You'll need to compare historical and current values of key Opportunity attributes, such as dates, amounts, and
status changes, to see how the pipeline has changed over time. You may want to focus on deals whose value grew or shrank,
or deals that moved into or out of a given target period.

Salesforce makes three months of historical data available for you to analyze. (The amount of historical data you can work
with in practice depends on your organization’s data design and use patterns.) You can select up to five date snapshots in that
span to compare, using up to four historical filters.

Note:  The system is optimized for day-to-day and week-to-week reporting. Using longer durations is not recommended
and may result in reports timing out and not returning. For small companies with fewer Opportunities records,
month-to-month trending may work, but this is not a design goal of the feature.

Set Up Historical Trend Reporting
To make historical trend reports available to your users, use filters to configure the amount of data that’s captured for historical
reporting and then select the fields that will be available for historial reports.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

Shape your historical trend data so that there’s enough for users to exploit but it doesn’t exceed the space limits. Consider
which fields contain historical data that your users will want to analyze, and which fields contain data you can leave out.

Important:  Retaining historical data increases the amount of data you need to store. The effect depends on the ways
your organization works. For example, if someone updates the status of a typical opportunity record every day or two,
the historical trending data for the Status field on the Opportunity object will take up more space than it would if
opportunity status values changed only once or twice a month. You’ll get an email alert if any of your trended objects
is in danger of exceeding the data limit.

1. From Setup, click Customize > Reports and Dashboards > Historical Trending.
2. Select the object that you want to do historical trend reporting on.

You can select Opportunities and up to three custom objects.

3. Select Enable Historical Trending.
4. Use the filters under Select Data to narrow down the records that your historical trending reports will include.

For example, to drop out the least likely deals, set Stage not equal to Prospecting.
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Note:  You’re working with fields in this step, but you’re not yet selecting the fields that will be available for
historical trending reports. All you’re doing here is specifying the total amount of data that will be captured for
historical trend reports.

5. Under Select Fields, choose up to eight fields to make available for historical trend reporting.

Users will be able to select these fields when they create historical trending reports.

Note:  For Opportunities reporting, five fields are preselected: Amount, Close Date, Forecast Category, Probability,
and Stage. You can add three more.

After you enable historical trending, a new custom report type is available for users to choose when they create a new report.
If you enable historical trending on a new field, that field is automatically added to the historical trending report layout.

If you need to turn off historical trending, keep these points in mind.

• When you turn off historical trending for a field, that field’s historical data is deleted.
• When you turn off historical trending for an object, all historical data and configuration settings are deleted for that object,

including the object’s historical trending report type and any reports that have been created with it.
• When you turn off historical trending for a field, and then delete that field, the field’s historical data will not be available

if historical trending is enabled again.

Note:

• The historical fields available to each user depend on the fields that user can access. If your permissions change
and you can no longer see a given field, that field’s historical data also becomes invisible.

• Each historical field has the same field-level security as its parent field. If the field permissions for the parent field
change, the historical field’s permissions change accordingly.

Watch Your Pipeline Change Over Time
Let’s say you want to know how the total value of your pipeline today compares with its value yesterday. Create a simple report
to compare the two dates.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Create and Customize Reports”

AND

“Report Builder”

To create, edit, and delete reports:

1. Create an opportunity history report.

a. On the Reports tab, click New Report.
b. Under Select Report Type > Opportunities, select Opportunities with Historical Trending.
c. Click Create.

2. For Show, select All Opportunities.

Note that the default value in the Historical Date Field is Yesterday, and the Amount (Historical) field
shows yesterday’s date.
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Tip:  “Yesterday” is a rolling date value, meaning that it points to a date that is relative to today’s date. If you run
this same report tomorrow, Amount (Historical) will show today’s date.

3. Click the down arrow in the headers of the Amount (Historical) and the Amount—Today columns. Click Summarize
This Field, then select Sum.
The total amount appears at the bottom of each column.

4. Click the down arrow in the header of the Amount column and select Show Changes.
5. Click Run Report.
6. In the Change column, observe the difference between the total value of the Amount (Historical) column and that

of the Amount–Today column.

Tip:  You can see changes at a glance by looking for values that are colored green or red.

You’ve created a simple historical trending report that can help you analyze your pipeline’s behavior.

Limitations on Historical Trend Reporting
Historical trending in Salesforce is subject to certain limits on the time during which data is tracked, the number of rows of
data, and the fields and objects you can track. These limits are designed to restrict the data set so that reports return data
quickly.

• You can make up to three months of data available for historical trend reporting.
• Up to 5 million rows of historical trending data can be stored for each object. Historical data capture stops when the limit

is exceeded. The admin is alerted by email when any object reaches 70 percent of the limit, and again if the limit is exceeded.
• Each historical trend report can contain up to 100 fields. In Opportunities reports, this includes the standard preselected

fields, which can’t be disabled.
• You can specify up to five historical snapshot dates in each historical trend report.
• You can use up to four historical filters on each historical trend report.
• These field types are supported: Number, Currency, Date, Picklist.
• Internet Explorer 6 is not supported.
• The Report Wizard is not supported. Historical trend reports can only be created with the Report Builder.

Important:  If a picklist field is already being used in a historical trending data filter, think hard before changing any
of its values. You could make that field less useful for historical reporting in the future.

Embedded Analytics
Users can now get the data they need right on their most-visited pages, without having to go to the Reports tab. You can
embed report charts in record detail pages for any standard or custom object. Users are empowered to make decisions based
on data they see in the context of the page.
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Available in: All editions except Database.com

User Permissions Needed

“View Setup”To view page layouts:

“Customize Application”To embed charts on page layouts:

For example, here’s an opportunity record that shows key data directly on its detail page.

Adding a Report Chart to a Page Layout

To embed a report chart on standard or custom object pages, edit the object’s page layout with the enhanced page layout
editor, then add the chart.

Example of Report Charts on an Account Page

In this example, we've embedded two report charts on an important account page that show deals in the pipeline and open
support cases for the account. From looking at the charts, the account executive can quickly gauge the account’s activity and
health.

Limits on Report Charts in Pages

Consider these limits when embedding charts in detail pages.

Adding a Report Chart to a Page Layout
To embed a report chart on standard or custom object pages, edit the object’s page layout with the enhanced page layout editor,
then add the chart.

Available in: All editions except Database.com
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User Permissions Needed

“View Setup”To view page layouts:

“Customize Application”To edit page layouts:

Before you add a chart, check that:

• Its source report is in a folder that’s shared with users who need access. Reports in personal report folders are unavailable
to add to a page.

• The source report format is summary or matrix.
• The source report has a chart.

1. Go to the page layout editor for the object you’re adding a chart to.

• For a standard object, from Setup, click Customize > Object > Page Layouts.
• For a custom object, from Setup, click Create > Objects, then choose the object.

2. Click Edit next to the page layout.
3. Click Report Charts.

4. In the Quick Find box, type the name of the report and click  to find and select the report chart.

You can browse up to 200 recently viewed reports by chart type in the Report Charts palette.

5. Drag the chart to a new or existing section of the layout.

6. Click  on the chart to customize it.
7. Click Save.

The Preview As option is unavailable for report charts.

Example of Report Charts on an Account Page
In this example, we've embedded two report charts on an important account page that show deals in the pipeline and open
support cases for the account. From looking at the charts, the account executive can quickly gauge the account’s activity and
health.

Available in: All editions except Database.com
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Figure 2: Report Charts on an Account Page

1. The pipeline chart shows opportunities for the account in various stages including two that were won. The account executive
can hover on the chart to get the value of each opportunity (Values are highlighted if the source report chart has hover
enabled). She is able to click the chart, go to the report, and get more details for these opportunities.

2. From the charts on open cases, she can see there are a couple of unresolved support issues for the account. She can click
the chart, drill into the report for case details and follow up with the support engineers to get them resolved before a crucial
meeting with the client.

Limits on Report Charts in Pages
Consider these limits when embedding charts in detail pages.

Available in: All editions except Database.com

• You can have two report charts per page.
• You can only add report charts from the enhanced page layout editor. The mini console and the original page layout editor

are not supported.
• On detail pages, users can refresh up to 100 report charts every 60 minutes.
• Your organization can refresh up to 3,000 report charts every 60 minutes.

Analytics API
The REST-based Analytics API will revolutionize the way you access and visualize your Salesforce data. The API gives you
programmatic access to report data defined using the report builder. You can easily integrate report data into any web or mobile
application, inside or outside the Salesforce platform. And you can define rich visualizations on top of the API to animate the
data.
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To access the Analytics API, establish an authenticated OAuth session and encode responses and requests in JSON.

Available in: All editions that are API enabled except Database.com

User Permissions Needed

“Run Reports”To run reports:

Usage Example for the Analytics API

Let’s look at an example to see how easy it is to do pull data dynamically into a mobile app with the Analytics API.

Resources for the Analytics API

The Analytics API provides resources for querying report metadata and data, filtering report data dynamically, and getting
results at the summary or record detail level.

Analytics API Limits

The Analytics API has some restrictions in addition to the general API limits.

Usage Example for the Analytics API
Let’s look at an example to see how easy it is to do pull data dynamically into a mobile app with the Analytics API.

The mobile app shows a chart of all deals in the pipeline for the quarter. The data is from a sales opportunity pipeline Salesforce
report grouped by account rep and monthly quota.

Now an account rep can stay up to date on her pipeline by pulling up the chart on her phone or tablet and filtering to compare
against deals closed by her peers, or zeroing in on just those closed by her.
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Here’s how the Analytics API works behind the scenes to allow this seamless flow of data between Salesforce and the app:

• When the rep opens the app she gets the latest numbers, because the Instances resource of the API ran the Salesforce
pipeline report asynchronously. Generally, it’s a good idea to run reports asynchronously, because you can run more reports
and store results for later access. This means you can show the user current data each time she reopens the app, without
running into API limits or report timeout limits, even for reports that take longer to run.

• When the rep filters to compare against deals closed by her peers, the API does a couple of things:

1. It uses the Describe resource to fetch metadata from the Salesforce pipeline report based on her filters.
2. It then feeds this metadata in an Execute resource request to run the pipeline report synchronously (right away), which

means the results are available only for a short time. While the rep can see the data change on her phone, the underlying
source report in Salesforce is never changed by the API.

For more information and code snippets, see the Analytics API Developer Guide.

Resources for the Analytics API
The Analytics API provides resources for querying report metadata and data, filtering report data dynamically, and getting
results at the summary or record detail level.

You can run a report and get results immediately, or you can run more reports asynchronously and store their results for later
access.

Note:  You can extract report metadata and get both summary and detailed data results for all report formats except
the joined format.

The API has the following resources.

Resource URLSupported
HTTP
Method

DescriptionResource

/services/data/v29.0/analytics/reports/<report
Id>/describe

GETGives metadata for a report.
This includes information about
fields defined in the report as

Describe

detail columns,  summaries,
custom summary formulas, and
groupings.

GET,
POST

Gives summary level data with
or without details for a report.

Execute
Sync

• Summary
data:/services/data/v29.0/analytics/reports/<report
Id>

Returns specific report data if
you define filters in the
metadata of a POST request.

• Summary data with details:
/services/data/v29.0/analytics/reports/<report
Id>?includeDetails=true

POSTReturns an instance that stores
summary level data with or

Execute
Async

• Summary data:
/services/data/v29.0/analytics/reports/<report
Id>/instanceswithout details for a  report  run

• Summary data with details:
/services/data/v29.0/analytics/reports/<report
Id>/instances?includeDetails=true

asynchronously. To get specific
results, you can define filters in
the metadata of the request.
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Resource URLSupported
HTTP
Method

DescriptionResource

/services/data/v29.0/analytics/reports/<report
Id>/instances

GETLists all the instances of a report
that was run asynchronously.

Instances
List

/services/data/v29.0/analytics/reports/<report
Id>/instances/<report Instance Id>

GETDepending on the type of your
request, gives either summary
level data or both summary as

Instance
Results

well as record level data for an
instance  of a report run
asynchronously.

/services/data/v29.0/analytics/reportsGETGives a list of reports that you
most recently viewed in the

List

Salesforce app--except those in
the joined report format.

Analytics API Limits
The Analytics API has some restrictions in addition to the general API limits.

• Cross filters, standard report filters, and filtering by row limit are unavailable when filtering data.
• Historical trend reports in tabular format are unavailable.
• The API can process only reports that contain up to 100 fields selected as columns.
• The List resource returns up to 200 reports that the API user recently viewed.
• Your organization can request as many as 500 synchronous report runs per hour through the Execute Sync resource.
• The API supports as many as 20 synchronous report run requests at a time.
• The Instances List resource returns up to 2000 instances of a report that was run asynchronously.
• The API supports as many as 200 requests at a time to get results of asynchronous report runs.
• Your organization can request as many as 1200 asynchronous requests per hour through the Execute Async resource.
• Asynchronous report run results are available within a 24-hour rolling period.

Show or Hide Role Hierarchy in Reports
Salesforce hierarchies are powerful, but if yours is a little complex, it takes up valuable space in the header of your reports.
Now, a simple click lets you show or hide hierarchies on Salesforce reports.

Available in: All editions except Database.com

User Permissions Needed

“Run Reports”To view Reports:

201

Analytics API LimitsAnalytics



The role hierarchy listing at the top of Opportunity and Activity reports is now hidden by default, so you don't have to scroll
down to view the actual report data. Leaving the role hierarchy hidden can be especially handy if your organization includes
a portal, because a full listing of portal roles can take a lot of screen space to display.

Figure 3: Click Show Hierarchy to see a list of roles that have access to an Opportunity or Activity report.

Figure 4: Click Hide Hierarchy to stop seeing the list of roles.

Each user can choose to show the role hierarchy, to see exactly who has access to this report data. To show it, click Show
Hierarchy in the upper left corner of the screen where the report results appear. To hide it again, click Hide Hierarchy.

Report Types Support for User Sharing
With Winter ’14, User Sharing is automatically available in new organizations. If your organization has enabled User Sharing,
and the internal organization-wide default for the User object is set to Private, you can allow some report users to see data
belonging to users they wouldn’t normally be able to see.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

By default, these reports are accessible only to users who have the appropriate access. However, you can change the setting
such that users without the appropriate access to the relevant users can see those reports.

Additionally, some reports may display a user’s role. When a user can see a record but does not have access to the record owner,
the user can see the owner’s role on those reports.

The following report types are affected:

• Accounts

• Account Owners

• Accounts with Assets
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• Accounts with Custom Objects

• Accounts with Partners

• API Usage

• Campaigns with Opportunities

• Customizable Forecasting: Forecast History

• Customizable Forecasting: Opportunity Forecasts

• Custom Object Opportunity with Quotes Report

• Events with Invitees

• Opportunity

• Opportunity Field History

• Opportunity History

• Opportunity Trends

• Opportunities and Connections

• Opportunities with Competitors

• Opportunities with Contact Roles

• Opportunities with Contact Roles and Products

• Opportunities with Custom Objects

• Opportunities with Partners

• Opportunities with Products

• Opportunities with Products and Schedules

• Opportunities with Quotes and Quote Documents

• Opportunities with Quotes and Quote Line Items

• Opportunities with Sales Teams

• Opportunities with Sales Teams and Products

• Split Opportunities

• Split Opportunities with Products

• Split Opportunities with Products and Schedules

See User Sharing—Generally Available for more information.

Restrict List View Creation
You can restrict some users’ ability to create list views, so you don’t have too many list views cluttering users’ screens.

Available in: All editions except Database.com

A new permission, “Create and Customize List Views,” is available. Users who don’t have this permission can’t create new
list views. All users have this permission by default.

For example, suppose you want all support agents to use a shared set of list views managed by support supervisors. Assign the
“Create and Customize List Views” permission to the Support Supervisor role and remove it from the Support Agent role.

Important:  When you remove the “Create and Customize List Views” permission from a user, that user can still see
any list views they have access to. However, that user’s private list views — that is, list views that are not shared with
anyone — can’t be edited or deleted, even by users with the “Modify All Data” permission.
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Analytics Folder Sharing is On By Default
The new report and dashboard folder sharing model, introduced in Summer ’13, is enabled by default for new organizations
created in Winter ’14 or later. In existing organizations, you must use the Setup menu to activate it.

Available in: All editions except Database.com

In organizations created in Winter ’14 or later, standard report and dashboard folders are not automatically shared with portal
or community users. Portal and community users have access only to report and dashboard folders that are explicitly shared
with them.

In existing organizations, enabling analytics sharing does not change access for portal and community users. All users retain
access to report and dashboard folders equivalent to the access they had before analytics sharing was enabled.

The Setup option to enable analytics sharing does not appear in organizations created in Winter ’14 or later, because analytics
sharing is on by default.

For information about the new analytics folder sharing model, see “Share Reports and Dashboards” in the Salesforce Help.

Resize the Reports and Dashboards Folder List
On the Reports tab, you can now drag to resize the left pane, where report and dashboard folders are listed, so you can see the
full name of any report folder.

Available in: All editions except Database.com

Report Charts from Page Layouts in the Metadata API
The metadata for report charts added to standard or custom object detail page layouts (LayoutItem) is now available for
packaging via the Metadata API.

Available in: All editions except Database.com

For more information, see the Updated Metadata Types and Fields section of the release notes.
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Format of Report Object in the SOAP API
When you query the Salesforce Report object in the SOAP API using SOQL, you can filter or sort by the Format of the
report.

Available in: All editions except Database.com

This is helpful when you want to find reports by their format, which can be Tabular, Summary, Matrix, or Multiblock (Joined).
For more information, see the New and Changed Objects section of the release notes.
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Site.com
Site.com is a Web content management system (CMS) that makes it easy to build dynamic, data-driven Web pages quickly,
edit content in real time, and manage your websites.

Multilingual Site Support—Generally Available

Now generally available in Winter ’14, multilingual site support lets site administrators and designers create different language
versions of a site. And because all languages are maintained within the site, you don’t need to create and maintain a separate
site for each language.

Custom Properties for Widgets

Widgets let designers and administrators save time by building custom page elements that you and your team can reuse
throughout the site. With the introduction of custom properties in Winter ’14, you can now allow greater flexibility over
how your widgets are reused.

Sandbox Enabled for Site.com

With Winter ’14, Site.com is now supported on sandbox environments for both Site.com sites and Site.com community
sites.

HTML Import

Site.com Studio now supports importing HTML pages.

New Broken Link Finder

The broken link finder helps you search your pages for broken links. This is especially useful when importing HTML pages.

New Live Mode for Editing Content

With Live Mode, site administrators, designers, and contributors can preview pages, templates, and widgets as they would
appear to users on different platforms, such as mobile devices and computer screens.

Inline Editor

With Live Mode, you can now quickly edit text using the new inline editor. And because you’re editing the text inline, you
always know exactly how the finished page will look when it’s live.

Default Doctype Changed to HTML5

We’ve changed the default doctype property of pages from XHTML 1.0 to HTML5, which is the latest version.

Approval Processes Enabled in Site.com—Pilot

Site.com now supports approval processes.

External Reference Checking Enabled in Site.com

External reference checking is now enabled for all Site.com sites.

Additional Updates to Site.com Studio

Check out some of the other recent updates to Site.com Studio.

Organization ID Required for Domain Names

Adding a domain to Site.com or Force.com Sites organizations requires the use of an 18-character organization ID in the
CNAME target.
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New Company Community License

Available in: Developer, Enterprise, and Unlimited Editions, this is an internal user license. It’s designed for users to access
Force.com Light application custom objects, custom tabs, Chatter (people, groups, feeds, files), and a Community that
includes a Site.com site.

New Company Community Permission Set License

Use the Company Community Add-on permission set license to give read-only access to Salesforce Knowledge for users
with a Force.com user license.

Multilingual Site Support—Generally Available
Now generally available in Winter ’14, multilingual site support lets site administrators and designers create different language
versions of a site. And because all languages are maintained within the site, you don’t need to create and maintain a separate
site for each language.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

We’ve added a new Languages view (1) to the Site Configuration section of the Overview tab. In the Languages view, you
can define the default site language, choose from over 150 languages to add to your site, and manage language properties. You
can also export site content for translation, and then import the translated content back into the site.

After you add languages to the site, you’ll notice a language selector (2) that lets you switch between the available languages
when editing the content of a page. This makes content editing quick and easy because you never have to leave the page to
change to another language.

In addition, by adding a new Language Selector page element to your pages or templates, you can let site visitors choose their
preferred language from those available when viewing the site. And in case any part of the site content isn’t available in their
chosen language, you can specify a fallback language to display instead.
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For example, if a site visitor chooses Japanese from the language selector, but there’s no Japanese content available for that
page, the page displays content in the fallback language instead.

Custom Properties for Widgets
Widgets let designers and administrators save time by building custom page elements that you and your team can reuse
throughout the site. With the introduction of custom properties in Winter ’14, you can now allow greater flexibility over how
your widgets are reused.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

When you create a new widget, you can add custom properties to it and specify their values in the Properties pane. Then, by
adding custom code or content blocks to the widget, you can access the property values using expressions. Expressions serve
as placeholders for data that will be replaced with information when the page loads.

In turn, when you add the widget to a page, it creates a copy or instance of the widget. You can’t edit the widget instance, but
you can update its property values. Because expressions are just placeholders, their values are updated automatically when you
update the values in the Properties pane.

For example, let’s say you want to create a YouTube widget using the following embed code:

<iframe width="560" height="315" src="//www.youtube.com/embed/hcUaN6XBTz4" frameborder="0"
allowfullscreen></iframe>

In this case, you want users to specify which video to display when they add an instance of the widget to the page. By adding
a custom property called videoURL and specifying an initial value, you could instead use the following code:

<iframe width="560" height="315" src="{!videoURL}" frameborder="0" allowfullscreen></iframe>

Now, when users add the YouTube widget to the page, they can point to a different video by updating the videoURL property
in the Properties pane, which automatically updates the value represented by the {!videoURL} expression.
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Sandbox Enabled for Site.com
With Winter ’14, Site.com is now supported on sandbox environments for both Site.com sites and Site.com community sites.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

You can create, edit and preview sites using Site.com Studio. Using a .site file, you can also copy Site.com and Site.com
community sites from sandbox back to your production organization. This process replaces your existing site with the content
you’ve been modifying on sandbox.

Within Site.com Studio, you can preview production sites before publishing them to a live domain, but you can’t actually test
with real objects and code. Sandbox sites allow you to not just test the static content in your site, but also any dynamic data
elements in your site before publishing them.

Note:  You can’t publish sites from sandbox to a production environment.

HTML Import
Site.com Studio now supports importing HTML pages.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

With this new feature, you can now import entire websites. If you create a zipped file that includes the folder structure and
assets of your website, you can import it. Site.com will duplicate the folder structure from the zipped file when importing it.
This saves you from having to recreate your existing site and the assets from scratch.

New Broken Link Finder
The broken link finder helps you search your pages for broken links. This is especially useful when importing HTML pages.
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Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

Site.com attempts to format links correctly when importing an HTML page into your site. You can check for any links that
might still be broken using the link finder. Open the page, select  > Find Broken Links. A dialog displays showing any
broken links. To fix the link, click Edit. The link opens in the editor where you can make corrections.

New Live Mode for Editing Content
With Live Mode, site administrators, designers, and contributors can preview pages, templates, and widgets as they would
appear to users on different platforms, such as mobile devices and computer screens.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

There is also an inline editor for making quick changes to content blocks on a page.

Site.com contributors are automatically placed in Live Mode for all content editing. They can edit the content blocks they've
been given access to by the site administrators. Site administrators and designers can switch between Live and Design modes
by using the slider on the Site.com Studio toolbar. Live Mode has these options:

• The preset device  buttons quickly adjust the size of your page to preview how it looks on mobile devices, tablets,
or computer screens.

• With the slider , you can manually adjust the page to any size between 320x320 and 2880x2280 pixels.
• You can use the resizing handles at the edge of the frame to resize the screen.

• The preset  button allows you to store custom screen sizes that you use frequently.
• Rotate  changes the orientation for the screen from portrait to landscape.

Inline Editor
With Live Mode, you can now quickly edit text using the new inline editor. And because you’re editing the text inline, you
always know exactly how the finished page will look when it’s live.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

If you’re a contributor, you can use the inline editor to edit any editable text areas on the page. Editable areas display a grey
border when you hover over the text. Alternatively, if you’re a designer or site administrator, you can use the inline editor only
when you’re viewing the page in Live Mode.
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The inline editor lets you:

• Control the text style and layout (1) by:

◊ Applying bold or italic formatting

◊ Inserting numbered or bulleted lists

• Add images and hyperlinks, and remove unwanted formatting (2).

• Expand the toolbar (3) to access additional options (4–8).

• Undo and redo your edits (4).

• Control the text style and layout (5) by:

◊ Applying underline formatting

◊ Setting text alignment

◊ Applying blockquote formatting

• Set paragraph indentation (6).

• Apply paragraph and heading styles (7).

• Apply additional styles, such as highlighting (8).

Tip: Avoid applying formatting, such as different fonts or highlighting, directly to text whenever possible. Instead,
it’s best practice to use the paragraph and heading styles to quickly apply consistent formatting throughout the site.
This also ensures that all page text is updated automatically if a site administrator or designer modifies the site's
paragraph and heading styles.

Default Doctype Changed to HTML5
We’ve changed the default doctype property of pages from XHTML 1.0 to HTML5, which is the latest version.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

The Document Type Definition (DTD) or doctype of a page defines which version of HTML it’s using. This information is
used by some browsers to trigger a standard rendering mode.

As an administrator or designer, when you create a new site page or page template, its doctype property is now automatically
set to HTML5. With HTML5, you can take advantage of several semantic HTML5 elements that describe the content they
contain.

Approval Processes Enabled in Site.com—Pilot
Site.com now supports approval processes.
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Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

Note:  Approvals is currently available through a pilot program. For information on enabling approvals for your
organization, contact salesforce.com.

You can create an approval process that allows you to control content published on your site. Setting up approval processes in
Site.com is a two-part process. You first set up an approval process in your organization. After that, you must enable approvals
on your site.

Note:  Sites can't be published in a sandbox. If you approve a changelist to publish in a sandbox, the approval actions
are executed, but the changelist can only be recalled from the Change History list. It can’t be published.

After you enable approvals for a particular site, the publish process is changed into an approval process. Users see a Submit
Changes button instead of a Publish button. The process for selecting content to send for approval remains the same as the
publishing process.

When users send changes for approval, a changelist is created. Changelists are submitted for approval and acted on by any
matching Salesforce approval processes that is defined in the organization. Typically, an email is generated and sent to the
approver with a link to the changelist. When the approver clicks the link in the email, it opens up the changelist detail page
where the approver can view, approve, or reject the changes.

When approvals are enabled, additional filtering buttons appear at the top of the Change History list on the Overview tab.
During the approval cycle, all changelists are tracked in the Change History list within the site. From there, site administrators
can see the progress and state of any submitted changelist.

Let’s say your company has a policy that all new web content for a site must be reviewed and approved by the director of
marketing before it’s published. You first create an approval process in your organization that designates the site where the
changelists will come from. Next, add the director of marketing as the approver. After you’ve created the approval process,
you then turn on approvals for that site.

External Reference Checking Enabled in Site.com
External reference checking is now enabled for all Site.com sites.

Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

This functionality, previously available for other Salesforce features, is now protecting your links to real time data objects on
your site pages. For example, if someone from your organization tries to modify an object that is used in your site, they receive
a warning that the object is in use.

Additional Updates to Site.com Studio
Check out some of the other recent updates to Site.com Studio.
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Available for purchase in: Enterprise, Performance, and Unlimited Editions

Available (with limitations) in: Developer Edition

• To help you find page elements and custom widgets more easily, we added a search box to the Page Elements pane. We
also added a search box to the Page Structure pane to make it easier to find items on the page. But that’s not all! Now you
can resize both panes for a clearer view of all page elements.

• We streamlined the toolbar in the page editing view. In addition to adding the new Live Mode feature, the Page Actions

button was replaced with the  icon and the Edit Content button was removed.

• On the Overview tab, the Site Actions button was replaced with the  icon. Also, the Publish History view was renamed
“Change History” and the Recent Changes view was removed.

Organization ID Required for Domain Names
Adding a domain to Site.com or Force.com Sites organizations requires the use of an 18-character organization ID in the
CNAME target.

Available in: Enterprise, Performance, and Unlimited Editions

Currently, another organization could potentially take your domain name in the time it takes for the name to become live.
This window of opportunity is small, but adding the unique orgId to the CNAME target eliminates the problem.

The format is domain.orgID.live.siteforce.com. For example, a domain of www.example.com would have the
CNAME target of www.example.com.00dx00000000001aaa.live.siteforce.com, where 00dx00000000001aaa
is the organization ID.

If your existing domain uses the current format of domain.live.siteforce.com or subdomain.force.com as the
CNAME target, it will continue to function properly. Modifying the certificate of the domain or the composition of sites on
that domain will continue to update the domain.live.siteforce.com CNAME.

If you delete an existing domain.live.siteforce.com CNAME from your organization, you must meet the new criteria
to add the domain back again.

The 18-character organization ID appears when you add a new domain within Domain Management in Setup.
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New Company Community License
Available in: Developer, Enterprise, and Unlimited Editions, this is an internal user license. It’s designed for users to access
Force.com Light application custom objects, custom tabs, Chatter (people, groups, feeds, files), and a Community that includes
a Site.com site.

Company Community users have read-only access to Salesforce Knowledge articles and limited access to cases for creating
and reading their own cases. They can also:

• Access up to 10 custom objects and 10 custom tabs

• Use content, ideas, and answers

• Use activities, tasks, calendar, and events

• Have read-only access to accounts and contacts

New Company Community Permission Set License
Use the Company Community Add-on permission set license to give read-only access to Salesforce Knowledge for users with
a Force.com user license.

Available for an additional cost in: Enterprise, Performance, Unlimited, and Developer Editions.

Once you’ve assigned the Company Community Add-on permission set license to a user, add the “Allow View Knowledge”
permission to a permission set, and then assign that permission set to the user. See “Assigning Permission Set Licenses” in
the Salesforce Help for more information.
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Force.com Customization
Customization features enable you to expand your organization by enhancing your objects, data, and fields, customizing your
organization's look and feel, augmenting your business processes, creating websites, and creating apps—all using point-and-click
tools. Customization features also include tools to administer and secure your organization.

SalesforceA Mobile App for Administrators

Manage users and view information for Salesforce organizations from your mobile device.

Workflow for the User Object—Beta

You can now create workflow rules and actions for the User object.

Search in Setup—Beta

With Advanced Setup Search, you can search for Setup pages, custom profiles, permission sets, public groups, roles, and
users from the sidebar in Setup.

Freezing User Accounts

You can temporarily suspend a user account that requires more work to deactivate.

General Administration

Administration helps you manage your organization to suit your business needs.

Data

The Force.com platform makes it easy for you to import your data and track its history.

Business Logic and Process Automation

Workflow, Approvals, and Visual Workflow provide point-and-click tools for automating and simplifying complex business
processes.

Security

Use security to protect both your data and applications.

Sharing

Sharing improves your control over who sees what.

Globalization

Globalization tools help administrators manage multilanguage, multicurrency, and translated content.

Critical Updates

Features that are made available shortly after the release may require special preparation.

Additional Customization

Even small customization enhancements can make Salesforce easier to use.

SalesforceA Mobile App for Administrators
Manage users and view information for Salesforce organizations from your mobile device.
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The SalesforceA mobile app offers greater flexibility for Salesforce administrators. With SalesforceA, you can perform essential
user management tasks—including editing user details, resetting passwords, assigning permission sets, and unlocking, freezing,
and deactivating user accounts—all from your mobile device.

For more information, see SalesforceA on page 64.

Workflow for the User Object—Beta
You can now create workflow rules and actions for the User object.

Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Tasks, Sites, and Email Alerts are not available in Database.com

User Permissions Needed

“Customize Application”To create or change workflow rules and actions:

Note:

This release contains a beta version of workflow on the User object that is production quality but has known limitations.
To provide feedback and suggestions, go to IdeaExchange.

With support for the User object, you can set up workflow rules to:

• Send welcome email messages with training resources to newly created users.

• Send email alerts when users change roles or are deactivated.

• Use field updates to deactivate temporary employees after a specified period.

• Use outbound messages to sync user data with third-party systems.

You can now replace any Apex triggers you’ve been using to work around the previous lack of workflow on the User object.
However, don’t forget to delete those Apex triggers once you activate their equivalent workflow rules. Otherwise, both Apex
triggers and workflow rules will fire and cause unexpected results, such as overwritten field updates or redundant email messages.

Beta Limitations for Workflow on the User Object
Understand these limitations before you create workflow rules or workflow actions for the User object.

• Tasks are not supported as workflow actions for the User object.
• When setting the workflow rule criteria, you can’t select Current User fields using the picklists. You can, however, use

a formula to set the rule criteria and include fields from the current user. In the formula editor, click Insert Field, select
$User, select the field, and click Insert.

• Remember that custom validation rules run before workflow rules are executed. Refer to “Triggers and Order of Execution”
in the Force.com Apex Code Developer's Guide.

Search in Setup—Beta
With Advanced Setup Search, you can search for Setup pages, custom profiles, permission sets, public groups, roles, and users
from the sidebar in Setup.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
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User Permissions Needed

“Customize Application”To enable Advanced Setup Search:

“View Setup and Configuration”To search Setup:

Note:

• Advanced Setup Search is in beta; it is production quality but has known limitations.

• After Winter ’14 is available for your organization, it might take a few weeks before your organization’s group,
permission set, profile, and role data is indexed and searchable. During those initial weeks, searches might not
return all possible results.

To use Advanced Setup Search, enable the Advanced Setup Search user interface setting. From Setup, click Customize >
User Interface, then scroll to Enable Advanced Setup Search (Beta). If Advanced Setup Search is disabled, users
can find only Setup pages.

Advanced Setup Search is multipurpose, allowing you to use it in different ways.

• To find Setup pages, type part or all of a Setup page name in the Setup Search box. As you type in this box, you’ll immediately
see Setup pages whose names match what you're typing. Click the name of the page to open it.

• To find custom profiles, permission sets, public groups, roles, or users, enter at least two consecutive characters of the item

you want and click  or press Enter. In the Setup Search Results page that appears, select the item you want from the
list.

For example, let’s say you want to see all the workflow rules in your organization. Enter workf. As you enter letters, the Setup
menu shrinks to include only the menus and pages that match your search terms. You’ll quickly see the link for the page you
want (Workflow Rules).

Next, perhaps you want to change the password for one of your users, Jane Smith. Enter smit and click . From the Setup
Search Results page, click the Jane Smith result to go directly to her user detail page.

Tip:  When viewing setup search results, you can bookmark the results page in your Web browser to easily perform
the same search in the future. For example, if you often search for “smit”, you can bookmark the results page to
perform the same search again. The URL for this bookmark would be something like
https://MyCompany.salesforce.com/ui/setup/SetupSearchResultsPage?setupSearch=smit.

Freezing User Accounts
You can temporarily suspend a user account that requires more work to deactivate.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com
Editions

User Permissions Needed

“Manage Users”To freeze user accounts:

In some cases, you can’t immediately deactivate an account (such as when a user is selected in a custom hierarchy field). To
prevent users from logging into your organization while you perform the steps to deactivate them, you can freeze user accounts.
For example, let’s say a user, JoAnn Baker, just left your company and you want to deactivate her account. However, she’s
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selected in a custom hierarchy field, so you’ll need to perform some more steps to remove her from the field. Since you can’t
immediately deactivate her account, you can freeze it in the meantime.

To freeze a user account:

1. From Setup, click Manage Users > Users.
2. Click the name of the user whose account you want to freeze.
3. Click Freeze.

Note:  Freezing user accounts doesn’t make their user licenses available for use in your organization. You must
deactivate user accounts to make their user licenses available.

General Administration
Administration helps you manage your organization to suit your business needs.

Permission Set Licenses

You can assign permissions to give users access to certain features. However, some permissions require users to have a
permission set license before they can be assigned any permission sets containing those permissions.

Geolocation Performance Improvements

The performance of filters and queries using geolocation fields in a WHERE condition have been improved in certain
circumstances. Enabling the performance improvement requires creating a custom index on the relevant geolocation custom
field.

Rich Text Area Editor Context Menu Changes

The behavior of the context menu in the rich text field editor has changed. Previously, when right-clicking in the HTML
editing area of a rich text field, the editor-specific context menu appeared. In Winter ’14 right-clicking displays the browser’s
native context menu instead.

Permission Set Licenses
You can assign permissions to give users access to certain features. However, some permissions require users to have a permission
set license before they can be assigned any permission sets containing those permissions.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

For example, before a user can be assigned a permission set that includes the “Use Identity Connect” permission, that user
must have been assigned the Identity Connect permission set license.

Only the new permissions “Use Identity Connect” and “Sales Console” require permission set licenses. No permissions that
existed before Winter ’14 require a permission set license. Permission set licenses are superseding user feature licenses. Beginning
with Winter ’14, new features that require an additional license will require a permission set license rather than a user feature
license. This change doesn’t affect existing user feature licenses.

To purchase permission set licenses, contact your salesforce.com representative. To see an example of how to assign a permission
set license, see Assigning the Sales Console User Permission Set License on page 110.
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Geolocation Performance Improvements
The performance of filters and queries using geolocation fields in a WHERE condition have been improved in certain circumstances.
Enabling the performance improvement requires creating a custom index on the relevant geolocation custom field.

The conditions for being able to take advantage of the improved performance include the following:

• At least 100,000 records with a geolocation custom field used in a query.

• A query or filter condition that calculates and compares distances between a geolocation field on those records and another
position, using the <, >, or within operator. For example, finding all store locations within 10 miles of the customer’s
location.

• A data distribution where the typical query results are “small” compared to the overall data set. A good rule of thumb is
that typical query results should ideally be fewer than 10% of the overall records. The smaller the typical results set is
compared to the full data set, the greater the performance impact is likely to be.

These conditions are necessary, but aren’t a guarantee that an index on a geolocation field will improve performance. Many
factors affect performance, including the specific queries being performed, the influence of other indexes on those queries,
and so on. If your organization is making use of geolocation fields, and you want to investigate using a custom index to improve
performance, contact Salesforce Support to request an evaluation of your organization’s use case. If adding a custom index
improves performance, Support can add it to any of your geolocation custom fields.

Example: List View Filter
Here is a list view filter definition that might benefit from a custom index on the relevant geolocation custom field.

This list view definition includes a filter that uses a custom geolocation field, and filters using the within operator, to limit
the view to contacts who have a Home Location within 10 miles. The performance of this list view might be improved by
adding an index on the Home Location custom field.
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Example: SOQL Query
Here is a SOQL query that might benefit from a custom index on the relevant geolocation custom field.

SELECT name__c, address__c FROM Warehouses__c
WHERE (DISTANCE(warehouse_location__c, GEOLOCATION(37.775,-122.418), "mi") < 20)
ORDER BY DISTANCE(warehouse_location__c, GEOLOCATION(37.775,-122.418), "mi")

The WHERE clause is searching for records where a DISTANCE() calculation is under 20 miles. Assuming other conditions
align, this is a very good candidate for a custom index on the geolocation field.

Rich Text Area Editor Context Menu Changes
The behavior of the context menu in the rich text field editor has changed. Previously, when right-clicking in the HTML
editing area of a rich text field, the editor-specific context menu appeared. In Winter ’14 right-clicking displays the browser’s
native context menu instead.

The context menu in Salesforce Knowledge behaves differently. A right-click still accesses the HTML editor’s editor-specific
context menu. Press CTRL (CMD on Mac) and right-click to access the browser’s native context menu.

Data
The Force.com platform makes it easy for you to import your data and track its history.

Data Import Wizard—Beta
Field History Data Retention

Data Import Wizard—Beta

Available in: All Editions except Database.com

This release contains a beta version of the Data Import Wizard. The feature is automatically enabled for all organizations.

The Data Import Wizard provides a unified interface that lets you import a number of standard Salesforce objects, including
accounts, contacts, leads, and solutions. The wizard also lets you import custom objects.

To start using the new wizard, from Setup click Data Management > Data Import Wizard.

Note: The separate import wizards for accounts, contacts, leads, solutions, and custom objects are still available
during the beta. Their functionality hasn’t changed. To see a list of differences between the old and new wizards,
review the import wizards comparison table.

Field History Data Retention

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com
Editions

Earlier this year, salesforce.com announced that it would enable a feature in its Summer ’13 release to automatically delete
field history data older than 18 months for certain organizations (those created after 12:00 a.m. on June 2, 2011). As a result
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of customer feedback, we have suspended this feature. Salesforce.com is now working on a future service that will give you
the ability to retain your field history for longer periods of time. To date, we have not deleted any field history data from any
customer organization.

In Winter ’14, salesforce.com is offering a pilot feature for Field History data retention. The feature is only available through
the Salesforce Enterprise and Tooling APIs, and gives you the ability to define the field history data that you would like to
retain, and the length of time you would like to retain it. Contact your account team or Customer Support for more information
about joining the pilot.

Business Logic and Process Automation
Workflow, Approvals, and Visual Workflow provide point-and-click tools for automating and simplifying complex business
processes.

End of Support for the Legacy Desktop Flow Designer

As of Winter ’14, the legacy desktop Flow Designer is no longer supported. For more information, contact salesforce.com
Customer Support.

Approvals in the Salesforce1 Apps

In Salesforce1, users can receive approval request notifications, tap a notification to view the administrator-selected approval
page fields, and then tap Approve or Reject.

Approval Comment Merge Fields are Available in All Approvals-Related Email Alerts

The {!ApprovalRequest.Comments} merge field can be used in any approvals-related email alert.

New Limit of 30 Steps per Approval Process

The limit on the number of approval steps per approval process was increased from 15 to 30.

End of Support for the Legacy Desktop Flow Designer
As of Winter ’14, the legacy desktop Flow Designer is no longer supported. For more information, contact salesforce.com
Customer Support.

We recommend using the Cloud Flow Designer to create your flows. To get started, see the Cloud Flow Designer Workbook
and the Visual Workflow Implementation Guide.

To see how features and elements differ between the legacy desktop Flow Designer and the Cloud Flow Designer, see the
Flow Designer Matrix.

Approvals in the Salesforce1 Apps
In Salesforce1, users can receive approval request notifications, tap a notification to view the administrator-selected approval
page fields, and then tap Approve or Reject.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

The user can also:

• Submit comments with the approval or rejection.

• View the approval history related list for the record.
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All other approvals-related functionality is currently unsupported in Salesforce1. For limitations and differences from the full
Salesforce site, see Differences with Approvals on page 58.

Approval Comment Merge Fields are Available in All
Approvals-Related Email Alerts

The {!ApprovalRequest.Comments} merge field can be used in any approvals-related email alert.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Previously, all approval merge fields named {!ApprovalRequest.field_name} returned values only when used in an
approval assignment email template. When used in templates for other email alert actions—in workflow rules or approval
processes—the approval merge fields returned null.

Now, for example, if a request is rejected at any approval step, you can include the approver’s rejection comment in an email
alert to the submitter.

Note: The {!ApprovalRequest.Comments} merge field returns only the most recently entered comment in
emails for an approval step that requires unanimous approval from multiple approvers.

New Limit of 30 Steps per Approval Process
The limit on the number of approval steps per approval process was increased from 15 to 30.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

With the limit increase, you shouldn’t need to use the programmatic workaround of having Apex triggers send records through
a series of approval processes, unless, of course, your approval process requires more than 30 steps.

Security
Use security to protect both your data and applications.

RelayState Parameter Default Changed

If you use SAML 2.0, you can use the RelayState parameter to control where users get redirected after a successful login.

Entire SAML Assertion Now Signed

SAML responses now include signed assertions.

Custom Attributes for Connected Apps

Previously known as Service Provider SAML Attributes, Connected App Custom Attributes allow developers or administrators
to send user attributes to a connected app.

Automatic Installation of Salesforce Apps

Salesforce apps are now implemented as connected apps and automatically installed in your organization.

Updated Connected Apps OAuth Usage Page

The Connected Apps OAuth Usage page has been redesigned and now offers more functionality.
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Creating Service Providers as SAML-Enabled Connected Apps

You create service providers by creating a SAML-enabled connected app.

Restricting User Email Domains

You can define a whitelist to restrict the email domains allowed in a user's Email field.

Visibility and Control for Sessions and Identity Confirmation

Identity confirmation activations exposes activated device IP address and client browser information.

Session-Level Security

You can use the new security level associated with a user’s login method to restrict access to certain types of resources.

Two-Factor Authentication

Winter ’14 adds two-factor authentication, using time-based tokens for identity confirmation.

New Location of My Domain in Setup

To access the My Domain page from Setup, click Domain Management > My Domain.

Identity Provider Auto-Enabled for New My Domains

When a new My Domain is created, the SAML Identity Provider is automatically enabled, although no service providers
are configured by default.

Using OpenID Connect Authentication Providers

You can now use any third-party Web application that implements the server side of the OpenID Connect protocol, such
as Amazon, Google, and PayPal, as an authentication provider to log into your Salesforce organization, portal, or site with
single sign-on.

Mutual Authentication

You can now set up secure server-to-server connections initiated by a client.

Using Frontdoor.jsp to Log Into Salesforce

You can use frontdoor.jsp to give users access to Salesforce from a custom Web interface, such as a remote access Force.com
site or other API integration, using their existing session ID and the server URL.

Customizable Branding on Login Page

Customize the look and feel of your login page by adding a background color, logo, and right-frame content.

Add Alternate Identity Providers on Login Page

Allow users to authenticate using alternate identity providers right from your login page.

Identity License

Users with an Identity user license have access to connected apps and Chatter apps. The user must also have the “Use Identity
Features” permission.

Identity Connect License

The Identity Connect permission set license enables you to assign the “Use Identity Connect” permission to your users.
Identity Connect provides Active Directory integration.

RelayState Parameter Default Changed
If you use SAML 2.0, you can use the RelayState parameter to control where users get redirected after a successful login.
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When a service provider initiates login, the default RelayState is now /. In previous releases, the default RelayState was
/home/home.jsp.

Entire SAML Assertion Now Signed
SAML responses now include signed assertions.

SAML Identity Provider assertions are now signed with the same certificate used to sign the rest of the SAML response. The
assertions previously inherited their signature from the SAML Response signature but were not independently signed.

Custom Attributes for Connected Apps
Previously known as Service Provider SAML Attributes, Connected App Custom Attributes allow developers or administrators
to send user attributes to a connected app.

Developers can set attributes for a connected app, and administrators can delete or edit those attributes. Administrators can
also add additional custom attributes. Attributes added, edited, or deleted by administrators override attributes set by developers.

Custom attributes are available for all connected apps. When using SAML, attributes will be sent as SAML attribute statements.
When using OAuth, attributes are available as a custom_attributes object in the user’s Identity URL.

Automatic Installation of Salesforce Apps
Salesforce apps are now implemented as connected apps and automatically installed in your organization.

Salesforce apps built as connected apps have been placed into two managed packages – one for Chatter-related apps and one
for non-Chatter-related apps. To simplify administration, each package is asynchronously installed in your organization the
first time any user in the organization performs either of the following actions for any one of the Salesforce apps in the package:

• A user accesses the connected app’s OAuth approval page

• The connected app performs a refresh token flow for the app

The packages are scheduled to be available for installation starting Friday, September 20, 2013. The packages can be installed
at different times, depending upon when their apps are accessed. This means that many administrators will see Salesforce
connected apps (for example, Salesforce for Outlook), and the packages that contain these apps, installed in their organizations
with no action on their part because they were installed automatically.

Updated Connected Apps OAuth Usage Page
The Connected Apps OAuth Usage page has been redesigned and now offers more functionality.

On the updated page, you can:

• Click View App Info to go to the detail page of the connected app. Alternatively, if the connected app isn’t yet installed,
click Install.

• Click Block to end all current user sessions with the connected app and block all new sessions. Blocking an app is not
permanent. You can click Unblock to allow users to log in and access the app at another time.

Creating Service Providers as SAML-Enabled Connected Apps
You create service providers by creating a SAML-enabled connected app.
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Available in: Developer, Enterprise, Performance, Unlimited, and Database.com Editions

You can’t create service providers from the Identity Provider page anymore. Instead,

1. From Setup, click Create > Apps.
2. In the Connected Apps section, click New.
3. Enter the required Basic Information, and under Web App settings, select Enable SAML.
4. Specify the following:

Entity Id

This value comes from the service provider. Each entity ID in an organization must be unique. If you’re accessing
multiple apps from your service provider, you only need to define the service provider once, and then use the
RelayState parameter to append the URL values to direct the user to the correct app after signing in.

ACS URL

The ACS, or assertion consumer service, URL comes from the SAML service provider.

Subject Type

Specifies which field defines the user’s identity for the app. Options include the user’s username, federation ID, user
ID, a custom attribute, or an algorithmically calculated persistent ID.

Name ID Format

Specifies the format attribute sent in SAML messages. “Unspecified” is selected by default. Depending on your
SAML service provider, you may want to set this to email address, persistent, or transient.

Issuer

By default, the standard issuer for your identity provider is used (your organization’s My Domain). If your SAML
service provider requires a different value, specify it here.

The Start URL and Service Provider Certificate fields are optional.

5. Click Save.
6. Authorize users to access the SAML application by clicking Manage Apps > Connected Apps, clicking the name of the

application, and selecting the desired profiles and/or permission sets.

After a service provider is defined, you can get information about it from Setup by clicking Manage Apps > Connected Apps
and clicking the name of a connected app in the list.

Restricting User Email Domains
You can define a whitelist to restrict the email domains allowed in a user's Email field.

Available in: All Editions

User Permissions Needed

“Manage Users”To restrict user email domains:

To add an email domain to the whitelist:

1. From Setup, click Manage Users > Allowed Email Domains.
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Note:  If you don't see this page, contact your salesforce.com representative to enable it.

2. Click New Allowed Email Domain.
3. Enter a Domain.

You can enter a top-level domain, such as sampledoc.org, or a sub-domain, such as emea.sampledoc.org.

4. Click Save.

You can repeat the steps to add more email domains to the whitelist.

Once you've added one or more whitelisted email domains, the Email field for each new user must match a whitelisted domain.

The Email field for existing users doesn’t have to comply with the whitelist. However, if you edit an existing user, you must
update the Email field to match a whitelisted email domain.

Note:  The email domain whitelist doesn't apply to users external to your organization, such as portal, Communities,
or Chatter External users.

Visibility and Control for Sessions and Identity Confirmation
Identity confirmation activations exposes activated device IP address and client browser information.

Available in: All Editions

Identity confirmation is used to verify the identities of users coming from unknown devices, and adds an extra layer of security
on top of the authentication and single-sign-on features. When a user comes from an unknown device with a new IP address,
the user is challenged to provide an identity confirmation code delivered via email, SMS, or a mobile authenticator app. Once
the user completes the identity confirmation challenge, the device (and client browser) is considered activated.

Session-Level Security
You can use the new security level associated with a user’s login method to restrict access to certain types of resources.

Available in: Personal, Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, Developer, and
Database.com Editions

User Permissions Needed

“Customize Application”To set session security:

You can restrict access to certain types of resources based on the level of security associated with the authentication (login)
method for the user’s current session. By default, each login method has one of two security levels: Standard or High Assurance.
You can change the session security level and define policies so specified resources are only available to users with a High
Assurance level.

The different authentication methods are assigned these security levels, by default.

• Username and Password — Standard
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• Delegated Authentication — Standard

• Two-Factor Authentication — High Assurance

• Authentication Provider — Standard

• SAML — Standard

Note:  The security level for a SAML session can also be specified using the SessionLevel attribute of the
SAML assertion sent by the identity provider. The attribute can take one of two values, STANDARD or
HIGH_ASSURANCE.

To change the security level associated with a login method:

1. From Setup, click Security Controls > Session Settings.
2. Under Session Security Levels, select the login method.
3. Click the Add or Remove arrow to move it to the proper category.

Currently, the only features that use session-level security are connected apps, reports, and dashboards. You can set policies
requiring High Assurance on these types of resources and specify an action to take if the session used to access the resource is
not High Assurance. The two supported actions are:

• Block — This blocks access to the resource by showing an insufficient privileges error.

• Raise session level — This redirects you to a Two-Factor Authentication flow for raising the session’s security level to
High Assurance. Once you complete the flow successfully, you can access the resource.

To set a High Assurance required policy for accessing a connected app:

1. From Setup, go to Administer > Manage Apps > Connected Apps.
2. Click Edit next to the connected app.
3. Select High Assurance session required.
4. Select one of the two actions presented.
5. Click Save.

To set a High Assurance required policy for accessing reports and dashboards:

1. From Setup, go to Build > Customize > Reports & Dashboards > Access Policies.
2. Select the High Assurance session required.
3. Select one of the two actions presented.
4. Click Save.

The session levels have no impact on any resources in the app other than connected apps, reports, and dashboards for which
explicit security policies have been defined.

Two-Factor Authentication
Winter ’14 adds two-factor authentication, using time-based tokens for identity confirmation.

Salesforce uses time-based tokens from a supported mobile authenticator app as a form of two-factor authentication to verify
users’ identity and prevent unauthorized access to the service during login and whenever a High Assurance security level is
required.

Setting Two-Factor Authentication Login Requirements

Administrators can require users to enter a time-based token generated from an authenticator app on their mobile device
when they log into Salesforce.
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Using Time-Based Tokens to Access the API

Administrators can set the “Two-Factor Authentication for API Logins” permission to allow the use of a time-based token
to access the service instead of the standard security token.

Using Time-Based Tokens for Identity Confirmation

Time-based tokens can now be used in addition to SMS-based and email-based login verification to activate a computer.

Setting Two-Factor Authentication Login Requirements
Administrators can require users to enter a time-based token generated from an authenticator app on their mobile device when
they log into Salesforce.

Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit profiles and system permissions:

To require this verification every time users log into Salesforce, select the “Two-Factor Authentication for User Interface
Logins” permission in the user profile or permission set.

Note: Enhancing Security with Two-Factor Authentication (6:56 minutes)

See a demonstration of Two-Factor Authentication for Salesforce, and when to use it.

Users are prompted to add a time-based token the next time they log into Salesforce. They must enter the changing token
from their mobile app every time they log in.

Note:  Users aren’t asked for a verification code the first time they log in to Salesforce.

Once users add a time-based token to their account they can also use the token to confirm their identity when they activate
their computer. Partner Portal and Customer Portal users aren’t required to activate computers to log in.

Using Time-Based Tokens to Access the API
Administrators can set the “Two-Factor Authentication for API Logins” permission to allow the use of a time-based token
to access the service instead of the standard security token.

Available in: Enterprise, Performance, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“Manage Users”

AND

“Customize Application”

To edit profiles and system permissions:
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If users add a time-based token to their account and “Two-Factor Authentication for API Logins” permission is enabled in
their user profile or permission set, they must use this token instead of the standard security token whenever it’s requested,
such as when resetting the account’s password.

Note:  Since the “Two-Factor Authentication for User Interface Logins” permission is a prerequisite for this one,
users must add a time-based token when logging into Salesforce through the user interface if this feature is enabled.

Using Time-Based Tokens for Identity Confirmation
Time-based tokens can now be used in addition to SMS-based and email-based login verification to activate a computer.

Available in: All Editions

All users can add a time-based token to their account using a mobile authenticator app. The changing time-based token from
the mobile app can be used whenever they’re prompted to confirm their identity, such as when logging in from an unknown
IP address.

1. Download the supported authenticator app for the type of mobile device you’re using.
2. From your user detail page in Salesforce, click Add next to Time-Based Token.
3. For security purposes, you’re prompted to log into your account.
4. Scan the QR code with the authenticator app on your mobile device.

Alternatively, you can manually enter your username and the key displayed when you click Can’t scan the QR code? into
the app.

5. Enter the token generated from the mobile app into the Token field in Salesforce.

The authenticator app generates a new token every 30 seconds.

6. Click Verify and Add.

New Location of My Domain in Setup
To access the My Domain page from Setup, click Domain Management > My Domain.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions.

Previously, the path from Setup was Company Profile > My Domain.

Identity Provider Auto-Enabled for New My Domains
When a new My Domain is created, the SAML Identity Provider is automatically enabled, although no service providers are
configured by default.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions.

Previously, administrators had to access security control settings to enable the identity provider.

This change does not affect existing My Domains.
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Using OpenID Connect Authentication Providers
You can now use any third-party Web application that implements the server side of the OpenID Connect protocol, such as
Amazon, Google, and PayPal, as an authentication provider to log into your Salesforce organization, portal, or site with single
sign-on.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“View Setup and Configuration”To view the settings:

“Customize Application”

AND

“Manage Auth. Providers”

To edit the settings:

To specify authentication providers, from Setup, click Security Controls > Auth. Providers.

Mutual Authentication
You can now set up secure server-to-server connections initiated by a client.

Available in: Enterprise, Performance, Unlimited, and Developer Editions.

Salesforce now supports mutually authenticated transport layer security (TLS) on inbound connections. This allows secure
server-to-server connections initiated by a client using client certificate authentication, and means that both the client and the
server authenticate and verify that they are who they say they are. Previously, only the ability to secure outbound calls was
supported, by using mutually authenticated SSL/TLS connections.

This feature includes:

• Client certificates uploaded and stored in the database, where they are used for verification.

• A mechanism to prevent falling back to the standard TLS port.

• The ability to add certificates signed by a certificate authority (CA) trusted by Salesforce.

Setting up mutual authentication requires action by both the organization administrator and the API client manager.

Administrator Actions

1. Contact salesforce.com to have mutual authentication turned on for your organization.
2. Generate the Certificate Signing Request (CSR) for the client certificate the API client will present when attempting

to establish the mutually authenticated TLS connection to Salesforce. It’s important that the client certificate be
signed by one of the salesforce.com trusted root certificate authorities. The list is maintained here: Outbound
Messaging SSL CA Certificates.

3. Once the certificate is signed, upload the certificate to the organization at Security Controls > Certificate and Key
Management. Upload the signed client certificate to the Mutual Authentication Certificates table in order for
Salesforce to properly validate the client certificates presented by the client when initiating an inbound mutually
authenticated TLS connection.
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4. Enable the Enforce SSL/TLS Mutual Authentication user permission for the API client user. This permission forces
the use of port 8443 for secure connections.

This permission can be added to a profile or assigned to an individual user with a permission set.

API Client Manager Actions

Configure the API client to connect on port 8443 and present the client certificate. This configuration process is very
environment-specific and not under the control of salesforce.com. The client needs to be configured to present the
complete certificate chain (root > intermediate > client) to salesforce.com for the certificate to be properly validated.

For information on enabling this feature for your organization, contact salesforce.com.

Using Frontdoor.jsp to Log Into Salesforce
You can use frontdoor.jsp to give users access to Salesforce from a custom Web interface, such as a remote access Force.com
site or other API integration, using their existing session ID and the server URL.

Available in: All Editions

To authenticate users with frontdoor.jsp, you must pass the server URL and session ID to frontdoor.jsp in this format:

https://instance.salesforce.com/secur/frontdoor.jsp?sid=session_ID&retURL=optional_relative_url_to_open

Instance
You must know the instance of the user’s organization. For example, if the serverUrl returned when you log in via the API
is https://na1.salesforce.com, na1 is the instance. The rest of the server address (the salesforce.com domain
name) remains the same.

If you’re building an integration for a single Salesforce organization, you can hard-code this value. If you’re building an
integration for multiple organizations, parse the instance from the serverUrl of the returned LoginResult from the SOAP
API login() call.

Session ID
You can obtain the session ID from:

• The access_token from an OAuth authentication

Tip:  One of the scopes specified when you create a Connected App must be web or full.

• The LoginResult returned from a SOAP API login() call
• The Apex UserInfo.getSessionId()

The session ID returned using the Visualforce {!GETSESSIONID()} can’t be used on frontdoor.jsp.

Relative URL to Open
You can optionally include a URL-encoded relative path to redirect users to the Salesforce user interface or a particular record,
object, report, or Visualforce page (for example, /apex/MyVisualforcePage).
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Customizable Branding on Login Page
Customize the look and feel of your login page by adding a background color, logo, and right-frame content.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions.

User Permissions Needed

“Customize Application”To customize a login page:

Customizing your login page helps users recognize your page by tying it to your company's branding.

1. From Setup, click Domain Management > My Domain.
2. Click Edit.
3. To customize your logo, upload an image.

Images can be .jpg, .gif or .png files up to 100 KB in size. Maximum image size is 250px by 125px.

4. To customize your login page background, click the color picker or enter a valid hexadecimal color code.
5. Enter the URL to be included in the right side iframe on the login page.

Content must be located at a URL that uses SSL encryption and the https:// prefix. Maximum content size is 478px by
397px.

6. Optionally, select additional authentication services to include on your login page.
7. Click Save.

Add Alternate Identity Providers on Login Page
Allow users to authenticate using alternate identity providers right from your login page.

Available in: Group, Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions.

User Permissions Needed

“Customize Application”To add identity providers on a login page:

If you have enabled single sign-on and configured SAML, or if you have set up external authentication providers, you can
provide links to these alternate identity providers on your login page. Users will be sent to the alternate identity provider's
login screen to authenticate and then redirected back to Salesforce. Identity providers can be added by customizing your login
page.

Note:  Available authentication services include all providers configured in Security > Single Sign-On Settings and
in Security > Authentication Providers except Janrain. You must develop a custom login screen to make the Janrain
login widget available on your login page.

To include SAML identity providers as available authentication services, you must enable multiple SAML
configurations for your organization. From Setup, go to Security > Single Sign-On Settings and click Enable
Multiple Configs.

1. From Setup, click Domain Management > My Domain.
2. Click Edit.
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3. Select one or more authentication services as identity providers.
4. Click Save.

Identity License
Users with an Identity user license have access to connected apps and Chatter apps. The user must also have the “Use Identity
Features” permission.

Available for an additional cost in: Enterprise, Performance, Unlimited and Developer Editions.

Ten free Identity user licenses are included with each trial Enterprise Edition organization or new Developer Edition
organization.

After installing connected apps and Chatter apps, administrators can provide access to Identity license users through profile
and permission set assignments.

See also App Launcher for Identity License Users on page 247.

Identity Connect License
The Identity Connect permission set license enables you to assign the “Use Identity Connect” permission to your users. Identity
Connect provides Active Directory integration.

Available for an additional cost in: Enterprise, Performance, and Unlimited Editions.

Ten free Identity Connect user licenses are included with each trial Enterprise Edition organization.

Once you’ve assigned the Identity Connect permission set license to a user, add the “Use Identity Connect” permission to a
permission set and assign that permission set to the user. See “Assigning Permission Set Licenses” in the Salesforce Help for
more information.

Sharing
Sharing improves your control over who sees what.

User Sharing—Generally Available

Control who sees who in the organization with standard sharing functionality.

New Description Field for Sharing Rules

Provide a description to your sharing rules for better usability.

Sharing Records with Managers Groups

Share records up or down the management chain using sharing rules or manual sharing.

External Organization-Wide Defaults—Pilot

Eliminate sharing overhead for internal users while maintaining a Private organization-wide default for external users.

Parallel Organization-Wide Default Updates—Pilot

Speed up organization-wide default updates in large organizations.
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Asynchronous Recalculation of Sharing Rules—Pilot

Speed up sharing recalculation when creating and updating sharing rules.

Monitoring Parallel Recalculations

Monitor the progress of your parallel recalculations.

Contact Visibility under Shared Accounts

Customer Portal users gain access to other portal contacts if the contact object is Controlled By Parent.

User Sharing—Generally Available
Control who sees who in the organization with standard sharing functionality.

Available in: Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Watch a Demo: Who Sees Whom: User Sharing (6:05 minutes)

User Sharing enables you to show or hide an internal or external user from another user in your organization. Previously, User
Sharing for external users was enabled by default with Communities, while User Sharing for internal users was available through
a pilot program.

With Winter ’14, User Sharing is automatically enabled in new organizations. You can:

• Set the organization-wide defaults for user records to Private or Public Read Only.

• Create user sharing rules based on group membership or other criteria.

• Create manual shares for user records to open access to individual users or groups.

• Control the visibility of external users in customer or partner portals and communities.

Existing organizations can contact salesforce.com to enable User Sharing.

How can your organization use User Sharing? For example, you might be a manufacturer who needs to include all dealers in
your organization while still keeping them from seeing or interacting with each other. You can set the organization-wide
defaults for the user object to Private. Then, open up access among groups of dealers who need to see and interact with each
other in the organization with sharing rules or manual sharing. Additionally, you can assign the “View All Users” permission
to users who need to see everyone in the organization.

To see who you have access to, from Setup, click Manage Users > Users.

Note:  If you have access to a record owned by a user to whom you don’t have access, you’ll receive an insufficient
privileges error when hovering on the owner’s name. Similarly, on Chatter, if you lost access to a user, you cannot @
mention him or her. You’ll not be able to hover their names for a full profile nor see their profile page. But you can
@ mention the user if you are in a Chatter group together or if you are in the same conversation thread.

Understanding User Sharing

Implement User Sharing via a combination of organization-wide defaults, user sharing rules, manual sharing, and permissions.

Setting the Organization-Wide Sharing Defaults for User Records

Set the organization-wide sharing defaults for the user object before opening up access.

Creating User Sharing Rules

Share members of a group to members of another group, or share users based on criteria.
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Granting Access to User Records

Grant access to users to enable them to see and interact with you.

User Sharing Visibility for Teams

Provide better visibility controls when using Sales Teams.

Controlling Standard Report Visibility

Show or hide standard reports that might expose data of users to whom a user doesn’t have access.

Understanding User Sharing
Implement User Sharing via a combination of organization-wide defaults, user sharing rules, manual sharing, and permissions.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

With user sharing, you can set an organization-wide default for internal and external user records. You can then extend access
using sharing rules based on membership to public groups, roles, or territories, or use manual sharing to share individual user
records with other users or groups.

When you enable user sharing, users can see other users in search, list views, and so on only if they have Read access on those
users.

Review these user sharing considerations before implementing them for your organization.

“View All Users” permission

This permission can be assigned to users who need Read access to all users, regardless of the sharing settings. If you
already have the “Manage Users” permission, you are automatically granted the “View All Users” permission.

Organization-wide defaults for user records

This setting defaults to Private for external users and Public Read Only for internal users. When the default access is set
to Private, users can only read and edit their own user record. Users with subordinates in the role hierarchy maintain
read access to the user records of those subordinates.

User sharing rules

General sharing rule considerations apply to user sharing rules. User sharing rules are based on membership to a public
group, role, or territory.  Each sharing rule shares members of a source group with those of the target group. You must
create the appropriate public groups, roles, or territories before creating your sharing rules. Users inherit the same access
as users below them in the role hierarchy.

Manual sharing for user records

Manual sharing can grant read or edit access on an individual user, but only if the access is greater than the default access
for the target user. Users inherit the same access as users below them in the role hierarchy. Apex managed sharing is not
supported.

User sharing for external users

Users with the “Manage External Users” permission have access to external user records for Partner Relationship
Management, Customer Service, and Customer Self-Service portal users, regardless of sharing rules or organization-wide
default settings for User records. The “Manage External Users” permission does not grant access to guest or Chatter
External users.

235

User Sharing—Generally AvailableForce.com Customization



User Sharing Compatibility

When the organization-wide default for the user object is set to Private, User Sharing does not fully support these
features.
• Chatter Messenger is not available for external users. It is available for internal users only when the organization-wide

default for the user object is set to Public Read Only.
• Customizable Forecasts—Users with the "View All Forecast" permission can see users to whom they don't have

access.
• Salesforce CRM Content—A user who can create libraries can see users they don't have access to when adding library

members.
• Standard Report Types—Some reports based on standard report types expose data of users to whom a user doesn’t

have access. For more information, see Controlling Standard Report Visibility.

Setting the Organization-Wide Sharing Defaults for User Records
Set the organization-wide sharing defaults for the user object before opening up access.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set default sharing access:

For user records, you can set the organization-wide sharing default to Private or Public Read Only. The default must be set
to Private if there is at least one user who shouldn’t see a record.

Let’s say that your organization has internal users (employees and sales agents) and external users (customers/portal users)
under different sales agents or portal accounts, with these requirements:

• Employees can see everyone.
• Sales agents can see employees, other agents, and their own customer user records only.
• Customers can see other customers only if they are under the same agent or portal account.

To meet these requirements, set the default external access to Private, and extend access using sharing rules, manual sharing,
or user permissions.

When the feature is first turned on, the default access setting is Private for external users. The default for internal users is
Public Read Only. To change the organization-wide defaults for external access to the user object:

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. Select the default internal and external access you want to use for user records.

The default external access must be more restrictive or equal to the default internal access.

4. Click Save.

Users have Read access to those below them in the role hierarchy and full access on their own user record.

Creating User Sharing Rules
Share members of a group to members of another group, or share users based on criteria.
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Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To create sharing rules:

User sharing rules can be based on membership to public groups, roles, or territories, or on other criteria such as Department
and Title.  By default, you can define up to 300 user sharing rules, including up to 50 criteria-based sharing rules. Contact
Salesforce.com for information about increasing these limits.

User sharing rules based on membership enable user records belonging to members of one group to be shared with members
of another group. Before you can create a membership-based user sharing rule, confirm that the appropriate groups have been
created.

Users inherit the same access as users below them in the role hierarchy.

1. From Setup, click Security Controls > Sharing Settings.
2. In the User Sharing Rules related list, click New.
3. Enter the Label Name and click the Rule Name field to auto-populate it.
4. Enter the Description. This field describes the sharing rule. It is optional and can contain up to 1000 characters.
5. Select a rule type.
6. Depending on the rule type you selected, do the following:

a. Based on group membership—Users who are members of a group can be shared with members of another group.
In the Users who are members of line, select a category from the first drop-down list and a set of users from the
second drop-down list (or lookup field, if your organization has over 200 groups, roles, or territories).

b. Based on criteria—Specify the Field, Operator, and Value criteria that records must match to be included in the
sharing rule. The fields available depend on the object selected, and the value is always a literal number or string. Click
Add Filter Logic... to change the default AND relationship between each filter.

7. In the Share with line, specify the group that should have access to the user records. Select a category from the first
drop-down list and a set of users from the second drop-down list or lookup field.

8. Select the sharing access setting for users.

DescriptionAccess Setting

Users can view, but not update, records. They can see target
users in list views, lookups, search, and interact with them
on Chatter.

Read Only

Users can view and update records.Read/Write

Granting Access to User Records
Grant access to users to enable them to see and interact with you.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
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User Permissions Needed

“Read” on the user with whom you’re sharingTo grant access to your own user record:

“Manage Users”To grant access to any other user record:

Users can manually grant access to user records so other users can see them. Users inherit the same access as users below them
in the role hierarchy.

Granting access to a user record makes the user’s detail page visible to others, and makes the user visible in lookups, list views,
search, and so on.

You can share your user record manually if others cannot access it otherwise through the organization-wide defaults, sharing
rules, or role hierarchy. The higher level of access is maintained if you gain access through more than one method. High-volume
portal users can be shared with other users using manual shares, but not in sharing rules.

To grant access to a user record:

1. From Setup, click Manage Users > Users. Click the name of the user you want to share.
2. On the User Detail page, click Sharing.
3. Click Add.
4. From the drop-down list, select the group, user, role, or territory to share with.
5. Choose which users will have access by adding them to the Share With list.
6. Select the access level for the record you are sharing.

Possible values are Read/Write or Read Only, depending on your organization-wide defaults for users. You can only grant
a higher access than your organization-wide default.

7. Click Save.

To edit or delete the record access, click Sharing on the record, and click Edit or Del next to the manual share. You might
not see the Edit option if your organization-wide defaults is set to Public Read Only as the only valid access level on the
manual share is Read/Write.

User Sharing Visibility for Teams
Provide better visibility controls when using Sales Teams.

With Winter ’14, organizations with User Sharing will see the following changes when working with account teams, opportunity
teams, and case teams.

• You can only add users to your teams (including default teams) if you have Read access on those users.

• If you lose access to a default team member, you’ll still see their team member records and names, but not their full profiles.

• You can delete any of your default team members even if you don’t have Read access on the user.

Controlling Standard Report Visibility
Show or hide standard reports that might expose data of users to whom a user doesn’t have access.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To set standard report visibility:
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You can control whether users can see reports based on standard report types that might expose data of users to whom they
don’t have access. When User Sharing is first enabled, all reports that contain data of users to whom a viewing user does not
have access are hidden.

To enable report visibility:

1. From Setup, click Security Controls > Sharing Settings.
2. Click Edit in the Organization-Wide Defaults area.
3. Select the Standard Report Visibility checkbox to allow users to view reports based on standard report types that might

expose data of users to whom they don’t have access. Or deselect this checkbox if you want to hide these reports.
4. Click Save.

If the organization-wide default for the user object is Private and the checkbox is selected, a viewing user can only see the
names of the users they don’t have access to in the report. User details such as username and email are hidden.

When you deselect the Standard Report Visibility checkbox, users with the “View All Users” permission can still see all
reports based on standard report types. All users can also see these reports if the organization-wide default for the user object
is Public Read Only.

New Description Field for Sharing Rules
Provide a description to your sharing rules for better usability.

Available in: Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions

When creating or editing a sharing rule, you now have the option to fill in or update the Description field to describe the
sharing rule, below the Label Name and Rule Name fields. The maximum length for this field is 1000 characters.

The Description field can also be populated or updated via the SOAP API and the Metadata API.

Sharing Records with Managers Groups
Share records up or down the management chain using sharing rules or manual sharing.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Note:  Manager Groups is not automatically enabled in your organization. For information on enabling Manager
Groups, contact salesforce.com.

The role hierarchy controls the level of visibility that users have into your organization’s data. With Winter ’14, you can use
manager groups to share records with your management chain, instead of all managers in the same role based on the role
hierarchy. Manager groups can be used wherever other groups are used, such as in a manual share or sharing rule. But they
cannot be added to other groups and don’t include portal users. Manager groups can contain Standard and Chatter Only users
only.
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Every user has two manager groups.

1. Managers Group: Your direct and indirect managers
2. Manager Subordinates Group: You and your direct and indirect reports

To find out who a user’s manager is, from Setup, click Manage Users > Users. Click a user’s name. The Manager field on
the user detail page displays the user’s manager.

With manager groups, you can share records to these groups via manual sharing, sharing rules, and Apex managed sharing.
Apex sharing reasons is not supported.

For example, you might have a custom object for performance reviews whose organization-wide default is set to Private. After
deselecting the Grant Access Using Hierarchies check box, only the employee who owns the review record can view
and edit it. To share the reviews up the management chain, administrators can create a sharing rule that shares to a user’s
Managers Group. Alternatively, the employee can share the review record with his or her Managers Group using manual
sharing.

Inactive users remain in the groups of which they are members, but all relevant sharing rules and manual sharing are retained
in the groups.

Note:  If your organization has User Sharing enabled, you can’t see the users whom you don’t have access to.
Additionally, a querying user who doesn’t have access to a user cannot query that user’s groups.

External Organization-Wide Defaults—Pilot
Eliminate sharing overhead for internal users while maintaining a Private organization-wide default for external users.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
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Note:  External Organization-Wide Defaults is available through a pilot program. For more information on enabling
this feature for your organization, contact salesforce.com.

Previously, external organization-wide defaults was available for custom objects and users only. The latter is available as part
of User Sharing. With Winter ’14, you can also use external organization-wide defaults for accounts, cases, contacts, and
opportunities.

1. Default Internal Access
2. Default External Access

External users include:

• Authenticated Website users

• Chatter External Users

• Customer Portal users

• Guest users

• High-Volume Portal Users

• Partner Portal users

• Service Cloud Portal users

Without external organization-wide defaults, if your organization wanted Public Read Only or Public Read/Write access for
internal users but Private for external users, you would have to set the default access to Private and create a sharing rule to
share records with all internal users.

With separate organization-wide defaults, you can achieve similar behavior by setting Default Internal Access to Public Read
Only or Public Read/Write and Default External Access to Private without an additional sharing rule. Setting the default
internal access as Public Read Only or Public Read/Write also speeds up performance for reports, list views, searches, and
API queries.

Setting the External Organization-Wide Defaults

External Organization-Wide Defaults enable you to set a different default access level for external users.

Disabling External Organization-Wide Defaults

Disabling External Organization-Wide Defaults results in one organization-wide default for each object.

Setting the External Organization-Wide Defaults
External Organization-Wide Defaults enable you to set a different default access level for external users.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions
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User Permissions Needed

“Manage Users”To set default sharing access:

Note:  External Organization-Wide Defaults is available through a pilot program. For more information on enabling
this feature for your organization, contact salesforce.com.

Before you set the external organization-wide defaults, make sure that it is enabled. From Setup, click Security Controls >
Sharing Settings, and click the Enable External Sharing Model button.

When you first enable external organization-wide defaults, the Default Internal Access and Default External Access are set
to the original default access level. For example, if your organization-wide default for contacts is Private, the Default Internal
Access and Default External Access will be Private as well.

To set the external organization-wide default for an object:

1. From Setup, click Security Controls > Sharing Settings
2. Click Edit in the Organization-Wide Defaults area.
3. For each object, select the default access you want to use.

You can assign the following access levels.

DescriptionAccess Level

Users can perform actions (such as view, edit, delete) on a record
on the detail side of a master-detail relationship if they can perform
the same action on all associated master records.

Controlled by Parent

Only users who are granted access by ownership, permissions, role
hierarchy, manual sharing, or sharing rules can access the records.

Private

All users can view all records for the object.Public Read Only

All users can view and edit all records for the object.Public Read/Write

Note:  The Default External Access level must be more restrictive or equal to the Default Internal Access level.
For example, you can have a custom object with Default External Access set to Private and Default Internal
Access set to Public Read Only.

4. Click Save.

Disabling External Organization-Wide Defaults
Disabling External Organization-Wide Defaults results in one organization-wide default for each object.

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Users”To disable external organization-wide defaults:

Before disabling this feature, set Default External Access and Default Internal Access to the same access level for each object.
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To disable the external organization-wide defaults:

1. From Setup, click Security Controls > Sharing Settings
2. Click Disable External Sharing Model in the Organization-Wide Defaults area.

After disabling the external organization-wide defaults, you’ll see the Default Access setting instead of the Default External
Access and Default Internal Access settings in the organization-wide defaults area. If you have User Sharing, the Default
External Access settings for the account, contact, case, and opportunity objects remain visible but they are disabled.

Parallel Organization-Wide Default Updates—Pilot
Speed up organization-wide default updates in large organizations.

Available in: Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Note:  Parallel Organization-Wide Default Updates is available through a pilot program. For more information on
enabling it for your organization, contact salesforce.com.

With parallel organization-wide default updates, the resulting recalculations are run in parallel and asynchronously in the
background. Large organizations experience faster recalculations when updating the organization-wide defaults that affect
large amounts of data.

When you update the organization-wide defaults, recalculations continue in the background and you’ll receive an email
notification upon completion. Refresh the Sharing Settings page to see your changes. Before the recalculation completes, you
can’t run other sharing operations such as creating a sharing rule or updating the organization-wide defaults.

Additionally, you can monitor the progress of your parallel recalculations on the Background Jobs page.

Asynchronous Recalculation of Sharing Rules—Pilot
Speed up sharing recalculation when creating and updating sharing rules.

Available in: Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions

Note:  This information applies to organizations who are part of the ongoing pilot program for asynchronous
recalculation of sharing rules. For more information on enabling it for your organization, contact salesforce.com.

When you create or update sharing rules, the resulting recalculation is processed asynchronously and sequentially. With Winter
’14, these recalculations are processed asynchronously and in parallel for new organizations. Your sharing rules recalculates
faster as available resources are allocated appropriately for parallel processing. Recalculation continues in the background and
an email notification is sent upon completion. Before the recalculation completes, you can’t run other sharing operations such
as creating a sharing rule or updating the organization-wide defaults.

Additionally, you can monitor the progress of your parallel recalculations on the Background Jobs page.

Monitoring Parallel Recalculations
Monitor the progress of your parallel recalculations.
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Available in: Professional, Enterprise, Performance, Unlimited, Developer, and Database.com Editions

User Permissions Needed

“View Setup and Configuration”To monitor background jobs:

Parallel sharing rule recalculation is run when you click the Recalculate button for the sharing rules on the Sharing Settings
page. Similarly, recalculating your sharing rules on the Defer Sharing page triggers parallel recalculation.

To monitor the progress of your parallel recalculations, from Setup, click Monitoring > Background Jobs.

Previously, the Job Types column displays either Parallel Sharing Rule Recalculation or Parallel Asynchronous
Org-Wide Default Sharing Update to represent all parallel sharing operations.

With Winter ’14, the job types are more granular and differentiate between sharing rule operations for each object,
organization-wide default updates, and sharing rule operations via the Metadata API. For example, if parallel recalculation is
run when an account criteria-based sharing rule is updated, the Job Types column displays Parallel Sharing Rule
Recalculation and the Job Sub Types column displays Account — Criteria-based Sharing Rule.

Contact Visibility under Shared Accounts
Customer Portal users gain access to other portal contacts if the contact object is Controlled By Parent.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Portal users can see portal-enabled contacts under the same account if the organization-wide default is Private for accounts
and Controlled by Parent for contacts. With Winter ‘14, when you grant a Customer Portal user access to an account, the
user gains access to all portal-enabled contacts under that account as well. This behavior is similar to the current behavior for
Partner Portal users and Customer Portal super users.

Note:  This change is visible when you’re using the API or Visualforce pages, and has no impact on the user interface.

Globalization
Globalization tools help administrators manage multilanguage, multicurrency, and translated content.

Custom State and Country Picklists—Generally Available
Rename Standard Objects and Fields

Custom State and Country Picklists—Generally Available

Available in: All Editions except Database.com

State and country picklists allow users to select states and countries from predefined, standardized lists, instead of entering
state and country data into text fields. State and country picklists allow for faster and easier data entry and help to ensure
cleaner data that can be leveraged for other uses—in reports and dashboards, for example—with more dependable results. The
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states and countries in the picklists are based on ISO-3166 standard values, making them compatible with other applications
as well.

State and country picklists are available in the shipping, billing, mailing, and “other” address fields in the account, campaign
members, contact, contract, lead, person accounts, quotes, and service contracts standard objects. The picklists are also available
for managing users and companies in Administration Setup. To use the picklists, first choose the country and then choose
from the options that automatically populate the state or province picklist.

You can use the state and country picklists in most places that state and country fields are available in Salesforce, including:

• Record edit and detail pages

• List views, reports, and dashboards

• Filters, functions, rules, and assignments

You can also search state and country picklists using Advanced Search.

For a step-by-step guide to implementing state and country picklists, see Implementing State and Country Picklists.

To provide feedback on state and country picklists, go to IdeaExchange.

Note:  In Summer '13, Salesforce released a beta version of state and country picklists. Since then, we have made a
number of improvements for general availability, including:

• Enhanced metadata discovery, which alerts you to potential problems in workflow rules, assignment rules,
auto-response rules, and so on, when you enable state and country picklists.

• Enhanced support for Translation Workbench.

• Availability in Web-to-Lead forms.

Rename Standard Objects and Fields
Salesforce now supports the renaming of standard objects and standard fields through the Metadata API. See
CustomFieldTranslation under Updated Metadata Types and Fields.

Critical Updates
Features that are made available shortly after the release may require special preparation.

Clickjack Protection for Non-Setup Salesforce Pages

This critical update enables clickjack protection for all non-setup Salesforce pages to protect against user interface redress
attacks.

Clickjack Protection for Non-Setup Salesforce Pages
This critical update enables clickjack protection for all non-setup Salesforce pages to protect against user interface redress
attacks.

Available in: All Editions

Previously, to protect against clickjacking for non-setup Salesforce pages, you had to select Enable clickjack protection for
non-setup Salesforce pages under Setup > Security Controls > Session Settings.
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When you activate this critical update, clickjack protection for non-setup Salesforce pages will be enabled automatically for
your organization. Otherwise, on the auto-activation date, the protection will be enabled for all organizations by default.

If your organization displays non-setup Salesforce pages within a frame or <iframe>, it’s possible that the pages will either
display as a blank page or without the frame after clickjack protection is enabled. The behavior varies depending on your
browser and its version. Although there are reasons to frame pages, framed pages can be used by hackers.

You have two options for handing your existing framed pages:

• Don’t turn off clickjacking protection for your organization. Instead, discontinue displaying these pages within a frame or
<iframe>. This is the recommended solution.

• Disable clickjack protection for your organization. This allows you to continue framing non-setup Salesforce pages, but
the pages remain vulnerable to clickjack attacks. This option is not recommended.

Note:  In the Spring ’14 release, the ability to disable clickjack protection from the Session Settings page will be
removed, so you’ll have to contact salesforce.com Customer Support if you need to disable it. However, disabling
clickjack protection is not recommended.

Additional Customization
Even small customization enhancements can make Salesforce easier to use.

“Chatter Feed” Section of the Page Layout Editor Now “Publisher Actions”
Email Log Size Limits

Email logs return an increased number of records in multiple downloadable .zip files.

Outbound Single Email Limit

The number of emails you can send in a day has changed for selected organizations.

App Launcher for Identity License Users

The App Launcher presents icons for all of the current user’s standard apps and connected apps in a single tab.

“Chatter Feed” Section of the Page Layout Editor Now “Publisher
Actions”

Available in: All Editions

In the enhanced page layout editor, the Chatter Feed section is now labeled Publisher Actions.

Email Log Size Limits
Email logs return an increased number of records in multiple downloadable .zip files.

Available in: All Editions except for Database.com

246

Additional CustomizationForce.com Customization



Email logs now return a maximum of 500,00 records. An email log request can now result in multiple downloadable .zip files.
Each .zip file can hold up to 100,00 records, so your request might return up to five .zip files for download. Email logs still
count toward the overall file storage limit.

Outbound Single Email Limit
The number of emails you can send in a day has changed for selected organizations.

Available in: All Editions

For Developer Edition organizations and those evaluating Salesforce during a trial period, you can now send single emails to
a maximum of 15 email addresses per day. If you send emails via the user interface and the API, both count towards this limit.

App Launcher for Identity License Users
The App Launcher presents icons for all of the current user’s standard apps and connected apps in a single tab.

Available in: Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Use Identity Features”To see the App Launcher

Users must have access to a standard app or connected app for it to appear in the App Launcher. And, the connected app must
have a valid Start URL.

The App Launcher presents logos that link to your connected apps and standard apps, all from one tab in Salesforce. It appears
as an app in the Force.com App Menu for users assigned a profile or permission set with “Use Identity Features” enabled and
the App Launcher set to Visible.

The App Launcher is an app you select on any Salesforce page from the drop-down app menu.

In the App Launcher, click an installed app icon to launch the app.
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See also Identity License on page 233.
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Force.com Development
Force.com helps you develop new applications and integrations that extend your organization, or that you provide for resale.

Improvements to Deployment Monitoring

Get more information about the cancellation, success, or failure of a deployment when you’re using the Force.com Migration
Tool.

Changed Relationship Name for Notes and Attachments Related List

The relationship name for the Notes and Attachments related list has changed.

Canvas Apps in the Publisher and the Chatter Feed—Pilot

In addition to listing your app on the Chatter tab, you can now expose canvas apps as publisher actions and as Chatter feed
items.

Canvas Apps in the Salesforce1 App—Pilot

Now you can make Force.com Canvas apps accessible from Salesforce1.

Flexible API Limits—Pilot

We’re working on making our Force.com Platform limits more robust and intelligent to support spikes in API requests. If
this feature is enabled and your organization exceeds its API request limits, requests will be processed if our service has
capacity to handle them.

Deleting Components in a Managed Package—Pilot

ISVs can delete custom fields and tabs in a previously released managed package.

Sandbox

Use sandboxes to develop, test, and simulate deployment of your customization.

Change Sets and Deployment

Administrators and developers now have new ways to use change sets and external tools for deployments.

Developer Console

Use new features of Developer Console to more easily manage code in your organization.

Visualforce

Visualforce enhancements in Winter ’14 are focused on improving the experience of developing HTML5 apps, with some
additional development tools improvements and other changes.

Force.com Canvas

Force.com Canvas enables you to easily integrate a third-party application in Salesforce. Force.com Canvas is a set of tools
and JavaScript APIs that you can use to expose an application as a canvas app. This means you can take your new or existing
applications and make them available to your users as part of their Salesforce experience.

Apex Code

Apex code is the first multitenant, on-demand programming language for developers interested in building the next generation
of business applications.

API

Use the API to create apps that integrate Salesforce with other services.

249

Force.com Development



ISVforce

Winter ’14 includes several features that make it easier for partners to develop and distribute applications.

Improvements to Deployment Monitoring
Get more information about the cancellation, success, or failure of a deployment when you’re using the Force.com Migration
Tool.

Available in: Enterprise, Performance, Unlimited and Database.com Editions

We improved the status messages listed on the Monitor Deployments. The values are:

• Pending—The deployment has not started. It is waiting in a queue.

• In Progress—The deployment process started, but has not finished. See the Components and Tests counts on the page
to track the deployment progress.

• Cancel Requested—The deployment is being rolled back, but is not yet fully canceled.

• Succeeded—All components deployed successfully, and all tests ran successfully.

• Succeeded (partially)—A subset of changes were committed to the organization, but some files were missing, some
components had errors, or some tests failed. You can only receive this status with the deployment option RollBackOnError
= false.

• Canceled—The deployment has been successfully canceled. No changes were committed to the organization.

• Failed—No changes were committed to the organization because files were missing, components had errors, or tests failed.

On the Monitor Deployments page, the Start Time now shows the date and time when the deployment starts (In Progress),
not the time the deployment is waiting in a queue (Pending).

Also, the button to cancel a deployment has changed from “Abort” to “Cancel” to reflect the status messages more closely.

In addition, get real time error message details while a deployment is in-progress using the Metadata API and the Force.com
Migration Tool. For more information, see the release notes for the Metadata API on page 330. With this information, you
can decide to cancel a deployment in-progress, fix an issue and re-start the deployment

Changed Relationship Name for Notes and Attachments
Related List

The relationship name for the Notes and Attachments related list has changed.

CombinedAttachments now provides data for the Notes and Attachments related list. Until now, NotesAndAttachments
was the relationship name used to provide data for this related list. For example, when creating a Visualforce page, this sample
generates the Notes and Attachments related list on an account:

<apex:relatedList subject="{!account}"
list="CombinedAttachments" />

Note:

• Because the Case object doesn’t support notes, its relationship name for attachments was called Attachments.
It is now also updated to CombinedAttachments.

• If you describe a standard or custom object, the NotesAndAttachments relationship still shows up, although
you should use the CombinedAttachments relationship name to get related notes and attachments.
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Canvas Apps in the Publisher and the Chatter Feed—Pilot
In addition to listing your app on the Chatter tab, you can now expose canvas apps as publisher actions and as Chatter feed
items.

Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through a
pilot program and is available in all new Development Edition organizations. For information on enabling it for your
organization, contact salesforce.com.

This means you can extend the standard publisher and feed to include content from your Web applications. Now you can give
users the ability to quickly take action through the native publisher, but that action happens in your application—all through
the Salesforce user interface.

Canvas Apps in the Publisher
Force.com Canvas enables you to expose your canvas apps as publisher actions. The publisher allows users access to the most
common actions in your organization. You can expand the publisher to include a canvas app so that users can leverage the
common actions of a canvas app. These actions can then integrate with the Chatter feed and create a feed post specific to the
action that was performed. This graphic shows an example of the canvas custom action in the publisher and the canvas app
in the publisher pane.

Developers can use canvas apps in the publisher to:

• Add content from a Web application into the Chatter publisher.
• Create a custom action that exposes a canvas app.
• Integrate your canvas app directly into the publisher life cycle: post from your canvas app into the Chatter feed, use the

Share button functionality, and designate where to post your message.

For example, you might have a canvas app that your users use to log their hours worked. You can create a publisher action
that allows a user to open that canvas app in the publisher so they can quickly submit a time record, all right from within the
publisher.
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Users can still access the canvas app in the standard way for full functionality; but the canvas app in the publisher provides
quick access to the most common functions of your app. A user can select the publisher action and create a Chatter feed item
that can be a text post, a link post, or even a canvas post.

Canvas Apps in the Chatter Feed
Force.com Canvas enables you to expose your canvas apps as feed items. The feed gives users information about what’s
happening inside of Salesforce and information about records and groups they’re following.

When you create a canvas app Chatter feed item, it contains a thumbnail image, a link title, and a description. When the user
clicks on the link or the description, the canvas app opens up in the feed. If the user clicks the link again, the content is
collapsed, giving users a seamless experience for working in their feed. This graphic shows an example of canvas apps in the
feed where the first feed item is collapsed and the second feed item shows the full app.

Developers can use canvas apps in the feed to:

• Post to the Chatter feed from a canvas app in the publisher or through the Chatter API.
• Display a canvas app inside a Chatter feed item.

For example, you might have a canvas app that allows a user to log their hours worked. You can now programmatically create
a feed item that displays a canvas app which shows the user their currently logged hours.

In addition, the feed item could display actions depending on the current user. So the canvas app could then post a feed item
to the user’s manager, and the manager could approve or deny the hours logged. Since the content is served from the canvas
app, the developer has full control over the behavior.

Canvas Apps in the Salesforce1 App—Pilot
Now you can make Force.com Canvas apps accessible from Salesforce1.
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Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

Note:  Support for Force.com Canvas apps in Salesforce1 is currently available through a pilot program and is available
in all new Developer Edition organizations. For information on enabling it for your organization, contact salesforce.com.

Force.com Canvas enables you to expose your canvas apps in Salesforce1. The Salesforce1 app is Salesforce on the go. This
enterprise-class mobile app gives you real-time access to the same information that you see in the office, but it’s organized for
getting work done when you’re away from your desk. Just like in the full Salesforce site, users can access publisher and Chatter
feed items, including Force.com Canvas apps.

Developers can:

• Expose a canvas app in Salesforce1 as a publisher action. An icon indicates a canvas app. You can use either the default
puzzle icon or upload a custom icon for the related publisher action.

• Post to the feed from a canvas app in Salesforce1 or through the Chatter API.

• Display a canvas app inside a feed item from within Salesforce1. An icon indicates a canvas app. You can use either the
default puzzle icon or provide a thumbnail URL in the feed item to display a custom icon.

In the following example, you can see how a canvas custom action is used with the publisher within Salesforce1 to help
warehouse employees process shipments using a canvas app named Shipify.

1. Users can tap the Shipify icon in the publisher to access it.
2. After selecting an invoice, users can access a screen from which they can ship items for the invoice.
3. Once items are shipped, the application sets the invoice status to Closed and creates a feed item for the related account to

indicate that the items have shipped.

In the following images, you can see a canvas feed item that was created after a user processed an order. To confirm shipment,
another user can tap the canvas icon to open up the canvas app right within the mobile device.
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Users can still access your canvas app from within the full Salesforce site on a desktop machine. The additional functionality
for mobile devices that Salesforce1 offers doesn’t impact or limit existing functionality.

Flexible API Limits—Pilot
We’re working on making our Force.com Platform limits more robust and intelligent to support spikes in API requests. If
this feature is enabled and your organization exceeds its API request limits, requests will be processed if our service has capacity
to handle them.

Note:  This feature is currently available through a pilot program. For information on enabling it for your organization,
contact salesforce.com.

Flexible limits allow your organization to exceed its API request limit up to 50 percent above your normal limits within the
limit timeframe (typically 24 hours). For example, if your daily limit for API requests is 100,000, it’s extended to 150,000.
The following day, if your organization activity spikes again, the limit will be extended to 150,000 requests again.

If our service no longer has capacity to handle the extra API requests, the flexible limits are retracted and normal limits apply.

Which Limits are Covered?
Flexible limits apply to the number of API requests per 24-hour period for these APIs:

• SOAP API
• REST API
• Bulk API (batch limit: batches per rolling 24–hour period)
• Streaming API (number of events per rolling 24–hour period)

Note: Apex callouts to the SOAP API and REST API respect the flexible limits.
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How Can I Tell When Limits are Exceeded?
You can check your API usage in Salesforce. From Setup:

• Click System Overview to see API requests in the last 24 hours.
• Click API Usage Notifications to set up an email notification whenever your organization exceeds a specified limit for

the number of API requests made in a specified span of hours.
• Click Jobs > Bulk Data Load Jobs to see the number of Bulk API batches processed in the last 24 hours.
• Click Company Profile > Company Information to see Streaming API events in the last 24 hours.

Some additional features have been added in this release to help you proactively manage limits in your code:

• LimitInfoHeader for SOAP API—Use this header to monitor your API limits as you make SOAP API requests.
• Limit Info Header for REST API—Use this header to monitor your API limits as you make REST API requests.
• Limits Resource—Pilot—Use this REST resource to check your current usage versus API limits.

Deleting Components in a Managed Package—Pilot
ISVs can delete custom fields and tabs in a previously released managed package.

Available in: Developer Edition

Note:  This feature is currently available through a pilot program. For information on enabling it for your organization,
please contact salesforce.com.

The deletion of managed custom fields and tabs was not supported previously, to avoid the risk of data loss or integration
failures in subscriber organizations. However, for complex packages, the number of custom fields and tabs can grow very large
over multiple release cycles. The ability to delete custom fields and tabs can be very useful in such cases. It provides ISVs
greater flexibility in maintaining and upgrading their apps.

Once you delete a custom field or tab in a managed package, you can’t restore it or create another custom field or tab with the
same name. However, subscribers who upgrade to the new package version will still have the deleted components available in
their organization. They’re displayed in the Unused Components section of the Package Details page. This ensures subscribers
have the opportunity to export data and modify custom integrations involving those components, before explicitly deleting
them.

Note:  It’s your responsibility to educate your customers about the potential impact from any components you delete.
You should list all custom fields or tabs you've deleted and notify subscribers of any actions they need to take, in the
Release Notes for your upgraded package.

Deleting a managed custom field in a package under development will:

• Permanently delete all the data that currently exists in the field

• Permanently delete all tracked history data associated with the field

• Permanently delete any filters that use the custom field

• Change the result of assignment or escalation rules that rely on this field

• Prevent the creation of another managed custom field with the same name

Deleting a managed custom tab in a package under development will:

• Change the result of assignment or escalation rules that rely on this tab

• Prevent the creation of another managed custom tab with the same name
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Deleting a managed custom field in a subscriber organization will:

• Delete all dependent information for any dependent or controlling field

• Change the result of assignment or escalation rules that rely on this field

To preserve a record of data for future reference, subscribers can run a data export before deleting custom fields. From Setup,
click Data Management > Data Export.

You can delete custom fields and tabs from a managed package, both declaratively, from the user interface, and programmatically,
using the Metadata API. In the latter case, specify the custom fields or tabs you want to delete in a destructiveChanges.xml
manifest file and then use the standard deploy() call. The process is identical to that for deleting custom fields or tabs that
aren’t managed. For more information, see the Metadata API Developer’s Guide.

Sandbox
Use sandboxes to develop, test, and simulate deployment of your customization.

“Configuration Only” Sandboxes Renamed to “Developer Pro”
Sandbox Sizes Increase
Hyphen Now Required in Sandbox Subdomain Name

Salesforce is changing the way we address Force.com Sites domain names.

“Configuration Only” Sandboxes Renamed to “Developer Pro”

Available in: Enterprise, Performance, and Unlimited Editions

“Configuration Only” sandboxes are now called “Developer Pro” and the storage size has been increased. For more information,
see Sandbox Sizes Increase on page 256.

Sandbox Sizes Increase

Available in: Enterprise, Performance, Unlimited, and Database.com Editions

Salesforce has increased the storage limits for Developer and Developer Pro (formerly named “Configuration Only”) sandboxes.

• Developer sandboxes increased from 10 MB to a 200 MB storage limit.

• Developer Pro sandboxes increased from a 500 MB to a 1 GB storage limit.

• Full sandboxes continue to have the same storage limit as your production organization.

Hyphen Now Required in Sandbox Subdomain Name
Salesforce is changing the way we address Force.com Sites domain names.

Available in: Enterprise, Performance, and Unlimited Editions
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The system now requires a single hyphen to separate sandbox names from subdomain names, instead of a period. The format
is [sandboxName]-[subdomain].[instance].force.com. For example
https://mysandbox-mycompany.cs1.force.com.

This applies only to Force.com Sites. It doesn't affect My Domains or Force.com IDE settings.

No action is required. All existing deployments will get updated automatically.

Change Sets and Deployment
Administrators and developers now have new ways to use change sets and external tools for deployments.

If you’re using the Force.com Migration Tool or Force.com IDE, also see the changes in the Metadata API on page 330.

Approval Post Templates Available in Change Sets
Compact Layouts Available in Change Sets
Flexible Pages Available in Change Sets
User Permissions in Profile Settings in Change Sets
Change Sets Queue and Processing Improvements

Approval Post Templates Available in Change Sets

Available in: Enterprise, Performance, Unlimited, and Developer Editions

Post templates for Approvals in Chatter are now available in change sets.

Now you can easily use change sets to deploy approval processes that reference post templates. You no longer need to remove
references to post templates from the approval process before uploading it, or recreate the post templates in the destination
organization before deploying the approval process.

You do, however, need to resave any post templates that contain custom fields before adding them to the change set. From
Setup, click Create > Workflow & Approvals > Post Templates. For each post template, click Edit and then Save.

Compact Layouts Available in Change Sets

Available in: All editions except Database.com

Compact layouts—the new mobile-optimized record layouts for Salesforce1—are available in change sets.

Flexible Pages Available in Change Sets

Available in: All editions except Database.com

Flexible Pages—the new mobile app home pages for Salesforce1—are available in change sets.
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User Permissions in Profile Settings in Change Sets

Available in Enterprise, Performance, Unlimited, and Database.com Editions

User permissions (such as “Manage Users”) are now included in profile settings for change sets.

Change Sets Queue and Processing Improvements

Available in: Enterprise, Performance, Unlimited and Database.com Editions

Change set deployments are now queued for processing to avoid collisions between multiple users trying to deploy changes at
the same time.

Also, Salesforce no longer prevents navigation away from a change set detail page while the change set is deployed or validated.
During a deployment or validation, you can leave the change set detail page, and come back later to see if it has been processed.

Developer Console
Use new features of Developer Console to more easily manage code in your organization.

Available in: Performance, Unlimited, Developer, Enterprise, and Database.com Editions

Code Search
Save Order Debug View

The Developer Console includes a new Save Order debug view that provides a visual timeline of DML actions.

SOSL Search Support and Query History
Static Resource Editors

The Developer Console Source Code Editor now supports JavaScript, XML, CSS, and plain text.

Override Log Levels for a Class or Trigger

The Developer Console now allows you to define log levels for a specific class or trigger.

Code Search
New in this release, the Developer Console includes integrated code search for all file types. Click File > Search in Files or
press CTRL+SHIFT+H.

Save Order Debug View
The Developer Console includes a new Save Order debug view that provides a visual timeline of DML actions.

The Save Order tab displays a color-coded timeline of DML actions. For each DML action taken, save order elements are
shown as boxcars in the timeline.
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For details on a specific element, click the associated boxcar in the timeline. The popup window displays additional information,
including a link to navigate directly to the relevant place in the log.

To view the ID(s) of affected records, click the name of the sObject in the left pane.

SOSL Search Support and Query History
The Query Editor in the Developer Console now supports SOSL search. In SOSL search results with multiple objects, each
object is displayed on a separate tab.

The Query Editor also includes a new Query History panel that lists the last 10 queries for quick reuse.

Static Resource Editors
The Developer Console Source Code Editor now supports JavaScript, XML, CSS, and plain text.

To create a new JavaScript, XML, CSS or text file, click File > New > Static Resource. In the New Static Resource popup
window, enter a name for the file, choose the correct MIME Type, and click Submit.

Override Log Levels for a Class or Trigger
The Developer Console now allows you to define log levels for a specific class or trigger.

Logging levels determine how much request information is saved in a debug log. Parsing a large log can take a long time. To
reduce the size of a log, adjust the logging level. Use verbose logging for code you’re reviewing. Use terse logging for code
you’re not interested in.

To specify logging levels for future requests, click Debug > Change Log Levels. This page allows you to define general settings
and override the general log levels for a specific class or trigger.

To define log levels for a class or trigger, click Add and choose the class or trigger from the list. Click an entry to choose from
the list of available log levels.

259

SOSL Search Support and Query HistoryForce.com Development



Improved Visualforce Development in the Developer Console
Visualforce development in the Developer Console has been improved in several ways to make working in the Developer
Console as easy as using the Visualforce Development Mode footer.

Preview a Visualforce Page

Click Preview in a Visualforce tab to open and use the page in a separate window.

A Visualforce page in a preview window reloads automatically when you save changes to it or the page’s controller code.

Inspect a Visualforce Page’s View State—Beta

Note:  This release contains a beta version of the View State tab in the Developer Console that is production
quality but has known limitations.

The View State tab in the Developer Console allows you to examine the view state for a Visualforce page request.

The View State tab in the Developer Console works the same as the View State tab in the Visualforce Development
Mode footer, except that double-clicking a folder node doesn’t open a usage pie chart window. See “About the View
State Tab” in the Visualforce Developer’s Guide for details.

To enable the View State tab:

1. At the top of any Salesforce page, click the down arrow next to your name. From the menu under your name, select
Setup or My Settings—whichever one appears.

2. From the left pane, select one of the following:

• If you clicked Setup, select My Personal Information > Personal Information.
• If you clicked My Settings, select Personal > Advanced User Details.

3. Click Edit.
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4. Select the Development Mode checkbox if it isn't selected.
5. Select the Show View State in Development Mode checkbox.
6. Click Save.

Note:  Since the view state is linked to form data, the View State tab only appears if your page contains an
<apex:form> tag. In addition, the View State tab displays only on pages using custom controllers or controller
extensions.

Visualforce
Visualforce enhancements in Winter ’14 are focused on improving the experience of developing HTML5 apps, with some
additional development tools improvements and other changes.

Available in: Contact Manager, Group, Professional, Enterprise, Performance, Unlimited, and Developer Editions

For further information on features affected by these enhancements, refer to the Visualforce Developer’s Guide.

HTML5 Development with Visualforce

Visualforce features a number of improvements in Winter ’14 that are intended to make HTML5 development easier.

Additional Visualforce Improvements

Visualforce features a number of other changes in Winter ’14, ranging from enhanced or changed administrative user interface
elements, to new and enhanced components, to pilot features and bug fixes.

HTML5 Development with Visualforce
Visualforce features a number of improvements in Winter ’14 that are intended to make HTML5 development easier.

These release notes explain the new features in detail, and also provide an extended code sample showing how the different
features can be used together to create significantly new and better forms for user input.

New <apex:input> Component

<apex:input> is a new, HTML5-friendly, general purpose input component that adapts to the data expected by a form
field. It uses the HTML type attribute, particularly values new in HTML5, to allow client browsers to display type-appropriate
user input widgets, such as a date picker or range slider, or use a type-specific keyboard on touch devices, or to perform
client-side formatting or validation, such as with a numeric range or a telephone number.

type Attribute for <apex:input> and <apex:inputField>

Use the new type attribute with <apex:input> and <apex:inputField> to display input user interface elements using
HTML5 browser features or JavaScript user interface widgets, to supplement or replace the default Salesforce input elements.

HTML5 <datalist> Element for Input Components

The HTML5 <datalist> element specifies a list of values to associate with an <input> element, which can be used to
show a list of completion options filtered by input. Use the new list attribute for the <apex:input>,
<apex:inputField>, and <apex:inputText> components to generate a <datalist> block for the associated input
field.
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Additional Components with Support for Pass-Through HTML Attributes

You can add arbitrary attributes to many Visualforce components that will be “passed through” to the rendered HTML.
This is useful, for example, when using Visualforce with JavaScript frameworks, such as jQuery Mobile, AngularJS, and
Knockout, which use data-* or other attributes as hooks to activate framework functions. It can also be used to improve
usability with HTML5 features such as placeholder “ghost” text, pattern client-side validation, and title help text
attributes.

Accessibility Improvements to Visualforce Components

The accessibility of Visualforce pages has been improved, by improving the semantics and completeness of the HTML
generated by a number of Visualforce components.

Deferred Loading of JavaScript Resources via <apex:includeScript>

The <apex:includeScript> component has a new attribute, loadOnReady, which controls whether a JavaScript resource
loaded by the component is loaded immediately (existing behavior), or is delayed until the document model (DOM) for the
page is constructed.

Code Sample for HTML5 Features

Many of the new HTML5 development features in Visualforce are demonstrated in this code sample. It provides examples
of using the new <apex:input> component, HTML5 pass-through attributes, the list attribute for auto-complete using
<datalist>, and new user interface and accessibility options on the <apex:selectRadio> component.

New <apex:input> Component
<apex:input> is a new, HTML5-friendly, general purpose input component that adapts to the data expected by a form
field. It uses the HTML type attribute, particularly values new in HTML5, to allow client browsers to display type-appropriate
user input widgets, such as a date picker or range slider, or use a type-specific keyboard on touch devices, or to perform
client-side formatting or validation, such as with a numeric range or a telephone number.

An <apex:input> component generates an HTML <input> tag, and the component’s type attribute sets the corresponding
type attribute of the HTML tag. type can be set explicitly in Visualforce markup, or set to “auto” to have the component
detect the appropriate type from the controller property or method signature. See type Attribute for <apex:input> and
<apex:inputField> on page 263 for extended details of the type attribute.

Auto-detection of type behaves similarly to how <apex:inputField> adapts to the data type of sObject fields. However,
unlike <apex:inputField>, <apex:input> can’t be used with compound fields, such as Account Billing Address, which
combine multiple separate data elements.

Use this component to get user input for a controller property or method that does not correspond to a field on a Salesforce
object. Since it doesn’t correspond to a Salesforce field, or any other data on an object, custom code is required to use the value
the user enters.

Here’s a simple form that collects basic contact data.

<apex:form>
<apex:pageBlock title="{!acct.Name} Contacts">

<apex:pageBlockSection id="contactDetails" title="New Contact">

<apex:input label="First Name" value="{!cFirstName}"/>
<apex:input label="Last Name" value="{!cLastName}"/>
<apex:input label="Mobile Number" value="{!cMobile}" type="tel"/>
<apex:input label="Email" value="{!cEmail}" type="email"

html-pattern="^[a-zA-Z0-9._-]+@example.com$"/>

</apex:pageBlockSection>
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</apex:pageBlock>
</apex:form>

See Code Sample for HTML5 Features on page 267 for an extended code sample that illustrates additional ways to use the
<apex:input> component.

The specific user interface displayed for different input types is determined by the browser, not Visualforce. All modern
browsers support the type attribute for the <input> tag, but not all HTML5 types are supported in all browsers.
Non-supporting browsers will default to a text field for unknown type attributes. Test carefully in your target browsers to
verify intended behavior.

<apex:input> is supported in API version 29.0 and later, and requires that the <apex:page> docType attribute be set
to “html-5.0”.

type Attribute for <apex:input> and <apex:inputField>
Use the new type attribute with <apex:input> and <apex:inputField> to display input user interface elements using
HTML5 browser features or JavaScript user interface widgets, to supplement or replace the default Salesforce input elements.

The value of the type attribute is passed through to the HTML <input> tag, allowing you to enable new HTML5 client-side
behaviors such as auto-formatting phone numbers, a “clear” button to reset the field, or type-specific user interface widgets,
such as date pickers, or type-specific keyboards on touch-based devices. This can be especially valuable for mobile applications,
since the default Visualforce input elements are optimized for mouse and keyboard input, rather than a touch screen.

These behaviors combine well and become even more sophisticated when used with pass-through attributes to enable HTML5
features such as client-side validation. Client-side validation doesn’t replace the standard server-side validation performed by
Visualforce, but it can provide immediate feedback for invalid input, instead of requiring a round trip to the server. See Code
Sample for HTML5 Features on page 267 for an extended code sample that shows how to combine the type attribute with
pass-through attributes to achieve different behaviors.

Valid values for the type attribute are:

• auto

• date

• datetime

• datetime-local

• month

• week

• time

• email

• number

• range

• search

• tel

• text

• url

The type specified must be compatible with the data type of the sObject field or controller method or property return type,
or it will generate a compiler error when the page is saved. If you don’t set a type for an <apex:inputField> component,
it defaults to its standard smart behavior. If you don’t set a type for an <apex:input> component, it defaults to “text”.

When used with <apex:inputField>, date and time types by default still show the standard Salesforce date/time picker
widget. To suppress the date/time picker, in favor of a native browser or JavaScript picker, also set showDatePicker="false"
on the <apex:inputField>.
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When used with <apex:inputField>, picklist fields always show the standard Salesforce picklist widget. To override this
standard user interface element, use an <apex:input> component on the form, and handle the submitted data manually.
See Code Sample for HTML5 Features on page 267 for an extended code sample that shows a way to use picklist values with
<apex:input>.

The specific user interface displayed for different input types is determined by the browser, not Visualforce. All modern
browsers support the type attribute for the <input> tag, but not all HTML5 types are supported in all browsers.
Non-supporting browsers will default to a text field for unknown type attributes. Test carefully in your target browsers to
verify intended behavior.

The type attribute for the <apex:input> and <apex:inputField> components, and the showDatePicker="false"
attribute for <apex:inputField>, are supported in API version 29.0 and later, and requires that the <apex:page> docType
attribute be set to “html-5.0”.

HTML5 <datalist> Element for Input Components
The HTML5 <datalist> element specifies a list of values to associate with an <input> element, which can be used to
show a list of completion options filtered by input. Use the new list attribute for the <apex:input>, <apex:inputField>,
and <apex:inputText> components to generate a <datalist> block for the associated input field.

The list attribute is specified as either a comma-delimited static string or a Visualforce expression. An expression can resolve
to either a comma-delimited string, or a list of objects. List elements can be any data type, as long as that type can be coerced
to a string, either as an Apex language feature or via a toString() method.

For example:

<apex:inputText value="{!preferredBrowser}" list="{!modernBrowsers}"
html-inputText="Enter your preferred browser" html-autocomplete="on" />

Note the use of the HTML pass-through attribute autocomplete, which is required for many browsers to use the
<datalist> for auto-completion of form input.

See Code Sample for HTML5 Features on page 267 for an extended code sample that illustrates several ways to use the list
attribute.

The specific user interface behavior for <datalist> is determined by the browser, not Visualforce. The <datalist> tag
is supported in most modern browsers. Test carefully in your target browsers to verify intended behavior.

The list attribute for <apex:inputField> and <apex:inputText> is supported in API version 29.0 and later, and
requires that the <apex:page> docType attribute be set to “html-5.0”.

Additional Components with Support for Pass-Through HTML Attributes
You can add arbitrary attributes to many Visualforce components that will be “passed through” to the rendered HTML. This
is useful, for example, when using Visualforce with JavaScript frameworks, such as jQuery Mobile, AngularJS, and Knockout,
which use data-* or other attributes as hooks to activate framework functions. It can also be used to improve usability with
HTML5 features such as placeholder “ghost” text, pattern client-side validation, and title help text attributes.

The range of components that support this feature has expanded considerably in Winter ’14. The following components
support pass-through attributes:

• <apex:column>

• <apex:commandButton>

• <apex:commandLink>

• <apex:component>
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• <apex:dataTable>

• <apex:form>

• <apex:iframe>

• <apex:image>

• <apex:includeScript>

• <apex:input>

• <apex:inputCheckbox>

• <apex:inputField>

• <apex:inputHidden>

• <apex:inputSecret>

• <apex:inputText>

• <apex:inputTextarea>

• <apex:messages>

• <apex:outputField>

• <apex:outputLabel>

• <apex:outputLink>

• <apex:outputPanel>

• <apex:outputText>

• <apex:page>

• <apex:pageBlock>

• <apex:pageBlockButtons>

• <apex:pageBlockSection>

• <apex:pageBlockSectionItem>

• <apex:pageBlockTable>

• <apex:panelBar>

• <apex:panelBarItem>

• <apex:panelGrid>

• <apex:sectionHeader>

• <apex:selectCheckboxes>

• <apex:selectList>

• <apex:selectOption>

• <apex:selectOptions>

• <apex:selectRadio>

• <apex:stylesheet>

• <apex:tab>

• <apex:tabPanel>

See Code Sample for HTML5 Features on page 267 for an extended code sample that illustrates the use of pass-through
attributes. For additional considerations and examples of using HTML attributes, including specifics of the generated HTML,
see Setting Custom HTML Attributes on Visualforce Components in the Visualforce Developer’s Guide.

Accessibility Improvements to Visualforce Components
The accessibility of Visualforce pages has been improved, by improving the semantics and completeness of the HTML generated
by a number of Visualforce components.

The following components are affected.
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• <apex:inputField>—when used within an <apex:pageBlockSection>, the table that displays the input element
and its label now has appropriate header cells, improving the semantic relationship between field and label.

• <apex:inputFile>—<label> tag added to increase accessibility and usability.

• <apex:messages>—role="alert" attribute added so that screen reader users are alerted when there’s an important
message displayed using this component.

• <apex:outputField>—when used within an <apex:pageBlockSection>, the table that displays the field’s value
and its label now has appropriate header cells, improving the semantic relationship between field and label.

• <apex:pageMessages>—role="alert" attribute added so that screen reader users are alerted when there’s an
important message displayed using this component.

• <apex:selectCheckboxes>—see <fieldset> and <legend> for <apex:selectCheckboxes> and
<apex:selectRadio>.

• <apex:selectRadio>—see <fieldset> and <legend> for <apex:selectCheckboxes> and
<apex:selectRadio>.

Existing Visualforce pages that use these components will generate the new HTML automatically, improving their accessibility
without new developer effort.

With exceptions noted below, these components should look the same when using the default Salesforce styling. Even with
custom styling, visual changes should be minimal or nonexistent. In a few cases, you might need to make minor tweaks to
your stylesheets if you want to preserve precise formatting.

<fieldset> and <legend> for <apex:selectCheckboxes> and <apex:selectRadio>
The accessibility of the HTML generated by the <apex:selectCheckboxes> and <apex:selectRadio> components
is improved, by wrapping the resulting HTML within a <fieldset> tag.

In addition, three new attributes are available on <apex:selectCheckboxes> and <apex:selectRadio> that allow you
to add a <legend> to the <fieldset>, and to control the visibility of the legend text and the border around the grouped
input elements.

DescriptionAttribute TypeAttribute Name

Controls whether the border around the <fieldset> that wraps the
checkboxes or radio buttons group is visible or hidden. The default value
is false, there is no border.

BooleanborderVisible

Controls whether the legend text is displayed or hidden. The default value
is false, the legend text is displayed for all users.

When set to true, the <legend> has a styling attribute added,
class="assistiveText", which preserves the legend text in the DOM,

BooleanlegendInvisible

but moves the display off-screen. This makes the text accessible to screen
readers, without being displayed visually.

The text to be displayed as a legend for the checkboxes or radio buttons
group. When the border is visible, the legend is inlaid along the top-left

StringlegendText

edge of the border. When legendText is an empty string, or not set, no
legend is added.

These changes to the <apex:selectCheckboxes> and <apex:selectRadio> components are versioned, and you must
update your pages to API version 29.0 or later to use them.
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Deferred Loading of JavaScript Resources via <apex:includeScript>
The <apex:includeScript> component has a new attribute, loadOnReady, which controls whether a JavaScript resource
loaded by the component is loaded immediately (existing behavior), or is delayed until the document model (DOM) for the
page is constructed.

Set the loadOnReady attribute to true to cause JavaScript referenced by the component to wait to be loaded until the page
is “ready.” For example, <apex:includeScript loadOnReady="true"
value={$Resource.waitUntilReadyScript}"/>. Scripts loaded this way will be added to the DOM after the onload
event is triggered, instead of immediately. This occurs after the DOM is constructed, but can be before child frames or external
resources (such as images) have finished loading.

Setting loadOnReady="true" can improve the performance of the initial display of the page, but should only be used for
scripts that aren’t needed until after the page is fully loaded.

The default value for loadOnReady is false.

Code Sample for HTML5 Features
Many of the new HTML5 development features in Visualforce are demonstrated in this code sample. It provides examples
of using the new <apex:input> component, HTML5 pass-through attributes, the list attribute for auto-complete using
<datalist>, and new user interface and accessibility options on the <apex:selectRadio> component.

This Visualforce page displays a form for adding details to a contact.

<apex:page standardController="Contact" extensions="ContactExtras" docType="html-5.0">

<!--
This page expects to be referenced along with the ID of an existing contact record
For example: https://<salesforce_instance>/apex/ContactForm?id=003D000000QB6wh

-->

<apex:form id="theForm">
<apex:pageBlock title="Contact: {! Contact.Name }" >

<apex:pageBlockSection id="contactDetails" title="Contact Details" columns="1">

<apex:inputField value="{! Contact.MobilePhone }" type="tel"
html-placeholder="999-999-9999"
html-autofocus="true"
/>

<apex:inputField value="{! Contact.Email }" type="email"
html-placeholder="you@example.com"
html-pattern="^[a-zA-Z0-9._-]+@example.com$"
html-title="Please enter an example.com email address"
/>

<apex:inputField value="{! Contact.Birthdate }" type="date"
showDatePicker="false"
/>

<apex:inputField value="{! Contact.Pick_A_Number__c }" type="auto"
html-min="0" html-max="100" html-step="5"
html-title="Must be between 0 and 100"
/>

<apex:inputField value="{! Contact.Favorite_Color__c }" type="text"
list="{! colorsList }"
/>
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<apex:inputField value="{! Contact.Favorite_Shape__c }"
list="circle,square,rectangle,triangle,hexagon,cube,sphere"
/>

<apex:selectRadio value="{! Contact.LeadSource}" layout="pageDirection"
legendText="Select a source for this contact" borderVisible="true">
<apex:selectOptions value="{! sourcesList }"/>

</apex:selectRadio>

</apex:pageBlockSection>

<apex:pageBlockSection id="contactExtras" title="Contact Extras" columns="1">

<apex:input label="Car Color" value="{! fText }" list="{! colorsList }"/>

<apex:input label="Steps Today" value="{! fNumber }" type="number"
html-min="0" html-max="50000"
/>

<apex:input label="Favorite Date in History" value="{! fDate }"
type="auto"
/>

</apex:pageBlockSection>

<apex:pageBlockButtons location="bottom">
<apex:commandButton id="commandButton" value="Update"

action="{!quickSave}" reRender="theForm"
/>

</apex:pageBlockButtons>

</apex:pageBlock>
</apex:form>

</apex:page>

The supporting controller extension is deliberately simple. It’s intended to support the above markup, rather than to do anything
useful itself.

public class ContactExtras {

public ContactExtras(ApexPages.StandardController controller) { }

// Stub properties, to allow use on the form
// Real code would do something with them, like save to the record
public String fText { get; set; }
public Integer fNumber { get; set; }
public Date fDate { get; set; }

// Create a list of colors (strings) for use in a list attribute,
// for auto-completion via a <datalist>
// The choices come from a picklist custom field; you can use
// the list with any field, not just that picklist field
public List<String> getColorsList() {

List<String> colors = new List<String>();
Schema.DescribeFieldResult picklistColors = Contact.Favorite_Color__c.getDescribe();

for (Schema.PicklistEntry color : picklistColors.getPicklistValues()) {
colors.add(color.getValue());

}
return colors;

}

// Again from a picklist field, convert the values into a list that
// can be used with an <apex:selectRadio> component
public List<SelectOption> getSourcesList() {

List<SelectOption> sources = new List<SelectOption>();
Schema.DescribeFieldResult picklistSources = Contact.LeadSource.getDescribe();
for (Schema.PicklistEntry source : picklistSources.getPicklistValues()) {
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sources.add(new SelectOption(source.getValue(),source.getValue()));
}
return sources;

}
}

Additional Visualforce Improvements
Visualforce features a number of other changes in Winter ’14, ranging from enhanced or changed administrative user interface
elements, to new and enhanced components, to pilot features and bug fixes.

Preview Page Button for Visualforce Pages

Setup list views for Visualforce pages now include a button to open the page directly from the list, and other Visualforce
Setup pages allow opening the page from the Detail and Edit views.

Available for Touch Checkbox Renamed

The Available in Touch checkbox on the create Visualforce page has been renamed Available for Salesforce
mobile apps. The create Visualforce page is accessible in Setup by clicking Develop > Pages > New.

New <apex:milestoneTracker> Component

<apex:milestoneTracker> is a new Visualforce component that displays the milestone tracker on the Case Feed page.

registrationClassName Attribute Added to the <chatteranswers:registration> Component

The registrationClassName attribute has been added to the <chatteranswers:registration> component.

chatteranswers:allfeeds forceSecureCustomWebAddress Attribute Deprecated

The forceSecureCustomWebAddress attribute of the <chatteranswers:allfeeds> Visualforce component is
deprecated in Salesforce API version 29.0 and later, and has no effect on the page.

Server-Side View State—Pilot

Server-side view state maintains a Visualforce page’s view state on the server, instead of sending it back and forth during
form submissions and responses. This can reduce the amount of data being transmitted per request, which can improve
performance, especially over connections with limited bandwidth or high latency, such as a mobile wireless connection.

SOQL WHERE Clause No Longer Reset In a StandardSetController Initialized with a queryLocator

In prior releases there was a software defect that could cause a StandardSetController initialized with a queryLocator
to lose the WHERE clause when save() was called on the controller.

Preview Page Button for Visualforce Pages
Setup list views for Visualforce pages now include a button to open the page directly from the list, and other Visualforce Setup
pages allow opening the page from the Detail and Edit views.
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Click the Preview button ( ) to open a Visualforce page in a new window.

Visualforce page detail and edit views have added a Preview button that does the same thing:

Click Preview to open the page in a new window.

Available for Touch Checkbox Renamed
The Available in Touch checkbox on the create Visualforce page has been renamed Available for Salesforce
mobile apps. The create Visualforce page is accessible in Setup by clicking Develop > Pages > New.

This checkbox was renamed because it now also supports Visualforce pages in the Salesforce1 apps. Visualforce support in
Salesforce Touch is unchanged.

New <apex:milestoneTracker> Component
<apex:milestoneTracker> is a new Visualforce component that displays the milestone tracker on the Case Feed page.

Entitlements help you determine if your customers are eligible for customer support so you can create cases for them. A
customer may be eligible for support based on a particular asset, account, or service contract. Milestones are required steps in
your support process. They're metrics that represent service levels to provide to each of your customers. Examples of milestones
include First Response and Resolution Times on cases.

The milestone tracker shows the countdown time to an active milestone’s Target Date or how long a milestone has been in
violation. You can add it to the Case Feed page so that agents can see the time remaining on an active milestone or how
overdue the milestone is if its Target Date has passed, along with a list of upcoming milestones and closed milestones.

The entityId attribute is required when you use the <apex:milestoneTracker> component in a Visualforce page.

<apex:page standardController="Case" showHeader="true">
<apex:milestoneTracker entityId="{!case.id"/>

<apex:page>
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For information on the milestone tracker, see View Milestones on the Case Feed Page with the Milestone Tracker.

registrationClassName Attribute Added to the
<chatteranswers:registration> Component

The registrationClassName attribute has been added to the <chatteranswers:registration> component.

This attribute specifies the name of the Apex class that implements the ChatterAnswers.AccountCreator Apex interface.
If this attribute isn’t used, Chatter Answers registration uses the generated ChatterAnswersRegistration or
ChatterAnswers Apex class.

For information on using the registrationClassName attribute, see Customize the Account Creation Experience for
Chatter Answers Portal Users.

chatteranswers:allfeedsforceSecureCustomWebAddress Attribute
Deprecated

The forceSecureCustomWebAddress attribute of the <chatteranswers:allfeeds> Visualforce component is
deprecated in Salesforce API version 29.0 and later, and has no effect on the page.

Absolute URLs in the Chatter Answers feed now use a secure custom Web address by default, so setting this attribute isn’t
necessary. For existing organizations already using this attribute, there will be no change in the behavior of your Visualforce
page.

Server-Side View State—Pilot
Server-side view state maintains a Visualforce page’s view state on the server, instead of sending it back and forth during form
submissions and responses. This can reduce the amount of data being transmitted per request, which can improve performance,
especially over connections with limited bandwidth or high latency, such as a mobile wireless connection.

This feature is available as a limited pilot. Contact salesforce.com to request inclusion in the pilot program.

SOQL WHERE Clause No Longer Reset In a StandardSetController
Initialized with a queryLocator

In prior releases there was a software defect that could cause a StandardSetController initialized with a queryLocator
to lose the WHERE clause when save() was called on the controller.

Here’s a simple example that would exhibit the problem.

public class OpportunityListController {

public ApexPages.StandardSetController setCon {
get {

if(setCon == null) {
setCon = new ApexPages.StandardSetController(

Database.getQueryLocator(
[SELECT Name, CloseDate FROM Opportunity WHERE Amount > 0]

)
);
setCon.setPageSize(10);

}
return setCon;

}
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set;
}

public List<Opportunity> getOpportunities() {
return (List<Opportunity>) setCon.getRecords();

}

public PageReference dropWhereClauseOops() {
setCon.save();
return null;

}
}

If a Visualforce page called the action method dropWhereClauseOops(), the WHERE condition would be lost, and the page
would show all opportunities, instead of just those with non-zero amounts.

It’s a very specific, isolated bug, but if it affected your application code, you might have put some effort into writing a workaround.
In Winter ’14 this bug has been fixed and, if you like, you can remove any workaround.

Force.com Canvas
Force.com Canvas enables you to easily integrate a third-party application in Salesforce. Force.com Canvas is a set of tools
and JavaScript APIs that you can use to expose an application as a canvas app. This means you can take your new or existing
applications and make them available to your users as part of their Salesforce experience.

Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

The version of the Force.com Canvas SDK is 29.0.

For more information, see the Force.com Canvas Developer’s Guide.

API Enabled User Permission No Longer Required

A user no longer requires the API enabled permission to run an installed canvas app.

SDK Object and Field Changes

The following changes have been made to the objects and fields in the Force.com Canvas SDK.

Force.com Canvas Support for Streaming API

Force.com Canvas provides an event and methods that enable canvas apps to listen for Streaming API notifications.

API Enabled User Permission No Longer Required
A user no longer requires the API enabled permission to run an installed canvas app.

Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

To access this field, from Setup, navigate to Manage Users > Profiles and then click Edit next to a profile. The API Enabled
field is in the Administrative Permissions section.

SDK Object and Field Changes
The following changes have been made to the objects and fields in the Force.com Canvas SDK.
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Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

• The referenceId field has been added to the Application object.

DescriptionField

The ID of the canvas app.applicationId

The access method of the canvas app. You specify this value when you expose the canvas
app by creating a connected app.

authType

The URL of the canvas app, for example:
http://instance.salesforce.com:8080/canvas_app_path/canvas_app.jsp.

canvasUrl

The internal name of the canvas app. You specify this value in the API Name field when
you expose the canvas app by creating a connected app.

developerName

The name of the canvas app.name

The Salesforce namespace prefix associated with the canvas app.namespace

The unique ID of the canvas app definition. Used internally.referenceId

The version of the canvas app. This value changes after you update and re-publish a canvas
app in an organization.

version

"application":
{

"applicationId":"06Px000000003ed",
"authType":"SIGNED_REQUEST",
"canvasUrl":"http://instance.salesforce.com:8080/canvas_app_path/canvas_app.jsp",
"developerName":"my_java_app",
"name":"My Java App",
"namespace":"org_namespace",
"referenceId":"09HD00000000AUM",
"version":"1.0.0"}

• The clientHeight and clientWidth fields have been added to the Dimensions object.

DescriptionField

The values of clientHeight are sent to the canvas app within
SignedRequest and can be used to set the height of the outermost div

clientHeight

element. This field is useful for setting the height of an app that’s
accessed from a mobile device. The field can be referenced as
sr.context.environment.dimensions.clientHeight, where
sr is the parsed signed request JavaScript object.

The values of clientWidth are sent to the canvas app within
SignedRequest and can be used to set the width of the outermost div

clientWidth

element. This field is useful for setting the width of an app that’s
accessed from a mobile device. The field can be referenced as
sr.context.environment.dimensions.clientWidth, where
sr is the parsed signed request JavaScript object.

The height of the iFrame in pixels.height

The width of the iFrame in pixels.width
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DescriptionField

The maximum height of the iFrame in pixels. Defaults to 2,000;
“infinite” is also a valid value.

maxHeight

The maximum width of the iFrame in pixels. Defaults to 1,000;
“infinite” is also a valid value.

maxWidth

"dimensions":
{

"clientHeight": "50px",
"clientWidth": "70px",
"height": "900px",
"width": "800px",
"maxHeight": "2000px",
"maxWidth": "1000px"

},

Force.com Canvas Support for Streaming API
Force.com Canvas provides an event and methods that enable canvas apps to listen for Streaming API notifications.

Available in: Enterprise, Performance, Unlimited, Professional (with Force.com Canvas enabled), and Developer Editions

These events and methods include:

• sfdc.streamingapi—JavaScript event that you create and associate with a Streaming API channel defined by a
PushTopic. See Using the Streaming API Event.

• subscribe—Subscribes to the sfdc.streamingapi event that you define. See Subscribing to a Streaming API Event.

• unsubscribe—Unsubscribes from the sfdc.streamingapi event. See Unsubscribing from a Streaming API Event.

Using the Streaming API Event
Subscribing to a Streaming API Event
Unsubscribing from a Streaming API Event

Using the Streaming API Event
The Force.com Canvas SDK contains an event called sfdc.streamingapi that lets you define an event in your canvas app
and associate that event with a Streaming API channel. You then use the subscribe method to subscribe to the event and
receive Streaming API notifications.

For example, in Salesforce, you can create a Streaming API channel that receives notifications when an InvoiceStatement is
updated and the Status changes to Closed. In your canvas app, you can then create an event associated with that channel and
subscribe to it. In Salesforce, whenever an invoice statement is closed, the activated canvas app receives the notification and
can perform an action such as displaying a message to the user.

Here are some considerations when defining the Streaming API event:

• The event takes a single parameter that contains the PushTopic name.
• The PushTopic name must be prefaced by “/topic/.”

{name:"sfdc.streamingapi", params:{topic:"/topic/myPushTopicName"}}
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Subscribing to a Streaming API Event
This code example shows how to call the subscribe method so that a canvas app can subscribe to a Streaming API event.
When you subscribe to an event, you call the standard sfdc.canvas.client.subscribe method that you use to subscribe
to a canvas app event. When you call the subscribe method, you must pass in the client and the Streaming API event. Only
canvas apps that are open and subscribed to the event can receive Streaming API notifications.

In this example, the onComplete method specifies the function that runs after the code successfully subscribes to the event.
The onData method specifies the function that runs when a Streaming API notification is received by the event.

// Subscribe to Streaming API events.
// The PushTopic to subscribe to must be passed in.
// The 'onComplete' method may be defined,
// and will fire when the subscription is complete.
Sfdc.canvas(function() {

sr = JSON.parse('<%=signedRequestJson%>');
var handler1 = function(){ console.log("onData done");},
handler2 = function(){ console.log("onComplete done");};
Sfdc.canvas.client.subscribe(sr.client,

{name : 'sfdc.streamingapi', params:{topic:"/topic/InvoiceStatements"}},
onData : handler1, onComplete : handler2}

);
});

When you call the subscribe method, a REST call is made to ensure that the canvas app has the OAuth scope needed to
connect to the Streaming API. Therefore, each time a canvas app subscribes to a Streaming API event, one API call is used
and is counted against the organization’s total API requests limits. The canvas app needs at least the “Access and Manage
Your Data (API)” OAuth scope to connect to the Streaming API.

If the call to the subscribe method is successful, the onComplete method is called with a payload of
{success:true,handle:handle}. The handle is an array that contains the name of the Streaming API channel being
subscribed to and the subscriptionId is an integer that contains a unique ID. For example,
["/topics/InvoiceStatements", subscriptionId]. If the call to the subscribe method fails, the onComplete
method is called with a payload of {success:false,errorMessage:msg}. The msg is a string that contains the cause
of the error.

To receive Streaming API notifications, you must create a channel defined by a PushTopic. For more information, see “Step
2: Create a PushTopic” in the Force.com Streaming API Developer’s Guide.

Unsubscribing from a Streaming API Event
This code example shows how to call the unsubscribe method so that a canvas app can unsubscribe from a Streaming API
event.

//Unsubscribe from Streaming API events.
//The PushTopic to unsubscribe from must be passed in.
Sfdc.canvas(function() {

sr = JSON.parse('<%=signedRequestJson%>');
Sfdc.canvas.client.unsubscribe(sr.client, {name : 'sfdc.streamingapi',

params:{topic:"/topic/InvoiceStatements"}});
});

Apex Code
Apex code is the first multitenant, on-demand programming language for developers interested in building the next generation
of business applications.
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Available in: Performance, Unlimited, Developer, Enterprise, and Database.com Editions

Apex includes the following enhancements. For detailed information on these enhancements, refer to the Force.com Apex Code
Developer's Guide.

Statement Limit Elimination
Scheduled Job Name and Type Available in Queries
PreviousFireTime Reset for Upgraded Scheduled Apex Jobs
Triggers for Topic and TopicAssignment
QuickAction.QuickActionRequest Class Update
Chatter in Apex
Changed Error Behavior
Code Coverage Information in the Developer Console Only

Statement Limit Elimination
The code statement limit has been removed. Apex transactions are no longer limited by the number of code statements they
can execute, allowing you to potentially execute more code statements than the previously enforced statement limit.

To protect against infinite processes overusing shared CPU resources, the maximum CPU time for a transaction is 10,000
milliseconds for synchronous Apex, and 60,000 milliseconds for asynchronous Apex (Batch Apex and future methods).

CPU time is calculated for all executions occurring in the transaction—for the executing Apex code, and any processes that
are called from this code, such as package code and workflows. CPU time is private for a transaction and is isolated from other
transactions. If the CPU limit is exceeded, a LimitException that can’t be handled is thrown, as is the case with any other
governor limit that has been exceeded.

Operations that don’t consume application server CPU time aren’t counted toward CPU time. For example, the portion of
execution time spent in the database for DML, SOQL, and SOSL isn’t counted, nor is waiting time for Apex callouts.

Scheduled Job Name and Type Available in Queries
You can now obtain the name and type of a scheduled job programmatically via SOQL queries. Previously, this information
couldn’t be obtained in a query. The new CronJobDetail SOAP API object exposes the name and type of a scheduled job.
Each CronTrigger record, which represents a scheduled job, is now associated with a CronJobDetail record that provides the
additional information about the job’s name and type.

To get the job’s name and the job’s type, use the CronJobDetail relationship when performing a query on CronTrigger.
This example retrieves the most recent CronTrigger record with the job name and type from CronJobDetail.

CronTrigger job =
[SELECT Id, CronJobDetail.Id, CronJobDetail.Name, CronJobDetail.JobType
FROM CronTrigger ORDER BY CreatedDate DESC LIMIT 1];

Alternatively, you can query CronJobDetail directly to get the job’s name and type. This next example gets the job’s name and
type for the CronTrigger record queried in the previous example. The corresponding CronJobDetail record ID is obtained by
the CronJobDetail.Id expression on the CronTrigger record.

CronJobDetail ctd =
[SELECT Id, Name, JobType
FROM CronJobDetail WHERE Id = :job.CronJobDetail.Id];
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To obtain the total count of all Apex scheduled jobs excluding all other scheduled job types, perform the following query.

SELECT COUNT() FROM CronTrigger WHERE CronJobDetail.JobType = '7'

These are the available job types on the CronJobDetail SOAP API object. Each job type label is listed with its value in
parenthesis. Use the job type value when querying for a specific job type.

• Data Export (0)

• Dashboard Refresh (3)

• Analytic Snapshot (4)

• Scheduled Apex (7)

• Report Run (8)

• Batch Job (9)

PreviousFireTime Reset for Upgraded Scheduled Apex Jobs
To take advantage of a new and improved scheduling infrastructure introduced in Summer ’13, Apex jobs scheduled before
Summer ’13 are upgraded to run on this new scheduling infrastructure. As a result of this upgrade, the PreviousFireTime
field of the CronTrigger associated with the upgraded scheduled Apex job is set to null. Starting with the first scheduled
Apex job execution and for every subsequent execution, the system will update PreviousFireTime with the expected value
after each run completes.

This upgrade applies to scheduled Apex jobs only and not to other scheduled job types.

Triggers for Topic and TopicAssignment
Topic and TopicAssignment objects now support triggers. To create the triggers in the Salesforce user interface, from
Setup, click Customize > Topics > Topic Triggers or Customize > Topics > TopicAssignment Triggers, and then click
New.

New Classes, Methods, and Interfaces
The following are new Apex classes and methods.

Database Methods and Result Classes
Schema Methods and Describe Result Classes
New Available QuickAction Describe method and class
New QuickAction Describe method and class
QuickAction.DescribeLayoutComponent Class
QuickAction.DescribeLayoutItem Class
QuickAction.DescribeLayoutRow Class
QuickAction.DescribeLayoutSection Class
QuickAction.DescribeQuickActionDefaultValue Class
ChatterAnswers.AccountCreator Interface
New BusinessHours Methods
New QuickAction Methods
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Database Methods and Result Classes
New methods have been added to the Database class. Previously, the merge DML operation was only available as a DML
statement. With the addition of the new merge methods to the Database class, you can now perform a merge using the
appropriate Database method, optionally getting errors returned, if any, instead of exceptions resulting from the merge
operation. Also, two utility methods have been added (getDeleted and getUpdated). These methods are described in
more detail in this table.

DescriptionReturn TypeArgumentsName

Returns the list of individual records that have been
deleted for an sObject type within the specified start
and end dates and times.

The sObjectType argument is the sObject type
name for which to get the deleted records, such as
account or merchandise__c.

Database.GetDeletedResultString sObjectType

Datetime startDate

Datetime endDate

getDeleted

The startDate argument is the start date and time
of the deleted records time window.

The endDate argument is the end date and time of
the deleted records time window.

Results are returned for no more than 15 days
previous to the day the call is executed (or earlier if
an administrator has purged the Recycle Bin).

Example:

Database.GetDeletedResult r =
Database.getDeleted(
'Merchandise__c',
Datetime.now().addHours(-1),
Datetime.now());

Returns the list of individual records that have been
updated for an sObject type within the specified start
and end dates and times.

The sObjectType argument is the sObject type
name for which to get the updated records, such as
account or merchandise__c.

Database.GetUpdatedResultString sobjectType

Datetime startDate

Datetime endDate

getUpdated

The startDate argument is the start date and time
of the updated records time window.

The endDate argument is the end date and time of
the updated records time window.

Results are returned for no more than 30 days
previous to the day the call is executed.

Example:

Database.GetUpdatedResult r =
Database.getUpdated(
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DescriptionReturn TypeArgumentsName

'Merchandise__c',
Datetime.now().addHours(-1),
Datetime.now());

Merges the specified duplicate record into the master
sObject record of the same type, deleting the

Database.MergeResultsObject master

Id duplicate

merge

duplicate, and reparenting any related records.
Merges only accounts, contacts, or leads.

The master argument is the master sObject record
the duplicate record is merged into.

(Optional) Boolean
allOrNone

The duplicate argument is the ID of the record
to merge with the master. This record must be of
the same sObject type as the master.

Optional allOrNone argument—Set to false to
return any errors encountered in this operation as
part of the returned result. If set to true, this
method throws an exception if the operation fails.
The default is true.

Each executed merge method counts against the
governor limit for DML statements.

Merges the specified duplicate sObject record into
the master sObject of the same type, deleting the
duplicate, and reparenting any related records.

The master argument is the master sObject record
the duplicate record is merged into.

Database.MergeResultsObject master

sObject duplicate

(Optional) Boolean
allOrNone

merge

The duplicate argument is the sObject record to
merge with the master. This sObject must be of the
same type as the master.

Optional allOrNone argument—Set to false to
return any errors encountered in this operation as
part of the returned result. If set to true, this
method throws an exception if the operation fails.
The default is true.

Each executed merge method counts against the
governor limit for DML statements.

Merges up to two records of the same sObject type
into the master sObject record, deleting the others,
and reparenting any related records.

The master argument is the master sObject record
the other records are merged into.

List<Database.MergeResult>sObject master

List<Id>
duplicates

(Optional) Boolean
allOrNone

merge

The duplicates argument is a list of IDs of up to
two records to merge with the master. These records
must be of the same sObject type as the master.
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DescriptionReturn TypeArgumentsName

Optional allOrNone argument—Set to false to
return any errors encountered in this operation as
part of the returned result. If set to true, this
method throws an exception if the operation fails.
The default is true.

Each executed merge method counts against the
governor limit for DML statements.

Merges up to two records of the same object type
into the master sObject record, deleting the others,
and reparenting any related records.

The master argument is the master sObject record
the other sObjects are merged into.

List<Database.MergeResult>sObject master

LIST<SObject>
duplicates

(Optional) Boolean
allOrNone

merge

The duplicates argument is a list of up to two
sObject records to merge with the master. These
sObjects must be of the same type as the master.

Optional allOrNone argument—Set to false to
return any errors encountered in this operation as
part of the returned result. If set to true, this
method throws an exception if the operation fails.
The default is true.

Each executed merge method counts against the
governor limit for DML statements.

The following are new supporting classes for the getDeleted and getUpdated methods.

• Database.GetDeletedResult—Contains the deleted records retrieved for a specific sObject type and time window.

• Database.DeletedRecord—Contains information about a deleted record.

• Database.GetUpdatedResult—Contains the result for the Database.getUpdated method call.

The following is the supporting class for merge methods.

• Database.MergeResult—Contains the result of a merge Database method operation.

Schema Methods and Describe Result Classes
The following are new methods for the Schema class. These new methods result in parity with the counterpart SOAP API
calls.

DescriptionReturn TypeArgumentsName

Describes metadata (field list and object properties)
for the specified sObject or array of sObjects.

The types argument is a list of sObject type
names you want to describe.

List<Schema.
DescribeSObjectResult>

List<String> typesdescribeSObjects
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DescriptionReturn TypeArgumentsName

This method is similar to the getDescribe
method on the Schema.sObjectType token.
Unlike the getDescribe method, this method
allows you to specify the sObject type dynamically
and describe more than one sObject at a time.

You can first call describeGlobal to retrieve a
list of all objects for your organization, then iterate
through the list and use describeSObjects to
obtain metadata about individual objects. The
describeSObjects method is limited to a
maximum of 100 objects returned.

Example:

Schema.DescribeSObjectResult[]
descResult =
Schema.describeSObjects(
new String[]{
'Account','Contact'});

Returns information about the standard and
custom apps available to the running user.

An app is a group of tabs that works as a unit to
provide application functionality. For example,

LIST<Schema.
DescribeTabSetResult>

describeTabs

two of the standard Salesforce apps are “Sales” and
“Call Center.”

The describeTabs method returns the
minimum required metadata that can be used to
render apps in another user interface. Typically,
this call is used by partner applications to render
Salesforce data in another user interface, such as
in a mobile or connected app.

In the Salesforce user interface, users have access
to standard apps (and might also have access to
custom apps) as listed in the Salesforce app menu
at the top of the page. Selecting an app name in
the menu allows the user to switch between the
listed apps at any time.

Note:  The “All Tabs” tab isn’t included
in the list of described tabs.

Example:

Schema.DescribeTabSetResult[]
tabSetDesc =
Schema.describeTabs();
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The following are new supporting classes for describeTabs that contain result metadata information.

• Schema.DescribeTabSetResult—Contains metadata information about a standard or custom app available in the
Salesforce user interface.

• Schema.DescribeTabResult—Contains tab metadata information for a tab in a standard or custom app available in
the Salesforce user interface.

• Schema.DescribeColorResult—Contains color metadata information for a tab.

• Schema.DescribeIconResult—Contains icon metadata information for a tab.

New Available QuickAction Describe method and class
The new QuickAction describeAvailableQuickActions method returns an array of available quick action describe
result objects (QuickAction.DescribeAvailableQuickActionResult). Each result object contains describe metadata
information for a publisher quick action that is available for a specified parent.

Note:  In the application, QuickActions are referred to as actions or publisher actions.

DescriptionReturn TypeMethod

The publisher action label.StringgetLabel

The publisher action name.StringgetName

The publisher action type.StringgetType

New QuickAction Describe method and class
The new QuickAction describeQuickActions method returns an array of quick action describe result objects
(QuickAction.DescribeQuickActionResult). Each result object contains describe metadata information for a publisher
quick action for a specified sObject.

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeQuickActionResult class has the following instance methods.

DescriptionReturn TypeMethod

Returns the name of the Canvas application, if used.StringgetCanvasApplicationName

Note:  Support for Force.com Canvas apps in
the publisher and in the Chatter feed is
currently available through a pilot program and
is available in all new Development Edition
organizations. For information on enabling it
for your organization, contact salesforce.com.

Returns the default values for an action.LIST<QuickAction.
DescribeQuickActionDefaultValue>

getDefaultValues
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DescriptionReturn TypeMethod

Returns the height in pixels of the action pane.IntegergetHeight

Returns the actions’ icon name.StringgetIconName

Returns the URL of the 32x32 icon used for the action.StringgetIconUrl

Returns a list of Schema.DescribeIconResult
objects that describe colors used in a tab.

LIST
<Schema.DescribeIconResult>

getIcons

Returns the action label.StringgetLabel

Returns the layout sections that comprise an action.QuickAction.
DescribeLayoutSection

getLayout

Returns the 16x16 icon URL.StringgetMiniIconUrl

Returns the action name.StringgetName

Returns the object type used for the action.StringgetSourceSobjectType

Returns the parent object’s type for the action.StringgetTargetParentField

Returns the record type of the targeted record.StringgetTargetRecordTypeId

Returns the action’s target object type.StringgetTargetSobjectType

Returns a create or custom Visualforce action.StringgetType

If Visualforce is used, returns the name of the associated
page for the action.

StringgetVisualforcePageName

If a custom action is created, returns the width in pixels
of the action pane.

IntegergetWidth

QuickAction.DescribeLayoutComponent Class
The new QuickAction DescribeLayoutComponent class represents the smallest unit in a layout—a field or a separator.

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeLayoutComponent class has the following instance methods.

DescriptionReturn TypeMethod

Returns the vertical lines displayed for a field. Applies
to textarea and multi-select picklist fields.

IntegergetDisplayLines

Returns the tab order for the item in the row.IntegergetTabOrder

Returns the name of the
QuickAction.DescribeLayoutComponent type
for this component.

StringgetType
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DescriptionReturn TypeMethod

Returns the field name if the type for
QuickAction.DescribeLayoutComponent is
textarea.

StringgetValue

QuickAction.DescribeLayoutItem Class
Represents an individual item in a QuickAction.DescribeLayoutRow. For most fields on a layout, there is only one
component per layout item. However, in a display-only view, the QuickAction.DescribeLayoutItem might be a composite
of the individual fields (for example, an address can consist of street, city, state, country, and postal code data). On the
corresponding edit view, each component of the address field would be split up into separate
QuickAction.DescribeLayoutItems.

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeLayoutItem class has the following instance methods.

DescriptionReturn TypeMethod

Returns the label text for this item.StringgetLabel

Returns a list of
QuickAction.DescribeLayoutComponents for
this item.

LIST<QuickAction.
DescribeLayoutComponent>

getLayoutComponents

Indicates whether this item can be edited (true) or not
(false).

BooleanisEditable

Indicates whether this item is a placeholder (true) or
not (false). If true, this item is blank.

BooleanisPlaceholder

Indicates whether this item is required (true) or not
(false). This is useful if, for example, you want to
render required fields in a contrasting color.

BooleanisRequired

QuickAction.DescribeLayoutRow Class
Represents a row in a QuickAction.DescribeLayoutSection. A QuickAction.DescribeLayoutRow consists of
one or more QuickAction.DescribeLayoutItem objects. For each QuickAction.DescribeLayoutRow, a
QuickAction.DescribeLayoutItem refers either to a specific field or to an “empty”
QuickAction.DescribeLayoutItem (one that contains no QuickAction.DescribeLayoutComponent objects). An
empty QuickAction.DescribeLayoutItem can be returned when a given QuickAction.DescribeLayoutRow is
sparse (for example, containing more fields on the right column than on the left column).

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeLayoutRow class has the following instance methods.
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DescriptionReturn TypeMethod

Returns either a specific field or an empty
QuickAction.DescribeLayoutItem (one that

LIST<QuickAction.
DescribeLayoutItem>

getLayoutItems

contains no
QuickAction.DescribeLayoutComponent objects).

Returns the number of
QuickAction.DescribeLayoutItem.

IntegergetNumItems

QuickAction.DescribeLayoutSection Class
Represents a section of a layout and consists of one or more columns and one or more rows (an array of
QuickAction.DescribeLayoutRow).

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeLayoutSection class has the following instance methods.

DescriptionReturn TypeMethod

Returns the number of columns in the
QuickAction.DescribeLayoutSection.

IntegergetColumns

The heading text (label) for the
QuickAction.DescribeLayoutSection.

StringgetHeading

Returns an array of one or more
QuickAction.DescribeLayoutRow objects.

LIST<QuickAction.
DescribeLayoutRow>

getLayoutRows

Returns the number of rows in the
QuickAction.DescribeLayoutSection.

IntegergetRows

Indicates whether the
QuickAction.DescribeLayoutSection is a
collapsible section (true) or not (false).

BooleanisUseCollapsibleSection

Indicates whether the heading is used (true) or not
(false).

BooleanisUseHeading

QuickAction.DescribeQuickActionDefaultValue Class
Returns a default value for a quick action. Represents the default values of fields to use in default layouts.

Note:  In the application, QuickActions are referred to as actions or publisher actions.

The QuickAction.DescribeQuickActionDefaultValue class has the following instance methods.
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DescriptionReturn TypeMethod

Returns the default value of the quick action.StringgetDefaultValue

Returns the field name of the action.StringgetField

ChatterAnswers.AccountCreator Interface

Chatter Answers is available in: Enterprise, Developer, Performance, and Unlimited Editions.

The ChatterAnswers.AccountCreator interface is a new interface that creates Account records that will be associated
with Chatter Answers users. The ChatterAnswers.AccountCreator is specified in the registrationClassName
attribute of a chatteranswers:registration Visualforce component. This interface is called by Chatter Answers and
allows for custom creation of Account records used for portal users.

The ChatterAnswers.AccountCreator interface has one method,createAccount, which accepts basic user information
and creates an Account record. The implementation of this method returns the account ID.

This is an example implementation of the ChatterAnswers.AccountCreator interface. The createAccount method
implementation accepts user information and creates an Account record. The method returns a String value for the Account
ID.

public class ChatterAnswersRegistration implements ChatterAnswers.AccountCreator {
public String createAccount(String firstname, String lastname, Id siteAdminId) {

Account a = new Account(name = firstname + ' ' + lastname, ownerId = siteAdminId);

insert a;
return a.Id;

}
}

This example tests the code above.

@isTest
private class ChatterAnswersCreateAccountTest {

static testMethod void validateAccountCreation() {
User[] user = [SELECT Id, Firstname, Lastname from User];
if (user.size() == 0) { return; }
String firstName = user[0].FirstName;
String lastName = user[0].LastName;
String userId = user[0].Id;

String accountId = new ChatterAnswersRegistration().createAccount(firstName, lastName,
userId);

Account acct = [SELECT name, ownerId from Account where Id =: accountId];
System.assertEquals(firstName + ' ' + lastName, acct.name);
System.assertEquals(userId, acct.ownerId);

}
}

New BusinessHours Methods
These new static methods have been added to the BusinessHours class.

286

New Classes, Methods, and InterfacesForce.com Development



DescriptionReturn TypeArgumentsName

Returns true if the specified target date occurs within
business hours. Holidays are included in the calculation.

The businessHoursId argument is the business hours
ID.

BooleanString
businessHoursId

Datetime
targetDate

isWithin

The targetDate argument is the date to verify.

Starting from the specified target date, returns the next
date when business hours are open. If the specified target
date falls within business hours, this target date is returned.

The businessHoursId argument is the business hours
ID.

DatetimeString
businessHoursId

Datetime
targetDate

nextStartDate

The targetDate argument is the date used as a start date
to obtain the next date.

Examples

The following example finds whether a given time is within the default business hours.

// Get the default business hours
BusinessHours bh = [SELECT Id FROM BusinessHours WHERE IsDefault=true];

// Create Datetime on May 28, 2013 at 1:06:08 AM in the local timezone.
Datetime targetTime = Datetime.newInstance(2013, 5, 28, 1, 6, 8);

// Find whether the time is within the default business hours
Boolean isWithin= BusinessHours.isWithin(bh.id, targetTime);

The following example finds the next date starting from the target date when business hours reopens. If the target date is
within the given business hours, the target date is returned. The returned time is in the local time zone.

// Get the default business hours
BusinessHours bh = [SELECT Id FROM BusinessHours WHERE IsDefault=true];

// Create Datetime on May 28, 2013 at 1:06:08 AM in the local timezone.
Datetime targetTime = Datetime.newInstance(2013, 5, 28, 1, 6, 8);
// Starting from the targetTime, find the next date when business hours reopens. Return the
target time.

// if it is within the business hours. The returned time will be in the local time zone
Datetime nextStart = BusinessHours.nextStartDate(bh.id, targetTime);

New QuickAction Methods
These new static methods have been added to the QuickAction class.
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DescriptionReturn TypeArgumentsName

Returns the metadata information for the
available quick actions of the provided parent
object,

The parentType argument is the parent object
type. This can be an object type name ('Account')

List<QuickAction.
DescribeAvailable
QuickActionResult>

String
parentType

describeAvailableQuickActions

or 'Global' (meaning that this method is called
at a global level and not an entity level).

Returns the metadata information for the
provided quick actions.

The sObjectNames argument is the names of
the quick actions. The quick action name can

List<QuickAction.
DescribeQuick
ActionResult>

List<String>
sObjectNames

describeQuickActions

contain the entity name if it is at the entity level
('Account.QuickCreateContact'), or 'Global' if
used for the action at the global level
('Global.CreateNewContact').

QuickAction.QuickActionRequest Class Update
For Apex saved using Salesforce.com API version 28.0, a parent ID is associated with the QuickActionRequest instead of the
context ID. In version 29.0 and above, it’s context ID.

Chatter in Apex
To create custom Chatter experiences in Salesforce, use Chatter in Apex.

Many Chatter REST API resource actions are exposed as static methods on Apex classes in the ConnectApi namespace.
These methods use other ConnectApi classes to input and return information. The ConnectApi namespace is referred to
as Chatter in Apex.

In Apex, it is possible to access some Chatter data using SOQL queries and objects. However, ConnectApi classes expose
Chatter data in a much simpler way. Data is localized and structured for display. For example, instead of making many calls
to access and assemble a feed, you can do it with a single call.

Note:  To integrate mobile apps, intranet sites, and third party Web applications with Chatter, use Chatter REST
API.

General Updates to Chatter in Apex
New and Changed Chatter in Apex Classes
New and Changed Chatter in Apex Input Classes
New and Changed Chatter in Apex Output Classes
New and Changed Chatter in Apex Enums
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General Updates to Chatter in Apex
5000 character limit for feed items and comments

Feed item and comment input and output bodies can contain 5000 characters. The previous limit was 1000 characters.
This change is available in all API versions.

New and Changed Chatter in Apex Classes
Get mention proposals

Two new ConnectApi.Mentions.getMentionCompletions methods return
ConnectApi.MentionCompletionPage objects that represents a collection of possible users and groups to mention
in a feed item body or comment body. A mention is an “@” character followed by a user or group name. When a user
or group is mentioned, they receive a notification. Call these methods to generate a list of proposed mentions that a user
can choose from when they enter 2 or more characters in a feed item body or a comment body.

You can specify a contextId argument to narrow the results, with more useful results listed first. To get mention
proposals for a comment, specify the feed item ID so that other users in the thread are shown first in the results. To get
mention proposals for a feed item post to a group, specify the group ID so that group members are shown first in the
results.

Validate mention proposals
The new ConnectApi.Mentions.getMentionValidations method returns a
ConnectApi.MentionValidations object that represents information about whether the specified mention proposals
are valid for the context user. Call this method to verify that the list of proposed mentions is valid before you present
the proposals to the user.

Moderate communities
The new ConnectApi.CommunityModeration class provides information about moderation flags on comments and
feed items in a community. Add and remove one or more flags to and from comments and feed items. The class contains
these methods:
• ConnectApi.CommunityModeration.addFlagToComment—Add a moderation flag to a comment.
• ConnectApi.CommunityModeration.addFlagToFeedItem—Add a moderation flag to a feed item
• ConnectApi.CommunityModeration.getFlagsOnComment—Get moderation flags added to a comment.
• ConnectApi.CommunityModeration.getFlagsOnFeedItem—Get moderation flags added to a feed item.
• ConnectApi.CommunityModeration.removeFlagsOnComment—Remove moderation flags from a comment.
• ConnectApi.CommunityModeration.removeFlagsOnFeedItem—Remove moderation flags from a feed

item.

To see the moderation flags, use the new Moderation Feed. Pass the new ConnectApi.FeedType.Moderation
enum value in a call to ConnectApi.ChatterFeeds.getFeedItemsFromFeed.

Specify the number of comments to return
New variants of these methods take a recentCommentCount argument that specifies the maximum number of comments
to return per feed item:
• ConnectApi.ChatterFavorites.getFeedItems

• ConnectApi.ChatterFeeds.getFeedItemsFromFeed

• ConnectApi.ChatterFeeds.getFeedItemsFromFilterFeed

• ConnectApi.ChatterFeeds.searchFeedItems

• ConnectApi.ChatterFeeds.searchFeedItemsInFeed

• ConnectApi.ChatterFeeds.searchFeedItemsInFilterFeed
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Each method has an accompanying test method to use to register mock data for testing.

Specify the feed density to return
A new density argument of data type ConnectApi.FeedDensity specifies whether feed items return:
• AllUpdates—Displays all posts and comments from people and records the user follows and groups the user is a

member of.
• FewerUpdates—Displays all posts and comments from people and records the user follows and groups the user is

a member of, but hides system-generated posts from records that nobody commented on.

New variants of these methods take the density argument:
• ConnectApi.ChatterFeeds.getFeedItemsFromFeed

• ConnectApi.ChatterFeeds.getFeedItemsFromFilterFeed

• ConnectApi.ChatterFeeds.searchFeedItemsInFeed

• ConnectApi.ChatterFeeds.searchFeedItemsInFilterFeed

Create a group
ConnectApi.ChatterGroups.createGroup is a new method that creates a Chatter group.

Delete a group
ConnectApi.ChatterGroups.deleteGroup is a new method that deletes a Chatter group.

Set a group member’s role
ConnectApi.ChatterGroups.addGroupMemberWithRole is a new method that adds a user to a Chatter group
and assigns the member a role as a standard member or a group manager.

Update a group membership
ConnectApi.ChatterGroups.updateGroupMember is a new method that updates a user’s group membership role
to either a standard member or a group manager.

Get information about groups based on archive status
A new archiveStatus argument of data type ConnectApi.GroupArchiveStatus specifies a set of groups based
on their archive status:
• All—All groups, including groups that are archived and groups that are not archived.
• Archived—Only groups that are archived.
• NotArchived—Only groups that are not archived.

These methods take the archiveStatus argument:
• ConnectApi.ChatterGroups.getGroups

• ConnectApi.ChatterGroups.searchGroups

• ConnectApi.ChatterGroups.setTestSearchGroups

Search for a group with better results
The ConnectApi.ChatterGroups.searchGroups methods now search only the group name field. In earlier versions
the search included other fields, such as the group description field, which caused too much noise in the search results.

Crop photos
There are two new ConnectApi.ChatterGroups.setPhotoWithAttributes methods that let you set and crop
a group photo. One method sets an existing file, and the other uploads and sets a binary input.

Send, receive, and search Chatter Messages
ConnectApi.ChatterMessages is a new class that contains information about message and conversation data. It
contains these static methods:
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• ConnectApi.ChatterMessages.getConversation returns a conversation the context user has access to.
• ConnectApi.ChatterMessages.getConversations returns conversations the context user has access to.
• ConnectApi.ChatterMessages.getMessage returns a message the context user has access to.
• ConnectApi.ChatterMessages.getMessages returns a list of messages the context user has access to.
• ConnectApi.ChatterMessages.getUnreadCount returns the number of conversations the context user has

marked unread.
• ConnectApi.ChatterMessages.markConversationRead marks a conversation as read for the context user.
• ConnectApi.ChatterMessages.replyToMessage adds the specified text as a response to a previous message

the context user has access to.
• ConnectApi.ChatterMessages.searchConversation returns the conversation the context user has access

to with a page of messages that matches the specified search.
• ConnectApi.ChatterMessages.searchConversations returns a page of conversations the context user has

access to where member names and messages in the conversations match the specified search criteria.
• ConnectApi.ChatterMessages.searchMessages returns a page of messages the context user has access to

that match the specified criteria.
• ConnectApi.ChatterMessages.sendMessage sends the specified text to the indicated recipients.

Topics
ConnectApi.Topics is a new class that contains information about topics. It contains these static methods:
• ConnectApi.Topics.assignTopic assigns a topic to a feed item using the topic ID.
• ConnectApi.Topics.assignTopicByName assigns a topic to a feed item using the topic name.
• ConnectApi.Topics.deleteTopic deletes a topic. Only users with the “Delete Topics” or “Modify All Data”

permission can delete topics.
• ConnectApi.Topics.getGroupsRecentlyTalkingAboutTopic returns up to five groups that most recently

contributed to the topic.
• ConnectApi.Topics.getRecentlyTalkingAboutTopicsForGroup returns up to five topics most recently

used in a group.
• ConnectApi.Topics.getRecentlyTalkingAboutTopicsForUser returns up to five topics most recently

used by a user.
• ConnectApi.Topics.getRelatedTopics returns up to five topics most closely related to a topic.
• ConnectApi.Topics.getTopic returns information about a topic.
• Eight ConnectApi.Topics.getTopics methods that:

◊ Return the first page of topics assigned to a feed item.
◊ Return the first page of topics for the organization.
◊ Return the first page of topics for the organization in a specified order.
◊ Return the topics for a specified page.
◊ Return the topics for a specified page in a specified order.
◊ Return the topics that match specified search criteria in a specified order.
◊ Return the topics that match specified search criteria for a specified page.
◊ Return the topics that match specified search criteria for a specified page in a specified order.

• Two ConnectApi.Topics.getTopicSuggestions methods that return suggested topics for a feed item.
• Two ConnectApi.Topics.getTopicSuggestionsForText methods that return suggested topics for a string

of text.
• Two ConnectApi.Topics.getTrendingTopics methods that return up to the top five trending topics for the

organization.
• ConnectApi.Topics.unassignTopic removes a topic from a feed item.
• ConnectApi.Topics.updateTopic updates the description or spacing and capitalization of the name of a topic.
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Get information about a user profile
ConnectApi.UserProfiles is a new class used to access user profile data. It contains one static method,
getUserProfile, which returns the user profile of the context user.

ConnectApi.ChatterUsers.updateUser is a new method that updates the “About Me” section for the specified
user.

Get information about Chatter Answers zones
ConnectApi.Zones is a new class that contains information about searches in zones. It contains these methods:
• getZone returns a specific zone based on the zone ID.
• getZones returns a paginated list of zones.
• getZones returns a paginated list of zones with the specified page and page size.
• searchInZone searches a zone by keyword. Specify whether to search articles or questions.
• searchInZone searches a zone by keyword. Specify whether to search articles or questions and specify the page of

information to view and the page size.

New and Changed Chatter in Apex Input Classes
ConnectApi.CanvasAttachmentInput

Use this new class to attach a canvas app to a feed item. It’s a subclass of ConnectApi.FeedItemAttachmentInput
and has these properties:
• description—The description of the canvas app.
• developerName—The developer name (API name) of the canvas app.
• height—The height of the canvas app in pixels. Default height is 200 pixels.
• namespacePrefix—The namespace prefix of the Developer Edition organization in which the canvas app was

created.
• parameters—Parameters passed to the canvas app in JSON format.
• thumbnailUrl—A URL to a thumbnail image for the canvas app. Maximum dimensions are 120x120 pixels.
• title—The title of the link used to call the canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through
a pilot program and is available in all new Development Edition organizations. For information on enabling it
for your organization, contact salesforce.com.

ConnectApi.ChatterGroupInput

Use the new properties in this class to set the properties of a group.
• canHaveChatterGuests—true if this group allows Chatter customers, false otherwise. After this property is

set to true, it cannot be set to false..
• description—The “Description” section of the group.
• name—The name of the group.
• owner—The ID of the group owner.
• isArchived—true if the group is archived, false otherwise. Defaults to false.
• isAutoArchiveDisabled—true if automatic archiving is turned off for the group, false otherwise. Defaults

to false.
• visibility—Specifies whether a group is private or public.

◊ PrivateAccess—Only members of the group can see posts to this group.
◊ PublicAccess—All users within the internal community can see posts to this group.

292

Chatter in ApexForce.com Development



ConnectApi.MentionSegmentInput

The id property can be a user ID or a group ID because you can now mention Chatter groups in posts and comments.

ConnectApi.PhotoInput

Use these new properties to specify how to crop a photo:
• cropSize—The length, in pixels, of any edge of the crop square.
• cropX—The position X, in pixels, from the left edge of the image to the start of the crop square. Top left is position

(0,0).
• cropY—The position Y, in pixels, from the top edge of the image to the start of the crop square. Top left is position

(0,0).

ConnectApi.TopicAssignmentInput

This new input class has these properties:
• topicId—ID of the existing topic. Required for existing topics if the topicName property isn’t used.
• topicName—Name of the new or existing topic. Required for new topics; required for existing topics if the topicId

property isn’t used.

ConnectApi.TopicInput

This new input class has these properties:
• description—The description of a topic.
• name—The name of a topic. Pass this property in an argument to the ConnectApi.Topic.updateTopic to

change the spacing of a topic name in addition to the capitalization.

ConnectApi.UserInput

This new input class has one property, aboutMe. Pass it as an argument to the
ConnectApi.ChatterUsers.updateUser method. In the Chatter user interface, this property populates the “About
Me” section of the user profile.

New and Changed Chatter in Apex Output Classes
ConnectApi.AbstractRecordField

This new abstract output class represents a field on a record object. This class is a superclass of:
• ConnectApi.BlankRecordField—A record field displayed as a place holder in a grid of fields.
• ConnectApi.LabeledRecordField—A record field containing a label and a text value. This class is a superclass

of:

◊ ConnectApi.CompoundRecordField—A record field that is a composite of sub-fields.
◊ ConnectApi.CurrencyRecordField—A record field containing a currency value.
◊ ConnectApi.DateRecordField—A record field containing a date.
◊ ConnectApi.PercentRecordField—A record field containing a percentage value.
◊ ConnectApi.PicklistRecordField—A record field containing an enumerated value.
◊ ConnectApi.RecordField—A generic record field containing a label and text value.
◊ ConnectApi.ReferenceRecordField—A record field containing a reference to another object.
◊ ConnectApi.ReferenceWithDateRecordField—A record field containing a referenced object that acted

at a specific time, for example, “Created By...”.

ConnectApi.AbstractRecordView

This new abstract output class describes a view of a record, including a record on a custom object. It’s a subclass of
ConnectApi.ActorWithId.
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It’s a superclass of:

• ConnectApi.RecordSummary—As of API version 29.0, this class is a subclass of
ConnectApi.AbstractRecordView in all API versions (including earlier versions). (In 28.0, it was a subclass of
ConnectApi.ActorWithId.)

• ConnectApi.RecordView—A new class that describes a view of any record, including a record on a custom objects.
Designed for rendering an object quickly and easily. This object is returned if a specialized object, such as
UserSummary or ChatterGroup is not available for the record type. It has a sections property, which is a list
of ConnectApi.RecordViewSection objects that make up the sections of the record view detail.

ConnectApi.CanvasTemplateAttachment

This new output class contains properties that describe a feed item attachment with type CanvasPost. It’s a subclass
of ConnectApi.FeedItemAttachment and has these properties:
• description—Description of the canvas app.
• developerName—Developer name (API name) of the canvas app.
• height—Height of the canvas app in pixels. Default is 200 pixels.
• icon—Canvas app icon.
• namespacePrefix—The namespace prefix of the Developer Edition organization in which the canvas app was

created.
• parameters—Parameters passed to the canvas app in JSON format.
• thumbnailUrl—A URL to a thumbnail image for the canvas app. Maximum dimensions are 120x120 pixels.
• title—Title of the link used to call the canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through
a pilot program and is available in all new Development Edition organizations. For information on enabling it
for your organization, contact salesforce.com.

ConnectApi.CaseComment

This output class has a new eventType property which is a ConnectApi.CaseCommentEventType enum that
describes the publishing event type for the case comment.

ConnectApi.ChatterConversation

This new output class contains these properties about a conversation:
• conversationId—The ID for the conversation.
• conversationUrl—Chatter REST API URL identifying the conversation.
• members—A list of ConnectApi.UserSummary objects identifying the users in the conversation.
• messages—A ConnectApi.ChatterMessagePage object containing the content of the conversation.
• read—Specifies whether the conversation has been read (true) or not (false)

ConnectApi.ChatterConversationPage

This new output class contains properties about a page of conversations:
• conversations—A list of ConnectApi.ChatterConversation objects.
• currentPageToken—Token identifying the current page.
• currentPageUrl—Chatter REST API URL identifying the current page.
• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

ConnectApi.ChatterConversationSummary

This new output class contains properties about a conversation summary:
• id—The ID for the conversation summary.
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• latestMessage—A ConnectApi.ChatterMessage object containing the content of the conversation.
• members—A list of ConnectApi.UserSummary objects identifying the users in the conversation.
• read—Specifies whether the conversation has been read (true) or not (false)
• url—Chatter REST API URL to the conversation summary.

ConnectApi.ChatterGroup

This output class has these new properties:
• isArchived—Specifies whether the group is archived (true) or not (false).
• isAutoArchiveDisabled—Specifies whether automatic archiving is disabled for the group (true) or not (false).

ConnectApi.ChatterGroupDetails

This output class has a new pendingRequests property, which is the number of requests to join a group that are in a
pending state.

ConnectApi.ChatterGroupSummary

This new output class contains properties about a group. It’s a subclass of ConnectApi.ChatterGroup

ConnectApi.ChatterGroupSummaryPage

This new output class contains paginated information about ConnectApi.ChatterGroupSummary objects. The
properties are:
• currentPageUrl—Chatter REST API URL identifying the current page.
• groups

• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• previousPageUrl—Chatter REST API URL identifying the previous page or null if there isn’t a previous page.

ConnectApi.ChatterMessage

This new output class contains properties about a message.
• body—A ConnectApi.MessageBody class containing the message.
• conversationId—The ID for the conversation.
• conversationUrl—Chatter REST API URL identifying the message.
• id—The ID of the message.
• recipients—A list of ConnectApi.UserSummary objects to receive the message.
• sender—A ConnectApi.UserSummary object identifying who sent the message.
• sentDate—The date the message was sent.
• url—Chatter REST API URL identifying the current page.

ConnectApi.ChatterMessagePage

This new output class contains properties about a page of messages.
• currentPageToken—Token identifying the current page.
• currentPageUrl—Chatter REST API URL identifying the current page.
• messages—A list of ConnectApi.Message objects representing the messages on the current page.
• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

ConnectApi.Comment

This output class has a new moderationFlags property, which contains a ConnectApi.ModerationFlags object
that contains information about any moderation flags on the comment. If the
ConnectApi.Features.communityModeration property is false, this property is null.
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ConnectApi.EmailAddress

This new output class contains properties about an email address:
• displayName—The display name for the email address.
• emailAddress—The email address.

ConnectApi.EmailMessage

This new output class contains properties about an email message sent from a case record in Case Feed. This class is a
subclass of ConnectApi.FeedItemAttachment and has these properties:
• direction—An ConnectApi.EmailMessageDirection enum with one of these values:

◊ Inbound—An inbound message (sent by a customer).
◊ Outbound—An outbound message (sent to a customer by a support agent).

• emailMessageId—The ID of the email message.
• subject—The subject of the email message.
• textBody—The body of the email message.
• toAddress—A list of ConnectApi.EmailAddress objects to send the message to.

ConnectApi.Features

This output class has these new properties:
• chatterAnswers—Specifies whether Chatter Answers is enabled.
• communityModeration—Specifies whether Community moderation is enabled.
• ideas—Specifies whether Ideas is enabled.

ConnectApi.FeedFavorite

This output class has a new property target, which is a reference to the topic if applicable, null otherwise.

ConnectApi.FeedItem

This output class has these new properties:
• moderationFlags—Information about the moderation flags on a feed item. If the

ConnectApi.Features.communityModeration property is false, this property is null.
• topics—The topics for the feed item.

As of API version 29.0, the value of the ConnectApi.FeedItem.body.text property can be null, which means
you can’t use it as the default case for rendering text. Instead, use the ConnectApi.FeedItem.preamble.text
property as the default case.

ConnectApi.FeedItemTopicPage

This new output class contains a canAssignTopics property that indicates if topics can be assigned to the feed item
and a topics property that lists the topics for the feed item.

ConnectApi.FieldChangeValueSegment

This output class has a new valueType property that specifies whether the message segment contains the old value or
the new value.

ConnectApi.FileSummary

This output class has these new properties:
• publishStatus—A ConnectApi.FilePublishStatus enum.
• sharingRole—A ConnectApi.FileSharingType enum.
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ConnectApi.MentionCompletion

This new output class contains information about a record that could be used to mention a user or group. It has these
properties:
• additionalLabel—An additional label (if one exists) for the record represented by this completion, for example,

“(Customer)” or “(Acme Corporation)”.
• description—A description of the record represented by this completion.
• name—The name of the record represented by this completion. The name is localized, if possible.
• photoUrl—A URL to the photo or icon of the record represented by this completion.
• recordId—The ID of the record represented by this completion.

ConnectApi.MentionCompletionPage

This new output class contains a paginated list of the ConnectApi.MentionCompletionobjects.
• currentPageUrl—Chatter REST API URL identifying the current page.
• mentionCompletions—A list of mention completion proposals. Use these proposals to build a feed post body.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• previousPageUrl—Chatter REST API URL identifying the previous page or null if there isn’t a previous page.

ConnectApi.MentionSegment

This class has a new record property which is a ConnectApi.ActorWithId object that represents the mentioned
user or group.

The record property was added because you can now mention groups in addition to users. As of version 29.0, use the
record property instead of the user property, which is no longer available. In versions earlier than 29.0, if the mention
is not a user, the mention is in a ConnectApi.TextSegment object.

ConnectApi.MentionValidation

This new output class represents mention validation information for a specific proposed mention. It contains these
properties:
• recordId—The ID of the record to mention.
• validationStatus—Specifies the type of validation error for a proposed mention, if any.

◊ Disallowed—The proposed mention is invalid and will be rejected because the context user is trying to mention
something that is not allowed. For example a user who is not a member of a private group is trying to mention
the private group.

◊ Inaccessible—The proposed mention is allowed but the user or record being mentioned will not be notified
because they don't have access to the parent record being discussed.

◊ Ok—There is no validation error for this proposed mention.

ConnectApi.MentionValidations

This new output class represents a collection of mention validation information.
• hasErrors—Indicates whether at least one of the proposed mentions has an error (true), or not (false). For

example, the context user can’t mention private groups he doesn’t belong to. If such a group were included in the list
of mention validations, hasErrors would be true and the group would have a validationStatus of Disallowed
in its mention validation.

• mentionValidations—A list of mention validation information in the same order as the provided record IDs.

ConnectApi.ModerationFlags

This new output class represents moderation flags. It has these properties:
• flagCount—The number of moderation flags on this feed item or comment. If the logged-in user is not a community

moderator, the property is null.
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• flaggedByMe—Specifies whether the context user had flagged the feed item or comment for moderation (true)
or not (false).

ConnectApi.MoreChangesSegment

This output class has a new moreChanges property that contains the complete list of tracked changes for a feed item.

ConnectApi.Motif

ConnectApi.Motif has a new color property which contains the hex value of the record type’s base color. Use this
value behind the motif icons.

ConnectApi.RecordSnapshotAttachment

This new output class is a subclass of ConnectApi.FeedItemAttachment. It represents the fields of the record at
the point in time when the record was created. It has one property, recordView, which is a ConnectApi.RecordView
object.

ConnectApi.RecordViewSection

This new output class represents a section of a record fields on a record detail. It has these properties:
• columnCount—The number of columns to use to lay out the fields in a record section.
• columnOrder—The order of the fields to use in the fields property to lay out the fields in a record section. The

data type is a ConnectApi.RecordColumnOrder enum.
• fields—The fields and values for the record contained in this section. The data type is a list of

ConnectApi.AbstractRecordField objects.
• heading—A localized label to display when rendering this section of fields.
• isCollapsible—Indicates whether the section can be collapsed to hide all the fields (true) or not (false).

ConnectApi.Topic

This new output class contains properties about a topic.
• createdDate—ISO8601 date string, for example, 2011-02-25T18:24:31.000Z
• description—Description of the topic
• id—18-character ID of the topic
• name—
• talkingAbout—Number of people talking about this topic over the last two months, based on factors such as topic

additions and comments on posts with the topic

ConnectApi.TopicPage

This new output class contains a list of ConnectApi.Topic objects.

ConnectApi.TopicSuggestion

This new output class contains properties about a topic suggestion:
• existingTopic—A ConnectApi.Topic object that already exists or null for a new topic.
• name—The topic name.

ConnectApi.TopicSuggestionPage

This new output class contains a list of ConnectApi.TopicSuggestion objects.

ConnectApi.TrackedChangeAttachment

This new output class is a subclass of ConnectApi.FeedItemAttachment. It has one property, changes, which is
a list of ConnectApi.TrackedChangeItem objects.
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ConnectApi.TrackedChangeItem

This new output class represents a change to a field on a record. It has these properties:
• fieldName—The name of the field that was updated.
• newValue—The new value of the field or null if the field length is long or empty.
• oldvalue—The old value of the field or null if the field length is long or empty.

ConnectApi.UnreadConversationCount

This new output class contains properties about unread conversations:
• hasMore—Specifies if there are more unread messages (true) or not (false).
• unreadCount—The number of unread messages.

ConnectApi.UserCapabilities

This new output class contains information about the capabilities associated with a user’s profile.
• canChat—Specifies if the context user can use Chatter Messenger with the subject user (true) or not (false)
• canDirectMessage—Specifies if the context user can direct message the subject user (true) or not (false)
• canEdit—Specifies if the context user can edit the subject user’s account (true) or not (false)
• canFollow—Specifies if the context user can follow the subject user’s feed (true) or not (false)
• canViewFeed—Specifies if the context user can view the feed of the subject user (true) or not (false)
• canViewFullProfile—Specifies if the context user can view the full profile of the subject user (true) or only

the limited profile (false)
• isModerator—Specifies if the subject user is a Chatter moderator or admin (true) or not (false)

ConnectApi.UserDetail

This output class has a new thanksReceived property containing the number of times the user has been thanked.

ConnectApi.UserProfile

This new output class contains information required to display a user’s profile.
• capabilities—The context user’s capabilities specific to the subject user’s profile
• id—The ID of the user attached to the profile
• tabs—The tabs visible to the context user specific to the subject user’s profile
• url—The URL of the user’s profile
• userDetail—The details about the user attached to the profile

ConnectApi.UserProfileTab

This new output class contains properties about a user profile tab.
• id—The tab’s unique identifier or 18–character ID
• isDefault—Specifies if the tab appears first when clicking the user profile (true) or not (false)
• tabType—Specifies the type of tab
• tabUrl—The current tab’s content URL (for non built-in tab types)

ConnectApi.UserSettings

This output class has a new hasRestDataApiAccess property that indicates whether or not the user has access to
REST API.

ConnectApi.Zone

This new output class contains information about a zone.
• description—The description of the zone.
• id—The ID of the zone.
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• isActive—Indicates whether the zone is active.
• isChatterAnswers—Indicates whether the zone is available for Chatter Answers.
• name—The name of the zone.
• visibility—The zone visibility. A ConnectApi.ZoneShowIn enum value:

◊ Community—Available in a community.
◊ Internal—Available internally only.
◊ Portal—Available in a portal.

• visibilityId—If the zone is available in a portal or a community, this property contains the ID of the portal or
community. If the zone is available to all portals, this property contains the value All.

ConnectApi.ZonePage

This new output class contains information about a page of zones:
• zones—A list of ConnectApi.Zone objects.
• currentPageUrl—Chatter REST API URL identifying the current page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

ConnectApi.ZoneSearchPage

This new output class contains information about the search results within a zone:
• currentPageToken—Token identifying the current page.
• currentPageUrl—Chatter REST API URL identifying the current page.
• items—A list of ConnectApi.ZoneSearchResult objects.
• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

ConnectApi.ZoneSearchResult

This new output class contains information about a search result within a zone:
• hasBestAnswer—Indicates if the search result has a best answer.
• id—ID of the search result. The search result can be a question or an article.
• title—Title of the search result.
• type—Type of the search result. A ConnectApi.ZoneSearchResultType enum:

◊ Article—Search results contain only articles.
◊ Question—Search results contain only questions.

• voteCount—Number of votes given to the search result.

New and Changed Chatter in Apex Enums
ConnectApi.CaseCommentEventType

This new enum specifies the publishing event type of a case comment. It has these values:
• NewInternal—A case comment that has newly been marked Internal Only.
• NewPublished—A newly published case comment.
• NewPublishedByCustomer—A case comment by a customer that was newly published.
• PublishExsiting—An existing case comment that was re-published.

Note:  Although this value appears to be a typo, it’s not. Use this spelling in your code.
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• PublishExistingByCustomer—An existing case comment by a customer that was re-published.
• UnpublishExisting—An existing case comment that was unpublished.
• UnpublishExistingByCustomer—An existing case comment by a customer that was unpublished.

ConnectApi.EmailMessageDirection

This new enum specifies the direction of an email message. It has these values:
• Inbound—An inbound message (sent by a customer).
• Outbound—An outbound message (sent to a customer by a support agent).

ConnectApi.FeedDensity

This new enum specifies the amount of content to display in a feed. It has these values:
• AllUpdates—Displays all posts and comments from people and records the user follows and groups the user is a

member of.
• FewerUpdates—Displays all posts and comments from people and records the user follows and groups the user is

a member of, but hides system-generated posts from records that nobody commented on.

ConnectApi.FeedItemAttachmentInputType

Specifies the feed item attachment type for input objects. This enum has one new value:
• Canvas—Indicates that the feed item contains the metadata to create a canvas app feed item.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available
through a pilot program and is available in all new Development Edition organizations. For information on
enabling it for your organization, contact salesforce.com.

ConnectApi.FeedItemAttachmentType

Specifies the feed item attachment type for output objects. It has these values:
• Canvas—A feed item that contains the metadata to render a link to a canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available
through a pilot program and is available in all new Development Edition organizations. For information on
enabling it for your organization, contact salesforce.com.

• EmailMessage—An email attached to a case record in Case Feed.
• RecordSnapshot—The feed item attachment contains a view of a record at a single

ConnectApi.FeedItemType.CreateRecordEvent.
• TrackedChange—All changes to a record for a single ConnectApi.FeedItemType.TrackedChange event.

ConnectApi.FeedItemType

Specifies the feed item type. It has these values:
• CanvasPost—Feed item generated by a canvas app in the publisher or from Chatter REST API or Chatter in

Apex. The post itself is a link to a canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available
through a pilot program and is available in all new Development Edition organizations. For information on
enabling it for your organization, contact salesforce.com.

• ReplyPost—Feed item generated by a Chatter Answers reply.
• TrackedChange—All changes to a record for a single ConnectApi.FeedItemType.TrackedChange event.
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ConnectApi.FeedType

This enum has a new Moderation value. The Communities Moderation Feed contains all feed items and comments
that have been flagged for moderation in a community. This feed is available only to users with “Moderate Community
Feeds” permissions.

ConnectApi.FieldChangeValueType

This new enum specifies the value type of a field change. It has these values:
• NewValue—A new value
• OldValue—An old value

ConnectApi.FilePublishStatus

This new enum specifies the publish status of the file. It has these values:
• PendingAccess—File is pending publishing.
• PrivateAccess—File is private.
• PublicAccess—File is public.

ConnectApi.FileSharingType

This new enum specifies the sharing role of the file. It has these values:
• Admin—Owner permission, but doesn’t own the file.
• Collaborator—Viewer permission, and can edit, change permissions, and upload a new version of a file.
• Owner—Collaborator permission, and can make a file private, and delete a file.
• Viewer—Can view, download, and share a file.
• WorkspaceManaged—Permission controlled by the library.

ConnectApi.GroupArchiveStatus

This new enum specifies a set of groups based on whether the groups are archived or not. It has these values:
• All—All groups, including groups that are archived and groups that are not archived.
• Archived—Only groups that are archived.
• NotArchived—Only groups that are not archived.

ConnectApi.MentionCompletionType

This new enum specifies the type of mention completion. It has these values:
• All—All mention completions, regardless of the type of record to which the mention refers.
• Group—Mention completions for groups.
• User—Mention completions for users.

ConnectApi.MentionValidationStatus

This new enum specifies the type of validation error for a proposed mention, if any. It has these values:
• Disallowed—The proposed mention is invalid and will be rejected because the context user is trying to mention

something that is not allowed. For example a user who is not a member of a private group is trying to mention the
private group.

• Inaccessible—The proposed mention is allowed but the user or record being mentioned will not be notified
because they don't have access to the parent record being discussed.

• Ok—There is no validation error for this proposed mention.

ConnectApi.RecordColumnOrder

This new enum specifies the order in which to render record fields. It has these values:
• LeftRight—Fields are rendered from left to right.
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• TopDown—Fields are rendered from the top down.

ConnectApi.RecordFieldType

This new enum specifies the type of a record field. It has these values:
• Address

• Blank

• Boolean

• Compound

• CreatedBy

• Date

• DateTime

• Email

• LastModifiedBy

• Location

• Name

• Number

• Percent

• Phone

• Picklist

• Reference

• Text

• Time

ConnectApi.SortOrder

This new enum specifies generic sort directions. It has these values:
• Ascending—Ascending order (A-Z).
• Descending—Descending order (Z-A).

ConnectApi.TopicSort

This new enum specifies the sort order for topics. It has these values:
• popularDesc—Sorts topics by popularity with the most popular first. This value is the default.
• alphaAsc—Sorts topics alphabetically.

ConnectApi.UserProfileTabType

This new enum specifies the type of profile tab. It has these values:
• CustomVisualForce—Tab that displays data from a Visualforce page.
• CustomWeb—Tab that displays data from any external Web-based application or Web page.
• Feed—Tab that displays the Chatter feed.
• Overview—Tab that displays user details.

ConnectApi.ZoneSearchResultType

This new enum specifies the search result type in a zone. It has these values:
• Article—Search results contain only articles.
• Question—Search results contain only questions.

ConnectApi.ZoneShowIn

This new enum specifies where the zone is available. It has these values:
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• Community—Available in a community.
• Internal—Available internally only.
• Portal—Available in a portal.

Changed Error Behavior
Winter ’14 introduces these Apex error behavior changes.

Updated Errors for Email Messaging Methods
Different Status Codes Returned by DML Exceptions for the User Object

Updated Errors for Email Messaging Methods
Errors have changed for the Apex Messaging methods reserveMassEmailCapacity and reserveSingleEmailCapacity,
which are used when sending a mass or single email, respectively.

If the transaction would cause the organization to exceed its daily email limit, using either of these methods results in a Handled
Exception error. (Previously it resulted in a Limit Exception error.) The error that appears is: System.HandledException:
The daily limit for the org would be exceeded by this request.

In addition, if the organization doesn’t have permission to send API or mass email, using either of these methods now results
in the following error: System.NoAccessException: The organization is not permitted to send email.

Different Status Codes Returned by DML Exceptions for the User Object
For the User object, we improved the behavior around simultaneous updates to the same record. However, getDmlType may
now return different status codes. For details, see User Object Save Behavior and Error Changes on page 309.

Code Coverage Information in the Developer Console Only
All code coverage information is now available in the Developer Console only. The following are no longer available from
Setup:

• The Clear Code Coverage button was removed from the Develop > Apex Classes page.

• The Code Coverage column was removed from the list view on the Develop > Apex Classes page and the Develop >
Apex Triggers page.

Note:  The only code coverage information you can access from Setup is the code coverage estimate based on existing
test results. You can obtain this estimate from the Develop > Apex Classes page by clicking Estimate your
organization’s code coverage.

API
Use the API to create apps that integrate Salesforce with other services.

New and Changed Objects
SOQL
SOSL
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REST API
SOAP API
Streaming API
Metadata API
Tooling API
Analytics API

New in version 29.0, the Analytics API lets you integrate Salesforce report data into your apps programmatically. For example,
you can use the REST based API to build reporting into a third-party app to show a leaderboard of Dreamforce attendee
registrations at your sessions. The API has several resources that let you query report metadata, and get report results
dynamically at the summary or record detail level.

New and Changed Objects
For information about new and changed Chatter objects, see Chatter Objects.

New Objects

These objects are new in API version 29.0.
• The AcceptedEventRelation object represents invitees with the status Accepted for a given event.

• The AccountCleanInfo object stores the metadata Data.com Clean uses to determine an account record’s clean status.

• The AllowedEmailDomain object represents an allowed email domain for users in your organization.

• The AppMenuItem object represents an item in the app picker, exposing metadata for tab sets, service providers,
and Connected Apps.

• The AttachedContentDocument object contains all ContentDocument objects associated with an object.

• The AuthSession object exposes session data and enables read and delete operations on that data.

• The CombinedAttachment object contains all notes, attachments, Google Docs, documents uploaded to libraries in
Salesforce CRM Content, and files added to Chatter that are associated with an object.

• The ContactCleanInfo object stores the metadata Data.com Clean uses to determine a contact record’s clean status.

• The CronJobDetail object provides the name and type of a scheduled job represented by a corresponding CronTrigger
record.

• The DeclinedEventRelation object represents invitees with the status Declined for a given event.

• The EventWhoRelation object represents the relationship between an event and a lead or contacts. This derived
object is a filtered version of the EventRelation object.

• The FeedPoll Choice object represents a choice in a poll posted in a feed.

• The FeedPollVote object represents a vote in a poll.

• The FieldHistoryArchive object represents historical archived information about an object’s changed field values.
The object is currently available through a pilot program.

• The LeadCleanInfo object stores the metadata Data.com Clean uses to determine a lead record’s clean status.

• The LiveChatTranscriptOwnerSharingRule object represents the rules for sharing a Live Agent chat transcript record
with users other than the record owner.

• The PermissionSetLicense object represents a license that enables a user to receive a specified permission without
changing their profile or reassigning profiles.

• The PermissionSetLicenseAssign object represents the association between a User and a PermissionSetLicense.

• The TaskWhoRelation object represents the relationship between a task and a lead or contacts. This derived object
is a filtered version of the TaskRelation object.

• The UndecidedEventRelation object represents invitees with the status Not Responded for a given event.

• The UserLogin object represents the settings that affect a user’s ability to log into an organization.

305

New and Changed ObjectsForce.com Development



• The UserProfile object represents a Chatter user profile.

Changed Objects

These objects have changed in API version 29.0 and affect earlier API versions.
• For the User object, we improved the behavior around simultaneous updates to the same record. Some error conditions

now return different ExceptionCode and StatusCode values. See User Object Save Behavior and Error Changes
on page 309.

These objects have changed in API version 29.0.
• In the Account object, the CleanStatus field now supports the update() call. The CleanStatus field also has

a new picklist value: Skipped.
• In the CaseMilestone object, the TimeSinceTargetInMins field has been added.

• In the CollaborationGroup object, the GroupEmail field has been added.

• In the CollaborationGroupMember object, the NotificationFrequency field has a post notification limit. In
Communities, the Email on Each Post option is disabled once a group exceeds 10,000 members. All members who
had this option selected are automatically switched to Daily digests.

• In the Contact object, the CleanStatus field now supports the update() call. The CleanStatus field also has
a new picklist value: Skipped.

• In the Contact object, the IsEmailBounced field has been added.

• In the CronTrigger object, the CronJobDetailId field has been added.

• In the ForecastingAdjustment object, the ProductFamily field has been added.

• In the ForecastingFact object, the ForecastedObjectId field has been added.

• In the ForecastingItem object, the ProductFamily field has been added.

• In the ForecastingQuota object, the ProductFamily field has been added.

• The Group object now supports the search() call.

• The Dashboard object now supports the search() call.

• In the IdeaComments object, the UpVotes field has been added.

• In the IdeaReputation object, the CommentLikesReceivedCount field has been added.

• In the Lead object, the CleanStatus field now supports the update() call. The CleanStatus field also has a
new picklist value: Skipped.

• The LiveAgentSession object now supports the create(), search(), undelete(), and delete() calls. It also
supports create() and update() on the following fields:

◊ AgentId

◊ ChatReqAssigned

◊ ChatReqDeclined

◊ ChatReqEngaged

◊ ChatReqTimedOut

◊ LoginTime

◊ LogoutTime

◊ OwnerId

◊ TimeAtCapacity

◊ TimeIdle

◊ TimeInAwayStatss

◊ TimeInChats

◊ TimeInOnlineStatus
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• In the LiveChatButton object, the following fields have been added:

◊ AutoGreeting

◊ CustomAgentName

The nillable() property has been added to the SkillId field.
• In the LiveChatDeployment object, the OptionsHasPrechatApi field has been added.

• In the LiveChatUserConfig object, the following fields have been added:

◊ CriticalWaitTime

◊ CustomAgentName

◊ OptionsHasAgentSneakPeek

◊ OptionsHasChatMonitoring

◊ OptionsHasWhisperMessage

◊ SupervisorDefaultAgentStatus

◊ SupervisorDefaultButtonId

◊ SupervisorDefaultSkillId

• In the MilestoneType object, the RecurrenceType field has been added.

• In the Network object, the following fields have been added:

◊ OptionsAllowMembersToFlag

◊ OptionsSiteAsContainerEnabled

◊ SelfRegProfileId

• In the NetworkMember object, the DisableItemFlaggedEmail field has been added.

• In the Organization object, the PreferencesS1BrowserEnabled field has been added to control access to the
Salesforce1 mobile browser app.

• The PermissionSet object now supports the search() call.

• The Profile object now supports the search() call, and the following fields have been added:

◊ LastReferencedDate

◊ LastViewedDate

• The PushTopic object has four new fields to support Streaming API delete and undelete events. See Support for
Delete and Undelete Events on page 316.

• In the SignupRequest object, the following fields have been added:

◊ AuthCode

◊ CreatedOrgInstance

◊ SuppressSignupEmails

• The User object now supports the describeLayout() call, and the following fields have been added:

◊ UserPreferencesDisableCoachingEmail

◊ UserPreferencesDisableFeedbackEmail

◊ UserPreferencesDisableRewardEmail

◊ UserPreferencesDisableWorkEmail

◊ UserPreferencesHideChatterOnboardingSplash

◊ UserPreferencesHideSecondChatterOnboardingSplash
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Also, the UserPreferencesHideS1BrowserUI has been added to control user redirection to the Salesforce1
mobile browser app.

• The UserRole object now supports the search() call.

• In the Report object, the Format field has been added. It indicates the format of a report whether Tabular,
Summary, Matrix, or Joined.

• The Description field has been added to these objects:

◊ AccountOwnerSharingRule

◊ AccountTerritorySharingRule

◊ CampaignOwnerSharingRule

◊ CaseOwnerSharingRule

◊ ContactOwnerSharingRule

◊ LeadOwnerSharingRule

◊ LiveAgentSessionOwnerSharingRule

◊ OpportunityOwnerSharingRule

◊ QuickTextOwnerSharingRule

◊ ServiceContractOwnerSharingRule

◊ UserMembershipSharingRule

• The Type field in these objects has a new CanvasPost option, which indicates a canvas app posting on a feed:

◊ AccountFeed

◊ AssetFeed

◊ CampaignFeed

◊ CaseFeed

◊ CollaborationGroupFeed

◊ ContactFeed

◊ ContentDocumentFeed

◊ ContractFeed

◊ DashboardComponentFeed

◊ DashboardFeed

◊ EntitlementFeed

◊ EventFeed

◊ FeedItem

◊ LeadFeed

◊ OpportunityFeed

◊ Product2Feed

◊ ReportFeed

◊ ServiceContractFeed

◊ SolutionFeed

◊ UserFeed

New and Changed Chatter Objects
New Objects

These objects are new in API version 29.0.
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• The TopicFeed object represents a single feed tracked change for a topic.

Changed Objects

These objects are changed in API version 29.0.
• In the CollaborationGroup object:

◊ The IsArchived, IsAutoArchiveDisabled, and GroupEmail  (pilot) fields have been added.

Note:  The ability to post to a Chatter group by email is currently available through a pilot program. For
information on enabling this feature for your organization, contact salesforce.com.

◊ The field type for the FullPhotoUrl and the SmallPhotoUrl fields is now url (was string earlier).

• The EntitySubscription object’s ParentId field can now be a topic ID.

• The Topic object now supports the create(), update(), and upsert() calls. The Description and Name
fields now support the create and update properties. The NetworkId field now supports the create property. The
TalkingAbout field no longer supports the nillable property.

• The TopicAssignment object now supports the create() call. The EntityId, NetworkId, and TopicId fields
now support the create property.

• The TopicAssignment object now has these SOQL limits:

No SOQL limit if logged-in user has “View All Data” permission. If not, do one of the following:

◊ Specify a LIMIT clause of 1,100 records or fewer.

◊ Filter on Id or Entity when using a WHERE clause with "=".

User Object Save Behavior and Error Changes
We improved the behavior around saving a user record when changed by multiple users, clients, or processes simultaneously.
As part of the behavior changes, different ExceptionCode and StatusCode values are now returned for some error conditions
when saving user records. We strongly recommend that you test your code and modify it accordingly if your clients rely on
specific ExceptionCode and StatusCode values being returned.

The following table lists changes that take effect in API version 29.0. However, some implementations using API version
28.0 and earlier may also be affected.

Value Returned in API Version 29.0Value Returned in Earlier Versions

INVALID_CROSS_REFERENCE_KEYINVALID_ID_FIELD

INSUFFICIENT_ACCESS_ON_CROSS_REFERENCE_ENTITYINVALID_FIELD_FOR_INSERT_UPDATE

The following table lists changes that affect API version 28.0 and earlier versions.

New Value Returned in API Version 28.0 and EarlierOld Value Returned in API Version 28.0 and Earlier

INVALID_FIELD_FOR_INSERT_UPDATEINSUFFICIENT_ACCESS_ON_CROSS_REFERENCE_ENTITY
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SOQL
Use the Salesforce Object Query Language (SOQL) to construct query strings used in Salesforce APIs. For a full description
of the SOQL query syntax, see the Force.com SOQL and SOSL Reference.

OFFSET Use In Sub-queries – Pilot

Note: Using OFFSET in sub-queries is a pilot feature that is subject to change in future releases, and is not intended
for use in a production setting. There is no support associated with this pilot feature. For more information, contact
salesforce.com, inc.

The SOQL OFFSET clause is used to specify the starting row offset into the result set returned by a query. OFFSET can now
be used in sub-queries. It is only allowed as part of a relationship query where the parent query has a LIMIT 1 clause. The
following is a valid use of OFFSET in a subquery:

SELECT Name, Id
(

SELECT Name FROM Opportunities LIMIT 10 OFFSET 2
)

FROM Account
ORDER BY Name
LIMIT 1

Increased Number of Relationship Fields
You can now include up to 35 child-to-parent relationships in a SOQL query. The previous limit was 25.

An object can have up to 25 custom relationships. Since standard objects can also have standard relationships, this increase
makes it easier to include all the child-to-parent relationships for a standard object in one SOQL query.

SOSL
Use the Salesforce Object Search Language (SOSL) to perform text searches using Salesforce APIs.

WITH NETWORK Supports Multiple Communities
The WITH NETWORK NetworkIdSpec clause now lets you filter user and feed search results by multiple communities,
using the new syntax WITH NETWORK IN (‘NetworkId1’, ‘NetworkId2’, ...). You can continue to use WITH
NETWORK = ‘NetworkId’ to filter search results by a single community only.

REST API

AppMenu Resource
Returns a list of items in either the Salesforce app drop-down menu or the Salesforce1 navigation menu. To return a list of
the Salesforce app drop-down menu items, the URI is: /vXX.X/appMenu/AppSwitcher/. To return a list of the Salesforce1
navigation menu items, the URI is: /vXX.X/appMenu/Salesforce1/.

CompactLayouts Resource
Returns a list of compact layouts for a specific object. The resource uses a URI of the format
/vXX.X/sobjects/Object/describe/compactLayouts/.
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FlexiPage Resource
The FlexiPage resource returns a list of Flexible Pages and their details. Information returned includes Flexible Page regions,
the components within each region, and each component’s properties, as well as any associated QuickActions (publisher
actions). The resource uses a URI of the format /vXX.X/flexiPage/ID of Flexible page.

Get Deleted Objects Resource
The SObject Get Deleted resource retrieves the list of records that have been deleted within a given timespan. The resource
uses a URI of the format
services/data/v29.0/sobjects/SObjectName/deleted/?start=StartDateAndTime&end=EndDateAndTime.
StartDateAndTime and EndDateAndTime should be provided in ISO 8601 format. Here’s an example for getting a list of
Merchandise__c records that were deleted between May 5th, 2013 and May 10th, 2013:

/services/data/v29.0/sobjects/Merchandise__c/deleted/
?start=2013-05-05T00:00:00+00:00&end=2013-05-10T00:00:00+00:00

Get Updated Objects Resource
The SObject Get Updated resource retrieves the list of records that have been updated (modified or added) within a given
timespan. The resource uses a URI of the format
services/data/v29.0/sobjects/SObjectName/updated/?start=StartDateAndTime&end=EndDateAndTime.
StartDateAndTime and EndDateAndTime should be provided in ISO 8601 format. Here’s an example for getting a list of
Merchandise__c records that were updated between May 6th, 2013 and May 10th, 2013:

/services/data/v29.0/sobjects/Merchandise__c/updated/
?start=2013-05-06T00:00:00+00:00&end=2013-05-10T00:00:00+00:00

Limits Resource—Pilot
Note:  This REST feature is currently available through a pilot program and is available in all Development Edition
organizations. For information on enabling it for your organization, contact salesforce.com.

The Limits resource returns limits information for your organization for these resources:

• Daily API calls
• Daily Batch Apex and future method executions
• Daily Bulk API calls
• Daily Streaming API events
• Streaming API concurrent clients

The resource uses a URI of the format services/data/v29.0/limits and takes no parameters.

• Max is the limit total for the organization.
• Remaining is the total number of calls or events left for the organization.

Here’s an example of the response:

{
"DailyApiRequests":
{

"Remaining":"4980",
"Max":"5000"

},
"DailyAsyncApexExecutions":
{

"Remaining":"250000",
"Max":"250000"

},
"DailyBulkApiRequests":
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{
"Remaining":"3000",
"Max":"3000"

},
"DailyStreamingApiEvents":
{

"Remaining":"1000",
"Max":"1000"

},
"StreamingApiConcurrentClients":
{

"Remaining":"10",
"Max":"10"

}
}

Limit Info Header
The Limit Info header is a response header that’s returned from each call to the REST API. This header returns limit
information for the organization. Use this header to monitor your API limits as you make calls against the organization.

Field name
Sforce-Limit-Info

Field values

• api-usage—Specifies the API usage for the organization against which the call was made in the format nn/nnnn.
The first number is the number of API calls used, and the second number is the API limit for the organization.

Example
Sforce-Limit-Info: api-usage=14/5000

This is an example of a response to a REST request for a Merchandise record.

HTTP/1.1 200 OK
Date: Mon, 20 May 2013 22:21:46 GMT
Sforce-Limit-Info: api-usage=14/5000
Last-Modified: Mon, 20 May 2013 20:49:32 GMT
Content-Type: application/json;charset=UTF-8
Transfer-Encoding: chunked

{
"attributes" : {
"type" : "Merchandise__c",
"url" : "/services/data/v29.0/sobjects/Merchandise__c/a00D0000008pQSNIA2"

},
"Id" : "a00D0000008pQSNIA2",
"OwnerId" : "005D0000001QX8WIAW",
"IsDeleted" : false,
"Name" : "Phone Case - iPhone 4/4S",
"CreatedDate" : "2013-05-20T20:49:32.000+0000",
"CreatedById" : "005D0000001QX8WIAW",
"LastModifiedDate" : "2013-05-20T20:49:32.000+0000",
"LastModifiedById" : "005D0000001QX8WIAW",
"SystemModstamp" : "2013-05-20T20:49:32.000+0000",
"LastActivityDate" : null,
"LastViewedDate" : "2013-05-20T22:19:56.000+0000",
"LastReferencedDate" : "2013-05-20T22:19:56.000+0000",
"Description__c" : "Phone Case for iPhone 4/4S",
"Price__c" : 16.99,
"Stock_Price__c" : 12.99,
"Total_Inventory__c" : 108.0

}
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QueryAll Resource
The QueryAll resource executes a specified SOQL query. This resource behaves exactly like the Query resource, except that
it will return results that include deleted records that are filtered out of regular Query requests. Here’s an example that retrieves
deleted Merchandise__c records:

/services/data/v29.0/queryAll/?q=SELECT+Name+from+Merchandise__c+WHERE+isDeleted+=+TRUE

SObject Describe Resource Support for If-Modified-Since Header
The SObject Describe resource now supports the If-Modified-Since HTTP header. When this header is used, if the
object metadata has not changed since the provided date, a 304 Not Modified status code is returned, with no response
body. This is an example If-Modified-Since header that could be used to request object metadata changes made since July 3,
2013:

If-Modified-Since: Wed, 3 Jul 2013 19:43:31 GMT

SObject Quick Actions Resource
In API version 29.0, the SObject Quick Actions resource has a new URI to evaluate the default values for an action. The
resource uses a URI of the format vXX.X/sobjects/object/quickActions/{action
name}/defaultValues/{context id}. If you use API version 28.0, continue to use
vXX.X/sobjects/object/quickActions/{action name}/defaultValues/{parent id}.

Themes Resource
The Themes resource returns information on icons and colors used by themes in the Salesforce UI. Here’s a GET example
request that retrieves the theme icons and colors used for objects in the organization:

/services/data/v29.0/theme

SOAP API

New and Updated Calls
New Calls

These calls are new in API version 29.0.
• describeAppMenu(): Retrieves metadata about items either in the Salesforce1 navigation menu or the Salesforce

drop-down app menu. This information is returned via a DescribeAppMenuResult.
• describeCompactLayouts(): Retrieves metadata details about compact layouts for the specified object type.

This information is returned via a DescribeCompactLayoutsResult.
• describeFlexiPages(): Retrieves metadata details about a set of Flexible Pages. A Flexible Page is the home

page for a mobile app that appears as a menu item in the Salesforce1 navigation menu. This information is returned
via a DescribeFlexiPageResult.

• describeGlobalTheme(): Returns information about both objects and themes available to the current logged-in
user. Information is returned via DescribeGlobalTheme, which contains DescribeGlobalResult and
DescribeThemeResult.

• describeTheme(): Returns information about themes available to the current logged-in user. Information is
returned via DescribeThemeResult.

Updated Calls

These calls have been updated in API version 29.0.
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• describeAvailableQuickActions(): contextType is a new field used in API version 29.0 and greater and
replaces parentType. If you use API version 28.0, continue to use parentType—no action required.

• describeAvailableQuickActions(): DescribeAvailableQuickActionResult has been updated. In API version
29.0 and greater, each DescribeAvailableQuickActionResult object represents details about publisher actions available
for a specified context. In API version 28.0, the object represents details for a specified parent. If you use API version
28.0, continue to use parentType—no action required.

Also, the type field supports additional types:

◊ LogACall

◊ SocialPost

◊ Canvas

◊ Create

◊ Update

• describeLayout(): relatedContent is a new field that represents the new Related Content section on a page
layout.

• describeLayout(): ExpandedLookup added as a new value for LayoutComponentType.
• describeLayout(): As part of the DescribeLayoutResult metadata returned, Highlights Panel section details are

provided.
• describeLayout(): As part of the DescribeLayoutResult metadata returned, Related Content section details are

provided in two new types:

◊ RelatedContent—Represents the Related Content section of a page layout, containing an array of items.
◊ DescribeRelatedContentItem—Represents an individual item in the DescribeRelatedContentItem list.

• describeLayout(): DescribeLayoutButton now contains information on theme icons used for the button.
• describeLayout(): DescribeQuickActionListItemResult now contains information on theme icons and colors

used for the quick action.
• describeQuickActions(): In API version 29.0 and greater, describeQuickActions() takes the action name

in the form of ContextEntity.ActionName. In API version 28.0, ParentEntity.ActionName is used. If you
use API version 28.0, continue to use parentType—no action required.

• describeQuickActions(): DescribeQuickActionResult contains information on theme icons and colors used
for the quick action as well as a field to identify a Force.com Canvas application.

• DescribeQuickActionResult also has information on default values contained in DescribeQuickActionDefaultValue.

• DescribeQuickActionResult’s type field supports additional types:

◊ LogACall

◊ SocialPost

◊ Canvas

◊ Create

◊ Update

• describeTabs(): DescribeTab now contains theme color and theme icon information used for the tab.
• performQuickActions(): contextId is a new field used in API version 29.0 and greater and replaces parentId.

If you use API version 28.0, continue to use parentType—no action required.
• describeSObjects(): As part of the DescribeSObjectResult metadata returned, compactLayoutable is a new

property that indicates whether the object can be used in describeCompactLayouts().

LimitInfoHeader
This new SOAP API response header returns limit information for the organization. Use this header to monitor your API
limits as you make calls against the organization.
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DescriptionTypeElement Name

The number of calls for the specified limit type that have already been used in the
organization.

stringcurrent

The organization’s limit for the specified limit type.stringlimit

The type of limit information specified in the header.stringtype

• API REQUESTS—contains limit information about API calls for the
organization.

This is an example of a response to a SOAP request for a Merchandise record.

<?xml version="1.0" encoding="UTF-8"?>
<soapenv:Envelope xmlns:soapenv="http://schemas.xmlsoap.org/soap/envelope/"

xmlns="urn:partner.soap.sforce.com" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance"

xmlns:sf="urn:sobject.partner.soap.sforce.com">
<soapenv:Header>

<LimitInfoHeader>
<limitInfo>

<current>5</current>
<limit>5000</limit>
<type>API REQUESTS</type>

</limitInfo>
</LimitInfoHeader>

</soapenv:Header>
<soapenv:Body>

<queryResponse>
<result xsi:type="QueryResult">

<done>true</done>
<queryLocator xsi:nil="true"/>
<records xsi:type="sf:sObject">

<sf:type>dev_ns__Merchandise__c</sf:type>
<sf:Id>a00D0000008pQSNIA2</sf:Id>
<sf:dev_ns__Description__c>Phone Case for iPhone

4/4S</sf:dev_ns__Description__c>
<sf:dev_ns__Price__c>16.99</sf:dev_ns__Price__c>
<sf:dev_ns__Stock_Price__c>12.99</sf:dev_ns__Stock_Price__c>
<sf:dev_ns__Total_Inventory__c>108.0</sf:dev_ns__Total_Inventory__c>
<sf:Id>a00D0000008pQSNIA2</sf:Id>

</records>
<size>1</size>

</result>
</queryResponse>

</soapenv:Body>
</soapenv:Envelope>

Streaming API
Performance and functionality improvements have been made to Streaming API.

Increased Limits for Performance, Unlimited, and Enterprise Edition Organizations
Filtered Subscriptions
Support for Delete and Undelete Events
Generic Streaming — Pilot
New Supported Objects for PushTopic Queries — Pilot
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Increased Limits for Performance, Unlimited, and Enterprise Edition
Organizations

Streaming API now has increased limits for Performance Edition, Unlimited Edition and Enterprise Edition organizations.
The new limits are:

• The maximum number of events per day has been increased to 1,000,000 for Performance Edition and Unlimited Edition
organizations (previously 100,000), and 200,000 for Enterprise Edition organizations (previously 20,000).

• The maximum number of concurrent clients across all topics has been increased to 1000 for Performance Edition and
Unlimited Edition organizations (previously 100), and 500 for Enterprise Edition organizations (previously 20).

• The maximum number of topics has been increased to 50 for Performance Edition and Unlimited Edition organizations
(previously 20), and 25 for Enterprise Edition organizations (previously 20).

Filtered Subscriptions
When you subscribe to a channel, you can reduce the number of event notifications by adding an expression containing logical
AND or OR operators to the subscription URL.

Use this syntax in a subscription URL:

/topic/myChannel?<expression>

myChannel is the channel and <expression> is the expression containing logical AND or OR operators.

The expression engine uses MVEL, which is an expression language. See MVEL Operators for the expression grammar. We
currently support only the logical AND (&&) and logical OR (||) operators.

Note:  If you use an ID in filter criteria, you must use the 18-character ID format; 15–character IDs aren’t supported.

Logical AND Operator Example

This logical AND expression filters for events with Company=='Acme' and City=='Timbuktu':

Company=='Acme'&&City=='Timbuktu'

The SELECT clause of the SOQL query in the channel’s PushTopic must include the fields used in the left operands of the
comparison operators; in this case, the SELECT clause must include Company and City fields.

Logical OR Operator Example

This logical OR expression filters for events with UnitPrice > 50 or Amount >= 10:

UnitPrice>50||Amount>=10

Support for Delete and Undelete Events
Streaming API now supports notifications for deleted and undeleted records. The PushTopic object uses the new
NotifyForOperationCreate, NotifyForOperationUpdate, NotifyForOperationDelete, and
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NotifyForOperationUndelete boolean fields to determine which events generate a notification. The following example
Apex code creates a PushTopic that generates notifications when Invoice_Statement records are deleted or undeleted:

PushTopic pushTopic = new PushTopic();
pushTopic.Name = 'InvoiceStatementUpdates';
pushTopic.Query = 'SELECT Id, Name, Status__c, Description__c FROM Invoice_Statement__c';
pushTopic.ApiVersion = 29.0;
pushTopic.NotifyForOperationCreate = false;
pushTopic.NotifyForOperationUpdate = false;
pushTopic.NotifyForOperationUndelete = true;
pushTopic.NotifyForOperationDelete = true;
pushTopic.NotifyForFields = 'Referenced';
insert pushTopic;

Note that your client must connect using the cometd/29.0 Streaming API endpoint to get delete and undelete event
notifications. A new Extended value has been added to NotifyForOperations that is set whenever Create or Update
notifications are not enabled.

Generic Streaming — Pilot
You can now use the Streaming API to send custom event notifications that are not tied to Salesforce data changes. To use
generic streaming, you need:

• A StreamingChannel that defines the channel. You can create this through the Salesforce UI or using any data API.

• One or more clients subscribed to the channel via Bayeux.

• The Streaming Channel Push REST API resource. This new resource lets you monitor channels and push event notifications
on channels to clients.

Generic streaming is currently available through a pilot program. For information on enabling generic streaming for your
organization, contact salesforce.com, inc.

New Supported Objects for PushTopic Queries — Pilot
The following standard objects are now supported in PushTopic queries: ContractLineItem, Entitlement, LiveChatTranscript,
Quote, QuoteLineItem, and ServiceContract.

Support for these objects is currently available through a pilot program. For more information, contact salesforce.com.

Chatter REST API
To integrate mobile apps, intranet sites, and third party Web applications with Chatter, use Chatter REST API.

Note:  To create custom Chatter experiences in Salesforce, use Chatter in Apex.

General Updates
New and Changed Resources
New and Changed Request Bodies
New and Changed Response Bodies
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General Updates
Specify response size

Use the filterGroup parameter in a request URL or in a request body to specify whether to return a small, medium,
or big group of properties. Every property in every response body is tagged with a group size:
• Big—The default size. Includes every property in a response body, including those marked Big, Medium, and Small.
• Medium—Includes properties marked Medium and Small.
• Small—The smallest response size. Includes only properties marked Small.

When a request URL includes a filterGroup query parameter, only the properties included in the specified size are
returned to the client. Things to know about filter groups:
• The default filterGroup size is Big.
• Each filter group size assigned to a property has an API version. In future API versions properties may move to

different filter groups.
• Filter groups affect all HTTP verbs except DELETE.
• You can use a filterGroup parameter on any request URL, including subrequests in a batch request body, unless

otherwise stated.
• You can use a filterGroup parameter in conjunction with either an include or an exclude filter parameter to

change the set of properties returned. The resulting set is a union of the two sets.

Expanded bearer token support
If you pass the request header X-Connect-Bearer-Urls: true, these response body properties now contain bearer
token URLs:
• File Detail—renditionUrl240By180, renditionUrl720By480
• File Summary—renditionUrl240By180, renditionUrl720By480
• File Summary Page—currentPageUrl

• Icon—url

• Mention Completion—photoUrl

Request bearer token URLs to display images on HTML pages that aren’t hosted by Salesforce.com.

5000 character limit for feed items and comments
Feed item and comment request and response bodies can contain 5000 characters. The previous limit was 1000 characters.
This change is available in all API versions. The only exception is for posts to the User Profile Feed Items resource
(/chatter/feeds/user-profile/userId/feed-items) in API versions 23.0 and 24.0. In those versions, posts
to that resource created user status updates, not feed items, so the 1000 character limit is still in place.

Accept-Language HTTP header support
Chatter REST API now supports the Accept-Language HTTP header. Chatter REST API localizes names to the
locale setting of the user. If the user hasn’t set their locale, Chatter REST API uses the default locale of the organization.
However, individual clients may want to override the locale. Clients can use any locale available in the organization to
override the locale. Use the Accept-Language HTTP header to override the locale for any API request.

X-Connect-Theme HTTP header support
Clients can use the X-Connect-Theme HTTP header to specify a UI theme for any API request. There are two themes,
each with their own set of motif icons: Classic and Salesforce1.

No post notifications for large Communities groups
In Communities, the Email on Each Post option is disabled once a group exceeds 10,000 members. All members who
had this option selected are automatically switched to Daily Digest.
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New and Changed Resources
Get mention proposals

Mentions Completions is a new resource (/chatter/mentions/completions) that represents a collection of possible
users and groups to mention in a feed item body or comment body. A mention is an “@” character followed by a user or
group name. When a user or group is mentioned, they receive a notification. Use this resource to generate a list of
proposed mentions that a user can choose from when they enter 2 or more characters in a feed item body or a comment
body. The Mention Completions resource has the following parameters:
• contextId—A feed item ID (for a mention in a comment) or a feed subject ID (for a mention in a feed item) that

narrows search results, with more useful results listed first.
• page—The number of the page you want returned. Numbering starts at 0. The default value is 0.
• pageSize—The number of items per page. Valid values are between 1 and 100. The default size is 25. Attempting

to retrieve more than 500 results returns an HTTP 400 status code.
• q—A search term. Searches for matching user and group names. To search for a user, a minimum of 1 character is

required. To search for a group, a minimum of 2 characters is required. This parameter does not support wildcards.
• type—The mention completion type:

◊ All—All mention completions, regardless of the type of record to which the mention refers.
◊ Group—Mention completions for groups.
◊ User—Mention completions for users.

Validate mention proposals
Mentions Validations is a new resource (/chatter/mentions/validations) that represents information about
whether the specified mention proposals are valid for the context user. Use this resource to verify that the list of proposed
mentions is valid before you present the proposals to the user. The Mentions Validations resource has the following
parameters:
• parentId—The feed item parent ID (for new feed items) or feed item ID (for comments).
• recordIds—A comma separated list of IDs to be mentioned. The maximum value is 25.
• visibility—Specifies the type of users who can see a feed item.

◊ AllUsers—Visibility is not limited to internal users.
◊ InternalUsers—Visibility is limited to internal users.

Moderate communities
Community Moderation introduces these new resources:
• Moderate Flags on Feed Items

(/connect/communities/communityId/chatter/feed-items/feedItemId/moderation-flags/)—Flag
posts in a community as inappropriate. Community members that aren’t moderators can also use these resources to
remove a flag they previously set. Community moderators can view the number of flags on a post, and remove all
flags if needed.

• Moderate Flags on Comments
(/connect/communities/communityId/chatter/comments/commentId/moderation-flags)—Flag
comments in a community as inappropriate. Community members that aren’t moderators can also use these resources
to remove a flag they previously set. Community moderators can view the number of flags on a comment, and remove
all flags if needed.

• Communities Moderation Feed
(/connect/communities/communityId/chatter/feeds/moderation/feed-items)—A feed containing
all flagged posts and comments. The feed is available to users with “Moderate Community Feeds” permissions to
view and take action on flagged posts and comments.
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Specify the number of comments to return
These resources have a new recentCommentCount parameter for GET requests that specifies the maximum number
of comments to return for each feed item, the default value is 3:
• Feed Items Query resource (/chatter/feed-items)
• Bookmarks Feed Items resource (/chatter/feeds/bookmarks/userId/feed-items/)
• Favorites Feed Items resource (/chatter/feeds/favorites/userId/favoriteId/feed-items/)
• Files Feed Items resource (/chatter/feeds/files/userId/feed-items/)
• Filter Feed Items resource (/chatter/feeds/filter/userId/keyPrefix/feed-items/)
• Groups Feed Items resource (/chatter/feeds/groups/userId/feed-items/)
• News Feed Items resource (/chatter/feeds/news/userId/feed-items/)
• People Feed Items resource (/chatter/feeds/people/userId/feed-items/)
• Records Feed Items resource (/chatter/feeds/records/recordId/feed-items/)
• To Feed Items resource (/chatter/feeds/to/userId/feed-items/)
• Topics Feed Items resource (/chatter/feeds/topics/topicId/feed-items/)
• User Profile Feed Items resource (/chatter/feeds/user-profile/userId/feed-items/)

Specify the feed density to return
A new density parameter for GET requests specifies the density of feed items in a feed. Possible values are:
• AllUpdates—Displays all posts and comments from people and records the user follows and groups the user is a

member of.
• FewerUpdates—Displays all posts and comments from people and records the user follows and groups the user is

a member of, but hides system-generated posts from records that nobody commented on.

These resources take the density parameter:

• Bookmarks Feed Items resource (/chatter/feeds/bookmarks/userId/feed-items/)
• Files Feed Items resource (/chatter/feeds/files/userId/feed-items/)
• Filter Feed Items resource (/chatter/feeds/filter/userId/keyPrefix/feed-items/)
• Groups Feed Items resource (/chatter/feeds/groups/userId/feed-items/)
• News Feed Items resource (/chatter/feeds/news/userId/feed-items/)
• People Feed Items resource (/chatter/feeds/people/userId/feed-items/)
• Records Feed Items resource (/chatter/feeds/records/recordId/feed-items/)
• To Feed Items resource (/chatter/feeds/to/userId/feed-items/)
• Topics Feed Items resource (/chatter/feeds/topics/topicId/feed-items/)
• User Profile Feed Items resource (/chatter/feeds/user-profile/userId/feed-items/)

Get information about multiple feed items
The new Feed Items Batch resource (/chatter/feed-items/batch/feedItemIds) represents a batch of feed
items. Specify a comma-separated string of feed item IDs to get information about multiple feed items in one request.

Create a group
The Groups resource (/chatter/groups) can now be used to create a group. Make a POST request and pass request
parameters.

Delete a group
The Groups Information resource can now be used to delete a group. Make a DELETE request to
/chatter/groups/groupId.

Set a group member’s role
The Groups Members resource (/chatter/groups/groupId/members) has a new role parameter for POST
requests. It can have one of these values: GroupManager or StandardMember.
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Update a group membership
The Groups Memberships resource (/chatter/group-memberships/membershipId) now supports PATCH
requests. To update a group member’s role, make a PATCH request and pass either the new role parameter or a Group
Member Input request body, which also has a new role property.

Get information about groups based on archive status
The List of Groups resource (/chatter/groups) has a new archiveStatus parameter for GET requests. Use it to
retrieve a list of archived groups, active groups, or all groups (both active and archived).

Search for a group with better results
When you search using the List of Groups resource (/chatter/groups?q=someGroupName) the search only looks
at the group name field. In earlier versions the search included other fields, such as the group description field, which
caused too much noise in the search results.

Crop photos
The Groups Photo resource (/chatter/groups/groupId/photo) and the Users Photo resource
(/chatter/users/userId/photo) have new parameters that let you crop a photo:
• cropSize—The length, in pixels, of any edge of the crop square.
• cropX—The position X, in pixels, from the left edge of the image to the start of the crop square. Top left is position

(0,0).
• cropY—The position Y, in pixels, from the top edge of the image to the start of the crop square. Top left is position

(0,0).

Topics URI changes
All Topics resource URIs now begin with /connect instead of /chatter:
• /connect/topics

• /connect/topics/topicId

• /connect/topics/topicId/files

• /connect/topics/topicId/groups

• /connect/topics/topicId/related-topics

• /connect/topics/topicId/suggestions

• /connect/topics/topicId/trending

The Related Topics resource is now /connect/topics/topicId/related-topics, with a hyphen between
related and topics.

Change a topic name
Make a PATCH request to the Topic resource (/connect/topics/topicId) and pass the name parameter to change
the spacing of a topic name in addition to the capitalization.

Follow and unfollow a topic
The Following resource can now be used to follow a topic. The resource is /chatter/users/userId/following.

Use the Subscriptions Resource to unfollow a topic. The resource is /chatter/subscriptions/subscriptionId.

Get information about a topic
The Records resources can now return information about a topic, including its followers. The resources are
/chatter/records/recordId and /chatter/records/recordId/followers.

Get information about a user profile
The new User Profiles resource (/chatter/user-profiles/userID) represents a user’s profile, which contains user
information, a set of capabilities (permissions), and the set of configured profile subtab apps for the given user.
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Make a PATCH request to the User Profile Information resource (/chatter/users/userId) to update the new
aboutMe property. In the Chatter user interface, this property populates the “About Me” section of the user profile.

Get information about Chatter Answers zones
The new Zones resources contain information about zones, including Chatter Answers questions. The resources are:
• /connect/zones—Get information about zones available to the context user.
• /connect/zones/zoneId—Get information about a specified Chatter Answers zone.
• /connect/zones/zoneId/search-results—Search a Chatter Answers zone.

Post a canvas app to a feed
You can now post a feed item with a canvas app attachment to the News Feed, Record Feed, and User Profile Feed.
Use these new POST parameters:
• attachmentType—The attachment type. Must contain the value Canvas.
• description—Description of the canvas app.
• developerName—Specifies the developer name (API name) of the canvas app.
• height—The height of the canvas app in pixels. Default height is 200 pixels.
• namespacePrefix—The namespace prefix of the Developer Edition organization in which the canvas app was

created.
• parameters—Parameters passed to the canvas app in JSON format. The JSON must be URL-encoded.
• thumbnailUrl—The URL to a thumbnail image for the canvas app. Maximum dimensions are 120x120 pixels.
• title—The title of the link to the canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through
a pilot program and is available in all new Development Edition organizations. For information on enabling it
for your organization, contact salesforce.com.

Delete a list of files
To delete a list of files, make a DELETE request to the File Information, Batch resource
(/chatter/files/batch/fileIds). The DELETE method has been available since API version 26.0 but was
undocumented.

New and Changed Request Bodies
Attachment Input: Canvas App

This new request body describes a canvas app. Use it to attach a canvas app to a feed item. It has these properties:
• attachmentType—The attachment type. Must contain the value Canvas.
• description—The description of the canvas app.
• developerName—The developer name (API name) of the canvas app.
• height—The height of the canvas app in pixels. Default height is 200 pixels.
• namespacePrefix—The namespace prefix of the Developer Edition organization in which the canvas app was

created.
• parameters—Parameters passed to the canvas app in JSON format.
• thumbnailUrl—A thumbnail image for the canvas app. Maximum dimensions are 120x120 pixels.
• title—The title of the link used to call the canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through
a pilot program and is available in all new Development Edition organizations. For information on enabling it
for your organization, contact salesforce.com.
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Feed Item Input
The attachment property value can now hold a Attachment Input: Canvas App. Use this value to attach a canvas app
to a feed item.

Feed Item Topics Input
This new request body describes a topic. Use it in a POST request to /chatter/feed-items/feedItemId/topics
to associate a new or existing topic with the specified feed item. It has these properties:
• topicId—ID of an existing topic
• topicName—Name of a new or existing topic, up to 150 characters

Following Input
The subjectId property can now be a topic ID. Use this request body with the /chatter/users/userId/following
resource.

Group Input
This request body has new properties that you can use in a PATCH request to /chatter/groups/groupId to update
the group. The properties are:
• canHaveChatterGuests—true if this group allows Chatter customers, false otherwise. After this property is

set to true, it cannot be set to false..
• description—The “Description” section of the group.
• name—The name of the group.
• owner—The ID of the group owner.
• isArchived—true if the group is archived, false otherwise. Defaults to false.
• isAutoArchiveDisabled—true if automatic archiving is turned off for the group, false otherwise. Defaults

to false.
• visibility—Specifies whether a group is private or public.

◊ PrivateAccess—Only members of the group can see posts to this group.
◊ PublicAccess—All users within the internal community can see posts to this group.

Group Member Input
This request body has a new role property that has one of these values:
• GroupManager—User is the manager of the group.
• StandardMember—User is a standard member of the group.

To update this property for an existing group member, pass it in a PATCH request to
/chatter/group-memberships/membershipId. To set this property when you add a member to a group, pass it
in a POST request to /chatter/groups/groupId/members.

Message Segment Input: Mention
This request body can now take a group ID for the id property. Use a group ID to mention a group in a feed item or
comment.

Photo Input
This request body has new properties that specify how to crop a photo:
• cropSize—The length, in pixels, of any edge of the crop square.
• cropX—The position X, in pixels, from the left edge of the image to the start of the crop square. Top left is position

(0,0).
• cropY—The position Y, in pixels, from the top edge of the image to the start of the crop square. Top left is position

(0,0).
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To update a user photo, pass the request body to /chatter/users/userId/photo. To update a group photo, pass
the request body to /chatter/groups/groupId/photo.

Topic Input
This request body has a new name property that allows you to change the spacing of a topic name in addition to the
capitalization. Use this request body with the /connect/topics/topicId resource.

User Input
This new request body has one property, aboutMe. Use it in a PATCH request to /chatter/users/userId. In the
Chatter user interface, this property populates the “About Me” section of the user profile.

New and Changed Response Bodies
Comment

This response body has a new moderationFlags property, which contains a Moderation Flags response body that
contains information about any moderation flags on the comment. If the communityModeration property of the
Features response body is false, this property is null.

Email Address
This new response body represents an email address for an email message. It has these properties:
• displayName—The display name for the email address.
• emailAddress—The email address.

Features
The Features response body has these new properties:
• chatterAnswers—Specifies whether Chatter Answers is enabled.
• communityModeration—Specifies whether Community moderation is enabled.
• ideas—Specifies whether Ideas is enabled.

Feed Body
In API versions 29.0 and later, the text property of the Feed Body response body can be null, which means you can’t
use it as the default case for rendering text. Instead, use the text property of the Feed Item Preamble Message Body
response body because it can’t be null.

Feed Item
The Feed Item attachment property has these new values:
• Canvas—A feed item that contains the metadata to render a link to a canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available
through a pilot program and is available in all new Development Edition organizations. For information on
enabling it for your organization, contact salesforce.com.

• EmailMessage—An email attached to a case record in Case Feed.
• RecordSnapshot—The feed item attachment contains a view of a record at a single

ConnectApi.FeedItemType.CreateRecordEvent.
• TrackedChange—All changes to a record for a single ConnectApi.FeedItemType.TrackedChange event.

Feed Item has a new moderationFlags property that contains a Moderation Flags response body, which contains
information about any moderation flags on the feed item. If the communityModeration property of the Features
response body is false, this property is null.

The Feed Item type property has these new values:
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• CanvasPost—Feed item generated by a canvas app in the publisher or from Chatter REST API or Chatter in
Apex. The post itself is a link to a canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available
through a pilot program and is available in all new Development Edition organizations. For information on
enabling it for your organization, contact salesforce.com.

• ReplyPost—Feed item generated by a Chatter Answers reply.
• TrackedChange—All changes to a record for a single ConnectApi.FeedItemType.TrackedChange event.

Feed Item Attachment: Canvas Template
The Feed Item Attachment: Canvas Template is a new response body that represents a canvas app attached to a feed
item. It has these properties:
• description—Description of the canvas app.
• developerName—Developer name (API name) of the canvas app.
• height—Height of the canvas app in pixels. Default is 200 pixels.
• icon—Canvas app icon.
• namespacePrefix—The namespace prefix of the Developer Edition organization in which the canvas app was

created.
• parameters—Parameters passed to the canvas app in JSON format.
• thumbnailUrl—A URL to a thumbnail image for the canvas app. Maximum dimensions are 120x120 pixels.
• title—Title of the link used to call the canvas app.

Note:  Support for Force.com Canvas apps in the publisher and in the Chatter feed is currently available through
a pilot program and is available in all new Development Edition organizations. For information on enabling it
for your organization, contact salesforce.com.

Feed Item Attachment: Case Comment
Feed Item Attachment: Case Comment response body has a new eventType property that specifies the event type of
the case comment. It has these values:
• NewInternal—A case comment that has newly been marked Internal Only.
• NewPublished—A newly published case comment.
• NewPublishedByCustomer—A case comment by a customer that was newly published.
• PublishExsiting—An existing case comment that was re-published.

Note:  Although this value appears to be a typo, it’s not. Use this spelling in your code.

• PublishExistingByCustomer—An existing case comment by a customer that was re-published.
• UnpublishExisting—An existing case comment that was unpublished.
• UnpublishExistingByCustomer—An existing case comment by a customer that was unpublished.

Feed Item Attachment: Email Message
This new response body represents an email message sent from a case record in Case Feed. It has these properties:
• direction—An ConnectApi.EmailMessageDirection enum with one of these values:

◊ Inbound—An inbound message (sent by a customer).
◊ Outbound—An outbound message (sent to a customer by a support agent).

• emailMessageId—The ID of the email message.
• subject—The subject of the email message.
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• textBody—The body of the email message.
• toAddress—A list of ConnectApi.EmailAddress objects to send the message to.

Feed Item Attachment: Record Snapshot
The Feed Item Attachment: Record Snapshot is a new response body the represents a view of a record when it was
created. It has these properties:
• recordView—A view of the record when it was created.
• type—RecordSnapshot.

Feed Item Attachment: Tracked Change
Feed Item Attachment: Tracked Change is a new response body that represents the changes made to a fields of a record
attached to a feed item. It has these properties:
• changes—A collection of Feed Tracked Change response bodies.
• type—The String TrackedChange.

Feed Tracked Change
Feed Tracked Change is a new response body that represents a change to a field on a record. It has these properties:
• fieldName—The name of the field that was updated.
• newValue—The new value of the field or null if the field length is long or empty.
• oldvalue—The old value of the field or null if the field length is long or empty.

File
The File response body has these new properties:
• publishStatus—The publish status of the file. One of these values:

◊ PendingAccess—File is pending publishing.
◊ PrivateAccess—File is private.
◊ PublicAccess—File is public.

• sharingRole—The sharing role of the file. One of these values:

◊ Admin—Owner permission, but doesn’t own the file.
◊ Collaborator—Viewer permission, and can edit, change permissions, and upload a new version of a file.
◊ Owner—Collaborator permission, and can make a file private, and delete a file.
◊ Viewer—Can view, download, and share a file.
◊ WorkspaceManaged—Permission controlled by the library.

Following Count
The Following Count response body’s records property now includes the number of topics a user is following.

Group
The Group response body has these new properties:
• isArchived—Specifies whether the group is archived (true) or not (false).
• isAutoArchiveDisabled—Specifies whether automatic archiving is disabled for the group (true) or not (false).

Group Details
The Group Details response body has a new pendingRequests property. The value is an integer specifying the number
of pending requests to a private group.
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Mention Completion
Mention Completion is a new response body with properties that represent a record to be used as a mention. A mention
is an “@” character followed by a user or group name. It has these properties:
• additionalLabel—An additional label (if one exists) for the record represented by this completion, for example,

“(Customer)” or “(Acme Corporation)”.
• description—A description of the record represented by this completion.
• name—The name of the record represented by this completion. The name is localized, if possible.
• photoUrl—A URL to the photo or icon of the record represented by this completion.
• recordId—The ID of the record represented by this completion.

Mention Completion Page
Mention Completion Page is a new response body that contains a paginated list of the Mention Completion response
bodies. It contains these properties:
• currentPageUrl—Chatter REST API URL identifying the current page.
• mentionCompletions—A list of mention completion proposals. Use these proposals to build a feed post body.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.
• previousPageUrl—Chatter REST API URL identifying the previous page or null if there isn’t a previous page.

Mention Validation
Mention Validation is a new response body that represents validation information for a proposed mention. It has these
properties:
• recordId—The ID of the record to mention.
• validationStatus—Specifies the type of validation error for a proposed mention, if any.

◊ Disallowed—The proposed mention is invalid and will be rejected because the context user is trying to mention
something that is not allowed. For example a user who is not a member of a private group is trying to mention
the private group.

◊ Inaccessible—The proposed mention is allowed but the user or record being mentioned will not be notified
because they don't have access to the parent record being discussed.

◊ Ok—There is no validation error for this proposed mention.

Mention Validations
Mention Validations is a new response body that represents a collection of mention validation information. It has these
properties:
• hasErrors—Indicates whether at least one of the proposed mentions has an error (true), or not (false). For

example, the context user can’t mention private groups he doesn’t belong to. If such a group were included in the list
of mention validations, hasErrors would be true and the group would have a validationStatus of Disallowed
in its mention validation.

• mentionValidations—A list of mention validation information in the same order as the provided record IDs.

Message Segment: Field Change Value
The Message Segment: Field Change Value response body has a new valueType property that specifies whether the
message segment contains a NewValue or an OldValue.

Message Segment: Mention
The Message Segment: Mention response body has a new record property that can be a Group response body or a
User Summary response body.

The record property was added because you can now mention groups in addition to users. As of version 29.0, use the
record property instead of the user property, which is no longer available. In versions earlier than 29.0, if the mention
is not a user, the mention is in a Message Segment: Text response body.
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Message Segment: More Changes
The Message Segment: More Changes response body has a new moreChanges property that contains the complete
collection of tracked changes for a feed item.

Moderation Flags
Moderation Flags is a new response body that represents information about moderation flags. It has these properties:
• flagCount—The number of moderation flags on this feed item or comment. If the logged-in user is not a community

moderator, the property is null.
• flaggedByMe—Specifies whether the context user had flagged the feed item or comment for moderation (true)

or not (false).

Motif
The Motif response body has a new color property which contains the hex value of the record type’s base color. Use
this value behind the motif icons.

Record Field
These new response bodies represent fields on record objects:
• Record Field—A generic record field containing a label and text value.
• Record Field: Blank—A record field displayed as a place holder in a grid of fields.
• Record Field: Compound—A record field that is a composite of sub-fields.
• Record Field: Currency—A record field containing a currency value.
• Record Field: Date—A record field containing a date.
• Record Field: Percent—A record field containing a percentage value.
• Record Field: Picklist—A record field containing an enumerated value.
• Record Field: Reference—A record field containing a reference to another object.
• Record Field: Reference with Date—A record field containing a referenced object that acted at a specific time, for

example, “Created By...”.

Record View
These new response bodies represent a view of a record object:
• Record View—A view of any record in the organization, including a record on a custom object. This object is used

if a specialized object, such as User and ChatterGroup, is not available for the record type. Designed for rendering
an object quickly and easily.

• Record View Section—A section of record fields on a record detail.

Related List
These new response bodies represent a related list view on a record object:
• Related List—Defines a related list structure on a record view. There is no data in the list.
• Related List Column—A single column in a table of a record’s related list. Describes the shape of the data only.
• Related List Object—Defines the type of object displayed in the rows of a related list.
• Related List Sort—Defines an ordinal of a sort order in a related list.

Subscription
The Subscription response body’s subject property can now include a Topic response body.

Topic
The Topic response body has a new url property that points to the topic detail page.

Topic Collection
The Topic Collection response body has these new properties:
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• currentPageUrl—Returns the current page of topics
• nextPageUrl—Returns the next page of topics

Tracked Change Item
The Topic response body has a new url property that points to the topic detail page.

User Capabilities
User Capabilities is a new response body that describes the capabilities the context user may use with the subject user.
It has these properties:
• canChat—Specifies if the context user can use Chatter Messenger with the subject user (true) or not (false)
• canDirectMessage—Specifies if the context user can direct message the subject user (true) or not (false)
• canEdit—Specifies if the context user can edit the subject user’s account (true) or not (false)
• canFollow—Specifies if the context user can follow the subject user’s feed (true) or not (false)
• canViewFeed—Specifies if the context user can view the feed of the subject user (true) or not (false)
• canViewFullProfile—Specifies if the context user can view the full profile of the subject user (true) or only

the limited profile (false)
• isModerator—Specifies if the subject user is a Chatter moderator or admin (true) or not (false)

User Detail
The User Detail response body has a new thanksReceived property that contains the number of times the user has
been thanked.

User Profile
User Profile is a new response body that describes the details necessary to render a view of a user profile. It has these
properties:
• capabilities—The context user’s capabilities specific to the subject user’s profile
• id—The ID of the user attached to the profile
• tabs—The tabs visible to the context user specific to the subject user’s profile
• url—The URL of the user’s profile
• userDetail—The details about the user attached to the profile

User Profile Tab
User Profile Tab is a new response body that describes information about a profile tab. It has these properties:
• id—The tab’s unique identifier or 18–character ID
• isDefault—Specifies if the tab appears first when clicking the user profile (true) or not (false)
• tabType—Specifies the type of tab
• tabUrl—The current tab’s content URL (for non built-in tab types)

User Settings
User Settings has a new hasRestDataApiAccess property that indicates whether or not the user has access to REST
API.

Zone
Zone is a new response body that describes a Chatter Answers zone. It has these properties:
• description—The description of the zone.
• id—The ID of the zone.
• isActive—Indicates whether the zone is active.
• isChatterAnswers—Indicates whether the zone is available for Chatter Answers.
• name—The name of the zone.
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• visibility—The zone visibility. A ConnectApi.ZoneShowIn enum value:

◊ Community—Available in a community.
◊ Internal—Available internally only.
◊ Portal—Available in a portal.

• visibilityId—If the zone is available in a portal or a community, this property contains the ID of the portal or
community. If the zone is available to all portals, this property contains the value All.

Zone Page
Zone Page is a new response body that describes a page of Zone response bodies. It has these properties:
• zones—A list of ConnectApi.Zone objects.
• currentPageUrl—Chatter REST API URL identifying the current page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

Zone Search Page
Zones Search Page is a new response body that describes a page of Zone Search Result response bodies. It has these
properties:
• currentPageToken—Token identifying the current page.
• currentPageUrl—Chatter REST API URL identifying the current page.
• items—A list of ConnectApi.ZoneSearchResult objects.
• nextPageToken—Token identifying the next page or null if there isn’t a next page.
• nextPageUrl—Chatter REST API URL identifying the next page or null if there isn’t a next page.

Zone Search Result
Zone Search Result is a new response body that describes the result of a search within a zone. It has these properties:
• hasBestAnswer—Indicates if the search result has a best answer.
• id—ID of the search result. The search result can be a question or an article.
• title—Title of the search result.
• type—Type of the search result. A ConnectApi.ZoneSearchResultType enum:

◊ Article—Search results contain only articles.
◊ Question—Search results contain only questions.

• voteCount—Number of votes given to the search result.

Metadata API

Metadata Deployment Changes
This release introduces the following changes to the deployment process:

Improved workflow and status messages
When deploying components using Java, the deployment process steps have been reduced to two:
1. Issue a deploy() call to start the asynchronous deployment. An AsyncResult object is returned. Note the value in

the id field and use it for the next step.
2. Issue a checkDeployStatus() call using the id value returned in the AsyncResult object from the first step to

obtain a DeployResult object containing the results of the deploy() call.

The DeployResult object has new fields to give detailed real-time error messages, test failures and deployment status.
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Profile Settings for Managed Package Installed Components
In profiles and permission sets, you can now retrieve and deploy access settings for the following managed components:
• Apex classes
• Custom apps
• Custom field permissions
• Custom object permissions
• Custom tab settings
• External data sources
• Record types
• Visualforce pages

For example,  let’s say you install a managed package with the namespace MyNamespace and the custom object
JobRequest__c. You can now set object permissions for JobRequest__c in the package to a custom profile or a
permission set.

For changes to monitoring the deployment process, see Improvements to Deployment Monitoring.

New Metadata Types
These metadata types are new in API version 29.0.

AccountSettings
Represents an organization’s account settings for account teams, account owner report, and the View Hierarchy link.

BusinessHoursSettings
Represents the metadata used to manage settings for business hours and holidays in entitlements, entitlement templates,
campaigns, and cases.

CompactLayout
Represents the metadata associated with a compact layout.

ConnectedApp
Represents a Connected App application. A connected app is an application that integrates with salesforce.com using
APIs. Connected apps use standard SAML and OAuth protocols to authenticate, provide Single Sign-On, and provide
tokens for use with Salesforce APIs. In addition to standard OAuth capabilities, connected apps allow administrators
to set various security policies and have explicit control over who may use the applications.

FlexiPage
Represents the metadata associated with a Flexible Page. A Flexible Page is the home page for an app that appears as a
menu item in the Salesforce1 navigation menu.

PostTemplate
Represents the metadata associated with an approval post template for Approvals in Chatter. With approval post
templates, you can customize the information included in approval request posts that appear in Chatter feeds.

UserSharingRules
Represents the sharing rules for users. With user sharing rules, you can share members of a group with members of
another group.

Updated Calls
The following API call in version 29.0 supports a new argument.
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checkDeployStatus()

A boolean argument, includeDetails, sets the DeployResult object to populate the details field with information
about the deployment.

Updated Metadata Types and Fields
These metadata fields have been added or changed in API version 29.0.

ApprovalProcess
Salesforce Knowledge article approval actions and workflow rules are now supported in the Metadata API on deployed
article types. For article version (_kav) in approval processes, the supported action types are:
• Knowledge Action
• Email Alert
• Field Update
• Outbound Message

ArticleType CustomField
The following fields have been added:

defaultValue

If specified, represents the default value of the field.

deleteConstraint

Provides deletion options for lookup relationships. Valid values are:

SetNull

This is the default. If the lookup record is deleted, the lookup field is cleared.

Restrict

Prevents the record from being deleted if it’s in a lookup relationship.

Cascade

Deletes the lookup record as well as associated lookup fields.

formula

If specified, represents a formula on the field.

formulaTreatBlankAs

Indicates how to treat blanks in a formula. Valid values are BlankAsBlank and BlankAsZero.

referenceTo

If specified, indicates a reference this field has to another object.

relationshipLabel

If specified, indicates a reference this field has to another object.

relationshipName

If specified, indicates the value for one-to-many relationships. For example, in the object MyObject that had a
relationship to YourObject, the relationship name might be YourObjects.

The following field has been updated:

type

The following field types were added.
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• Currency

• ArticleCurrency

• Email

• Formula

• Lookup

• Number

• Percent

• Phone

• DependentPicklist

• URL

AuthProvider
The following fields have been added:

authorizeUrl

The OAuth authorization endpoint URL. Used only with OpenID Connect authentication providers.

defaultScopes

The scopes to be sent with the authorization request, if not specified when a flow is started. Used only with OpenID
Connect authentication providers.

tokenUrl

The OAuth token endpoint URL. Used only with OpenID Connect authentication providers.

userInfoUrl

The OpenID Connect endpoint URL. Used only with OpenID Connect authentication providers.

AsyncResult
Many fields moved to the DeployResult object as part of improving the status reporting of a deployment. The AsyncResult
object now contains:

done

Indicates whether the call has completed (true) or not (false).

id

ID of the component being created, updated, deleted, deployed, or retrieved.

message

Message corresponding to the statusCode field returned, if any.

state

One of four possible values.
• Queued: This call has not started. It is waiting in a queue.
• InProgress: This call has started, but has not completed yet.
• Completed: This call has completed.
• Error:

statusCode

If an error occurred, a status code is provided and a corresponding status message in the message field.
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ChatterAnswersSettings
The following field has been added:

enableAnswerViaEmail

Indicates whether users can post answers by replying to email notifications (true) or not (false).

The following field has been renamed:

enableOptimizeQuestionFlow has been renamed to enableInlinePublisher.

CriteriaBasedSharingRule
For all child components, the following field has been added:

description

Represents the description of the criteria-based sharing rule.

CustomField
The following field has been added:

trackTrending

An object is enabled for historical trending if this attribute is true for at least one field. Historical trending allows
you to capture and analyze changes to fields.

CustomFieldTranslation
The following fields have been added to provide language support for renaming standard fields:

caseValues

Different combinations of the custom object with regard to article, plural, possessive, and case. See the
ObjectNameCaseValue documentation for details.

gender

Indicates the gender of the noun. This is used for languages where words need different treatment depending on
their gender. Valid values are:

• Masculine

• Feminine

• Neuter

• Euter (Swedish)

• Common (Dutch)

startsWith

Indicates whether the noun starts with a vowel, consonant, or is a special character. This is used for languages
where words need different treatment depending on the first character. Valid values are:
• Consonant

• Vowel

• Special (for nouns starting with z, or s plus consonants)

CustomObject
The following fields have been added:

compactLayouts

A list of compact layouts associated with the object.

334

Metadata APIForce.com Development



compactLayoutAssignment

The compact layout assigned to this custom object.

The following field has been updated:

enableHistory

The enableHistory field is supported on standard objects (was previously custom objects, only).

CustomObjectTranslation
The following field has been added:

quickActions

A list of translations for publisher actions.

CustomTab
The following field has been added:

flexipage

The name of the Flexible Page to display in this tab.

DeployResult
Many fields have been added as part of improving the status reporting of a deployment. The DeployResult object now
contains::

checkOnly

Indicates whether this deployment is being used to check the validity of the deployed files without making any
changes in the organization (true) or not (false). A check-only deployment does not deploy any components
or change the organization in any way.

completedDate

Timestamp for when the deployment process ended.

createdDate

Timestamp for when the deploy() call was received.

details

Provides the details of a deployment that is in-progress or ended, if the includeDetails parameter is set to
true in the checkDeployStatus() call.

done

Indicates whether the server finished processing the deploy() call for the specified id.

errorMessage

Message corresponding to the values in the errorStatusCode field, if any.

errorStatusCode

If an error occurred during the deploy() call, a status code is returned, and the message corresponding to the
status code is returned in the errorMessagefield.

ignoreWarnings

Optional. Defaults to false. Specifies whether a deployment should continue even if the deployment generates
warnings. Do not set this argument to true for deployments to production organizations.

lastModifiedDate

Timestamp of the last update for the deployment process.
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numberComponentErrors

The number of components that generated errors during this deployment.

numberComponentsDeployed

The number of components deployed in the deployment process. Use this value with the numberComponentsTotal
value to get an estimate of the deployment’s progress.

numberComponentsTotal

The total number of components in the deployment. Use this value with the numberComponentsDeployed
value to get an estimate of the deployment’s progress.

numberTestErrors

The number of Apex tests that have generated errors during this deployment.

numberTestsCompleted

The number of completedApex tests for this deployment. Use this value with the numberTestsTotal value to
get an estimate of the deployment’s test progress.

numberTestsTotal

The total number of Apex tests for this deployment. Use this value with the numberTestsCompleted value to
get an estimate of the deployment’s test progress.

rollbackOnError

Optional. Defaults to true. Indicates whether any failure causes a complete rollback (true) or not (false). If
false, whatever set of actions can be performed without errors are performed, and errors are returned for the
remaining actions. This parameter must be set to true if you are deploying to a production organization.

startDate

Timestamp for when the deployment process began.

status

Indicates the current state of the deployment.

success

Indicates whether the deployment was successful (true) or not (false).

FolderShare
The following fields have been added to FolderSharedToType:

managers

A list of users whose direct and indirect managers receive sharing access. This field is available if your organization
has Manager Groups.

managerSubordinates

A list of users whose direct and indirect subordinates receive sharing access. This field is available if your organization
has Manager Groups.

IdeasSettings
The following fields have been added:

enableChatterProfile

Indicates that the Chatter user profile is used for Ideas user profiles.
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ideasProfilePage

The name of the Visualforce page to use for a custom Ideas user profile, if enableChatterProfile is false.

Layout
The following field has been added:

relatedContent

Represents the Related Content section of the page layout.

The following field has been added to LayoutItem:

reportChartComponent

Refers to a report chart that you can add to a standard or custom object page.

LiveChatAgentConfig
The following fields have been added:

criticalWaitTime

Specifies the number of seconds an agent can wait to answer an engaged chat before the chat tab flashes to alert
the agent to answer it.

enableAgentSneakPeek

Specifies whether an agent can see the content of a customer’s message before they send it (true) or not (false).

supervisorDefaultAgentStatusFilter

Specifies the Live Agent status for filtering the Agent Status list in the Supervisor Panel.

supervisorDefaultButtonFilter

Specifies the default button for filtering the Agent Status list in the Supervisor Panel.

supervisorDefaultSkillFilter

Specifies the default skill for filtering the Agent Status list in the Supervisor Panel.

supervisorSkills

Specifies the list of agent skills that are assigned to a supervisor, as specified in their assigned Live Agent
configuration.

LiveChatDeployment
The following field has been added:

enablePrechatApi

Indicates whether or not the pre-chat API is enabled for the deployment (true) or not (false).

MilestoneType
The following field has been added:

RecurrenceType

The type of recurrence for the milestone.

Network
The following fields have been added:

allowMembersToFlag

Determines whether users in the community can flag posts or comments as inappropriate. Flagged items are sent
to a community moderator for review.
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selfRegProfile

The profile assigned to users who self register. This value is used only if selfRegistration is enabled for the
community.

OwnerSharingRule
For all child components, the following field has been added:

description

Represents the description of the criteria-based sharing rule.

PermissionSet
The following fields have been added:

applicationVisibilities

Indicates which custom apps are visible to users assigned to the permission set.

recordTypeVisibilities

Indicates which record types are visible to users assigned to the permission set. This field is never retrieved or
deployed for inactive record types.

The following fields have changed:

userPermissions

In API version 28.0 and earlier, this field retrieves all user permissions, enabled or disabled. In API version 29.0
and later, this field retrieves only enabled user permissions. For example, if you have a permission set where “View
Setup and Configuration” is enabled and all other user permissions are disabled, in API version 29.0 and later, the
retrieved .permissionset file includes an entry for ViewSetup only.

<userPermissions>
<enabled>true</enabled>
<name>ViewSetup</name>

</userPermissions>

objectPermissions

Object permissions for Documents and Pricebooks can now be both retrieved and deployed.

Profile
The following field has been added:

userPermissions

Specifies a user permission (such as “API Enabled”) and whether it’s enabled for this profile.

The following fields have changed:

objectPermissions

Object permissions for Documents and Pricebooks can now be both retrieved and deployed.

recordTypeVisibilities

This field is no longer retrieved or deployed for inactive record types.

QuickAction
The following fields have been added:

338

Metadata APIForce.com Development



canvas

If a custom action is created using a canvas app, this identifies the app. Returns the fully-qualified name of the
canvas app in the format <namespace>__<dev_name>, if the quick action type is Canvas; otherwise, returns
null.

standardLabel

Specifies the standard label to use for the action. The valid values are:
• LogACall

• LogANote

• New

• NewRecordType (For example, a label with something like “New Idea”)
• Update

• UpdateRecordType

• NewChild

• NewChildRecordType

• CreateNew

• CreateNewRecordType (For example, a label with something like “Create New Idea”)
• QuickRecordType

• Quick (a quick record)

The following field includes new values:

type

LogACall

SocialPost

Canvas

Create

Update

RecordType
The following field has been added:

compactLayoutAssignment

Represents the compact layout that is assigned to the record type.

Report
The following fields have been added:

historicalSelector

Defines a date range for which historical trend reporting data is to be captured. Default is “Any Historical Date.”

showCurrentDate

Can be set to true for historical trending reports in matrix format.

The following fields have been added to ReportColumn:

reverseColors

In historical trend reports, displays greater Date values as green and greater Amount values as red, reversing the
default colors.
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showChanges

In historical trend reports, adds a column displaying the difference between current and historical Date and Amount
values.

The following fields have been added to ReportFilterItem:

columnToColumn

Indicates that the field contains data from a historical snapshot.

snapshot

Represents the date value, either relative (in the format N_DAYS_AGO:2) or absolute (in the format yyyy-MM-dd).

ReportType
The following field has been added:

autogenerated

Indicates that the report type was automatically generated when historical trending was enabled for an entity.

Translations
The following field has been added:

quickActions

A list of global (rather than object-specific) quick actions.

Bulk API
You can now submit up to 3,000 batches per rolling 24–hour period. The previous limit was 2,000 batches.

Tooling API
In version 29.0, Tooling API includes:

• Support for executing anonymous Apex.

• Expanded query functionality.

• Access to code coverage results.

• A new StaticResource object, and support for static resource deployment.

• A new FieldHistoryRetentionJob object, which lets you specify date ranges for the retention of field history data. The
object is currently available through a pilot program.

For details, see the Force.com Tooling API Developer’s Guide.

Analytics API
New in version 29.0, the Analytics API lets you integrate Salesforce report data into your apps programmatically. For example,
you can use the REST based API to build reporting into a third-party app to show a leaderboard of Dreamforce attendee
registrations at your sessions. The API has several resources that let you query report metadata, and get report results dynamically
at the summary or record detail level.

Available in: All editions that have API enabled except Database.com

For more information, see Analytics API in the release notes Analytics section.
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ISVforce
Winter ’14 includes several features that make it easier for partners to develop and distribute applications.

Environment Hub
Signup API Enhancements
Compact Layouts Available in Packages
Flexible Pages Available in Packages

Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

The Environment Hub lets you view, connect, create, and log into multiple Salesforce organizations from one location. This
can be especially convenient if you use a large number of organizations for business, development, and testing.

You must choose one organization as the Environment Hub (or hub organization), and can then connect all your other
organizations (or member organizations) to the hub. You can establish single sign-on between the hub and member organizations,
enabling users to seamlessly switch between them without having to provide login credentials.

When you connect an organization to the hub, related organizations are automatically discovered so you don't have to manually
connect them. The following types of related organizations are auto-discovered.

• For any organization, all sandbox organizations created from it.

• For a release organization, all its related patch organizations.

• For a Trialforce Management Organization, all Trialforce Source Organizations created from it.

• For a License Management Organization (LMO), that is, an organization with the License Management App installed,
any release organization (and therefore all its associated patch organizations) that has a managed package registered in the
LMO.

To access the Environment Hub:

1. In the Force.com App menu, click Environment Hub.
2. Click the Environment Hub tab.

Note:  To find the hub organization for any member organization, from Setup, click Company Profile > Company
Information. The organization ID of the hub organization is listed in the Organization Details section.

The Environment Hub main page displays a list of all member organizations connected to the hub. For each organization, its
name, description, edition, organization ID, single sign-on status, and other details are displayed. From the Environment
Hub tab, you can perform these actions.

• Click Connect Organization to add another organization.

• Click Create Organization to create a new organization.
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• Click the name of any organization to view details about it, including other organizations related to it.

• Click Edit next to an organization to update its details.

• Click Del next to an organization to delete it from the Environment Hub.

• Click Login next to an organization to log into it. If you’ve previously enabled single sign-on for that organization, you’ll
be logged in without providing login credentials.

If you’ve added a large number of organizations to the Environment Hub, you can zero in on organizations of a specific type,
for example, development organizations, or organizations created after a certain date. To create a custom view, click Create
New View at the top of the page. You can filter organizations based on multiple criteria such as edition, creation date, instance,
origin, SSO status, and so on.

Each member organization corresponds to an EnvironmentHubMember object. This is a standard object, similar to Accounts
or Contacts. Hence, you can use the full functionality of the Force.com platform to extend or modify the Environment Hub,
both via the user interface or the API. For example, you can create custom fields, set up workflow rules, or define user mappings
and enable single sign-on using the API, for any member organization.

Setting up Environment Hub
Setting up My Domain for the Environment Hub
Environment Hub Best Practices
Connecting an Organization to the Environment Hub
Viewing an Environment Hub Member’s Details
Editing an Environment Hub Member’s Details
Creating a New Organization from the Environment Hub
Enabling Single Sign-On in the Environment Hub
Disabling Single Sign-On in the Environment Hub
Mapping Users for Single Sign-On in the Environment Hub

Setting up Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

Follow these steps to set up Environment Hub for the first time.

1. Choose which organization you want to use as your hub organization. This should be the organization most employees
log into regularly.

2. Set up and deploy My Domain for your hub organization. This is a requirement for enabling Environment Hub.
3. Contact salesforce.com support to get Environment Hub enabled for your hub organization.
4. Once the feature is enabled, log into your hub organization via the new My Domain URL.
5. Edit profiles or permission sets to assign users access to specific features of Environment Hub..

a. From Setup, click Manage Users > Profiles.
b. Click Edit next to the appropriate profile.
c. Select the settings you want to enable, on the profile editing page.
d. Click Save.
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This table summarizes the settings for Environment Hub in the profile editing page.

Settings for Environment HubSection of Profile

Enable the Environment Hub custom app, so it’s available in the Force.com App
menu.

Custom App Settings

The Environment Hub connected app is for internal use only, and doesn’t need
to be enabled for any profiles.

Connected App Access

A new entry appears here automatically here whenever single sign-on is enabled
in a member organization. Enabling access to a service provider allows single

Service Provider Access

sign-on login access to the corresponding member organization.  The service
provider is named "[OrganizationID] Service Provider"
where [OrganizationID] is the organization ID of the member organization.
Users who don’t have access to the service provider may see this message when
attempting to log in via single sign-on: "User [UserID] does not have access
to sp [ServiceProviderID]."

The "Manage Environment Hub" permission controls which profiles can enable,
create, and edit single sign-on configuration for member organizations. It also

Administrative Permissions

controls which profiles can create new organizations from the hub (via the Create
Organization button).

The "Connect Organization to Environment Hub" permission controls which
profiles can connect existing organizations to the Environment Hub.

General User Permissions

The "Hub Members" settings are used to control access to the Environment
Hub Member entities as follows:

Standard Object Permissions

• Read: The ability to view existing Hub Member records.
• Create: This setting has no impact on the ability to create Hub Member

records. That’s because record creation is handled either by connecting an
existing organization or creating a new organization from the Environment
Hub.

• Edit: The ability to edit various fields on existing Hub Member records
(Organization, Description, etc.). Note that not all fields are editable, as most
are managed internally.

• Delete: The ability to "disconnect" an organization from the Hub, and delete
its corresponding Environment Hub Member record and Service Provider
record (if SSO was enabled on the Member).

• View All: The administrative ability to read all Hub Member records,
regardless of who created them.

• Modify All: The administrative ability to read, edit and delete all Hub
Member records, regardless of who created them.

Also, the "Hub Invitations" settings are used to manage connecting organizations
to the Environment Hub. When enabling the "Connect Organization to
Environment Hub" permission, Create, Read, Update, and Delete should also
be enabled for the "Hub Invitations" object. Otherwise, it can safely be disabled.

6. Define user mappings to configure which users should have single sign-on access to specific member organizations. For
details, see: Enabling Single Sign-On and Defining a SSO User Mapping.
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Once you’ve completed the above steps, any user with the appropriate profile can access the Environment Hub by clicking
Environment Hub in the App menu. The types of actions a user can perform in the Environment Hub will depend on the
settings in that user’s profile.

Setting up My Domain for the Environment Hub

User Permissions Needed

“Customize Application”To set up a domain name:

My Domain must be fully functional in your organization before Environment Hub can be enabled. Follow these steps to set
up and deploy My Domain.

1. Find a domain name that’s available and sign up for it.

a. From Setup, click Domain Management > My Domain.
b. Enter the subdomain name you want to use within the sample URL. You can use up to 40 characters.
c. Click Check Availability. If your name is already taken, choose a different one.
d. Click Terms and Conditions to review your agreement, then select the checkbox.
e. Click Register Domain.

You'll receive an email when your domain name is ready for testing. It can take from 10 minutes to 24 hours.
2. Test your domain name and deploy it to your entire organization.

a. From Setup, click Domain Management > My Domain, then click Click here to login, or click the URL in the
confirmation email, to login to Salesforce using your new domain name.

b. Test the new domain name by clicking tabs and links within your application. You’ll notice that all pages show your
new domain name. If you’ve customized your Salesforce UI with features such as custom buttons or Visualforce pages,
make sure you test custom elements thoroughly before deploying your domain name. Your customizations should not
use instance-based URLs.

c. To roll out the new domain name to your organization, from Setup, click Domain Management > My Domain and
then click Deploy to Users .

The domain is activated immediately and all users are redirected to pages with new domain addresses.
3. Set the domain login policy for users accessing your pages.

a. From Setup, click Domain Management > My Domain.
b. Under My Domain Settings, click Edit.
c. To turn off authentication for users who do not use your domain-specific login page, select the login policy. For example,

this will prevent users from logging in at the generic https://<instance>.salesforce.com/ login page, and
being redirected to your pages after login. This option enhances security by preventing login attempts by anyone who
does not know your domain name.

d. Choose a redirect policy, based on the level of security desired. You have three options, in order of increasing security:

• Redirect users to the same page within the domain.
• Redirect users with a warning.
• Prevent redirecting, so users have to enter the new domain name.

4. Optionally, customize your login page and add or change identity providers available on your login page. For details, see
the Salesforce online help.
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Environment Hub Best Practices

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

These guidelines can help you use Environment Hub effectively.

• Choose the organization that most employees log into regularly, as your hub organization.

• You should have only one hub organization.

• Set up My Domain for each member organization, in addition to the hub organization.

• Edit profiles or permission sets to assign users access to specific features of Environment Hub. Some key settings are listed
below.

◊ The Environment Hub custom app must be enabled for it to appear in the Force.com App menu.

◊ "Manage Environment Hub” is required to create new organizations or configure single sign-on access. This is powerful
functionality and should only be assigned to admin users

◊ “Connect Organization to Environment Hub” is required to add new member organizations to the hub.

◊ Service Provider Access must be enabled for each member organization to which you want to allow single sign-on
access.

For details of all the profile settings, see: Setting up the Environment Hub.
• Decide on a strategy for enabling single sign-on access based on your organization's security requirements. You can then

choose which combination of the three SSO methods (explicit mapping, Federation ID, or custom formula) to use for
your specific needs. For details, see: Enabling Single Sign-On.

• Since each member organization is a standard object (of type EnvironmentHubMember), you can modify its behavior or
access it programmatically. For example, you can create custom fields, set up workflow rules, or define user mappings and
enable single sign-on using the API, for any member organization.

• Single sign-on won’t work for newly added users or for SSO user mappings defined in a sandbox organization. You should
only add users, edit user information, or define SSO user mappings in the parent organization for the sandbox.

Connecting an Organization to the Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Connect Organization to Environment Hub”To connect an organization to the Environment Hub:

To connect an organization to the Hub:

1. On the Environment Hub main page, click Connect Organization.
2. Enter the admin username for the member organization, that is, the organization you want to connect to the hub.
3. Click Connect Organization.
4. Enter the admin username and password of the member organization in the popup window.
5. Click Log in to Salesforce.
6. Click Allow in the next popup window.

The organization is now connected to the hub and appears in the list of member organizations in the Environment Hub.
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Viewing an Environment Hub Member’s Details

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

Click the name of any organization in the Environment Hub to view details about it, such as its name, description, organization
ID, related organizations, and linked users.

The detail page has the following sections.

• Hub Member Detail

• Parent Organizations

• Child Organizations

• Single Sign-On User Mappings

From the Hub Member Detail page, you can do any of the following.

• Click Edit to edit information about this organization.

• Click Delete to remove this organization from the Environment Hub.

• Click Enable SSO to enable single sign-on for this organization. This lets linked users log into this organization from the
Environment Hub without providing credentials.

• Click Log into Organization to log in. If you’ve enabled SSO for this organization, you’ll be logged in without entering
login credentials.

• Click New SSO User Mapping to link a username in the member organization with a username in the hub organization
for single sign-on access.

Hub Member Detail

This section displays the following attributes (in alphabetical order).

DescriptionAttribute

A brief description of this organization.Description

The organization’s edition, for example, DE or EE.Edition

The method by which this organization was added to the
Environment Hub. Possible values are Auto Discovered
and User Added.

Origin

The name of this organization.Organization

The organization ID of this organization.Organization ID

If this is a sandbox organization.Sandbox

A Details link here indicates that the organization has been
activated for Environment Hub single sign-on by

Service Provider

salesforce.com support. You need to enable service provider
access for this organization in all profiles that will be using it
for single sign-on.

The licensing or creation status of this organization. Possible
values include Trial, Free, Active, Suspended, and
Deleted.

Status
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DescriptionAttribute

If single sign-on has been enabled for this organization.
Possible values are:

SSO

• On—Single sign-on is enabled.
• Off—Single sign-on is disabled.
• Pending—Single sign-on is in the process of being

enabled.
• Failed—Single sign-on enablement failed. Contact

salesforce.com support for assistance.

The number of SSO user mappings defined between this
organization and the environment hub.

SSO Method 1 — Mapped Users

If single sign-on has been enabled based on matching
Federation ID.

SSO Method 2 — Federation ID

If single sign-on has been enabled using a custom formula to
match usernames.

SSO Method 3 — User Name Formula

Parent Organizations and Child Organizations

When you connect an organization to the Environment Hub, the following types of related organizations are automatically
discovered and connected.

• For any organization, all sandbox organizations created from it.
• For a release organization, all its related patch organizations.
• For a Trialforce Management Organization, all Trialforce Source Organizations created from it.
• For a License Management Organization (LMO), that is, an organization with the License Management App installed,

any release organization (and therefore all its associated patch organizations) that has a managed package registered in the
LMO.

These sections display a list of the organizations related to this organization. For each organization in the list, its name and
relationship to this organization are displayed.

Single Sign-On User Mappings

This section displays a list of mapped users, that is, users in the hub organization who are associated with a corresponding
user in the member organization. If single sign-on has been enabled for the member organization, all mapped users can log
into it from the Environment Hub without needing to provide credentials.

From this section, you can do any of the following:

• Click New SSO User Mapping to define a new user mapping.
• Click Del next to a user to disable single sign-on access.

User mappings can be many-to-one (but not one-to-many). This means you can associate multiple users in the hub organization
to the same user in a member organization. This can be useful, for example, if you want a group of users to log into a test
organization as the same user, so they experience exactly the same configuration.

Note:

• If a user mapping has been defined and the user is still unable to use single sign-on, check that the user’s profile
has the appropriate permissions enabled. For details, see: Setting up Environment Hub.

• Single sign-on won’t work for newly added users or for SSO user mappings defined in a sandbox organization.
You should only add users, edit user information, or define SSO user mappings in the parent organization for the
sandbox.
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Editing an Environment Hub Member’s Details

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

To edit details of a member organization in the Environment Hub:

1. Click Edit next to the organization’s name in the Environment Hub main page, or on its detail page.
2. In the page that displays, edit the name and description for the organization. It’s helpful to specify a meaningful name and

description. This lets you easily recognize the organization in the list of members in the Environment Hub.
3. Optionally, specify one or more single sign-on methods (see below for details).
4. Click Save.

To match users in the member and hub organizations for single sign-on, you can use any of three methods.

DescriptionSSO Method

Match users in the hub organization to users in a member organization manually.
This method is on by default if you’ve defined any SSO user mappings from the
member detail page. For details, see: Defining a SSO User Mapping.

Mapped Users

Match users who have the same Federation ID in both organizations. To enable
this method, select the checkbox next to it.

Federation ID

Define a custom formula for matching users in the hub and member organizations.
This allows you the most flexibility. To enable this method, type a custom formula

User Name Formula

into the text box provided. For example, the following formula matches the first
part of the user name (the part before the “@” sign) with an explicit domain name.

LEFT($User.Username, FIND("@", $User.Username)) &
("mydev.org")

If you specify more than one single sign-on method, they're evaluated in the order of precedence listed above at the time a
user tries to log in. The first method that results in a match is used to log the user in, and the other methods are ignored. If
no matching user can be identified, you’re directed to the standard salesforce.com login page.

Creating a New Organization from the Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

To create a new organization in the Environment Hub:

1. On the Environment Hub, click Create Organization.
2. From the pulldown menu, choose the type of organization you want to create. Possible choices are: Development, Test,

and Release.
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3. On the page that appears, enter the organization’s name and My Domain, as well as the name, user name, and email
address of the admin user. If you’re creating a test organization, you must also specify either its edition or a Trialforce
template ID.

4. Click Create.

Here’s a comparison of the different types of organizations used for development.

• Development organization — a standard Developer Edition (DE) organization.

• Release organization — A DE organization used for creating and uploading a managed package.

• Test organization — a trial organization created for test and demonstration purposes, similar to an organization created
from www.salesforce.com/trial. Partners can specify a Trialforce template for creating trial organizations. This enables
them to configure and test exactly how their prospects experience the trial.

Enabling Single Sign-On in the Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

To enable single sign-on for an organization:

1. On the Environment Hub main page, click the name of the organization.
2. Click Enable SSO on the organization’s detail page.
3. On the page that displays, click Enable SSO.

You’re taken to the detail page of the organization. Its single sign-on status displays both at the top of the page, and next to
the SSO field in the Hub Member Details section.

To match users in the member and hub organizations for single sign-on, you can use any of three methods.

DescriptionSSO Method

Match users in the hub organization to users in a member organization manually.
This method is on by default if you’ve defined any SSO user mappings from the
member detail page. For details, see: Defining a SSO User Mapping.

Mapped Users

Match users who have the same Federation ID in both organizations. To enable
this method, select the checkbox next to it.

Federation ID

Define a custom formula for matching users in the hub and member organizations.
This allows you the most flexibility. To enable this method, type a custom formula

User Name Formula

into the text box provided. For example, the following formula matches the first
part of the user name (the part before the “@” sign) with an explicit domain name.

LEFT($User.Username, FIND("@", $User.Username)) &
("mydev.org")

If you specify more than one single sign-on method, they're evaluated in the order of precedence listed above at the time a
user tries to log in. The first method that results in a match is used to log the user in, and the other methods are ignored. If
no matching user can be identified, you’re directed to the standard salesforce.com login page.
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Note:

• If a user mapping has been defined and the user is still unable to use single sign-on, check that the user’s profile
has the appropriate permissions enabled. For details, see: Setting up Environment Hub.

• Single sign-on won’t work for newly added users or for SSO user mappings defined in a sandbox organization.
You should only add users, edit user information, or define SSO user mappings in the parent organization for the
sandbox.

Disabling Single Sign-On in the Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

To disable single sign-on for an organization:

1. On the Environment Hub main page, click the name of the organization.
2. Click Disable SSO on the organization’s detail page.
3. On the page that displays, click Disable SSO.

You’re taken to the detail page of the organization. Its single sign-on status displays both at the top of the page, and next to
the SSO field in the Hub Member Details section.

Mapping Users for Single Sign-On in the Environment Hub

Available in: Professional, Enterprise, Performance, Unlimited, and Developer Editions

User Permissions Needed

“Manage Environment Hub”To set up and configure the Environment Hub:

You can define a mapping between a user in the hub organization and one or more users in a member organization. If single
sign-on has been enabled for the member organization, all mapped users can log into it from the Environment Hub without
needing to provide credentials.

User mappings can be many-to-one (but not one-to-many). This means you can associate multiple users in the hub organization
to the same user in a member organization. This can be useful, for example, if you want a group of users to log into a test
organization as the same user, so they experience exactly the same configuration.

To define a new single sign-on user mapping in Environment Hub:

1. On the Environment Hub main page, click the name of the organization.
2. Click New SSO User Mapping on the hub member detail page.
3. In the page that appears, enter the username for the member organization and specify the corresponding user for the hub

organization using the lookup field.
4. Click Save (or Save & New to save and add a new mapped user).
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Note:

• If a user mapping has been defined and the user is still unable to use single sign-on, check that the user’s profile
has the appropriate permissions enabled. For details, see: Setting up Environment Hub.

• Single sign-on won’t work for newly added users or for SSO user mappings defined in a sandbox organization.
You should only add users, edit user information, or define SSO user mappings in the parent organization for the
sandbox.

Signup API Enhancements

Available in: Developer Edition

In Winter '14, the following fields have been added to the SignupRequest object. They expand your options for signing up
new trial organizations using the API.

DetailsField Name

Type

string

AuthCode

Properties

Create, Filter, Group, Sort

Description

A one-time authorization code that can be exchanged for an OAuth access token and
refresh token using standard Salesforce APIs. It’s used in conjunction with
ConnectedAppCallbackUrl and ConnectedAppConsumerKey, when the specified
Connected App hasn't been configured with an X.509 certificate. This is a read-only
field provided by the system once the signup request has been processed. This field is
available in API version 29.0 and later.

Type

string

CreatedOrgInstance

Properties

Filter, Group, Nillable, Sort

Description

The server instance of the new trial organization, for example, “na8.” This field is available
in API version 29.0 and later.

Type

boolean

SuppressSignupEmails

Properties

Filter, Group, Nillable, Sort
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DetailsField Name

Description

When set to true, no signup emails are sent when the trial organization is created. This
field is used for the Proxy Signup feature, and is available in API version 29.0 and later.

Compact Layouts Available in Packages

Available in: All editions except Database.com

Compact layouts—the new mobile-optimized record layouts for Salesforce1—are supported in both managed and unmanaged
packages.

Flexible Pages Available in Packages

Available in: All editions except Database.com

Flexible Pages—the new mobile app home pages for Salesforce1—are available in managed and unmanaged packages.
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Other salesforce.com Products
desk.com
Desk.com is an all-in-one customer support app for small businesses and growing teams.

For information on new features, go to the Desk.com Product Updates Blog.

do.com
Do.com is a social productivity platform for organizing, tracking, and creating project-based tasks.

For information on new features, go to the do.com New Features Help page.

Heroku
Heroku is a cloud-based application platform for building and deploying web apps.

For information on new features, go to the Heroku Changelog.

Salesforce Marketing Cloud
Salesforce Marketing Cloud is a unified social marketing suite that allows companies to listen to and engage customers, publish
content, optimize social advertising, measure campaigns, and integrate social insights with customer data.

For information on new features, go to the Salesforce Marketing Cloud Facebook page.

Work.com
Work.com is a social performance-management tool that helps managers and teams learn faster and perform better.

For information on new features, read the Work.com Release Notes.
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Help and Training
Release Notes
The Salesforce.com Release Notes are now available in HTML format. See HTML Release Notes—Beta on page 1.

Videos
•

Who Sees Whom: User Sharing (6:05 minutes)

Learn how you can control visibility among users in your organization.

•
Connecting Social Networks to Accounts, Contacts, and Leads (3:29 minutes)

Gain insights to your current and prospective customers by adding social data to your Salesforce accounts, contacts, and
leads.

•
Updating Entitlement Processes with Entitlement Versioning (2:20 minutes)

Learn how to create a new version of an entitlement process, change the milestone in the new version of the entitlement
process, and apply the new version of the entitlement process to an entitlement and its associated cases.

Tip Sheets and Implementation Guides
• The Using Date and Date/Time in Formulas tip sheet contains a myriad of Date and Date/Time formula examples, as

well as providing an overview of how they work.
• The Customizing Chatter Profile Pages tip sheet contains information about deploying custom content on Chatter profiles.

Developer Guides
• The Force.com Apex Code Developer’s Guide (PDF | HTML) has been restructured. The topics in the guide have been

reorganized—they’re grouped into logical parts, and the order of some topics has changed. For example, to learn about
everything that’s related to data in Apex, including DML, SOQL, and dynamic Apex, refer to the Working with Data in
Apex chapter. Fundamental concepts are presented first, and are followed by more complex concepts that build on them,
which makes it easier to learn the Apex language. The documentation about Apex governor limits and transactions has
been enhanced. The reference section has been reorganized to list classes by namespace, and method documentation has
been reformatted. Finding and consuming Apex documentation is faster and easier than ever.

• In the SOAP API Developer’s Guide, the following changes have been made to the documentation for DescribeLayoutResult
to bring it in line with what’s already in the API.

◊ DescribeButtonSection has been updated to DescribeLayoutButtonSection, and information about its field
detailButtons has been added.

◊ A description for DescribeLayoutButton was added, as well as information for its three fields: custom, label, and
name.

• In the Force.com Apex Code Developer’s Guide, the query cursor limits were incorrectly documented as 50 query cursors per
user for all Apex features and Visualforce, except for the Batch Apex start method that was documented to have 5 query
cursors. The Winter ’14 documentation has been updated with the correct per-user query cursor limits—namely 50 for
Apex with the exception of 15 for the Batch Apex start method, and 5 for the Batch Apex execute and finish
methods each. Visualforce has 5 query cursors.

• The Live Agent REST API is now generally available, supported by the new Live Agent REST API Developer’s Guide. The
Live Agent REST API allows developers to customize and extend the functionality of Live Agent chat windows in mobile
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and web applications. This guide provides a comprehensive reference of the REST API resources that are available to Live
Agent developers.
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